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August 7, 2024
Important:

The product lifecycle strategy for Current Releases (CR) and Long Term Service Releases (LTSR)
is described in Lifecycle Milestones.

Session Recording records, catalogs, and archives sessions for retrieval and playback.

Session Recording provides flexible policies to trigger recordings of application and desktop sessions
automatically. Session Recording also supports dynamic session recording. Session Recording en-
ables IT personnel to monitor and examine user activity, and so supports internal controls for regula-
tory compliance and security monitoring. Similarly, Session Recording also aids in technical support
by speeding problem identification and time-to-resolution.

Benefits

Enhanced security through logging and monitoring. Session Recording allows organizations to
record on-screen user activity for applications that deal with sensitive information, monitoring and
preventing the leakage of sensitive information from virtual sessions. Prevention of sensitive infor-
mation leakage is especially critical in regulated industries such as healthcare and finance.

Powerful activity monitoring. Session Recording captures and archives screen updates, including
mouse activity and visible output of keystrokes to provide a record of activity for specific users, appli-
cations, and servers.

Session Recording isn’t designed for the evidence collection for legal proceedings. However, orga-
nizations can use Session Recording together with other techniques for evidence collection, such as
conventional video records combined with traditional text-based eDiscovery tools.

Faster problem resolution. When users call with a problem that is difficult to reproduce, help desk
support staff can enable recording of user sessions. If the issue recurs, Session Recording provides a
time-stamped visual record of the error, which can then be used for faster troubleshooting.

What’s new

July 16, 2024
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What’s new in 2407

This release includes the following new features and addresses issues to improve the user experi-
ence:

Hide screen areas for specific applications during Thinwire screen recording

Previously, hiding screen areas for specific applications was only available for lossy screen recording.
Starting with release, you can also hide screen areas for specific applications when recording Thin-
wire-transmitted session screens.

Tip:

Thinwire, a part of Citrix HDX technology, is the Citrix default display remoting technology used
in Citrix Virtual Apps and Desktops. Display remoting technology allows graphics generated on
one machine to be transmitted, typically across a network, to another machine for display.

For more information, see Create a custom recording policy.

Capture printing activities in recorded sessions (preview)

We have extended the scope of event detection to monitor printing activities that occur during
recorded sessions and tag the printing activities as events in recordings for later search and
playback.

To use this feature, make sure that:

+ You have configured and activated a session recording policy that specifies sessions to record.
For more information, see Configure session recording policies.

 You have created an event detection policy and selected the Log printing activities option for
it. For more information, see Create a custom event detection policy.

Note:

This is a preview feature. It is available with Session Recording version 2407 and later. Preview
features might not be fully localized and are recommended for use in non production environ-
ments. Citrix Technical Support doesn’t support issues found with preview features.

Report message queue quota exceedance on each VDA to the Session Recording server

In any of the scenarios outlined below, there’s a chance of exceeding the maximum size of the Mi-
crosoft Message Queuing (MSMQ) directory on a VDA, resulting in packet drops or pushback.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 6


https://docs.citrix.com/en-us/session-recording/current-release/whats-new/fixed-issues.html
https://docs.citrix.com/en-us/session-recording/current-release/configure/settings-on-session-recording-agent/enable-or-disable-lossy-screen-recording
https://docs.citrix.com/en-us/citrix-daas/graphics/thinwire
https://docs.citrix.com/en-us/session-recording/current-release/configure/policies/session-recording-policies#create-a-custom-recording-policy
https://docs.citrix.com/en-us/session-recording/current-release/configure/policies/session-recording-policies.html
https://docs.citrix.com/en-us/session-recording/current-release/configure/policies/event-detection-policies#create-a-custom-event-detection-policy

Session Recording 2407

« Onthe VDA side, the incoming rate of Message Queuing messages exceeds the outgoing rate.

« The network connection between the VDA and the Session Recording server is poor and thus
messages are stuck in the queue on the VDA side.

« The queue quota on the Session Recording server side is used up and messages are stuck in the
gueue on the VDA side.

To facilitate diagnoses and troubleshooting, Session Recording can now capture and report the is-
sues as logs to the Session Recording server for display in the Windows Event Viewer. This feature is
enabled by default. You can disable and re-enable the feature by using the following registry value on
the target VDA:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\DiagnosticLoggingEnabled
Value data: 1 =enabled, 0 =disabled

You can also set how long these logs can be retained on the Session Recording database. To do so, go
to the Logging tab of Session Recording Server Properties and configure the Retention period for
diagnostic logs. The default value is 30 days.

For more information, see Diagnostic logging.

Dynamic screen recording through Citrix PowerShell SDKs extended to event-only recording

You can run PowerShell commands that Citrix SDKs provide to start recording the screen at any
time during a session. Previously, this feature was unavailable for sessions that fall into the scope
of an event-only recording policy. Starting with this release, you can run PowerShell commands to
dynamically turn an event-only recording into a screen recording so that the screen is also captured
in addition to the target events.

For more information, see Configure session recording policies and Dynamically start or stop record-
ing by using PowerShell commands in the Citrix SDKs.

What’s new in earlier releases

For new featuresincluded in the releases that shipped after the 1912 LTSR through the 2402 LTSR, see
What’s new history.

Fixed issues

July 4,2024

Compared with: Session Recording 2402 LTSR
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Session Recording 2407 adds the following fixes:

+ When viewing recordings in the player, you might encounter an error message indicating miss-
ing data from the recording process, along with a data loss warning in the Event logs (Event ID:
2005) on the Session Recording server. [SRT-12682] [SRT-12707]

« When you disable a rule for an event response policy on the Session Recording policy console,
all configurations associated with the rule might be deleted. [SRT-12037]

+ Whenyou use Microsoft Edge to access the website http://<SR Server>/WebPlayer/#/logging/config,
the browser incorrectly opens 3 sign-in windows. [SRT-12274]

« Theweb player might not support playing the recordingfiles stored in C:\SessionRecordingsRestored.
[SRT-12599]

« Theweb playerisunable to play recordings when its URL contains the word “cloud.”[SRT-12045]

Known issues

July 2,2024

The following issues have been identified in this release:

« If you are using Citrix Web App Firewall (WAF) signatures to mitigate in part the CVE-2021-44228
vulnerability, Session Recording might not work as expected. To resolve the issue, exclude the
IP addresses of your Session Recording servers from the mitigate_cve_2021_44228 policy on
the NetScaler side. [CVADHELP-24365]

+ Attempts to save the Session Recording policy settings might fail and you can obtain the follow-
ing error message by using CDFControl:

This operation is blocked. Session Recording Administrator
Logging failed. The formatter threw an exception while trying
to deserialize the message: There was an error while trying to

deserialize parameter http://tempuri.org/:operation. The
InnerException message was 'There was an error deserializing
the object of type SmAudLoggingInterface.LogOperation. The
maximum string content length quota (8192) has been exceeded
while reading XML data. This quota may be 1increased by
changing the MaxStringContentLength property on the
XmlDictionaryReaderQuotas object used when creating the XML
reader. Line 186, position 62.'. Please see InnerException for
more details.

To address the issue, perform one of the following operations:
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- Add an HTTPS site bindingin IIS for communication with the Session Recording server. For

example:
Site Bindings ? et
Type Host Name Port IP Address Binding Informa... Add...
https 443 *
http a0 =

Close

- Addthefollowinglinestothe Web.configfile available in C:\Program Files\Citrix\SessionRecording\Log;

<readerQuotas maxDepth="32" maxStringContentlLength="5242880"
maxArraylLength="16384" maxBytesPerRead="4096"
maxNameTableCharCount="16384" />

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 9
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| "Web.config - Notepad - O X
9 P

File Edit Format View Help
<?xml version="1.0" encoding="utf-8"2> "
<configuration>
<system.serviceModel>
<protocolMapping>
<add scheme="http" binding="wsHttpBinding" bindingConfiguration="MessageSecurity” />
<add scheme="https" binding="wsHttpBinding" bindingConfiguration="TransportSecurity” />
</protocolMapping>
<bindings>
<wsHttpBinding:»
<binding name="TransportSecurity”»
<security mode="Transport”:»
<message clientCredentialType="Windows" />
securit

kreaderQuotas maxDepth="32" maxStringContentlength="5242880" maxArraylength="16384" maxBytesPerRead="40896"
maxMameTableCharCount="16384" />

</binding>
<binding name="MessageSecurity”>
<security mode="Message">
<message clientCredentialType="Windows" establishSecurityContext="false" />
securit

<readerQuotas maxDepth="32" maxStringContentlength="5242888" maxArraylength="16384" maxBytesPerRead="4896" |
axMameTableCharCount="16384" />
</binding>
</wsHttpBinding>
</bindings>
<behaviors>
<serviceBehaviors>
<behavior>
<serviceDebug includeExceptionDetailInFaults="False" />
<servicefuthorization principalPermissionMode="UseAspletRoles” roleProviderName="AuthorizationStoreRoleProvider”

/>
</behavior:
</serviceBehaviors>»
</behaviors>»
<serviceHostingEnvironment multipleSiteBindingsEnabled="True" />
</system.serviceModel>
<system.web>
<compilation debug="False" /> v
Ln14, Col 4 100%  Windows (CRLF) UTF-8 with BOM

[SRT-11791]

+ Attempts to close unresponsive or dormant live recordings automatically or manually by using

the ICLDB DORMANT command might fail. The issue occurs when you update Session Recording

to 2308 instead of doing a fresh installation. To resolve the issue, run the following script in
PowerShell on the Session Recording server machine and ensure that you have administrative

access to the Session Recording database:

Add-Type -AssemblyName System.data

SregistryKey = [Microsoft.Win32.Registry]::LocalMachine.
OpenSubKey ("SOFTWARE\\Citrix\\SmartAuditor\\Server")

$dbName = S$SregistryKey.GetValue("DatabaseName")

$dbInstance = $registryKey.GetValue("SmAudDatabaseInstance")

write-host "Connecting to $dbInstance\$dbName"

# Connect db

$conn = New-Object System.Data.SqlClient.SqlConnection

$conn.ConnectionString = "workstation 1id=.;packet size=4096;
integrated security=SSPI;data source=$SdbInstance;persist
security info=True;initial catalog=$dbName"

$conn.Open()
$cmd = Sconn.CreateCommand()
$cmd.CommandText = "use [$dbName];if not exists(select * from [

dbo] . [EndReason] where ID=5) begin insert [dbo].[EndReason]
values (5, 'Dormant') end"
$cmd. ExecuteNonQuery ()

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 10



Session Recording 2407

[SRT-11119]

+ Session Recording doesn’t capture file transfers between a native disk on the session host (VDA)
and a disk that’s mapped to the session from the client. [SRT-10514]

+ When you upgrade Session Recording to the latest version, your image resolution scaling set-
tings for lossy screen recording are lost and the default value 1.0 is restored. [SRT-10130]

+ A domain user with local administrator privileges on the Session Recording policy console can
add local and domain users to which the action of a policy rule applies. However, a local user
with local administrator privileges can add only local users but not domain users. [SRT-5769]

+ The web player might not work properly if you upgrade it from Version 2009 or earlier. To work
around the issue, clear your browser cache. [SRT-5624]

+ Rules of custom policies might be lost after you update Session Recording from the version in-
cluded in XenApp and XenDesktop 7.6 LTSR to the latest version. As a workaround, update the
software to the version included in the latest CU of XenApp and XenDesktop 7.15 LTSR and then
update it to the latest release. [SRT-4546]

+ When Machine Creation Services (MCS) or Citrix Provisioning (PVS) creates multiple VDAs with
Microsoft Message Queuing (MSMQ) installed, those VDAs can have the same QMId. This condi-
tion might cause various issues, for example:

- Sessions might not be recorded even if the recording agreement is accepted.
- The Session Recording server might not be able to receive session-logoff signals and there-
fore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]

Third party notices

June 21, 2024
Session Recording Version 2407 (PDF Download)

This release of Session Recording can include third party software licensed under the terms defined
in this document.

System requirements

June 21,2024
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Session Recording includes the Session Recording Administration components, the Session Record-
ing agent, and the Session Recording player. You can install the Session Recording Administration
components (Session Recording database, Session Recording server, and Session Recording policy
console) on a single server or on different servers. The following section details the requirements for
each of the Session Recording components.

For information about using this Current Release (CR) in a Long Term Service Release (LTSR) environ-
ment and other FAQs, see Knowledge Center article.

Session Recording database

Supported operating systems:

« Windows Server 2025
« Windows Server 2022
« Windows Server 2019

Supported Microsoft SQL Server versions:

» Microsoft SQL Server 2022 Enterprise, Express, and Standard editions
« Microsoft SQL Server 2019 Enterprise, Express, and Standard editions
» Microsoft SQL Server 2017 Enterprise, Express, and Standard editions
« Microsoft SQL Server 2016 SP2 Enterprise, Express, and Standard editions

Supported Azure SQL database services:

+ Azure SQL Managed Instance
« SQL Server on Azure Virtual Machines (VMs)

(Use supported versions of Microsoft SQL Server that are listed earlier.)
« Azure SQL Database

Supported AWS RDS database services:
« SQL Server

Requirement: .NET Framework 4.7.2

Session Recording server

Supported operating systems:

« Windows Server 2025
« Windows Server 2022
« Windows Server 2019

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 12
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Other requirements:

« Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5

+ .NET Framework Version 4.7.2

+ If the Session Recording server uses HTTPS as its communications protocol, add a valid certifi-
cate. Session Recording uses HTTPS by default, which Citrix recommends.

« Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP
support enabled.

+ For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11

Session Recording policy console

Supported operating systems:

« Windows Server 2025
« Windows Server 2022
« Windows Server 2019

Requirement: .NET Framework 4.7.2

Session Recording agent

Install the Session Recording agent on every Windows Virtual Delivery Agent (VDA) on which you want
to record sessions.

Supported operating systems:

« Windows Server 2025

« Windows Server 2022

« Windows Server 2019

« Windows 11

« Windows 10, minimum version 1607

« Windows 10 Enterprise for Virtual Desktops

Requirements:

« Citrix Virtual Apps and Desktops 7 2203 with Premium license

« Citrix Virtual Apps and Desktops 7 1912 LTSR CU4 or later with Platinum license

« XenApp and XenDesktop 7.15 LTSR CU8 with Platinum license

« .NET Framework 4.7.2

+ Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP
support enabled

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 13
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Note:

Session Recording currently supports Citrix DaaS (formerly Citrix Virtual Apps and Desktops ser-
vice) Advanced, Advanced Plus, Premium, and Premium Plus editions.

Session Recording player

Supported operating systems:

« Windows Server 2025

« Windows Server 2022

« Windows Server 2019

« Windows 11

+ 64-bit Windows 10, minimum version 1607

Requirement: .NET Framework 4.7.2
Note:

On 32-bit Windows 10, you can install the player only by using the SessionRecordingPlayer.msi
file. You can find the msi file on the Citrix Virtual Apps and Desktops ISO under \x86\Session
Recording.

For optimal results, install the Session Recording player on a workstation with:

+ Screen resolution of 1024 x 768

« Color depth of at least 32-bit

+ 2GBRAM minimum; more RAM and CPU/GPU resources can improve performance when playing
graphics-intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and your machine’s hardware specifica-

tions.

Get started

June 21,2024

Session Recording consists of five components:

Session Recording components

Session Recording consists of the following components:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 14
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+ Session Recording Administration components:

- Session Recording policy console. A console used to configure policies such as session
recording policies that specify which sessions to record. For more information, see Poli-
cies.

- Session Recording server. A server that hosts:

x The Broker. An 1IS 6.0+ hosted Web application that serves the following purposes:
- Handling search queries and file download requests from the Session Recording
player and web player.
- Handling policy administration requests from the Session Recording policy con-
sole.
- Evaluating recording policies for each Citrix Virtual Apps and Desktops or Citrix
DaaS (formerly Citrix Virtual Apps and Desktops service) session.
*x The Storage Manager. A Windows service that manages the recorded session files re-
ceived from each Session Recording-enabled VDA.
» Administrator logging. An optional subcomponent installed with the Session
Recording server to log the administration activities. All the logging data is stored in
a separate SQL Server database named CitrixSessionRecordingLogging by default.
You can customize the database name.

- Session Recording database. A component that manages the SQL Server database for
storing recorded session data. When this component is installed, it creates a database
named CitrixSessionRecording by default. You can customize the database name.

+ Session Recording agent. A component installed on each VDA for multi-session OS or single-
session OS to enable recording. It is responsible for recording session data.

+ Session Recording player [ web player. A user interface that users access from a workstation
to play recorded session files.

To install Session Recording or upgrade an existing installation, go to each machine where you are
about to or have already installed the Session Recording components and then run the Citrix Virtual
Apps and Desktops I1SO.

Tip:

Go to the Citrix Virtual Apps and Desktops download page to download the appropriate version
of Citrix Virtual Apps and Desktops.

For more information about installing Session Recording, see Install, upgrade, and uninstall. You can
also refer to the Citrix Tech Zone article POC Guide: Citrix Session Recording for information on how
to quickly set up and configure Citrix Session Recording and Citrix Session Recording service.
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Example deployment

The following diagram shows an example deployment:

-

Session Recording

Policy Console Session Recording
Player

Session - /
=]
[___os]
[__e=]

Recording Agent

Desktop
0S VDA ﬁ
ﬁ machine
L P or —> Session
User device Recording

Server
0S VDA ﬁ SEMNEr
machine

. Database

All the Session Recording components reside behind a security firewall.

The Session Recording agent is installed on a VDA for multi-session OS or single-session OS.

A second server hosts the Session Recording policy console, a third server acts as the Session

Recording server, and a fourth server hosts the database.

The Session Recording player is installed on a workstation. Installing the Session Recording

server lets you install the Session Recording web player automatically.

A client device outside the firewall communicates with the VDA where the Session Recording

agent s installed.

Inside the firewall, the Session Recording agent, policy console, player, and database all com-

municate with the Session Recording server.

© 1999-2024 Cloud Software Group, Inc. All rights reserved.
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Plan your deployment

July 4,2024

Limitations and caveats

Session Recording doesn’t support Desktop Composition Redirection (DCR) display mode. By default,
Session Recording disables DCR in a session to be recorded. You can configure this behavior in Ses-
sion Recording Agent properties.

When you browse URLs configured in the browser content redirection policy in Internet Explorer,
graphics activities are not recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display
mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode
might not contain the sessions’activities.

Session Recording can’t record the Lync webcam video when using the HDX RealTime Optimization
Pack.

Depending upon your environment, you can deploy the Session Recording components in different
scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording agent,
all components are independent of the server site. For example, you can configure multiple sites to
use a single Session Recording server.

A single Session Recording server might experience a high performance demand. For example, you
might have a large site with many agents and plan to record many sessions or many graphically in-
tense applications such as AutoCAD. To alleviate performance issues, you can install multiple Session
Recording servers and configure load balancing.

Ports

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 17
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Source

Virtual Delivery
Agent

Destination

Session
Recording server

Type

TCP

Port

80, 443

Details

Communication
between the
Session
Recording agent
installed on
Virtual Delivery
Agent and the
Session
Recording server.
Default
installation uses
HTTPS/SSL to
secure
communications.
If SSL is not
configured, use
HTTP.
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Source

Virtual Delivery
Agent

Session
Recording policy
console

Destination

Session
Recording server

Session
Recording server

Type

TCP

TCP

Port

1801

80, 443

Details

By default,
Session
Recording uses
TCP as the
communication
protocol and thus
MSMQ uses port
1801 for sending
messages over
TCP. Alternatively,
MSMQ can use
port 80 or 443 for
sending
messages over
HTTP or HTTPS
based on your
protocol setting
on the
Connections tab
of Session
Recording Agent
Properties.
Communication
between the
server where the
Session
Recording policy
console is
installed and the
Session
Recording server.
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Source Destination Type Port Details

Session Session TCP 80,443 Communication

Recording player  Recording server between the
workstation
where the
Session

Recording player
is installed and
the Session
Recording server.

Session Microsoft SQL TCP 1433 Connection to

Recording server  Server the Session
Recording
database.

Suggested server site deployment

Use this type of deployment for recording sessions for one or more sites. The Session Recording agent
is installed on each VDA in a site. The site resides in a data center behind a security firewall. The Ses-
sion Recording Administration components are installed on other servers and the Session Recording
player on a workstation, all behind the firewall.
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Important deployment notes

+ To enable Session Recording components to communicate with each other, install them in the
same domain or across trusted domains that have a transitive trust relationship. The system
cannot be installed on a workgroup or across domains that have an external trust relationship.

« Consideringitsintense graphical nature and memory usage when playing back large recordings,
we do not recommend installing the Session Recording Player as a published application.

+ The Session Recording installation is configured for TLS/HTTPS communication. Install a certifi-
cate on the Session Recording server. Make sure the root certificate authority (CA) is trusted on
the Session Recording components.

+ Forthe Session Recording server on a standalone server running SQL Server, enable the TCP/IP
protocol and run the SQL Server Browser service. These settings are disabled by default, but
they must be enabled for the Session Recording server to communicate with the database. For
more information, see the Microsoft articles Enable TCP/IP Network Protocol for SQL Server and
SQL Server Browser service.

+ Consider the effects of session sharing when planning your Session Recording deployment. Ses-
sion sharing for published applications can conflict with Session Recording policy rules for pub-
lished applications. Session Recording matches the active policy with the first published appli-
cation that a user opens. After the user opens the first application, any subsequent applications
opened during the same session continue to follow the policy that is in force for the first applica-
tion. For example, if a policy states to record only Microsoft Outlook, the recording commences
when the user opens Outlook. If the user opens a published Microsoft Word second while Out-
look is running, Word also is recorded. Conversely, if the active policy doesn’t specify to record
Word and the user launches Word before Outlook, Outlook is not recorded.

+ Though you can install the Session Recording server on a Delivery Controller, we don’t recom-
mend it because of performance issues.

+ You can install the Session Recording Policy Console on a Delivery Controller.

+ You can install both the Session Recording server and the Session Recording Policy Console on
the same system.

+ Ensure that the NetBIOS name of the Session Recording server does not exceed the limit of 15
characters. Microsoft has a 15-character limit on the host name length.

« PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install
the Session Recording agent on Windows Server 2012 R2 that has PowerShell 4.0 installed. Fail-
ure to comply can cause failed API calls.

+ For step-by-step instructions on deploying and configuring the Citrix Session Recording and Cit-
rix Session Recording service, see this Citrix Tech Zone article: POC Guide: Citrix Session Record-

ing.
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Security recommendations

June 21,2024

Session Recording is deployed within a secure network and accessed by administrators, and as such,
is secure. Out-of-the-box deployment is simple and security features such as digital signing and en-
cryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information
Services (IIS) and Microsoft Message Queuing (MSMQ). 1IS provides the web services communication
link between Session Recording components. MSMQ provides a reliable data transport mechanism
to send recorded session data from the Session Recording agent to the Session Recording server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Consider these security recommendations when planning your deployment:

+ Configure Microsoft Internet Information Services (IIS).

You can configure Session Recording with a restricted IS configuration. On each Session Record-
ing server, open the IIS Manager and set the following recycling limits for each IS application
pool:

- Virtual Memory Limit: Set the value to 4,294,967,295.

- Private Memory Limit: Set the value to the physical memory of the Session Recording
server. For example, if the physical memory is 4 GB, set the value to 4,194,304.

- Request Limit: We recommend you leave this setting unspecified. Oryou can setthe value
to 4,000,000,000.

Tip:

To access the preceding settings, highlight each application pool, select Advanced Set-
tings in the Actions pane, and then scroll down to the Recycling section in the Advanced
Settings dialog box.

« Ensure that you properly isolate the different administrator roles in the corporate network, in
the Session Recording system, or on individual machines. By not doing so, security threats that
can impact the system functionality or abuse the system might occur. We recommend that you
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assign different administrator roles to different persons or accounts. Do not allow general ses-
sion users to have administrator privileges to the VDA system.

- Do not grant VDA local administrator role to any users of published apps or desktops. If
the local administrator role is a requirement, protect the Session Recording agent compo-
nents by using Windows mechanisms or third-party solutions.

- Separately assign the Session Recording database administrator and Session Recording
policy administrator.

- Do not assign VDA administrator privileges to general session users, especially when using
Remote PC Access.

- The Session Recording server’s local administration account must be strictly protected.

- Control access to machines where the Session Recording player is installed. If a useris not
authorized for the Player role, do not grant that user the local administrator role for any
player machine. Disable anonymous access.

- We recommend using a physical machine as a storage server for Session Recording.

+ Session Recording records session graphics activities without regard to the sensitivity of the
data. Under certain circumstances, sensitive data (including but not limited to user credentials,
privacy information, and third-party screens) might be recorded unintentionally. Take the fol-
lowing measures to prevent risks:

- Disable core memory dump for VDAs unless for specific troubleshooting cases.
To disable core memory dump:

1. Right-click My Computer, and then select Properties.
2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
3. Under Write Debugging Information, select (none).

See the Microsoft article at https://support.microsoft.com/en-us/kb/307973.

- Session owners notify attendees that online meetings and remote assistance software
might be recorded if a desktop session is being recorded.

- Ensure that logon credentials or security information does not appear in all local and Web
applications published or used inside the corporation. Otherwise, they are recorded by
Session Recording.

- Close any application that might expose sensitive information before switching to a re-
mote ICA session.

- We recommend only automatic authentication methods (for example, single sign-on,
smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

+ Session Recording relies on certain hardware and hardware infrastructure (for example, corpo-
rate network devices, operation system) to function properly and to meet security needs. Take
measures at the infrastructure levels to prevent damage or abuse to those infrastructures and
make the Session Recording function secure and reliable.
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- Properly protect and keep network infrastructure supporting Session Recording available.
- We recommend using a third-party security solution or Windows mechanism to protect
Session Recording components. Session Recording components include:
* On the Session Recording server
- Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
- Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
- Allfiles in the Session Recording server installation folder
- Registry values within HKEY_LOCAL_MACHINE\SOFTWARE\CitrixX\SmartAuditor\Server
* On the Session Recording agent
- Process: SsRecAgent.exe
- Service: CitrixSmAudAgent

- Allfiles in the Session Recording agent installation folder
- Registry values under HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\

SmartAuditor\Agent

+ Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording server
to restrict VDA or VDI machines that can send MSMQ data to the Session Recording server and
prevent unauthorized machines from sending data to the Session Recording server.

1. Install server feature Directory Service Integration on each Session Recording server and
VDA or VDI machine where Session Recording is enabled. Then restart the Message Queu-

ing service.

2. From the Windows Start menu on each Session Recording server, open Administrative

Tools > Computer Management.
3. Open Services and Applications > Message Queuing > Private Queues.

4. Click the private queue citrixsmauddata to open the Properties page and select the Se-
curity tab.
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+ Properly protect the event log for the Session Record server and Session Recording agents. We
recommend using a Windows or third-party remote logging solution to protect the event log or
redirect the event log to the remote server.

+ Ensure that servers running the Session Recording components are physically secure. If possi-
ble, lock these computers in a secure room to which only authorized personnel can gain direct
access.

« Isolate servers running the Session Recording components on a separate subnet or domain.

+ Protect the recorded session data from users accessing other servers by installing a firewall be-
tween the Session Recording server and other servers.

+ Keep the Session Recording Administration Server and SQL database up-to-date with the latest
security updates from Microsoft.

+ Restrict non-administrators from logging on to the administration machine.
« Strictly limit who is authorized to make recording policy changes and view recorded sessions.

« Install digital certificates, use the Session Recording file signing feature, and set up TLS commu-
nicationsin lIS.

» Setup MSMQ to use HTTPS asitstransport. The way is to set the MSMQ protocol listed in Session
Recording Agent Properties to HTTPS. For more information, see Troubleshoot MSMQ.

o UseTLS1.10rTLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Record-
ing server and Session Recording Database.

+ Disable RC4 cipher suites for TLS on the Session Recording server and Session Recording data-
base:

1. Using the Microsoft Group Policy Editor, navigate to Computer Configuration > Admin-
istrative Templates > Network > SSL Configuration Settings.

2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not
Configured.

3. Remove any RC4 cipher suites.

+ Use playback protection. Playback protection is a Session Recording feature that encrypts
recorded files before they are downloaded to the Session Recording player. By default, this
option is enabled and is in Session Recording Server Properties.

+ Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.
+ Configure TLS 1.2 support for Session Recording.

We recommend using TLS 1.2 as the communication protocol to ensure the end-to-end security
of the Session Recording components.

To configure TLS 1.2 support of Session Recording:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 26


https://docs.citrix.com/en-us/session-recording/current-release/troubleshooting/locate-recordings-using-player-fails.html#troubleshoot-msmq

Session Recording 2407

1. Logon tothe machine hosting the Session Recording server. Install the proper SQL Server
clientcomponent and driver, and set strong cryptography for . NET Framework (version
4 or later).

a) Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.

b) Apply the latest hotfix rollup of .NET Framework.

c) Install ADO.NET - SqglClient based on your version of .NET Framework. For
more information, see https://support.microsoft.com/en-us/kb/3135244,

d) Add aDWORD value SchUseStrongCrypto=1under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
and HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NetFramework\v4.0.30319.

e) Restart the machine.

2. Logontothemachine hostingthe Session Recording policy console. Apply the latest hotfix
rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4 or
later). The method for setting strong cryptography is the same as substeps 1-4 and 1-5.
You can omit these steps if you choose to install the Session Recording policy console on
the same computer as the Session Recording server.

To configure the TLS 1.2 support for SQL Server with versions earlier than 2016, see https://support.
microsoft.com/en-us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication protocol
for the Session Recording components.

Scalability considerations

August 5, 2024

Session Recordingis a highly scalable system that handles thousands or tens of thousands of sessions.
Installing and running Session Recording requires few extra resources beyond what is necessary to
run Citrix Virtual Apps and Desktops or Citrix DaaS (formerly Citrix Virtual Apps and Desktops service).
However, we still recommend you consider the performance of your system if you plan to record many
sessions. Or, the sessions you plan to record might resultin large session files (for example, graphically
intense applications).

This article explains how Session Recording achieves high scalability and how you can get the most
out of your recording system at a lowest cost.

Why Session Recording scales well

There are two major reasons that Session Recording scales well compared with competitive prod-
ucts:
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+ Small file size

Arecorded session file made with Session Recording is highly compact. Itis many orders of mag-
nitude smaller than an equivalent video recording made with solutions that screen-scrape. The
network bandwidth, disk space, and disk IOPS required to transport/store a recorded session
fileis typically at least 10 times less than an equivalent video file.

The small size of recorded session files means faster and smoother rendering of video frames.
Recordings are also lossless and have no pixelation that is common in most compact video for-
mats. Text in recordings is easy to read during playback as it is in the original sessions. To
maintain small file sizes, Session Recording does not record key frames within the files. Ses-
sion Recording can drop H.264 packages while recording sessions that have videos running and
thus reduce the recording file sizes. To use this functionality, set HKEY _LOCAL_MACHINE
\SOFTWARE\Citrix\SmartAuditor\Agent\DropH264Enabled to 1 on the Session
Recording agent and set the value of Use video codec for compression to For actively chang-

ing regions.
g Create Policy
bvs »
Edit Setting
Policyd Use video codec for compression
Boveienl| settings |BAssnedito | -
— S ————— Value: | For actively changing regions ¥
» Use video codec for compression
User setting - ICA\Graphics Use default value: Use when preferred
For actively changing regions (Default: Use when preferred)
¥ Applies to the following VDA versions -

Virtual Delivery Agent: 7.6 Server OS, 7.6 Desktop OS, 7.7 Server OS, 7.7 Desktop OS, 7.8 Server
OS, 7.8 Desktop OS, 7.9 Server OS, 7.9 Desktop OS, 7.11 Server OS, 7.11 Desktop OS, 7.12 Server
0S, 7.12 Desktop OS, 7.13 Server OS, 7.13 Desktop OS, 7.14 Server OS, 7.14 Desktop 0S, 7.15
Server 08, 7.15 Desktop OS, 7.16 Server OS, 7.16 Desktop 0S, 7.17 Server OS, 7.17 Desktop OS,
7.18 Server OS, 7.18 Desktop OS, 1808 Server OS, 1808 Desktop OS, 1811 Server OS, 1811
Desktop OS, 1903 Server OS, 1903 Desktop OS, 1906 Server OS, 1906 Desktop OS, 1909 Multi-
session OS, 1909 Single-session 0S, 1912 Multi-session 0S, 1912 Single-session OS

w Description
This setting is available only on VDA versions XenApp and XenDesktop 7.6 Feature Pack 3 and
later.

Allows use of a video codec to compress graphics when video decoding is available on the
endpoint. When 'For the entire screen’ is chosen the video codec will be applied as the default
codec for all content (some small images and text will be optimized and sent losslessly). When
‘For actively changing regions’ is selected the video codec will be used for areas where there is
constant change on the screen, other data will use still image compression and bitmap caching.
When video decoding is not available on the endpoint, or when you specify ‘Do not use’, a
combination of still image compression and bitmap caching is used. When ‘Use when preferred’ is
selected, the system chooses, based on various factors. The results may vary between versions as
the selection method is enhanced.

Select Do not use’ to optimize for server CPU load and for cases that do not have a lot of server-
rendered video or other graphically intense applications.

Select "For the entire screen’ to optimize for cases with heavy use of server-rendered video and
3D graphics, especially in low bandwidth.

+ Low processing required to generate files

A recorded session file contains the ICA protocol data for a session that is extracted virtually in
its native format. The file captures the ICA protocol data stream that is used to communicate
with Citrix Workspace app. There is no need to run expensive transcoding or encoding software
components to change the format of data in real time. The low amount of processing is also
important for VDA scalability. It ensures the end-user experience is maintained when many ses-
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sions are recorded from the same VDA.

Moreover, only those ICA virtual channels that can be played back are recorded, which results
in a further optimization. For example, the printer and client drive mapping channels aren’t
recorded. The channels can generate high volumes of data without any benefit in video play-
back.

Estimate data input and processing rates

The Session Recording server is the central collection point for recorded session files. Each machine
that is running a multi-session OS VDA with Session Recording enabled sends recorded session data
to the Session Recording server. Session Recording can handle high volumes of data and can tolerate
bursts and faults. But there are physical limits on how much data any one server can handle.

Consider how much data you send to each Session Recording server. Estimate how quickly the servers
can process and store the data. The rate at which your system can store incoming data must be higher
than the data input rate.

To estimate your data input rate, do the following calculation:

1. Multiply the number of recorded sessions by the average session size.
2. Divide the product by the time for which you are recording sessions.

For example, you might record 5,000 Microsoft Outlook sessions of 20 MB each over an 8-hour work
day. In this case, the data input rate is approximately 28 Mbps (5,000 sessions multiplied by 20 MB,
divided by 8 hours, divided by 3,600 seconds per hour, and multiplied by 8 for conversion to Mbps).
A typical Session Recording server connected to a 100 Mbps LAN with sufficient disk space to store
the recorded data can process data at around 5.0 Mbps. This rate is the processing rate based on the
physical limits imposed by disk and network IOPS. In the example, the processing rate (5.0 Mbps) is
lower than the input rate (28 Mbps), so recording the 5,000 Outlook sessions is impossible.

The amount of data per session varies greatly depending on what is being recorded. Other factors
such as screen resolution, color depth, and graphics mode also have impacts. A session where CAD
is running likely generates a much larger recording than a session where the user sends and receives
emails in Outlook. Therefore, recording the same number of CAD sessions can generate a high input
rate and require the use of more Session Recording servers.

Bursts and faults

The previous example assumes a simple uniform throughput of data but doesn’t explain how the
system deals with short periods of higher activity, known as bursts. A burst might occur when all users
log on at the same time in the morning, known as the 9 o’clock rush. It can also occur when they
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receive the same email in their Outlook inbox at once. The 5.0 Mbps processing rate of the Session
Recording server is highly inadequate at dealing with this sudden demand.

The Session Recording agent running on each VDA uses Microsoft Message Queuing (MSMQ) to send
recorded data to the Storage Manager running on the central Session Recording server. The data is
sent in a store-and-forward manner similar to how an email is delivered between the sender, mail
server, and receiver. If the Session Recording server or network can’t handle a high rate of data in
bursts, the recorded data is temporarily stored. The data message might be temporarily stored in the
outgoing queue on the VDA if the network is congested. The other case is that the data has traversed
the network but the Storage Manager is busy processing other messages. In this case, the data mes-
sage is stored on the Session Recording server’s receiving queue.

MSMQ also serves as a fault tolerance mechanism. If the Session Recording server goes down or the
link is broken, recorded data stays in the outgoing queue on each VDA. When the fault is rectified, all
queued data is sent together. MSMQ also allows you to take a server offline for upgrade or mainte-
nance without interrupting session recording and losing data.

The main limitation of MSMQ is that disk space for the temporary storage of data messages is finite.
This limitation limits how long a burst, fault, or maintenance event can last before data is eventually
lost. The overall system can continue after data loss, but in this situation, individual recordings have
chunks of data missing. A file with missing data is still playable but only up to the point where data
was first lost. Note the following:

+ Adding more disk space to each server, especially the Session Recording server, and making it
available to MSMQ can increase the tolerance to bursts and faults.

« Itisimportant to configure the Message Life setting for each Session Recording agent to an ap-
propriate level (on the Connections tab in Session Recording agent Properties). The default
value is 7,200 seconds (two hours). It means that each recorded data message has two hours to
reach the Storage Manager before the Storage Manager discards it and damages the recording
file. With more disk space available (or fewer sessions to record), you can choose to increase
this value. The maximum value is 365 days.

The other limitation with MSMQ is that when data backlogs, there is extra disk IOPS in the queue to
read and write data messages. Normally, the Storage Manager receives and processes data from the
network directly, without data messages ever being written to disk. Storing the data involves a single
write operation to disk that appends the recorded session file. When data is backlogged, the disk IOPS
is tripled: each message must be written to disk, read from disk, and written to file. As the Storage
Manager is heavily IOPS bound, the processing rate of the Session Recording server drops until the
backlog of messages is cleared. To mitigate the effects of this extra IOPS, adopt the following recom-
mendations:

+ Make sure that the disk on which MSMQ stores messages is different from the recording file
storage folders. Even though IOPS bus traffic is tripled, the drop in the true processing rate is
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never as severe.

+ Plan outages at off-peak times only. Depending on budget constraints, follow recognized ap-
proaches to building high availability servers. The approaches include the use of Uninterrupt-
ible Power Supply (UPS), dual NICs, redundant switches, and hot swappable memory and disks.

Design for spare capacity

The data rate of recorded session data is unlikely to be uniform, bursts and faults might occur, and
the clearing of message backlogs is expensive in IOPS. For this reason, design each Session Recording
server with plenty of spare capacity. Adding more servers or improving the specification of existing
servers, as described in later sections, always gains you extra capacity. The general rule of thumb is to
run each Session Recording server at a maximum of 50% of its total capacity. In the earlier example,
if the server can process 5.0 Mbps, target the system to run only at 2.5 Mbps.

Backlogs and live playback

Live playback is when a reviewer opens a session recording for playback while the session is still ac-
tive. During live playback, the responsible Session Recording agent switches to a streaming mode for
that session. Recording data is sent immediately to the Storage Manager without internal buffering.
Because the recording file is constantly updated, the player can continue to be fed with the latest data
from the live session. However, data sent from the agent to the Storage Manager is through MSMQ, so
the queuing rules described earlier apply. A problem can occur in this scenario. When MSMQ is back-
logged, the new recorded data available for live playback is queued like all other data messages. The
reviewer can still play the file, but viewing the latest live recorded data is delayed. If live playback is
an important feature for reviewers, ensure a low probability of backlog. You can design spare capacity
and fault tolerance into your deployment.

System scalability

Session Recording never reduces session performance and never stops sessions in response to
recorded data backlogs. Maintaining the end-user experience and single-server scalability is para-
mount in the design of the Session Recording system. If the recording system becomes irreversibly
overloaded, recorded session data is discarded. Recording ICA sessions has a low impact on the
performance and scalability of VDAs. The size of the impact depends on the platform, the memory
available, and the graphical nature of the sessions being recorded. With the following configuration,
you can expect a single-server scalability impact of between 1% and 5%. In other words, if a server
can host 100 users without Session Recording installed, it can host 95-99 users after installation:

+ 64-bit server with 8 GB RAM running a multi-session OS VDA
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« All sessions running Office productivity applications, such as Outlook and Excel
» The use of applications is active and sustained
+ All sessions are recorded as configured by the Session Recording policies

With fewer sessions recorded or session activity less sustained and more sporadic, the impact is less.
Often times, the scalability impact is negligible and user density per server remains the same. As
mentioned earlier, the low impact results from the simple processing requirements of the Session
Recording components on each VDA. Recorded data is extracted from the ICA session stack and sent
as-is to the Session Recording server through MSMQ. There is no expensive encoding of data.

There is a minor overhead of using Session Recording even when no sessions are recorded. If you are
not going to record any sessions from a particular server, you can disable recording on that server. Re-
moving Session Recording is one way. A less invasive approach is to clear the Enable session record-
ing for this VDA machine check box on the Session Recording tab in Session Recording Agent Prop-
erties. If session recording is required in future, reselect this check box.

Measuring throughput

You can measure the throughput of recorded session data from the sending VDA to the receiving Ses-
sion Recording server. Asimple and effective approach is to observe the size of recording files and the
rate at which disk space on the Session Recording server is being consumed. The volume of data writ-
ten to disk closely reflects the volume of network traffic being generated. The Windows Performance
Monitor tool (perfmon.exe) has standard system counters that you can observe in addition to some
counters provided by Session Recording. Counters can be used to measure throughput, and identify
bottlenecks and system problems. The following table outlines some of the most useful performance

counters.

Performance Object Counter Name Description

Citrix Session Recording Agent  Active Recording The number of sessions that
Count are currently being recorded on

a particular VDA.

Citrix Session Recording Agent  Bytes read from the The number of bytes read from
Session Recording the kernel components
Driver responsible for acquiring

session data. Useful for
determining how much data a
single VDA generates for all
sessions recorded on that
server.
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Performance Object

Citrix Session Recording
Storage Manager

Citrix Session Recording
Storage Manager

LogicalDisk

MSMQ Queue

Counter Name

Active Recording
Count

Message bytes/sec

Disk Write Bytes/sec

Bytes in Queue

Description

Similar to the Citrix Session
Recording agent counter except
for the Session Recording
server. Indicates the total
number of sessions currently
being recorded for all servers.
The throughput of all recorded
sessions. Can be used to
determine the rate at which the
Storage Manager is processing
data. If MSMQ is backlogged
with messages, the Storage
Manager runs at full speed.
This value can be used to
indicate the maximum
processing rate of the Storage
Manager.

Can be used to measure disk
write-through performance,
which isimportant in achieving
high scalability for the Session
Recording server. Performance
of individual drives can also be
observed.

Can be used to determine the
amount of data backlogged in
the CitrixSmAudData message
queue. If this value increases
over time, the rate of recorded
data received from the network
is greater than the rate at which
the Storage Manager can
process data. This counter is
useful for observing the effect
of data bursts and faults.
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Performance Object Counter Name Description

MSMQ Queue Message 1in Queue Similar to the Bytes in Queue
counter but measures the
number of messages.

Network Interface Bytes Total/sec Can be used to measure on
both sides of the link to
observe how much data is
generated when sessions are
recorded. When measured on
the Session Recording server,
this counter indicates the rate
at which incoming data is
received. Contrasts with the
Citrix Session Recording
Storage Manager
Message bytes/sec
counter that measures the
processing rate of data. If the
network rate is greater than
this value, messages build in
the message queue.

Processor % Processor Time Worth monitoring even though
CPU is unlikely to be a
bottleneck.

Session Recording server hardware

You can increase the capacity of your deployment by carefully selecting the Session Recording server
hardware. You have two choices: scaling up (by increasing the capacity of each server) or scaling out
(by adding more servers). In making either of the choices, your aimis to increase scalability at a lowest
cost.

Scaling up

When examining a single Session Recording server, consider the following best practices to ensure op-
timal performance for available budgets. The system depends on IOPS that can ensure a high through-
put of recorded data from the network onto the disk. So it is important to invest in appropriate net-
work and disk hardware. For a high-performance Session Recording server, a dual CPU or dual core
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CPU is recommended but little is gained from any higher specification. 64-bit processor architecture
is recommended but an x86 processor type is also suitable. 4 GB of RAM is recommended but again
there is little benefit from adding more.

Scaling out

Even with the best scaling up practices, there are limits to performance and scalability that can be
reached with a single Session Recording server when recording many sessions. It might be necessary
to add extra servers to meet the load. You can install more Session Recording servers on different
machines to have the Session Recording servers work as a load balancing pool. In this type of deploy-
ment, the Session Recording servers share the storage and the database. To distribute the load, point
the Session Recording agents to the load balancer that is responsible for the workload distribution.

Network capacity

A 100 Mbps network link is suitable for connecting a Session Recording server. A Gb Ethernet connec-
tion might improve performance, but does not resultin 10 times greater performance than a 100 Mbps
link. In practice, the gain in throughput s less.

Ensure that network switches used by Session Recording are not shared with third-party applications
that might compete for available network bandwidth. Ideally, network switches are dedicated for
use with the Session Recording server. If network congestion proves to be the bottleneck, a network
upgrade is a relatively inexpensive way to increase the scalability of the system.

Storage

Investment in disk and storage hardware is the single most important factor in server scalability. The
faster that data can be written to disk, the higher the performance of the overall system. When select-
ing a storage solution, take more note of the write performance than the read performance.

Store data on a RAID or a SAN.
Note:
Storing data on a NAS, based on file-based protocols such as SMB and NFS, might have perfor-

mance and security implications. Use the latest version of the protocol in place to avoid security
implications and perform scale testing to ensure proper performance.

For a local drive setup, aim for a disk controller with built-in cache memory. Caching allows the con-
troller to use elevator sorting during write-back. It minimizes disk head movement and ensures that
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write operations are completed without waiting for the physical disk operation to complete. It canim-
prove write performance significantly at a minimal extra cost. Caching does however raise the prob-
lem of data loss after a power failure. To ensure the integrity of data and the file system, consider a
battery backup facility for the caching disk controller.

Consider using a suitable RAID storage solution. There are many RAID levels available depending on
performance and redundancy requirements. The following table specifies each of the RAID levels and
how applicable each standard is to Session Recording.

Minimum Number of

RAID Level Type Disks Description
RAID 0 Striped set without 2 Provides high
parity performance but no

redundancy. Loss of
any disk destroys the
array. RAID O is a low
cost solution for
storing recorded
session files where the
impact of data loss is
low. Easy to scale up
performance by
adding more disks.

RAID 1 Mirrored set without 2 No performance gain
parity over one disk, making
it a relatively

expensive solution.
Use this solution only
if a high level of
redundancy is
required.
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RAID Level

RAID 3

RAID 5

Type

Striped set with
dedicated parity

Striped set with
distributed parity

Minimum Number of
Disks

Description

Provides high write
performance with
redundancy
characteristics similar
to RAID 5. RAID 3is
recommended for
video production and
live streaming
applications. As
Session Recording is
this type of
application, RAID 3 is
most highly
recommended butitis
not common.
Provides high read
performance with
redundancy but at the
cost of slower write
performance. RAID 5 is
the most common for
general purpose
usages. But due to the
slow write
performance, RAID 5 is
not recommended for
Session Recording.
RAID 3 can be
deployed at a similar
cost but with better
write performance.
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Minimum Number of

RAID Level Type Disks Description
RAID 10 Mirrored set and 4 Provides performance
striped set characteristics of RAID

0 with redundancy
benefits of RAID 1. An
expensive solution
thatis not
recommended for
Session Recording.

RAID 0 and RAID 3 are the most recommended RAID levels. RAID 1 and RAID 5 are popular standards
but are not recommended for Session Recording. RAID 10 does provide some performance benefits
but is too expensive for the additional gain.

Decide on the type and specification of disk drives. IDE/ATA drives and external USB or Firewire drives
are not suitable for use in Session Recording. The main choice is between SATA and SCSI. SATA drives
provide reasonably high transfer rates at a reduced cost per MB compared with SCSI drives. However,
SCSl drives provide better performance and are more common in server deployments. Server RAID so-
lutions mostly support SCSI drives but some SATA RAID products are now available. When evaluating
the specifications of disk drive products, consider the rotational speed of disk and other performance
characteristics.

Because the recording of thousands of sessions per day can consume significant amounts of disk
space, you must choose between overall capacity and performance. From the earlier example, record-
ing 5,000 Outlook sessions over an 8-hour work day consumes about 100 GB of storage space. To store
10days’worth of recordings (that is, 50,000 recorded session files), you need 1,000 GB (1 TB). This pres-
sure on disk space can be eased by shortening the retention period before archiving or deleting old
recordings. If 1 TB of disk space is available, a seven-day retention period is reasonable, ensuring
disk space usage remains around 700 GB, with 300 GB remaining as a buffer for busy days. In Session
Recording, the archiving and deleting of files is supported with the ICLDB utility. It has a minimum
retention period of two days. You can schedule a background task to run once a day at some off-peak
time. For more information about the ICLDB commands and archiving, see Manage your database
records.

The alternative to using local drive and controllers is to use a SAN storage solution based on block-
level disk access. To the Session Recording server, the disk array appears as a local drive. SANs are
more expensive to set up, but as the disk array is shared, SANs do have the advantage of simplified
and centralized management. There are two main types of SAN: Fibre Channel and iSCSI. iSCSI is
essentially SCSI over TCP/IP and is gaining popularity over Fibre Channel since the introduction of Gb
Ethernet.
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Database scalability

The volume of data sent to the Session Recording database is small because the database stores only
metadata about the recorded sessions. The files of the recorded sessions themselves are written to
a separate disk. Typically, each recorded session requires only about 1 KB of space in the database,
unless the Session Recording Event APl is used to insert searchable events to the session.

The Express Editions of Microsoft SQL Server 2019, Microsoft SQL Server 2017, Microsoft SQL Server
2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, and Microsoft SQL Server 2008 R2 impose
a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about
4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are
limited only by available disk space. As the number of sessions in the database increases, perfor-
mance of the database and speed of searches diminishes only negligibly.

If you are not making customizations through the Session Recording Event API, each recorded session
generates four database transactions: two when recording starts, one when the user logs on to the
session being recorded, and one when recording ends. If you use the Session Recording Event API
to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing
load on the database is unlikely to be stressed. The impact is light enough that the Session Recording
database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and
Desktops data store database.

If your Session Recording deployment requires many millions of recorded sessions to be cataloged in
the database, follow Microsoft guidelines for SQL Server scalability.

Install, upgrade, and uninstall

August 5, 2024
Note:

To configure server high availability through load balancing, see Configure load balancing in an
existing deployment and Deploy and load balance Session Recording in Azure.

To learn more about how to quickly set up and configure Citrix Session Recording and Citrix Ses-
sion Recording service, see the Citrix Tech Zone article POC Guide: Citrix Session Recording.

You caninstallthe Session Recording serverand agent on an Azure AD joined machine and enable
Azure AD support for them. Later when you configure various policies and playback permissions
from the cloud, you can specify Azure AD users and groups who launch sessions from Azure AD
joined machines. The Enable Azure AD support option is not available on the GUI when you
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install the Session Recording server using the Citrix Virtual Apps and Desktops installer.

This article contains the following sections:

Installation checklist

Use Citrix scripts to install the Windows roles and features prerequisites

Install Session Recording using the Citrix Virtual Apps and Desktops installer

Automate installation

Install the Session Recording database on cloud SQL database services

Upgrade Session Recording
Uninstall Session Recording

Integrate with Citrix Analytics for Security

Installation checklist

Before you start the installation, complete this list:

Step

Select the machines on which you want to install
each Session Recording component. Ensure that
each computer meets the hardware and

software requirements for the components to be

installed on it.

Use your Citrix account credentials to access the
Citrix Virtual Apps and Desktops download page
and download the product ISO file. Unzip the
ISO file or burn a DVD of it.

To use the TLS protocol for communication
between the Session Recording components,
install the correct certificates in your

environment.
Install any hotfixes required for the Session

Recording components. The hotfixes are
available from the Citrix Support.
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] Step

Configure the Citrix Director to create and
activate the Session Recording policies. For
more information, see Configure Director to use
the Session Recording Server.

Note:

« We recommend that you divide the published applications into separate Delivery Groups
based on your recording policies. Session sharing for published applications can conflict
with the active policy if the applications are in the same Delivery Group. Session Recording
matches the active policy with the first published application that a user opens. Starting
with the 7.18 release, you can use the dynamic session recording feature to start or stop
recording sessions at any time during the sessions. This feature can help to mitigate the
conflict issue with the active policy. For more information, see Dynamic session recording.

+ Ifyou are planning to use Machine Creation Services (MCS) or Provisioning Services, prepare
a unique QMId. Failure to comply can cause recording data losses.

+ SQL Server requires TCP/IP, running SQL Server Browser service, and enabled Windows Au-
thentication.

+ To use HTTPS, configure server certificates for TLS/HTTPS.

« Ensure that users under Local Users and Groups > Groups > Users have write permission
to the C:\windows\Temp folder.

(Required only for msi installation) Use Citrix scripts to install the Windows roles and
features prerequisites

For Session Recording to work properly, use the following Citrix scripts to install the necessary Win-
dows roles and features prerequisites before
installing Session Recording:

+ InstallPreregsforSessionRecordingAdministration.psl

<#
.Synopsis
Installs Prereqs for Session Recording Administration
.Description
Supports Windows Server 2025, Windows Server 2022, Windows
Server 2019.
Install below windows feature on this machine:
-Application Development
-Security - Windows Authentication
-Management Tools - IIS 6 Management Compatibility
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ITIS 6 Metabase Compatibility
IIS 6 WMI Compatibility
IIS 6 Scripting Tools
IIS 6 Management Console
-Microsoft Message Queuing (MSMQ), with Active Directory
integration disabled, and MSMQ HTTP support enabled.

#>
function AddFeatures($Sfeaturename)
{

try

{

$feature=Get-WindowsFeature | ? {
$_.DisplayName -eq Sfeaturename -or $_.Name -eq $featurename }

Add-WindowsFeature $feature

}
catch
{
Write-Host "Addition of Windows feature $featurename
failed"
Exit 1
}

Write-Host "Addition of Windows feature $featurename
succeeded"

$system= gwmi win32_operatingSystem | select name

if (-not (($system -Like 'xMicrosoft Windows Server 2025x') -or (
$system -Like 'xMicrosoft Windows Server 2022%') -or (S$system
-Like 'xMicrosoft Windows Server 2019%')))

{
Write-Host("This is not a supported server platform.
Installation aborted.")
Exit
+

# Start to install Windows feature
Import-Module ServerManager

AddFeatures('Web-Asp-Net45') #ASP.NET 4.5
AddFeatures('Web-Mgmt-Console') #IIS Management Console
AddFeatures('Web-Windows-Auth') # Windows Authentication
AddFeatures('Web-Metabase') #IIS 6 Metabase Compatibility
AddFeatures('Web-WMI') #IIS 6 WMI Compatibility
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AddFeatures('Web-Lgcy-Scripting')#IIS 6 Scripting Tools
if ((Ssystem -Like 'xMicrosoft Windows Server 2022x') -or (
$system -Like '*Microsoft Windows Server 2019x'))

{

AddFeatures('Web-Lgcy-Mgmt-Console') #IIS 6 Management
Console

AddFeatures('MSMQ-HTTP-Support') #MSMQ HTTP Support
AddFeatures ('web-websockets') #IIS Web Sockets
AddFeatures('NET-WCF-HTTP-Activation45') #http activate

+ InstallPrereqgsforSessionRecordingAgent.psl

<#
.Synopsis
Installs Prereqs for Session Recording Agent
.Description
Supports Windows Server 2025, Windows Server 2022, Windows
Server 2019, windows 11, and Windows 10.
Install below windows feature on this machine:
-Microsoft Message Queuing (MSMQ), with Active Directory
integration disabled, and MSMQ HTTP support enabled.

#>
function AddFeatures($Sfeaturename)
{

try

{

$feature=Get-WindowsFeature | ? {
$_.DisplayName -eq Sfeaturename -or $_.Name -eq $featurename }

Add-WindowsFeature $feature

}
catch
{
Write-Host "Addition of Windows feature $featurename
failed"
Exit 1
}

Write-Host "Addition of Windows feature $featurename
succeeded"

# Start to install Windows feature
$system= gwmi win32_operatingSystem | select name
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if (-not (($system -Like 'xMicrosoft Windows Server 2025x') -or (
$system -Like '*Microsoft Windows Server 2022x') -or ($system
-Like 'xMicrosoft Windows Server 2019*') -or ($system -Like 'x
Microsoft Windows 11x') -or ($system -Like 'xMicrosoft Windows

10x")))
{
Write-Host("This is not a supported platform. Installation
aborted.")
Exit
+

if ($system -Like 'xMicrosoft Windows Serverx')

{
Import-Module ServerManager
AddFeatures('MSMQ') #Message Queuing
AddFeatures ('MSMQ-HTTP-Support')#MSMQ HTTP Support
+
else
{
try
{
dism /online /enable-feature /featurename:MSMQ-HTTP /all
}
catch
{
Write-Host "Addition of Windows feature MSMQ HTTP Support
failed"
Exit 1
}
write-Host "Addition of Windows feature MSMQ HTTP Support
succeeded"
}

To install the Windows roles and features prerequisites, complete the following steps:
1. Onthe machine where you plan to install the Session Recording administration components:

a) Make sure that the execution policy is set to RemoteSigned or Unrestricted in Power-
Shell.

Set-ExecutionPolicy RemoteSigned

b) Start a command prompt as an administrator and run the powershell.exe -file
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InstallPrereqsforSessionRecordingAdministration.pslcommand.
The script displays the features that are successfully added and then stops.

c) After the script runs, make sure that the execution policy is set to a proper value based on
your company policy.

2. On the machine where you plan to install the Session Recording agent component:

a) Make sure that the execution policy is set to RemoteSigned or Unrestricted in Power-
Shell.

Set-ExecutionPolicy RemoteSigned
b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAgent.psl command.
The script displays the features that are successfully added and then stops.

c) After the script runs, make sure that the execution policy is set to a proper value based on
company policy.

Install Session Recording using the Citrix Virtual Apps and Desktops installer

Note:

We recommend that you install the Session Recording Administration, Session Recording agent,

and Session Recording player components on separate servers.

The Session Recording Administration componentsinclude the Session Recording database, Ses-
sion Recording server, and Session Recording policy console. Installing all of them on a single
server is fine for a proof of concept. However, we recommend that you install the Session Record-
ing policy console on a separate server and install the Session Recording server, administrator
logging, and Session Recording database components on another separate server.

Installing the Session Recording server lets you install the Session Recording web player auto-

matically.

Install the Session Recording Administration components
Install the Session Recording agent

Install the Session Recording player

Install the Session Recording Administration components

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 45


https://docs.citrix.com/en-us/session-recording/current-release/install-upgrade-uninstall.html#install-the-session-recording-administration-components
https://docs.citrix.com/en-us/session-recording/current-release/install-upgrade-uninstall.html#install-the-session-recording-agent
https://docs.citrix.com/en-us/session-recording/current-release/install-upgrade-uninstall.html#install-the-session-recording-player

Session Recording 2407

Note:

Before installing the Session Recording Administration components on Windows Server where
TLS 1.0 is disabled and the version of the .NET Framework is earlier than 4.6, complete the fol-
lowing steps:

1. Install Microsoft OLE DB Driver for SQL Server.

2. Under the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4
.0.30319 registry key, add the SchUseStrongCrypto DWORD (32-bit) value and set
the value datato 1.

3. Restart Windows Server.

For more information, see Transport Layer Security (TLS) best practices with the .NET Frame-
work.

The Session Recording Administration components include the Session Recording database, Session
Recording server, and Session Recording policy console. You can choose the component to install on
aserver.

Step 1: Download the product software and launch the wizard

1. Use your Citrix account credentials to access the Citrix Virtual Apps and Desktops download
page and download the product ISO file. Unzip the ISO file or burn a DVD of it.

2. Use a local administrator account to log on to the machine where you are installing the Ses-
sion Recording Administration components. Insert the DVD in the drive or mount the 1SO file.
If the installer does not launch automatically, double-click the AutoSelect application or the
mounted drive.
The installation wizard launches.
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Deliver applications and desktops to any user, anywhere,

* Hybrid cloud, cloud and enterprise provisioning
- Centralized and flexible management

Manage your delivery according to your needs:

Virtual Apps Deliver applications

Virtual AppS and DesktOpS Deliver applications and desktops

citrix

Step 2: Choose which product toinstall

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Citrix Virtual Apps and Desktops 7

Get Started Prepare Machines and Images

Virtual Delivery Agent for Window:

Install this agent to deliver application:s
single-session OS virtual machines or

Extend Deployment

Citrix Studio

Step 3: Select Session Recording

Select the Session Recording entry.
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Step 4: Read and accept the license agreement

Citrix Virtual Apps and Desktops 7

Licensing Agreement
Core Components
Summary

Install

Finish

Software License Agreement

Last Revised: August 19, 2020
CITRIX LICENSE AGREEMENT

This is a legal agreement ("AGREEMEN"
the providing Citrix entity (the applicabl
"CITRIX"). This AGREEMENT include
Services Security Exhibit and any other dc
location of receipt of the Citrix produc
(hereinafter "MAINTENANCE") determi.
www.citrix.com/buy/licensing/citrix-provi
USING THE PRODUCT, YOU AGREE
AGREEMENT. IF YOU DO NOT AGRE
DO NOT INSTALL AND/OR USE THE |
order or any other document submitted |
terms and conditions contained in this AGI
to third party products sold by Citrix, whic
provider.

1. PRODUCT LICENSES.

a. End User Licenses. Citrix hereb

I have heard, understand, and accept the
checked to be able to continue installatic

@) | do not accept the terms of the license a

On the Software License Agreement page, read the license agreement, accept it, and then click

Next.
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Citrix Virtual Desktops 7

censing Agreement
Core Components
Features

Database and Server
Administrator Logging
Summary

Install

Finish

Step 5: Select the components to install and the installation location

Core Compo
Coi
Se
d 1]
Da
Yo
Se:
Thi
Se
U In

On the Core Components page:

+ Location: By default, components are installed in C:\Program Files\Citrix. The default location
works for most deployments. You can specify a custom installation location.
« Component: By default, all the check boxes next to the components that can be installed are

selected. Theinstaller knows whether it is running on a single-session OS or a multi-session OS.

It allows the Session Recording Administration components to be installed on a multi-session
OS only. It allows the Session Recording agent to be installed only on a machine that has a VDA
installed. If you install the Session Recording agent on a machine that has no VDA installed in
advance, the Session Recording Agent option is unavailable.

Select Session Recording Administration and click Next.
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Citrix Virtual Desktops 7

# Licensing Agreement
Core Components
Features
Database and Server
Administrator Logging
Surmmary
Install

Finish

Core Components

Location: C:\Program Files\Citrix

Component (Select all)

Session Recording Administration

The Session Recording Administration components are the Session Recording
Database, the Session Recording Server, and the Session Recording Policy Console,
You can choose which of these compenents to install on a server.

Session Recording Agent
This component cannot be installed en this machine,

Session Recording Player

Install the Session Recording Player on the Session Recording Server or ane or more
workstations in the domain for users who view session recordings.

. o
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Citrix Virtual Desktops 7 Features

Feature (Select all)

. Session Recording Policy Console
Citrix Session Recording Policy Console
Database and Server
Session Recording Server
Administrator Loggin v TR S [0 B g :
: gqing Citrix Session Recording Broker and Storage Managem
Summary
Session Recording Administrator Logging
Install L Administrator L ng captures Session Recording Ser
Finish recording activities to the Session Recording Database
v, Session Recording Database
Citrix Session Recording Database
Back

Step 6: Select the features toinstall

On the Features page:

+ By default, all the check boxes next to the features that can be installed are selected. Installing
all these features on a single server is fine for a proof of concept. For a large production envi-
ronment, install the Session Recording policy console on a separate server. Install the Session
Recording server, administrator logging, and database on another separate server.

+ The Session Recording administrator logging is an optional subfeature of the Session Record-
ing server. Select the Session Recording server before you can select the Session Recording ad-
ministrator logging. The Session Recording database is a mandatory subfeature of the Session
Recording server. When the Session Recording server is selected for installation, the Session
Recording database is also selected automatically and cannot be unselected.
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Citrix Virtual Apps and Desktops 7

Features

Feature (Select all)

Session Recording Policy

Features B - _
x Session Recording s
Summary
Install Session Recording Server
5 Citrix Session Recording Broker and Storage Management
Finish
Back. Cancel
Citrix Virtual Apps and Desktops 7
Features
S Feature (Select all)
mponen
Session Recordin
Features Citrix Session Rec

Database anc Server
Session Recording Server

Summary v
K Citrix Session Recording Broker and Storage Management

Install
Einish Session Recording Administrator Logging

A configuration changes and

v
— =
Back Next Cancel

« If you select the Session Recording server, the Session Recording web player is installed too.

« To add features on the same server after you select and install features on it, you can only use
the msi package. You cannot run the installer again.
+ Session Recording server

The Session Recording server is a server that hosts:

- The Broker. An 1IS 6.0+ hosted Web application that serves the following purposes:
*x Handling search queries and file download requests from the Session Recording

player and web player.
* Handling policy administration requests from the Session Recording policy console.
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* Evaluating recording policies for each Citrix Virtual Apps and Desktops or Citrix DaaS
(formerly Citrix Virtual Apps and Desktops service) session.

- The Storage Manager. AWindows service that manages the recorded session files received
from each Session Recording-enabled VDA.

- Administrator Logging. An optional subcomponent installed with the Session Recording
server to log the administration activities. All the logging data is stored in a separate SQL
Server database named CitrixSessionRecordingLogging by default. You can customize
the database name.

« Session Recording database

- The Session Recording database isn’t an actual database. It is a component that creates
and configures the required databases in the Microsoft SQL Server instance during instal-
lation. Session Recording supports three solutions for database high availability based on
Microsoft SQL Server. For more information, see Database high availability.

- You can install the Session Recording database on the following cloud SQL database ser-
vices:

* Azure SQL Database

* Azure SQL Managed Instance

SQL Server on Azure Virtual Machines (VMs)
AWS RDS

Google Cloud SQL Server

*

*

*

There are typically three types of deployments for the Session Recording database and
Microsoft SQL Server:

- Deployment 1: Install the Session Recording server and Session Recording database on
the same machine and the Microsoft SQL Server on a remote machine. (Recommended)

- Deployment 2: Install the Session Recording server, Session Recording database, and Mi-
crosoft SQL Server on the same machine. (Not recommended)

» Session Recording admin logging

We recommend that you install the Session Recording administrator logging together with the
Session Recording server at the same time. If you don’t want the administrator logging fea-
ture to be enabled, you can disable it on a later page. However, if you choose not to install this
feature at the beginning but want to add it later, you can only manually add it by using Session-
RecordingAdministrationx64.msi.

+ Session Recording policy console

You can use the Session Recording policy console to configure policies.
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Step 6.1: Install the Session Recording server, database, and administrator logging As de-
scribed earlier, the Session Recording database is a mandatory subfeature of the Session Recording
server and we recommend that you install the Session Recording administrator logging together with
the Session Recording server at the same time. Therefore, this section walks you through installing

the three components on the same machine.

1. On the Features page, select Session Recording Server and Session Recording Administra-
tor Logging. With Session Recording Server selected, Session Recording Database is also
selected automatically. Click Next.

Citrix Virtual Apps and Desktops 7
Features

Feature (Select all)

omponent
Session Recording Pol
Features Citrix Session Recordir

Database ang Server
N Session Recording Server
Summary v - - o M
trix Session Recording Broker and Storage Management
Install

Finish

o e [T

2. On the Database and Server Configuration page, specify the instance name and database
name of the Session Recording database, enable SQL Server authentication as needed, and

click Next.
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Citrix Virtual Apps and Desktops 7

Database and Server Configuration

Configuration

Specify the instance name and database name of the Session Recording Database.

Database and Server Enable SQL Server authentication
Administrator Logging Instance name:

Summary

Install

Finish Database name:

CitrixSessionRecording

Back

Cancel

On the Database and Server Configuration page:

« Enable SQL Server authentication: This option lets you connect to the Session Recording

database using SQL Server authentication.

Citrix Virtual Apps and Desktops 7

Database and Server
Administrator Logging
Summary

Install

Finish

Database and Server Configuration

Specify the instance name and database name of the Session Recording Database.

Configuration

Enable SQL Server authentication

Instance name:

Example: \SQLEXPRESS, computer-name\SQLEXPRESS, computer-name

Database name

T
CitrixSessionRecording

SQL user name:

SQL password:

Show password

Back

Cancel

i ]

i ]

« Instance name: If the database instance isn’t a named instance, you can use only the com-

puter name of the SQL Server. If you have named the instance during the instance setup,

use computer-namel\instance-name as the database instance name. To determine the

server instance name that you are using, run select @@servername on the SQL Server.

Thereturnvalueis the exact database instance name. If your SQL server is configured to be

listening on a custom port other than the default port 1433, set the custom listener port by
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appending a comma to the instance name. For example, type DXSBC-SRD-1,2433 in the
Instance name text box, where 2433, following the comma, denotes the custom listener
port.

- Database name: Type a custom database name in the Database name text box or use the
default database name preset in the text box. Click Test connection to test the connectiv-
ity to the SQL Server instance and the validity of the database name.

Note:

The Session Recording server default installation uses HTTPS/TLS to secure commu-
nications. If TLS is not configured in the default Internet Information Services (lIS)
site of the Session Recording server, use HTTP. To do so, cancel the selection of SSL
in the IS Management Console by navigating to the Session Recording Broker site,
opening the SSL settings, and clearing the Require SSL check box.

Important:

A custom database name must contain only A-Z, a-z, 0-9, and underscores, and can-
not exceed 123 characters.

You must have the securityadmin and dbcreator server role permissions of the SQL
Server instance. If you do not have the permissions, you can:

- Askthe database administrator to assign the permissions for the installation. After the
installation completes, the securityadmin and dbcreator server role permissions are
no longer necessary and can be safely removed.

- Or, use the SessionRecordingAdministrationx64.msi package under \x64\Session
Recording on the Citrix Virtual Apps and Desktops ISO. During the msi installation,
a dialog box prompts for the credentials of a database administrator with the
securityadmin and dbcreator server role permissions. Type the correct credentials
and then click OK to continue the installation.

The installation creates the Session Recording database and adds the machine ac-
count of the Session Recording server as db_owner.

3. Onthe Administration Logging Configuration page, specify configurations for the administra-
tion logging feature.
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Citrix Virtual Desktops 7 Administrator Logging Configuration

Specify Session Recording logging configuration

Configuration

The Administrator Logging database is installed on the SQL Server instance:
Database and Server

Administrator Logging

Summary Administrator Logging database name:

Install CitrixSessionRecordinglogging v

Finish

Test connection...

- Enable Administrator Logging
This option enables the Session R
v Enable mandatory blocking
is option blocks policy and server property changes if logging fails

Back | [RELCSR [ Concel

On the Administration Logging Configuration page:

+ The Administration Logging database is installed on the SQL Server instance: This text
box is not editable. The SQL Server instance name of the Administration Logging database
is automatically grabbed from the instance name that you typed on the Database and
Server Configuration page.

« Administrator Logging database name: To install the Session Recording administrator
logging feature, type a custom database name for the administrator logging database in
this text box or use the default database name CitrixSessionRecordingLogging that is
preset in the text box.

Note:

The administrator logging database name must be different from the Session Record-
ing database name that is set in the Database name text box on the previous Data-
base and Server Configuration page.

+ After typing the administrator logging database name, click Test connection to test the
connectivity to the administrator logging database.

« Enable Administration Logging: By default, the administration logging feature is
enabled. You can disable it by clearing the check box.

+ Enable mandatory blocking: By default, mandatory blocking is enabled. The normal
features might be blocked if logging fails. You can disable mandatory blocking by clearing
the check box.

Click Next to continue the installation.
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4. Review the prerequisites and confirm the installation.

Citrix Virtual Apps and Desktops 7

Summary

Agreement Review the prerequisites and confirm the components you want to install.

omponents
Installation directory

C:\Program Files\Citrix

Prerequisites

Microsoft Message Queuing

Summary
Core Components
Install
Session Recording Administration
Finish

Features

Session Recording Server
Session Recording Administrator Logging
Session Recording Database

Back | JCECTI | Cancel

The Summary page shows your installation choices. You can click Back to return to the earlier
wizard pages and make changes, or click Install to start the installation.

5. Complete the installation.

Citrix Virtual Desktops 7 Finish Installation

# Licensing Agreement The installation completed successfully. ' Success

i

Core C omponents

Core Components

¥ reatures v Session Recording Administration Installed
+ Database and Server Post Install
+ Summary v Companent Initialization Initialized
+ Install

Finish

i
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The Finish Installation page shows green check marks for all the prerequisites and components
that have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording server, database, and admin-
istrator logging.

Step 6.2: Install the Session Recording policy console To install the Session Recording policy con-
sole, complete the following steps:

1. On the Features page, select Session Recording Policy Console and click Next.

Citrix Virtual Apps and Desktops 7

Features

Feature (Select all)

omponents

Features

Summary
Install Session Recording Server
5 Citrix Session Recording Broker and Storage Management

Finish

Back Cancel

2. Review the prerequisites and confirm the installation.
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Citrix Virtual Desktops 7 Summary
v Licensing Agreement Review the prerequisites and confirm the components you want to install.

Installation directory

Features
CA\Program Files\Citrix
Summary
Core Components
Install ) X . . i
Session Recording Administration
Firish

Features

Session Recording Policy Console

Back " ﬁ Cancel

The Summary page shows your installation choices. You can click Back to return to the earlier
wizard pages and make changes, or click Install to start the installation.

3. Complete the installation.
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Citrix Virtual Desktops 7 Finish Installation
¥ licensing Agreement The installation completed successfully. v Success
¥ Core Components
Core Components

+ Features v Session Recording Administration Installed
L L) Post Install
 Install v Component Initialization Initialized

Finish

ez

The Finish Installation page shows green check marks for all the prerequisites and components
that have been installed and initialized successfully.

Click Finish to complete your installation of the Session Recording policy console.

Step 7: Install Broker_PowerShellSnapin_x64.msi
Important:

To use the Session Recording policy console, install the Broker PowerShell Snap-in (Broker_PowerShellSnz:
.msi) manually. Locate the snap-in on the Citrix Virtual Apps and Desktops ISO (\x64\Citrix
Desktop Delivery Controller) and follow the instructions for installing it. Failure to

comply can cause an error.

Install the Session Recording agent

The Session Recording agent is a component installed on each VDA for multi-session OS or single-
session OS to enable recording. It is responsible for recording session data.

Step 1: Download the product software and launch the wizard Use alocal administrator account
to log on to the machine where you are installing the Session Recording agent. Insert the DVD in the
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drive or mount the ISOfile. If the installer does not launch automatically, double-click the AutoSelect
application or the mounted drive.

The installation wizard launches.

Deliver applications and desktops to any user, anywhere,

= Hybrid cloud, cloud and enterprise provisioning
« Centralized and flexible management

Manage your delivery according to your needs:

Virtual AppS Deliver applications

Virtual AppS and DESktOpS Deliver applications and desktops

citrix

Step 2: Choose which product to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Citrix Virtual Apps and Desktops 7

Get Started Prepare Machines and Images

Delivery Controller Virtual Delivery Agent for Windo

Start here. Select and install the Delivery Controller and other Install this agent to deliver application:

essential services like License Server and StoreFront. based VMs or physical machines.

Bxtend Deployment

Cittrix Director i Citrix Studio

Citrix License Server i Universal Print Server

Citrix StoreFront i Federated Authentication Service

Services and Support
tion Access supporting content online.
r Access knowledge base articles, secunity bulletins, and troubleshooting guides.

Step 3: Select Session Recording

Select the Session Recording entry.
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Citrix Virtual Desktops 7

Licensing Agreement
Core Components
Features

Database and Server
Administrator Logging
Agent

Summary

Install

Finish

Step 4: Read and accept the license agreement

Software License Agreement

Last Revised: March I, 2018
CITRIX LICENSE AGEEEMENT

This 1z a legal agreement ("AGREEMENT")
the providing Citrix entity (the applicable p
"CITRIX"). This AGREEMENT includes t
Services Security Exhibit and any other docus
location of receipt of the Citrix product (1
(hereinafter "MAINTENANCE") determines
www.citrix com/buy/licensing/citrix-providing
USING THE PRODUCT, YOU AGEEE TC
AGREEMENT. IF YOU DQ NOT AGREE "
DO NOT INSTALL AND/QE. USE THE PR
order or any other document submitted by
terms and conditions contained in this AGRE]

1. PRODUCT LICENSES.

a. End User Licenses. Citrix hereby g
license to use the software in a softw
an applisnce PEODUCT under
www.citrix com/buy/licensing ‘produ

| have read, understand, and accept the tern

®) | do not accept the terms of the license agre

On the Software License Agreement page, read the license agreement, accept it, and then click

Next
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Step 5: Selectthe component to install and the installation location

Select Session Recording Agent and click Next.

Citrix Virtual Desktops 7

censing Agreement
Core Components
Agent

Summary

Install

Finish

Core Compon
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Step 6: Specify the agent configuration

Citrix Virtual Apps and Desktops 7

Agent Configuration

¥ Licensing Agreement m T
Configuration
¥ Core Components

Session Recording Server name

Agent
Summary | |
Install Maote: Enter information for connecting to the Sessior
Finich such information later in the Session Recording Agen
Protocol:
[ HTTRS
Port
s e

Enable Azure AD support

On the Agent Configuration page, complete the following settings:

+ Type the computer name of the machine where you installed the Session Recording server and
the protocol and port information for connecting to the Session Recording server. If you have
not installed Session Recording yet, you can change such information later in Session Record-

ing Agent Properties.

+ If you are installing the Session Recording agent on an Azure AD joined machine, select Enable
Azure AD support. To fully enable Azure AD identity support for configuring playback permis-
sions and various Session Recording policies from the cloud, complete the following steps and

then restart the VDA:

Note:

Azure AD support is a preview feature. It is available with Session Recording version 2402

and later.

Preview features might not be fully localized and are recommended for use in

non-production environments. Citrix Technical Support doesn’t support issues found

with preview features.

- Usethe MSI package to install the Session Recording server on an Azure AD joined machine
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as well. Select Enable Azure AD support during the MSl installation.
- Connect Citrix Cloud to Azure AD.

- Go to the home page for the Full Configuration interface and enable the SessionRecord-
ingSupportAAD and Send User Identity Info In Prepare Session toggles under the Pre-
view features section. To access the home page for the Full Configuration interface, com-
plete the following steps:

1. Signin to Citrix Cloud.
2. Inthe upper left menu, select My Services > DaaS. By default, the home page for the
Full Configuration interface appears.

Note:

There is a limitation with the test connection function of the installer. It does not support the
“HTTPS requires TLS 1.2”scenario. If you use the installer in this scenario, the test connection
fails but you can ignore the failure and click Next to continue the installation. It does not affect

normal functioning.

Citrix Virtual Desktops 7 Summary

¥ Licensing Agreement Review the prerequisites
v Core Components _ .
Installation directory
+ Agent i
CA\Program Files\C

Summa
i Core Components

Install . .
e Session Recording

Finish

Step 7: Review the prerequisites and confirm the installation
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The Summary page shows your installation choices. You can click Back to return to the earlier wizard
pages and make changes, or click Install to start the installation.

Citrix Virtual Desktops 7 Finish Instaliation

¥ Licensing Agreement The installation completed successfully.
Core Components
v Agent +" Session Recording Agent

¥ Summar Post Install
+ Component Initialization

Step 8: Complete theinstallation

The Finish Installation page shows green check marks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Agent.
Note:

When Machine Creation Services (MCS) or Citrix Provisioning creates multiple VDAs with a master
image and Microsoft Message Queuing (MSMQ) installed, the VDAs might have the same QMid.
The same QMId might cause various issues, for example:

+ Sessions might not be recorded even if the recording agreement is accepted.
+ The Session Recording Server might not be able to receive session logoff signals and there-
fore, sessions might always be in Live status.

As aworkaround, create a unique QMId for each VDA and it differs depending on the deployment
methods.
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No extra actions are required if single-session OS VDAs with the Session Recording agent installed

are created with PVS 7.7 or later and MCS 7.9 or later in the static desktop mode that is, for exam-

ple, configured to make all changes persistent with a separate Personal vDisk or the local disk of
your VDA.

For multi-session OS VDAs created with MCS or PVS and single-session OS VDAs that are config-

ured to discard all changes when a user logs off, use the GenRandomQMID.ps1 script to change

the QMId on system startup. Change the power management strategy to ensure that enough

VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1.

Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

Set-ExecutionPolicy RemoteSigned

2. Create a scheduled task, set the trigger as on system startup, and run with the SYSTEM ac-

3.

count on the PVS or MCS master image machine.
Add the command as a startup task.

powershell .exe -file C:\\GenRandomQMID.psl

Summary of the GenRandomQMID.ps1 script:

1. Remove the current QMId from the registry.
2. Add SysPrep = 1 to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\

Parameters.

. Stop related services, including CitrixSmAudAgent and MSMQ.
. To generate a random QMId, start the services that stopped previously.

Example GENRANDOMQMID.PS1:

1

(6]

O o ~N O

11
12
13

# Remove old QMId from registry and set SysPrep flag for MSMQ

Remove-Itemproperty -Path HKLM:Software\Microsoft\MSMQ\Parameters)
MachineCache -Name QMId -Force

Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -
Name "SysPrep" -Type DWord -Value 1

# Get dependent services

$depServices = Get-Service -name MSMQ -dependentservices | Select -
Property Name

# Restart MSMQ to get a new QMId

Restart-Service -force MSMQ
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# Start dependent services

if ($depServices -ne $null) {

foreach (S$depService 1in $depServices) {

$startMode = Get-WmiObject win32_service -filter "NAME = 'S
($depService.Name)'" | Select -Property StartMode

if ($SstartMode.StartMode -eq "Auto") {

Start-Service S$depService.Name

Install the Session Recording player

The Session Recording player is a user interface that you access from a workstation to play recorded
session files. Install the Session Recording player on the Session Recording server or on workstations
in the domain.

Tip:

« Installing the Session Recording server lets you install the Session Recording web player
automatically

+ Before or after you install the Session Recording player, install the Microsoft Visual C++ Re-
distributable package called VC_redist.x86.exe. You can find the package on the Citrix Vir-
tual Apps and Desktops ISO under \Support\VcRedist.

Step 1: Download the product software and launch the wizard Use alocal administrator account
to log on to the machine where you are installing the Session Recording player component. Insert the
DVD in the drive or mount the ISO file. If the installer does not launch automatically, double-click the
AutoSelect application or the mounted drive.

The installation wizard launches.
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Deliver applications and desktops to any user, anywhere,

* Hybrid cloud, cloud and enterprise provisioning
- Centralized and flexible management

Manage your delivery according to your needs:

Virtual Apps Deliver applications

Virtual AppS and DesktOpS Deliver applications and desktops

citrix

Step 2: Choose which product toinstall

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Citrix Virtual Apps and Desktops 7

Get Started

Delivery Controller

Start here. Select and install the Delivery Controller and other
essential services like License Server and StoreFront.

BExtend Deployment

Citrix Director i Citrix Studio

Prepare Machines and Images

Virtual Delivery Agent for Windo

Install this agent to deliver application:
based VMs or physical machines.

Self-Service

Citrix License Server i Universal Print Server

Citrix StoreFront i Federated Authentication Service

Services and Support
1 Access supporting content online.

r Access knowledge base articles, security bulletins, and troubleshooting guides.

Step 3: Select Session Recording

Select the Session Recording entry.
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Citrix Virtual Desktops 7

Licensing Agreement
Core Components
Features

Database and Server
Administrator Logging
Summary

Install

Finish

Step 4: Read and accept the license agreement

Software License Agreement

Last Revised: March 1, 2018
CITRIX LICENSE AGREEMENT

This is a legal agreement ("AGEEEMENT™)
the providing Citrix entity (the applicable p
"CITRIX"). This AGREEMENT includes t
Services Security Exhibit and any other docus
location of receipt of the Citrix produoct (}
(hereinafter "MAINTENANCE") determines
www.citrix eom/buy/licensing/citrix-providing
USING THE PRODUCT, YOU AGEEE TC
AGREEMENT. IF YOU DO NOT AGREE "
DO NOT INSTALL AND/OE. USE THE PR
order or any other document submitted by
terms and conditions contained in this AGRE]

1. PRODUCT LICENSES.

a. End User Licenses. Citrix hereby g
license to use the software in a softw
an applisnce PRODUCT under
www.citrix.com/buy/licensing ‘produ

| have read, understand, and accept the terr

%) | do not accept the terms of the license agre

On the Software License Agreement page, read the license agreement, accept it, and then click

Next.
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Step 5: Select the component to install and the installation location

Select Session Recording Player and click Next.

Citrix Virtual Desktops 7

censing Agreement
Core Components
Surmnmmary

Install

Finish

Core Compon

Com

Sess

Dat:

You

Sess

Sess
U Inst;
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Step 6: Review the prerequisites and confirm the installation

Citrix Virtual Desktops 7

Core Components
Summary
Install

Finish

Summary
Review the prerequisites

Installation directory
C:\Program Files\C
Core Components

Session Recording

The Summary page shows your installation choices. You can click Back to return to the earlier wizard

pages and make changes, or click Install to start the installation.

© 1999-2024 Cloud Software Group, Inc. All rights reserved.

76



Session Recording 2407

Citrix Virtual Desktops 7 Finish Installation
v Licensing Agreement The installation completed successfully.
Core Components
Core Components
aLMIany: +" Session Recording Player
e Post Install
Finish v Component Initialization

Step 7: Complete theinstallation

The Finish Installation page shows green check marks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording player.

Automate installation

Session Recording supports silent installation with options.

Automate installation of the Session Recording Administration components

Install the complete set of the Session Recording Administration components by using a single
command For example, either of the following commands installs the complete set of the Session
Recording Administration components and creates a log file to capture the installation information.

msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordinglLogging" DATABASEUSER="
localhost" /q /1l*vx "yourinstallationlog"
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msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordinglLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" SERVICEKEYAUTHENABLE="1" /q /1
*vx "c:\WithLogging.log"

Note:

You can find the SessionRecordingAdministrationx64.msi file on the Citrix Virtual
Apps and Desktops ISO under \x64\Session Recording.

Where:

« ADDLOCAL provides the features for you to select. You can select more than one option. SsRec-
Server is the Session Recording server. PolicyConsole is the Session Recording policy console.
SsReclLogging is the Administrator Logging feature. StorageDatabase is the Session Recording
database. Session Recording Administrator Logging is an optional subfeature of the Session
Recording server. Select the Session Recording server before you can select Session Recording
administrator logging.

+ DATABASEINSTANCE is the instance name of the Session Recording database. For example,. \
SQLEXPRESS, computer—-name\SQLEXPRESS,computer-name or tcp:srt-sql-
support.public.ca7b16b60789.database.windows.net,3342 if you are using
Azure SQL Managed Instance.

+ DATABASENAME is the database name of the Session Recording database.

+ LOGGINGDATABASENAME is the name of the administrator logging database.

+ AZURESQLSERVICESUPPORT determines whether cloud SQL is supported. To use cloud SQL,
setitto 1.

+ DATABASEUSER is the computer account of the Session Recording server.

+ AZUREUSERNAME is the cloud SQL admin name.

« AZUREPASSWORD is the cloud SQL admin password.

+ SERVICEKEYAUTHENABLE enables the service key authentication between the Session Record-
ing agent and the Session Recording server. This parameter is required only when you want to
enable Azure AD support and you must set it to 1. Otherwise, do not add this parameter.

+ /g specifies quiet mode.

+ [U*v specifies verbose logging.

« yourinstallationlog is the location of your installation log file.

Create a master image for deploying the Session Recording server You might already have the
Session Recording database and the administration logging database in place from an existing deploy-
ment. For such scenarios, you can now forego database checks when you are installing the Session
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Recording Administration components using SessionRecordingAdministrationx64.msi. You can cre-
ate a master image for deploying the Session Recording server easily on many other machines. After
deploying the Session Recording server on target machines using the master image, run a command
on each machine to connect to the existing Session Recording database and administration logging
database. This master image support facilitates deployment and minimizes the potential impact of
human error. It applies only to fresh installations and consists of the following steps:

1. Starta command prompt and run a command similar to the following:

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"
DATABASEINSTANCE="sqglnotexists" DATABASENAME="
CitrixSessionRecording2" LOGGINGDATABASENAME="
CitrixSessionRecordinglLogging2" DATABASEUSER="localhost" /q /1%
vx "c:\WithLogging.log" IGNOREDBCHECK="True"

This command installs the Session Recording Administration components without configuring
and testing connectivity to the Session Recording database and the administration logging data-
base.

Set the IGNOREDBCHECK parameter to True and use random values for DATABASEINSTANCE,
DATABASENAME, and LOGGINGDATABASENAME.

2. Create a master image on the machine that you are operating.
3. Deploy the master image to other machines for deploying the Session Recording server.
4. On each of the machines, run commands similar to the following:

.\SsRecUtils.exe -modifydbconnectionpara DATABASEINSTANCE
DATABASENAME LOGGINGDATABASENAME

iisreset /noforce

The commands connect the Session Recording server installed earlier to an existing Session
Recording database and administration logging database.

You can find the SsRecUtils.exefileat \Citrix\SessionRecording\Server\bin
\. Set the DATABASEINSTANCE, DATABASENAME, and LOGGINGDATABASENAME parameters
as needed.

Retain databases when uninstalling the Session Recording Administration components With
KEEPDB set to True, the following command retains the Session Recording database and the admin-
istration logging database when uninstalling the Session Recording Administration components:

msiexec /x "SessionRecordingAdministrationx64.msi" KEEPDB="True"
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Automate installation of the Session Recording player and web player

For example, the following commands install the Session Recording player and web player, respec-
tively.

msiexec /i "c:\SessionRecordingPlayer.msi" /q /lx\vx "
yourinstallationlog"

msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /lxvx "
yourinstallationlog"

Note:

You can find SessionRecordingPlayer.ms1 on the Citrix Virtual Apps and Desktops ISO

under \x86\Session Recording.

You can find SessionRecordingWebPlayer.msi on the Citrix Virtual Apps and Desktops
ISO under \x64\Session Recording.

Where:

+ /q specifies quiet mode.
+ [*v specifies verbose logging.
+ yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording agent For example, the following command in-
stalls the Session Recording agent and creates a log file to capture the installation information.
msiexec /i SessionRecordingAgentx64.msi /q /lxvx yourinstallationlog
SESSTONRECORDINGSERVERNAME=yourservername
SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol

SESSTIONRECORDINGBROKERPORT=yourbrokerport
SESSTIONRECORDINGAUTHENTICATION="Citrix Cloud" SESSIONRECORDINGRPC="

Websocket" SESSIONRECORDINGIDP="IDP"

Note:

You canfind SessionRecordingAgentx64.ms1 onthe Citrix Virtual Apps and Desktops ISO

under \x64\Session Recording.

Where:

+ yourservername is the NetBIOS name or FQDN of the machine hosting the Session Recording
server. If not specified, this value defaults to localhost.

+ yourbrokerprotocol is the HTTP or HTTPS that the Session Recording agent uses to communi-
cate with the Session Recording Broker. If not specified, this value defaults to HTTPS.
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« yourbrokerport is the port number that the Session Recording agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to zero, which directs
the Session Recording Agent to use the default port number for your selected protocol: 80 for
HTTP or 443 for HTTPS.

+ SESSIONRECORDINGAUTHENTICATION is the authentication type between the Session
Recording agent and the Session Recording server. This parameter is required only when you
want to enable Azure AD support. To enable Azure AD support, add this parameter and set it to
Citrix Cloud.

+ SESSIONRECORDINGRPC is the communication method between the Session Recording agent
and the Session Recording server. This parameter is required only when you want to enable
Azure AD support. To enable Azure AD support, add this parameter and set it to Websocket.

« SESSIONRECORDINGIDP specifies the identity type. This parameter is required only when you
want to enable Azure AD support. To enable Azure AD support, add this parameter and set it to
IDP.

+ /q specifies quiet mode.

+ [t*v specifies verbose logging.

« yourinstallationlog is the location of your installation log file.

Upgrade Session Recording

You can upgrade certain deployments to later versions without having to first set up new machines or
sites. You can upgrade from the version of Session Recording included in the latest CU of XenApp and
XenDesktop 7.6 LTSR, and from any later version, to the latest release of Session Recording.

Note:

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and choose Mod-
ify in Session Recording Administration to add the administrator logging service, the SQL Server
instance name does not appear on the Administrator Logging Configuration page. The follow-
ing error message appears when you click Next: Database connection test failed. Please enter
correct Database instance name. As a workaround, add the read permission for localhost users
to the following SmartAuditor Server registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server.

You cannot upgrade from a Technical Preview version.

Requirements, preparation, and limitations

+ Use the Session Recording installer’s graphical or command-line interface to upgrade the Ses-
sion Recording components on the machine where you installed the components.
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+ Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL
Server instance. In this way, you can restore it if any issues are discovered after the database
upgrade.

« In addition to being a domain user, you must be a local administrator on the machines where
you are upgrading the Session Recording components.

« If the Session Recording server and Session Recording database aren’t installed on the same
server, you must have the database role permission to upgrade the Session Recording database.
Otherwise, you can:

- Ask the database administrator to assign the securityadmin and dbcreator server role
permissions for the upgrade. After the upgrade completes, the securityadmin and dbcre-
ator server role permissions are no longer necessary and can be safely removed.

- Or, use the SessionRecordingAdministrationx64.msi package to upgrade. During the msi
upgrade, a dialog box prompts for the credentials of a database administrator who has the
securityadmin and dbcreator server role permissions. Type the correct credentials and
then click OK to continue the upgrade.

+ You can choose not to upgrade all Session Recording agents at the same time. Session Record-
ingagent7.6.0 (and later) is compatible with the latest (current) release of the Session Recording
server. However, some new features and bug fixes might not take effect.

+ Any sessions started during the upgrade of the Session Recording server are not recorded.

+ The Graphics Adjustment option in Session Recording agent Properties is enabled by default
after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirec-
tion mode. You can disable this option manually after a fresh installation or upgrade.

« The administrator logging feature is not installed after you upgrade Session Recording from a
previous release where the feature is unavailable. To add the feature, modify the installation
after the upgrade.

« If there are live recording sessions when the upgrade process starts, there is little chance that
the recording can be complete.

+ Review the following upgrade sequence, so that you can plan and mitigate potential outages.

Upgrade sequence
To upgrade an existing installation, go to each machine where a Session Recording component is in-
stalled and then run the Citrix Virtual Apps and Desktops ISO.

Tip:

Go to the Citrix Virtual Apps and Desktops download page to download the appropriate version
of Citrix Virtual Apps and Desktops.

Upgrading an existing installation generally follows the following sequence:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 82


https://www.citrix.com/downloads/citrix-virtual-apps-and-desktops/

Session Recording 2407

. Upgrade the Session Recording server component.

If there is more than one Session Recording server, first upgrade the one where the Session
Recording database component is installed. After that, upgrade the rest Session Recording
servers.

To do so, complete the following steps:

a) Stop the Session Recording Storage Manager service manually on the Session Recording
server.

b) Through the Internet Information Services (IIS) Manager, ensure that the Session Record-
ing Broker is running.

¢) Run the Citrix Virtual Apps and Desktops ISO and select the Session Recording entry to
upgrade.

. The Session Recording service is back online automatically when the upgrade of the Session

Recording server is completed.
Upgrade the Session Recording agent (on the master image).
Upgrade the Session Recording policy console with or after the Session Recording server.

Upgrade the Session Recording player.

Install the Session Recording database on cloud SQL database services

This section describes how to install the Session Recording database on the following cloud SQL data-

base services:

Azure SQL Database

Azure SQL Managed Instance
SQL Server on Azure VMs
AWS RDS

Google Cloud SQL Server

Install the Session Recording database on Azure SQL Database

1.

Create an Azure SQL Database.

a) Signin to the Azure portal using your Azure account.
b) From the portal menu, select Create a resource.
c) Inthe portal search box, enter SQL database.

d) From the list of search results, select SQL databases.
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e) Click Create to create an Azure SQL Database.
f) Inthe Create SQL Database section, provide the following information:

+ Subscription: Select the Azure subscription that you want.
+ Resource Group: Select Create new or choose an existing resource group.
+ Database Name: A unique name is required.
+ Server: Select Create new, and fill out the New Server form with the following values:
- Server name: Enter a unique name. Server names must be globally unique for
all servers in Azure.
- Location: Select a location from the drop-down list.
- Authentication method: Select Use SQL authentication.
- Server admin login: Enter a cloud SQL administrator name.
- Password: Enter a cloud SQL administrator password that meets requirements
and enter it again in the Confirm password field.
- Select OK.

After providing the preceding information, click Review + Create. Click the Create button
to complete the Azure SQL Database.

2. Repeat Step 1 to create a different Azure SQL Database on the same Server.

3. Get the server connection string for the created Azure SQL Databases.

a) In the Azure portal, search for and click either of the Azure SQL Databases that you have
created.

b) Click Connection strings from the left navigation.

c) Keep a record of the Server string that is to be used as the instance name of the Session
Recording database and the Session Recording logging database later.

4. Runacommand similar to the following to install the Session Recording database on the Azure
SQL Database that you have created earlier.

Note:

On Azure SQL Database, installation of the Session Recording database can be done only
by running a command similar to the following:

msiexec /i "SessionRecordingAdministrationx64.msi"ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"DATABASEINSTANCE
="DatabaseConnectionString '"DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordinglLogging"AZURESQLSERVICESUPPORT
="1"CLOUDDBSUPPORT="1"AZUREUSERNAME="CloudSQLAdminName"AZUREPASSWORD
="CloudSQLAdminPassword"/q /1lxvx "c:\WithLogging.log"

Where:
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« ADDLOCAL provides the features for you to select. You can select more than one option.
SsRecServer is the Session Recording server. PolicyConsole is the Session Recording pol-
icy console. SsRecLogging is the Administrator Logging feature. StorageDatabase is the
Session Recording database. Session Recording Administrator Logging is an optional sub-
feature of the Session Recording server. Select the Session Recording server before you
can select Session Recording administrator logging.

« DATABASEINSTANCE is the instance name of the Session Recording database, which is
specified by the Azure SQL Database connection string.

+ DATABASENAME is the database name of the Session Recording database.

+ LOGGINGDATABASENAME is the name of the administrator logging database.

+ AZURESQLSERVICESUPPORT determines whether cloud SQL is supported. To use cloud
SQL, setitto 1.

+ DATABASEUSER is the computer account of the Session Recording server.

+ AZUREUSERNAME is the cloud SQL admin name.

« AZUREPASSWORD is the cloud SQL admin password.

« /g specifies quiet mode.

« [l*v specifies verbose logging.

« yourinstallationlog is the location of your installation log file.

Install the Session Recording database on Azure SQL Managed Instance or on AWS RDS
Tip:

On Azure SQL Managed Instance and on AWS RDS, you can install the Session Recording database
by:

+ Double-clicking and running the SessionRecordingAdministrationx64.msi package.
+ Running a command similar to the following:

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="
CitrixSessionRecording" LOGGINGDATABASENAME="
CitrixSessionRecordinglLogging" AZURESQLSERVICESUPPORT="1"
AZUREUSERNAME="CloudSQLAdminName" AZUREPASSWORD="
CloudSQLAdminPassword" /q /1l*xvx "c:\WithLogging.log"

1. Create an Azure SQL Managed instance or create a SQL Server instance through the Amazon RDS
console.

2. (For Azure SQL only) Keep a record of the Server strings that appear in the properties panel.
The strings are the instance name of the Session Recording database. For an example, see the
following screen capture.
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ADO.NET JDBEC  ODBC  PHP

ADO.MET (SQL authentication) - private endpoint

Server=tcpisr-sglinstance.3141e49e4d94.database.windows.net, 1433;Persist Security Info=False;User ID={your_username}Password=
{your_password:MultipleActiveResultSets=False;Encrypt=True; TrustServerCertificate=False;Connection Timeout=30;

ADO.MET (5L authentication) - public endpoint

Server=tcpisr-sqglinstance.public.3141e49e4d94.database.windows.net, 3342; Persist Security Info=False;User ID={your_username};Password=
{your_password}Multiple ActiveResultSets=False;Encrypt=True TrustServerCertificate = False;Connection Timeout=30;

3. (For AWS RDS only) Keep a record of the Endpoint and Port information. We use it as the in-

stance name of your database, in the format of <Endpoint, Port>.

'::'_1“_"‘"'_5 Services ¥
Amazon RDS X
Connectivity & security Monitoring Logs & events Configu
Dashboard
Databases
Query Editor Connectivity & security
Performance Insights
Snapshots Endpoint & port
Automated backups Endpoint
Reserved instances database-2.ccjfaeoogg0g.us-east-2.rds.amazonaws.com
Proxies
Port
Subnet groups 1433

Parameter groups

Option groups

Events

Event subscriptions

Recommendations

Certificate update

Security group rules (2)

Q

Security group

db2sg (sg-00fbd0fee602a731b)

db2sg (sg-00fbd0fee602a731hb)

4. Run SessionRecordingAdministrationx64.msi to install the Session Recording database.
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Select the Enable cloud SQL check box and fill in the cloud SQL admin name and password.

Make other required configurations.

ﬁ Citrix Session Recording Administration Setup —

Specify the instance name and database name of the Session Recording Database and the
computer account of the Session Recording Server.

Instance name I

Example: \SQLEXPRESS, compuier-name\SQLEXPRESS, compuier-name,
top:xxxx. daiabase windows.net, 3342

[+] Enable cloud SGL

Database name I

[] Use default database name

Cloud SQL admin I
name

Cloud SQL admin |
password

Session Recording
Server computer
account Example: lncalhost, domain\compuier-name

<Back | Net> | | Cancel

Note:

If you change the cloud SQL admin password, you must update the password in Session

Recording Server Properties. When you open Session Recording Server Properties,

an error message appears. Click OK to proceed, select the Cloud DB tab, and type the

new cloud SQL admin password. Restart the Citrix Session Recording Analytics service,

the Citrix Session Recording Storage Manager service, and the IS service.

Azure AD authentication is not supported.
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% Session Recording Server Properties — >

Playback Motfications CEIP  Logging RBAC Email Cloud DB wel 4 | ¢

Azure 501 Managed Instance support

This option allows you to enable cloud SQL.

Enable cloud SGL

Cloud SQL admin srtsqsladmin
name

Cloud SQL admin  [cererererererasases
password:

Concal | | s

Migrate an on-premises database to cloud SQL Managed Instance

1. Migrate your on-premises database according to https://docs.microsoft.com/en-us/data-
migration/ or https://docs.aws.amazon.com/prescriptive-guidance/latest/patterns/migrate-
an-on-premises-microsoft-sql-server-database-to-amazon-rds-for-sqgl-server.html.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the Session
Recording server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.
exe -modifyazuredbconnectionpara { Database Instance } { Session
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Recording Database Name } { Session Recording Logging Database
Name } { AzureAdminName } { AzureAdminPassword } diisreset /
noforce

3. Onthe Session Recording server, restart the Citrix Session Recording Analytics service, the Citrix
Session Recording Storage Manager service, and the IIS service.

Migrate a production database from Azure SQL Managed Instance to an on-premises database

1. Migrate the database according to https://docs.microsoft.com/en-us/data-migration/.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the Session
Recording server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils
.exe -modifydbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } iisreset /noforce

3. Onthe Session Recording server, restart the Citrix Session Recording Analytics service, the Citrix
Session Recording Storage Manager service, and the IIS service.

Install the Session Recording database on SQL Server on Azure VMs

On SQL Server on Azure VMs, you can install the Session Recording database by double-clicking and
running the SessionRecordingAdministrationx64.msi package or by using the Citrix Virtual Apps and
Desktops installer.

1. Check out an Azure SQL VM.

2. Configurethe VM and add it to the domain where you install the Session Recording components.

3. Use the VM’s FQDN as the instance name during the installation of the Session Recording data-
base.
Note: If you are using SessionRecordingAdministrationx64.msi for the installation, clear the En-
able cloud SQL check box.

4. Follow the installation user interface to complete installing the Session Recording database.

Install the Session Recording database on Google Cloud SQL Server
Tip:

On Google Cloud SQL Server, installation of the Session Recording database can be done by
running a command similar to the following or by double-clicking and running the Session-
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RecordingAdministrationx64.msi package. For a description of the command parameters, see
the preceding Automate installation section in this article.

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="

SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording
" LOGGINGDATABASENAME="CitrixSessionRecordinglLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /lxvx "c:\WithLogging.

'Logll
This section details the installation method by using SessionRecordingAdministrationx64.msi that

you can find on the Citrix Virtual Apps and Desktops ISO under \x64\Session Recording.

1. Create a SQL Server instance in Google Cloud.

a) Go to the Google Cloud console and open the SQL instances page.

b) Click CREATE INSTANCE. For example:

= GoogleCloud | & ~ || search () for resources Qsarch | B @ @ .
g sQL Instances [ CREATE INSTANCE 3 MIGRATE DATA ) HELP ASSISTANT  SHOW INFO PANEL
= Filter £ " (> m
O nstanceo @ 1
O @ sessionrecor ding
c) Choose SQL Server as your database engine.
Google Cloud 1 v || Search (/) for resources, docs, products, and more Q Search | T QO o : .

[E) HELP ASSISTANT

& o

saL & Create an instance

Choose your database engine
£ MysaL £ PostgreSQL £ sQL Server

Versions: 8.0,5.7, 5.6 Versions: 2019, 2017

Choose MySQL Choose SQL Server

Want more context on the Cloud SQL database engines? Learn more

d) Fillin the Instance ID field and enter a password for the user. Keep a record of the pass-
word. Select a SQL Server version for your instance. Do other configurations as needed.

For example:
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= Google Cloud H

< Create a SQL Server instance

Instance info

Instance ID *
testinstance
wercase letle al
Password *
............. ®  GENERATE
mi
Database version *
SQL Server 2019 Standard -

Choose a configuration to start with

These suggested configurations will pre-filthis form as @ starting point for creating an
instance. You can customize as needed later.

@  Youve made changes that override the selected configuration. RESET
@ Production
plimized for the m cal workloads. Highly available, performant, and durable

O Developmen
Performant but not highly available, while re svisic es

v CONFIGURATION DETAILS

Choose region and zonal availability

For better performance, keep your data close to the services that need it. Region is
permanent, while zone can be changed any time.

Region
us-centrall (lowa) v
Zonal availability

@ single zone
of outage, no fail Not ded for productios

O Muttiple zones (Highly available)
pEpET : a2 ithin v ted region. Recommended for
Increase

Primary zone

Any v

A HIDE ZONES

Summary

Region
DB Version

VCPUs

Memory

Storage

Network throughput
(MB/s) @

Disk throughput (MB/s)
2]

ioPs @

Connections
Backup
Availability

Point-in-time recovery

Q Search

Tt @o : i

[EJ HELP ASSISTANT

Assign the instance a public IP address and set an authorized network that can connect to

the instance. In the Network field, enter the IP address of the machine where the Session

Recording server is installed. For example:
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Google Cloud o - Search (/) for resources, docs, products, and more ‘ Q search | ff & ° @ .

< Create a SQL Server instance (5] HELP ASSISTANT

Customize your instance

Summary
You can also customize instance configurations later
N Region us-central1 (o
Machine type v DB Version Server 2019
Machine has 4 vCPUs and 26 GB of memory.
VvCPUs
Memory
Storage Storage
Storage ze is 100 GB, and will automatically scale as neet v Network throughput 2000
Google-mana d (most common; (MB/s) @
Disk throughput (MB/s)
Connections ~ ©
ors @
Choose how you want your source to connect to this instance, then define which rte 3000 of 1
networks are authorized to connect. Leam more -
Connections Public IP
You can use the Cloud SQL Proxy for extra security with either option. Learn more Backup Automated
Instance IP assignment Availability Single zone
[ private 1P Point-in-time recovery Disabled

Assigns an internal, Goo

quires additional APIs and
pe ons. Can't be more

Public IP
Assigns an ex emet-accessi Requires using an auth
or the Cloud S nnect t nce. Learn more

Authorized networks
YYou can specify CIDR ranges to allow IP addresses in those ranges to access your
instance. Learn more

New network ~

Name
[ test

Use CIDR notation 2

CANCEL DONE

ADD A NETWORK

Authentication v
No Active Directory domain selected
Data Protection

kups enabled. Point-in-time recovery (via transaction logs) disabled.

abled.

f) Click CREATE INSTANCE and wait for a few minutes.
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Customize your instance
You can alse customize instance configurations later

Machine type
Machine has 4 vCPUs and 26 GB of memary.

Storage
Storage type is SSD. Storage size is 100 GB, and will automatically scale as needed. V'
Google-managed key enabled (m: o)

Connections
Public IP enabled

Authentication
No Active Directory domain selected

Data Protection
Automatic backups enabled. Point-intime recovery (via transaction logs) disabled. v
Instance deletion protection enabled

Maintenance
pdates may occur any day of the week. Maintenance timing set to Later

Flags and parameters
Add any database flags or parameters youd like to apply to this instance. Default ™
collation is SQL_Latin1_General_CP1_CI_AS. Timezone is UTC.

Labels
Nolabels set

A HIDE CONFIGURATION OPTIONS

CREATE INSTANCE [IIVNY=2TH

g) On the page of the newly created instance, find the public IP address and keep a record of
it.

= GoogleCloud | & v | search (/) for resources, docs, products, and more Qsearch | i B @ @ ¢ ‘

g SqQL Overview /7 EDIT & IMPORT & EXPORT Y RESTART W STOP @ DELETE B CLONE [E HELP ASSISTANT

PRIMARY INSTANCE
Allinstances > testinstance

© testinstance

SQL Server 2019 Standard

A Owen
2 Connections
2t Users Thour 6hours + 1day 7days 30days Custom w

[  Databases

Chart ~r:
CPU utilization - @ A=
&)  Backups
iZ  Operations
urc WPM  Mayo  200AM  400AN G00AM  SO0AM  1000AM  1200PM  200PM  400PM
=) Connect to this instance A configuration
Public IP address
m VCPUS Memory SSD storage
4 26GB 100GB
Connection name
1] o
@ Database version is SQL Server 2019 Standard CU19
«» Auto storage increase is enabled

Need help connecting?

®

Review the documentation to learn about the many ways to connect Automated backups are enabled

to your instance. Learn more

Point-in-time recovery is disabled

Instance deletion protection is enabled
711 Suggested actions

Located in us-central1-b

=> Create abackup Not highly available (zonal)

B\ »r & @

> Enable high availability Database flags and parameters

h) Run SessionRecordingAdministrationx64.msi to install the Session Recording database.

On the following page during the installation, make the following configurations:
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« Select the Enable cloud SQL check box.

+ Inthe Instance name field, enter the public IP address of the SQL Server instance that
you created earlier.

« Fillin the cloud SQL admin name and password.

ﬁ Citrix Session Recording Administration Setup — >

cifrix

Specify the instance name and database name of the Session Recording Database and the
computer account of the Session Recording Server.

Database and Server Configuration

Instance name |

Example: \SQLEXPRESS, compuier-name\SQLEXPRESS, compuier-name
’l

top:xxax. database windows.net, 334
Enable cloud SGL

Database name |

[ ] Use default database name

Cloud SQL admin |
name

Cloud SQL admin |
password

Session Recording
Server computer
aCCDLII‘It E'~E"‘Ii}."'5.’ JOCRANOST Comaun \COMPULE-Name

< Back Mext = Cancel

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall
or remove programs option available from the Windows Control Panel. To remove the Session
Recording database, you must have the same securityadmin and dbcreator SQL Server role permis-
sions as when you installed it.

For security reasons, the administrator logging database is not removed after the components are
uninstalled.

Integrate with Citrix Analytics for Security

You can configure Session Recording servers to send user events to Citrix Analytics for Security, which
processes the user events to provide actionable insights into user behaviors.
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Prerequisites

Before you begin, ensure the following:

+ The Session Recording server must be able to connect to the following addresses:
- https://*.cloud.com
- https://*.citrixdata.com

- https://api.analytics.cloud.com

+ The Session Recording deployment must have port 443 open for outbound internet connections.
Any proxy servers on the network must allow this communication with Citrix Analytics for Secu-
rity.

+ If you are using Citrix Virtual Apps and Desktops 7 1912 LTSR, the supported Session Recording
version is 2103 or later.

Connect your Session Recording server to Citrix Analytics for Security

1. Signin to Citrix Cloud.
2. Find Citrix Analytics for Security and click Manage.
3. From the top bar, click Settings > Data Sources.

4. On the Virtual Apps and Desktops- Session Recording site card, click Connect Session
Recording server.

Session Recording (i
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5. Onthe Connect Session Recording Server page, review the checklist, and select all the manda-

tory requirements. If you do not select a mandatory requirement, the Download File option is
disabled.

6. If you have proxy servers in your network, enter the proxy address in the SsRecStorageMan-
ager.exe.config file in your Session Recording server.

You can find the configuration file at <Session Recording server 1installation
path>\bin\SsRecStorageManager.exe.config

For example: C:\Program Files\Citrix\SessionRecording\Server\Bin\
SsRecStorageManager.exe.config

=1 SsRecStorageManager exe corfig E3 | [N

<2xml version="1.0" encoding="utf-8"2>
Bl<configuration>
= <startup useLegacyV2Runcti

vationPolicy="true">
v4.0.30319"/>
"y2.0.50727"/>

' </acarcup>
= <appSettings>
</appSettings>
<system.net>
<mailSettings>
<smtp from="yourEmail@address.com">

" userName="yourEmail@address.com" password="yourpassword"

I </smtp>
f </mailSettings>
<defaultProxy rue">
<prox fault="False" proxyaddress=" bypassonlocal="True"/>
</defaultProxy>
</system.net>
<runtime>
T <generatePublisherEvidence exab;ed=”talse"/ﬂ

‘ </runtime>
</configuration>

7. Click Download File to download the SessionRecordingConfigurationfFile.json file.

Note:

The file contains sensitive information. Keep the file in a safe and secure location.

8. Copy the file to the Session Recording server that you want to connect to Citrix Analytics for
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Security.

9. If you have multiple Session Recording servers in your deployment, you must copy the file in
each server that you want to connect and follow the steps to configure each server.

10. On the Session Recording server, run the following command to import the settings:

<Session Recording server 1installation path>\bin\SsRecUtils.exe -
Import_SRCasConfigurations <configuration file path>

For example:

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.exe
-Import_SRCasConfigurations C:\Users\administrator\Downloads\
SessionRecordingConfigurationFile.json

11. Restart the following services:

« Citrix Session Recording Analytics Service

« Citrix Session Recording Storage Manager

12. After configuration is successful, go to Citrix Analytics for Security to view the connected Session
Recording server. Click Turn On Data Processing to allow Citrix Analytics for Security to process
the data.

Note:

If you are using Session Recording server version 2103 or 2104, you must first launch a Vir-
tual Apps and Desktops session to view the connected Session Recording server on Citrix
Analytics for Security. Otherwise the connected Session Recording server fails to get dis-
played. This requirement is not applicable for Session Recording server version 2106 and
later.

View the connected deployments

The server deployments appear on the Session Recording site card only if the configuration is suc-
cessful. The site card shows the number of configured servers that have established connections with
Citrix Analytics for Security.

If you don’t see your Session Recording servers even after the configuration was successful, refer to
the troubleshooting section at Configured Session Recording server fails to connect.
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Session Recording G

On thesite card, click the number of deployments to view the connected server groups with Citrix Ana-
lytics for Security. For example, click 1 Session Recording Deployment to view the connected server
or server groups. Each Session Recording server is represented by a base URL and a ServerGrouplD.

“ Connected Session Recording Deployments

Session re cording servers

Session Recording deployment

n recording server is successfully configured and connected

View received events

The site card displays the connected Session Recording deployments and the events received from
these deployments for the last one hour, which is the default time selection. You can also select 1
week (1 W) and view the data. Click the number of received events to view the events on the self-
service search page.

After you have enabled data processing, the site card might display the No data received status. This
status appears for two reasons:

1. If you have turned on data processing for the first time, the events take some time to reach the
event hub in Citrix Analytics. When Citrix Analytics receives the events, the status changes to
Data processing on. If the status does not change after some time, refresh the Data Sources

page.
2. Citrix Analytics has not received any events from the data source in the last one hour.

Add Session Recording servers

To add a Session Recording server, do one of the following:
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+ Onthe Connected Session Recording Deployments page, click Connect to Session recording
server.

“ Connected Session Recording Deployments

Session recording servers

« On the Virtual Apps and Desktops- Session Recording site card, click the vertical ellipsis (K)
and then select Connect Session Recording server.

Turn off data processing

Session Record

Connect Session Recording server

Recerved Events: ( H

No data to display

Follow the steps to download the configuration file and configure a Session Recording server.

Remove Session Recording servers

To remove a Session Recording server:

1. On Citrix Analytics for Security, go to the Connected Session Recording Deployments page
and select the server deployment that you want to remove.

2. Click the vertical ellipses (K) and select Remove Session Recording server from Analytics.
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“ Connected Session Recording Deployments

Session recording servers

ssion Recording deployment

3. Onthe Session Recording server that you have removed from Citrix Analytics, run the following
command:

<Session Recording server installation path>\bin\SsRecUtils.exe -
Remove_SRCasConfigurations

For example:

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.exe
-Remove_SRCasConfigurations

Turn on or off data processing on the data source

You can stop the data processing at any time for a particular data source- Director and Workspace app.
On the data source site card, click the vertical ellipsis (®) and then select Turn off data processing.
Citrix Analytics stops processing data for that data source. You can also stop the data processing from
the Virtual Apps and Desktops site card. This option applies to both data sources- Director and Work-
space app.

To enable data processing again, click Turn On Data Processing.

Configured Session Recording server fails to connect

Your Session Recording server fails to connect to Citrix Analytics after configuration. Therefore, you
don’t see the configured server on the Session Recording site card.

To troubleshoot this issue, do the following:

1. Onyour configured Session Recording server, run the following PowerShell command to check
the Client Machine Identification (CMID):

Get-WmiObject -class SoftwarelLicensingService | select
Clientmachineid

2. If CMID is empty, add the following registry files in the specified paths:
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Registry name Registry path Key type Value

AuditorUniqueID Computer) String Enter your UUID.
HKEY_LOCAL_MACHINE
\SOFTWARE\
Citrix\
SmartAuditor\
Server)\

EnableCASUseAudi totdmgdutedp REG_DWORD 1
HKEY_LOCAL_MACHINE
/SOFTWARE/
Citrix/
SmartAuditor/
Server/

3. Restart the following services:

« Citrix Session Recording Analytics Service

« Citrix Session Recording Storage Manager

Dynamic session recording

June 21, 2024

Previously, session recording started strictly at the very beginning of sessions that met the recording
policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this fea-
ture, you can start or stop recording a specific session or sessions that a specific user launches, at any
time during the sessions.

Note:

To make the feature work as expected, upgrade Session Recording, VDA, and Delivery Controller
to Version 7.18 or later.

Enable or disable dynamic session recording

On the Session Recording agent, a registry value is added for enabling or disabling the feature. The
registry value is set to 1 by default, which means that the feature is enabled by default.
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To enable or disable the feature, complete the following steps:

1. After the Session Recording installation is complete, log on as an administrator to the machine
where you installed the Session Recording agent.

2. Open the Registry Editor.

3. Browseto HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.

4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.
1: enable dynamic recording
0: disable dynamic recording

5. Restart the Session Recording agent to make your setting take effect.
If you are using MCS or PVS for deployment, change the setting on your master image and per-
form an update to make your change take effect.

Warning:

Incorrectly editing the registry can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of the Registry Editor can be solved. Use the Registry Editor at your own risk. Be sure to back up
the registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix SDKs

You can use the dynamic session recording feature in both on-premises and Citrix Cloud environments.
To use the featurein an on-premises environment, use the Citrix Virtual Apps and Desktops PowerShell
SDK. To use the feature in a Citrix Cloud environment, use the Citrix DaaS Remote PowerShell SDK
(formerly Citrix Virtual Apps and Desktops Remote PowerShell SDK).

To determine which SDK to install and use, be aware of the Delivery Controller that you specified when
creating your recording policy. If you select the Citrix Cloud Controller check box to record sessions
in a Citrix Cloud environment, you must validate your Citrix Cloud credentials.
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! @ Delivery Group or Machine Mame Cueries >
|

[l Create Query *

Site Address: [] Citrix Cloud Controller

|E:feraafeadd'ﬁss |

(@ Delivery Groups () Machines

| Enfer 3 Delven Group name |

Create Cancel
Close

Note:

Do not install the Citrix DaaS Remote PowerShell SDK on a Citrix Cloud Connector machine. You

caninstall the Remote PowerShell SDK on any domain-joined machine within the same resource

location. We recommend that you do not run this SDK’s cmdlets on Cloud Connectors. The SDK’

s operation does not involve the Cloud Connectors.

The following table lists three PowerShell commands that both Citrix SDKs provide for dynamic ses-

sion recording.

Command

Description

Start-BrokerSessionRecording

Lets you start recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. If a specific session is originally
set up for an event-only recording according to
policy settings, using this command allows you
to start capturing the screen in addition to the
target events. For more information, run Get-
Help Start-BrokerSessionRecording
to see the command online help.
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Command

Stop-BrokerSessionRecording

Get-BrokerSessionRecordingStatus

Description

Lets you stop recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Stop-BrokerSessionRecording
to see the command online help.

Lets you get the recording status of a specific
active session. For more information, run
Get-Help Get-
BrokerSessionRecordingStatus to see
the command online help.

For example, when a user reports an issue and needs timely support, you can use the feature to dy-

namically start recording the user’s active sessions. You can play the live recording to proceed with

the follow-up troubleshooting. You can do the following:

1. (For Citrix Virtual Apps and Desktops PowerShell SDK only) Launch PowerShell from the Citrix

Studio console.

= = [Adoss
~ TN CITRIX itrStudio (8YT_DE) -

CommonTests | Actons | Powerspol |

“yKage-gge-1

i Retrezn

| rer

2. Usethe Get-BrokerSession command to get all the active sessions of the target user.

rogram Files\Citrix\Desktop
Files\Citrix\Desktop

Files\Citrix\Desktop

\Program Files\Citrix\Desktop

PS C:
Desktop
A cation
\Program Files\Citrix\Desktop
dows 2016
ws 2016
\Program Files\Citrix\Desktop

t Administrator. C\Windows\System32\WindowsPowerShel\w1.0\Powershell exe

Studi

Studio:

Studio:

Studio:

Studio> §

Studio>

s.sessionstate

sessiontype

)Stype

t-brokersession WKAOE\testusert ~
1id

- [m] X
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3. Usethe Get-BrokerSessionRecordingStatus command to get the recording status of

the specified session.

PS C:\Program Files\Citrix\Desktop Studio>
SessionNotRecorded

Ps C:\Program Files\Citrix\Desktop
SessionNotRecorded

PS C:\Program Files\Citrix\Desktop

Studio>

Studio>

Note:

Get-BrokerSessionRecordingStatus

Get-BrokerSessionRecordingStatus

The -Session parameter can accept only one session UID at a time.

Usethe Start-BrokerSessionRecordingcommand to start recording. By default, a no-

tification message appears to inform users of the recording activity.

The following table shows common ways of using the Start-BrokerSessionRecording

command.

Command

Start-BrokerSessionRecording -
User DomainA \ UserA

Start-BrokerSessionRecording -
User DomainA \ UserA -NotifyUser
$false

Start-BrokerSessionRecording -
Sessions $SessionObject

Start-BrokerSessionRecording -
Sessions uidl,uid2,...,uidn

Description

Starts recording all sessions of user UserA in the
domain named DomainA and notifies UserA.

Starts recording all sessions of user UserA in the
domain named DomainA and does not notify
UserA.

Starts recording all sessions in the object named
$SessionObject and notifies the user. To get the
object $SessionObiject, run
$SessionObject=Get-BrokerSession
—username UserA. The name of an object is
prefixed with a dollar sign $. For more
information, see Step 2 and the command online
help.

Starts recording the sessions UID1, UID2, ...,
and UIDn, and notifies the users.

5. Usethe Get-BrokerSessionRecordingStatus command to get the recording status of

each target session. The status is supposed to be SessionBeingRecorded.

6. Play back the Live or Complete recordings and proceed with the follow-up troubleshooting.

Note

When you play a Complete recording ended by the Stop—-BrokerSessionRecording

command, the last section of the timeline on the player progress bar might show gray. And,
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the last section of the recorded session is idle. It is not obvious when the recorded session
has constant activities.

7. Usethe Stop-BrokerSessionRecordingcommand to stop recording when the reported
issue has been triaged or resolved.

The following table shows common ways of using this command:

Command Description

Stop-BrokerSessionRecording -User  Stopsrecording all sessions of user UserA in the

DomainA\ UserA domain named DomainA.
Stop-BrokerSessionRecording - Stops recording all sessions in the
Sessions $SessionObject $SessionObject.
Stop-BrokerSessionRecording - Stops recording the sessions UID1,UID2, ...,
Sessions uidl,uid2,...,uidn and UIDn.

On the Citrix Studio Logging screen, you can view the resulting logs of the Start-BrokerSessionRecording
and Stop-BrokerSessionRecording commands.

&4 Citrix Studio - X
File Action View Help
ke A e] il 7|
[ Console Root = Actions
v B8 CirxStudio (4DDC3) ogging =
Logging =
O Search
g Machine Catalogs || Administrator | Main Task Start + | End Status & Preferences
£ Delivery Groups ~ Today [E] Create Cust...
& Apl‘_’“_“t‘u”s APRQ\gh Stop Recording of Session "5DAE93E5-E14E..  8/20/2020:3:56:13...  8/20/2020:3:56:13..  Successful 5¢ Deletelogs
E"""_e‘ APRQ\gh Stop Recording of Session "4DDS7787-DDE...  8/20/2020: 3:56:00...  8/20/2020: 3:56:09...  Successful View ,
g Lal n
a 99 APRO\gh Start Recording of Session "5DAE93E5-E14E..  8/20/2020: 3:56:05...  8/20/2020: 3:56:05...  Successful
~ x4 Configuration 6] Refresh
£ Administrators APROQ\gh Start Recording of Session '4DD677B7-DDE...  8/20/2020: 3:56:02...  8/20/2020: 3:56:02...  Successful
Controllers APRQ\gh Stop Recording of Session "4DD67787-DDE..  8/20/2020: 3:55:13...  8/20/2020: 3:55:13...  Successful ﬂ Help
Hosting APRO\gh Stop Recording of Session "5DAE93E5-ET4E..  8/20/2020: 3:55:09...  8/20/2020:3:55:10...  Successful
#g Licensing APROQ\gh Create Machine 'Styx_VDA1_1"in Delivery G...  8/20/2020:1:22:535...  8/20/2020: 1:22:35...  Successful
g f‘”i’?; vil| APRQAah Create Delivery Group 'Styx VDA1' 8/20/2020 : 1:22:54,..  8/20/2020: 1:22:55...  Successful
o ublishir|
0 Zz:as APRQ\gh Create Machine Catalog "Styx_VDAT' 8/20/2020: 1:22:24...  8/20/2020: 1:22:24...  Successful
. B Citrix StoreFront APRQ\gh Create Machine 'Styx VDA2_1'in Delivery G...  8/20/2020:1:2001...  8/20/2020: 1:20:02... Successful
APRQ\gh Create Delivery Group "Styx VDA2' 8/20/2020 : 1:19:59...  8/20/2020: 1:20:02...  Successful
APRQ\gh Create Machine Catalog "Styx_VDAZ' 8/20/2020:1:18:50...  8/20/2020: 1:18:51...  Successful
b Vesterday

Configure

June 21, 2024

This section provides instructions for you to configure the following settings:

« Settings on the Session Recording agent
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- Enable or disable recording
- Configure the connection to the Session Recording Server
- Configure the communication protocol

+ Settings on the Session Recording server

Authorize users

Customize recording notification messages

Specify where recordings are stored

Specify file size for recordings

Enable or disable digital signing

CEIP and Google Analytics

« Policies

Configure session recording policies

Configure recording viewing policies

Configure event detection policies

Configure event response policies
« High availability and load balancing

- Load balance Session Recording servers
- Configure database high availability

Configure settings on the Session Recording agent

June 21, 2024

This section guides you through the following settings:

« Enable or disable recording
+ Configure the connection to the Session Recording Server
+ Configure the communication protocol

Enable or disable recording

June 21, 2024

You can install the Session Recording agent on both multi-session OS and single-session OS VDAs for
recording sessions hosted on those VDAs. Within each agent is a setting that enables recording for
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the VDA on which it is installed. After recording is enabled, Session Recording evaluates the active
recording policy that determines which sessions are recorded.

We recommend you disable session recording on VDAs that are not recorded. There is a small impact
on performance, even if no recording takes place.

Enable or disable recording on a VDA

1. Log on to the server where the Session Recording agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.

3. Under Session Recording, select or clear the Enable session recording for this VDA machine
check box to specify whether sessions can be recorded for this VDA.
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L@'ﬁ; Session Recording Agent Properties —

Recording Connections Lossy Video

Session recording

Select this option to enable policy-based session recording on this VDA
machine. If this option 15 not selected, session recording i1s disabled on
this machine.

Enable session recording for this YDA machine

Custom event recording

Select this option to allow third party applications to inject custom data
into the recorded session while recording 15 in progress. This data is
availlable during playback.

Allow third party applications to record custom data on this VDA
L] machine

Compressed recording

Select this option to enable compressed recording for parts of Thimwire-
transmitted session screens that are not H.264 compressed.

] Enable compressed recording for Thinwire-transmitted session
screens on this VDA machine

OK Cancel

4. When prompted, restart the Session Recording agent service to accept the change.

Note:

When you install Session Recording, the active policy is
Do not record (no sessions are recorded on any server). To begin recording, use the
Session Recording policy console to activate a different policy.
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Enable custom event recording

Session Recording allows you to use third-party applications to insert custom data, known as events,
to recorded sessions. These events appear when the recorded session is played back. Events are part
of the recorded session file and can’t be modified after the session is recorded.

For example, an event might contain the following text: “User opened a browser.”Each time a user
opens a browser during a session being recorded, the text inserts to the recording at that point. When
a viewer plays back the recorded session, the viewer can locate and count the times that the user
opened a browser by noting the number of markers.

To insert custom events to recordings on a server:

+ Use Session Recording Agent Properties to enable a setting on each server where you want
to insert custom events. Enable each server separately. You can’t globally enable all servers in
a site.

+ Write applications built on the Event API that runs within each user’s virtual session, to inject
the data into the recording.

The Session Recording installation includes an event recording COM application (API) that allows you
to insert text from third-party applications to a recording. You can use the APl from many program-
ming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center
article CTX226844. The Session Recording Event API .dll is installed as part of the Session Recording
installation. You canfinditatC: \rogram Files\Citrix\SessionRecording\Agent\Bin
\Interop.UserApi.dll.

To enable custom event recording on a server, complete the following steps:

Log on to the server where the Session Recording agent is installed.
From the Start menu, choose Session Recording Agent Properties.
In Session Recording Agent Properties, click the Recording tab.

> w e

Under Custom event recording, select the Allow third party applications to record custom
data on this server check box.

Enable compressed recording

You can enable compressed recording for parts of Thinwire-transmitted session screens that are not
H.264 compressed. This feature reduces recording file size significantly.

Note:

« This feature is disabled by default.
« The minimum version required for the VDA is 2303.
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To enable compressed recording, complete the following steps:

1. Logon to the server where the Session Recording agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.

3. In Session Recording Agent Properties, click the Recording tab.

4. Under Compressed recording, select the Enable compressed recording for Thinwire-

transmitted session screens on this VDA machine check box.

LIE‘}_; Session Recording Agent Properties — -

Recording Connections Lossy Video

Session recording
Select this ophion to enable policy-based session recording on this VDA

machine. If this option 15 not selected, session recording is disabled on
this machine.

Enable session recording for this YDA machine

Custom event recording
Select this option to allow third party applin_::at_iﬂns to inject custom data

into the recorded session while recording is in progress. This data is
available during playback.

Allow third party applications to record custom data on this VDA
L] machine

Compressed recording

Select this ophion to enable compressed recording for parts of Thimwire-
transmitted session screens that are not H.264 compressed.

] Enable compressed recording for Thinwire-transmitted session
screens on this VDA machine

QK Cancel
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Enable or disable lossy screen recording

July 31, 2024

Lossy screen recording lets you adjust compression options to reduce the size of recording files and
to accelerate navigating recorded sessions during playback. Lossy screen recording is suitable for use
when:

+ the size of recording files per time unit is too large, or
+ thereis alag while you fast forward or rewind during recording playback.

You can now enable lossy screen recording in any of the following ways:

« Activate a system-defined session recording policy that has lossy screen recording enabled.

+ Create and activate a custom session recording policy, and make sure to select Enable lossy
screen recording when creating the custom policy.

+ Select Enable lossy screen recording when configuring an event response policy. When a mon-
itored event is detected later, lossy screen recording is triggered.

For more information, see Configure session recording policies and Configure event response poli-

cies.

When the active session recording or event response policy doesn’t have lossy screen recording en-
abled, compression options are unavailable.
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E’: Session Recording Agent Properties — >

Recording Connections Lossy Screen  Player

Video fluency: Low

Video image quality: Low

[-Frame interval:

[ it

[=]

n

[x]

aling: 10

L

Image n

1]
[ra]
[=]

Cursor refresh rate: Low

Cance

When the active session recording or event response policy has lossy screen recording enabled, com-

pression options are available on the Lossy Screen tab of Session Recording Agent Properties.
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E’: Session Recording Agent Properties — >

Recording Connections Lossy Screen  Player

Codec settings

Video fluency: Low e

Wideo image quality: Low w

[-Frame interval: '

Image resolution scaling: 10 -
Cursar

Cursor refresh rate: Low -

Cance

You can adjust the compression options to your needs. We recommend you use the default values
unless there is a practical need to change the values.

For a description of compression options, see the following table:

Compression option Description Default value Remarks
Video fluency (FPS) Low: 1; Medium: 5; Low N/A
High: 10

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 114



Session Recording 2407

Compression option

Video image quality

I-Frame interval
(seconds)

Image resolution
scaling

Cursor refresh rate
(times per second)

Description

Low: bitrate:140
(kbps); Medium:
bitrate:280 (
kbps); High:
bitrate:420 (kbps)

60, 120, 300, 600,
1200, 1800, 3600

1.0,0.9,0.8,0.7,0.6,
0.5,0.4

Low: 3; Medium: 5;
High: 10

Default value

Low

600

Low

Remarks

Session Recording
uses Average Bitrate
(ABR) for video bitrate
encoding. Higher
values mean less
compression. You can
also set a custom
value between 40 kbps
and 80,000 kbps by
editing the Registry at

HKEY_LOCAL_MACHINE\SOFTWARE

The larger the I-Frame
interval value, the
smaller the storage
space occupied by the
compressed video.
The smaller the
I-Frame interval value,
the better the seeking
experience (fast
forward and rewind).
You can downscale the
resolution of recorded
screensto a
percentage, for
example, 0.9 means
90%. If you don’t want
to change the
resolution, use the
default value 1.0. You
can also set the image
resolution scaling by
editing the Registry at

HKEY_LOCAL_MACHINE\SOFTWARE

N/A
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Enable fast seeking

June 21,2024

Fast seeking allows to accelerate navigating ICA screen recordings during playback. It significantly
improves the playback seeking experience.

Note:

Fast seekingis valid only for the sessions that are recorded after the feature is enabled in Session
Recording Agent Properties.

Enable fast seeking

To enable fast seeking, complete the following steps:

1. Open the Player tab of Session Recording Agent Properties.
2. Select Enable fast seeking and configure how often an I-Frame is generated.

You can select a system-defined I-Frame interval or configure a custom I-Frame (in seconds,
ranging from 10 to 1,800 seconds). By default, the system-defined I-Frame interval Medium
(60 seconds) is selected.

For a description of the system-defined I-Frame intervals, see the following table:

System-defined I-Frame interval Description
Low 300 seconds
Medium 60 seconds
High 30 seconds

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 116



Session Recording 2407

25 Session Recording Agent Properties = X
Recording Connections Lossy Screen Player

Enable fast seeking
Seek settings

(@) System-defined |-Frame interval:

(O Custom |-Frame interval:

0K Cancel

3. (Optional) If you also want to enable fast seeking for the Session Recording web player, navigate
to Configuration > Preferences on the web player page and ensure that Enable fast seeking
is selected.
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Cifrix | Session Recording

Preferences

Set your playback preferences.

Administrator Logging v Player cache

Set the cache size you want the player to use for playback.

{8 Configuration ~ ———0 —o— —o— 32 }% MB

Seek options

Enable fast seeking

Select this check box to improve the seek performance during playback

Configure the connection to the Session Recording server

June 21,2024

Configure the connection of the Session Recording player to the Session Recording
server

Before a Session Recording player can play sessions, configure it to connect to the Session Recording

server that stores the recorded sessions. Each player can be configured with the ability to connect to

multiple Session Recording servers, but can connect to only one Session Recording server at a time.

If a player is configured with the ability to connect to multiple Session Recording servers, users can

change which Session Recording server the player connects to.

ok wpn =

Log on to the workstation where the Session Recording player is installed.

Start the Session Recording player.

From the Session Recording player menu bar, choose Tools > Options.

On the Connections tab, click Add.

In the Hostname field, type the name or IP address of the machine hosting the Session Record-
ing server and select the protocol. By default, Session Recording is configured to use HTTPS/SSL
to secure communications. If SSL is not configured, select HTTP.

To configure the Session Recording player with the ability to connect to multiple Session Record-
ing servers, repeat Steps 4 and 5 for each Session Recording server.

Ensure that you select the check box of the Session Recording server you want to connect to.
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Configure the connection of the Session Recording agent to the Session Recording
server

The connection is typically configured when the Session Recording agent is installed. To configure
this connection after the Session Recording agent is installed, use Session Recording Agent Proper-
ties.

1. Logon to the server where the Session Recording agent is installed.

2. From the Start menu, choose Session Recording Agent Properties.

3. Click the Connections tab.

4. In the Session Recording Server field, type the FQDN of the Session Recording server.
Note:

To use Message Queuing over HTTPS (TCP is used by default), type an FQDN in the Session
Recording Server field. Otherwise, session recording fails.

5. In the Session Recording Storage Manager message queue section, select the protocol that
is used by the Session Recording Storage Manager to communicate and change the default port
number if necessary.

Note:

To use Message Queuing over HTTP and HTTPS, install all the 1IS recommended features.

6. In the Message life field, accept the default 7,200 seconds (two hours) or type a new value for
the number of seconds each message is retained in the queue if there isa communication failure.
After this time elapses, the message is deleted and the file is playable until the point where the
data is lost.

7. In the Session Recording Broker section, select the communication protocol that the Session
Recording Broker uses to communicate and change the default port number if necessary.

8. When prompted, restart the Session Recording agent service to accept the changes.

Change your communication protocol

June 21, 2024

For security reasons, Citrix does not recommend using HTTP as a communication protocol. The
Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must
change several settings.
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Use HTTP as the communication protocol

1. Logon to the machine hosting the Session Recording server and disable secure connections for
Session Recording Broker in IIS.

2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on
each server where the Session Recording agent is installed:

a) Logon to each server where the Session Recording agent is installed.

b) From the Start menu, choose Session Recording Agent Properties.

c) In Session Recording Agent Properties, choose the Connections tab.

d) Inthe Session Recording Broker area, select HTTP from the Protocol drop-down list and
click OK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:

a) Logon to each workstation where the Session Recording Player is installed.

b) From the Start menu, choose Session Recording Player.

c) From the Session Recording Player menu bar, choose Tools > Options > Connections,
select the server, and choose Modify.

d) Select HTTP from the Protocol drop-down list and click OK twice to accept the change
and exit the dialog box.

4. Change the protocol setting from HTTPS to HTTP in the Session Recording policy console:

a) Logon to the server where the Session Recording policy console is installed.

b) From the Start menu, choose Session Recording Policy Console.

c) SelectHTTP fromthe Protocol drop-down listand click OKto connect. If the connectionis
successful, this setting is remembered the next time you start the Session Recording policy
console.

Revert to HTTPS as the communication protocol

1. Logon to the machine hosting the Session Recording server and enable secure connections for
the Session Recording Broker in IIS.

2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on
each server where the Session Recording agent is installed:

a) Logon to each server where the Session Recording agent is installed.
b) From the Start menu, choose Session Recording Agent Properties.
) In Session Recording Agent Properties, choose the Connections tab.
)

In the Session Recording Broker area, select HTTPS from the Protocol drop-down list

c
d
and click OK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:
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a) Log on to each workstation where the Session Recording Player is installed.

b) From the Start menu, choose Session Recording Player.

¢) From the Session Recording Player menu bar, choose Tools > Options > Connections,
select the server, and choose Modify.

d) Select HTTPS from the Protocol drop-down list and click OK twice to accept the change
and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording policy console:

a) Logon to the server where the Session Recording policy console is installed.

b) From the Start menu, choose Session Recording Policy Console.

c) Select HTTPS from the Protocol drop-down list and click OK to connect. If the connection
is successful, this setting is remembered the next time you start the Session Recording
policy console.

Configure settings on the Session Recording server

June 21, 2024

This section guides you through the following settings:

Authorize users

Customize recording notification messages

Specify where recordings are stored

Specify file size for recordings

Enable or disable digital signing

CEIP and Google Analytics

Authorize users

June 21,2024

To grant users the rights, you assign users to roles using the Session Recording Authorization Console
on the Session Recording server. Five roles are available:

Important:

For security reasons, grant users only the rights they need to perform specific functions, such as
viewing recorded sessions.
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PolicyAdministrator. Grants the right to view, create, edit, delete, and enable recording poli-
cies. By default, administrators of the machine hosting the Session Recording server are mem-
bers of this role.

PolicyQuery. Allows the servers hosting the Session Recording agent to request recording pol-
icy evaluations. By default, authenticated users are members of this role.

LoggingWriter. Grants the right to write the Administrator Logging logs. By default, local ad-
ministrators and the Network Service group are members of this role. Changing the default
LoggingWriter membership can cause log writing failure.

LoggingReader. Grants the right to query the Administrator Logging logs. There is no default
membership in this role.

PrivilegedPlayer. Grants the right to place and remove access restrictions on recordings and
the right to archive and delete recordings.

Player. Grants the right to view recorded Citrix Virtual Apps and Desktops and Citrix DaaS (for-
merly Citrix Virtual Apps and Desktops service) sessions. There is no default membership in
this role. When you install Session Recording, no user has the right to play recorded sessions.
A user without the permission to play recorded sessions receives the following error message
when trying to play a recorded session:

Search Failed

'.6.' Search for recorded session files failed,

Access to Session Recording Server was denied. Rejected user request as
access is denied by role-based security,

oK

To assign users to a role, do the following:

ok w e

Log on as an administrator to the machine hosting the Session Recording server.
Start the Session Recording Authorization Console.

Select the role to which you want to assign users.

From the menu bar, choose Action > Assign Users and Groups.

Add the users and groups.

Session Recording supports users and groups defined in the Active Directory.

Any changes made to the console take effect during the update that occurs once every minute. Also,

starting with the 1906 release, you can use the Session Recording policy console to create recording

viewing policies. For more information, see Recording viewing policies.
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CEIP and Google Analytics

June 21,2024

When you participate in the Citrix Customer Experience Improvement Program (CEIP), anonymous
configuration and usage data is collected and sent to Citrix. The data helps improve the product qual-
ity and performance. In addition, a copy of the anonymous data can be sent to Google Analytics for
fast and efficient analysis.

CEIP setting

By default, you automatically participate in CEIP when you install Session Recording. The first upload
of data occurs approximately seven days after you install Session Recording. To unsubscribe from
CEIP, do the following:

1. Logon to the machine hosting the Session Recording server.

2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the CEIP tab.

4. Clear the Participate in the Customer Experience Improvement Program check box.

5. Restart the Citrix Session Recording Analytics Service for the setting to take effect.
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iE[]] Session Recording Server Properties — >

Storage  Signing  Follover  Plapback  Motifications CEIP Logging  REBAC

Thiz option allows wou o make the product better by jaining the Custamer
Experence Improvement Program. Learn more

Farticipate in the Customer Expernence Improvement Program.

Corcal | | osh

Google Analytics setting

When Google Analytics is enabled, the heartbeat data between Google Analytics and the Session
Recording server is collected every 5 hours. User behavior data on the web player is also sent to
Google Analytics. User behavior includes activities such as opening the web player and playing or
searching recordings in it.

Google Analyticsisenabled by default, except for EU customers. If the time zone or region you selected
when installing Session Recording belong to the EU, you are considered an EU customer and Google
Analytics is disabled for you by default.

Registry setting that enables or disables Google Analytics:

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\
Name: CeipHeartBeatDisable

Value: 1 =disabled, 0 = enabled

To disable Google Analytics, complete the following steps:
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1. Logon to the machine hosting the Session Recording server.

2. Open the Registry Editor.

3. Browseto HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.

4. Locate or add the registry value CeipHeartBeatDisable.

5. Set the value data of CeipHeartBeatDisable to 1.

6. Restart the Citrix Session Recording Analytics Service for the setting to take effect.

To enable Google Analytics, complete the following steps:

Open the Registry Editor.

ok wpn e

Data collected from the Session Recording server

Log on to the machine hosting the Session Recording server.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.
Remove the registry value CeipHeartBeatDisable or set its value data to 0.
Restart the Citrix Session Recording Analytics Service to make for the setting to take effect.

The following table gives an example of the types of anonymous information collected. The data does

not contain any details that identify you as a customer.

Data Point Key Name
Machine GUID machine_guid
Operating System version 0S_version

Description

Identifying the machine where
the data originates. With
Google Analytics enabled,
heartbeat data is sent to
Google Analytics regardless of

whether CEIP is enabled.
Text string denoting the

machine’s operating system.
With Google Analytics enabled,
heartbeat data is sent to
Google Analytics regardless of
whether CEIP is enabled.

© 1999-2024 Cloud Software Group, Inc. All rights reserved.

125



Session Recording 2407

Data Point

Session Recording server
version

Number of application
recordings

Number of recordings

Number of dynamic recordings

Number of agents hosting
recorded sessions

Number of agents hosting
recorded sessions containing
logged events

Number of recordings
containing logged events

Key Name

SRS_version

application-recording
—-number

recording-number

dynamic-recording-
number

recorded-agent-number

event-logging-enabled
—agent-number

event-logging-
recording-number

Description

Text string denoting the
installed version of the Session
Recording server. With Google
Analytics enabled, heartbeat
data is sent to Google Analytics
regardless of whether CEIP is
enabled.

Integer denoting the number of
application recording files. The
data is sent when both Google
Analytics and CEIP are enabled.
Integer denoting the number of
both application and desktop
recording files. The data is sent
when both Google Analytics
and CEIP are enabled.

Integer denoting the number of
dynamically recorded files. The
data is sent when both Google
Analytics and CEIP are enabled.
Integer denoting the number of
VDAs hosting recorded sessions.
The data is sent when both
Google Analytics and CEIP are
enabled.

Integer denoting the number of
VDAs hosting recorded sessions
that contain logged events. The
data is sent when both Google
Analytics and CEIP are enabled.
Integer denoting the number of
recording files that contain
logged events. The data is sent
when both Google Analytics
and CEIP are enabled.
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Data Point

Administrator logging
enablement

Number of logged events

Number of custom policies

Load balancing enablement

Recording viewing policy
enablement

Key Name

admin-logging-status

collected-events-
number

customized-policies-
number

load-balancing-status

rbac-status

Customize recording notification messages

June 21,2024

Description

Digit indicating the
enablement of administrator
logging. “1”means enabled.
“0”means disabled. The data is
sent when both Google
Analytics and CEIP are enabled.
Integer denoting the number of
logged events. The data is sent
when both Google Analytics
and CEIP are enabled.

Integer denoting the number of
custom session recording and
event logging policies. The
data is sent when both Google
Analytics and CEIP are enabled.
Digit indicating the
enablement of load balancing.
“1”’means enabled. “0”means
disabled. The data is sent when
both Google Analytics and CEIP
are enabled.

Digit indicating the enablement
of recording viewing policies.
“1”’means enabled. “0”means
disabled. The data is sent when
both Google Analytics and CEIP
are enabled.

If the active recording policy records sessions with notifications, users receive recording notifications

after typing credentials.

« When Allow end user to deny recording of their session is enabled on the Netifications tab of
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the Session Recording Server Properties, the default notification message reads as follows:

Session Recording

Your activity with the desktop or program(s) you recently started is being recorded. If
you accept, click "OK", if you deny, click "Cancel” and the session will be disconnected.

Allow end user to deny recording of their session. This feature forces end users to explicitly
consent to the session recording disclaimer before they can continue with their session. If end
users accept the disclaimer, their session continues with session recording enabled. If end users
deny the disclaimer, their session is terminated.

+ When Allow end user to deny recording of their session is not enabled, the default notifica-
tion message is Your activity with the desktop or program(s) you recently started is being
recorded. If you object to this condition, close the desktop or program(s). Users can click
OK to dismiss the window and continue their sessions.

The default notification message appears in the language of the operating system on the VDA. You can
change the default message title and message body as needed.

You can also create notification messages in specific languages that you choose. While doing so, you
can customize the message title and message body too. You can have only one notification message
for each language. Your users see notification messages in the languages of their preferred local set-

tings. The language-specific notification messages take precedence over the default notification mes-
sage.

Customize recording notification messages

1. Logon to the machine hosting the Session Recording server.
2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Notifications tab.
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[% Session Recording Server Properties — -

Storage Signing Rollover Playback Motfications CEIP Logging RE Y Y

Matification can be sent to end users to inform them that their session is
being recorded. Customize content of the notification message below.

[] Allow end user to deny recording of their session

Default message
Title

Session Recording |

Body

Your activity with the desktop or programis) you recently startted is being
recorded. i you ohject to this condition, close the desktop or programis).

Language specific messages

Add...
List of language-specific notification messages is
empty. Only the default notification message will Modfy...
be used.
Femove

Corca | [I0GR%

4. To enable explicit user consent before recording sessions, select Allow end user to deny
recording of their session.

After you select Allow end user to deny recording of their session, the default message body
changes accordingly:
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[% Session Recording Server Properties — -

Storage Signing Rollover Playback Motfications CEIP Logging RE Y Y

Matification can be sent to end users to inform them that their session is
being recorded. Customize content of the notification message below.

Allow end user to deny recording of their session

Default message

Title

Session Recording

Body

Your activity with the desktop or programis) you recently startted is being
recorded. K you accept, click "OK", if you deny, click "Cancel” and the
session will be disconnected.

Language specific messages

Add...
List of language-specific notification messages is
empty. Only the default notification message will Modfy...
be used.
Femove

Corcd | [ ool

5. If you want to use the default notification message, change the default message title and mes-
sage body as needed and then click OK to complete the settings. If you want to use a language-

specific notification message, proceed to the following steps.
6. Click Add in the Language specific messages section.

7. Choose the language for the message and type the message title and message body. You can

create only one message for each language.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 130



Session Recording 2407

Language-Specific Motification Messages

Select language:

Title

Motification message:

Cancel

After accepting and activating, the new message appears in the language-specific notification
message box.

Enable or disable digital signing

June 21, 2024

You can install certificates on machines where you installed the Session Recording server and the Ses-
sion Recording player. Doing so can enhance the security of your deployment by assigning digital
signatures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session
Recording grants the read permission to the Session Recording Storage Manager Service.

Enable digital signing

Log on to the machine hosting the Session Recording server.
From the Start menu, choose Session Recording Server Properties.
In Session Recording Server Properties, click the Signing tab.

W

Browse to the certificate that enables secure communication among the machines where you
installed the Session Recording components.
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Disable digital signing

1. Logon to the machine hosting the Session Recording server.

2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.

4. Click Clear.

Event response reports

June 21, 2024

Overview

You can receive emailed event response reports on a daily or weekly basis. An event response report
contains a digest chart as the email body and a csv file as the attachment. The csv file includes a full
list of the events during the day or week that have triggered various event responses.

Note:

By selecting email notifications as the event response in your custom event response policy, you
can still be notified about each individual occurrence. You can choose regular event response
reports, individual notifications, or both.

The following are example digest charts contained in a weekly and a daily event response report:
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Weekly Daily

citrix cifrix.

Session Recording Event Response Report
Aug B, 2023
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il Al et b E—— |
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See the screen capture below for an example csv file that can be linked to an event response report:
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-~

A

Trigger time Trigger description

XF4B5\Administrator 9/20/2023 3:21:50 A

XF4B5\Administrator 9/20/2023 3:26:53 A perf
XF4B5\Administrator 9/18/2023 8:52:36 A

XF4B5\Administrator 9/18/2023 8:53:09 A perf
XF4B5\Administrator 9/16/2023 3:03:56 A

XF4B5\Administrator 9/18/2023 3:09:06 A

XF4B5\Administrator 9/18/2023 6:58:15 A web
XF4B5\Administrator 9/20/2023 5:41:04 A perf
XF4B5\Administrator 9/20/2023 5:50:37 A perf
XF4B5\Administrator 9/20/2023 5:51:07 A perf
XF4B5\Administrator 9/20/2023 6:14:43 A perf
XF4B5\Administrator 9/20/2023 6:26:47 A perf
XF4B5\Administrator 9/20/2023 6:56:26 A perf
XF4B5\Administrator 9/20/2023 3:28:23 A perf
XF4B5\Administrator 9/20/2023 3:29:24 A perf
XF4B5\Administrator 9/20/2023 3:29:54 A perf
XF4B5\Administrator 9/20/2023 3:30:24 A perf
XF4B5\Administrator 9/20/2023 3:31:25 A perf
XF4B5\Administrator 9/20/2023 3:31:54 A perf
XF4B5\Administrator 9/20/2023 6:44:52 A perf
XF4B5\Administrator 9/20/2023 6:46:52 A perf
XF4B5\Administrator 9/20/2023 3:32:24 A perf
XF4B5\Administrator 9/20/2023 3:32:54 A perf
XF4B5\Administrator 9/20/2023 3:33:24 A perf
XF4B5\Administrator 9/20/2023 6:19:45 A perf
XF4B5\Administrator 9/20/2023 6:20:15 A perf
XF4B5\Administrator 9/20/2023 6:26:17 A perf
XF4B5\Administrator 9/20/2023 6:27:18 A perf
XF4B5\Administrator 9/20/2023 6:27:47 A perf
XF4B5\Administrator 9/20/2023 6:52:54 A perf

XF4B5\Administrator 9/20/2023 5:41:33 A perf

= EventResponses 9 21 2023.csv

Open with

Recording file Trigger type Trigger detail Event detail
C:\SessionRecording Session Start Email alert when a s Session Start
C:\SessionRecordings\2023\09\19\i_fab04 and start screen recording when a is deteq
C:\SessionRecording Session Start Email alert when a s Session Start
C:\SessionRecordings\2023\09\18\i_3c71% and disconnect session when a isdetecte!
C:\SessionRecording Session Start Email alert when a s Session Start
C:\SessionRecording Session Start Email alert when a s Session Start
C:\SessionRecording WebBrowsing Email alert and lock WebBrowsing<SPLT
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i

C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i

C:\Sesi0nRecor®ngs\2023\09\19\i798cd( and start screen recording when a i

C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i
C:\SessionRecordings\2023\09\19\i_98cdc and start screen recording when a i

C:\SessionRecordinas\2023\09\19\i 98cdc and start screen recordina when a i

Configuration

To receive emailed event response reports on a daily or weekly basis, schedule reports through Ses-
sion Recording Server Properties. Make sure to configure outgoing email settings on the Email tab
too.

Note:

If your Session Recording servers are configured in a load balancing manner, schedule reports
on one of the servers. Otherwise, create a schedule on each of your Session Recording servers.
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Storage report
This option allows you to receive storage reports regularly. Make sure to

configure outgoing email settings on the Email tab too.
[] Send storage reports by email
@ Daily
O \eekly |Monday v
Email recipients: |

Event response report
This option allows you to receive event response reports regularly. Make
sure to configure outgoing email settings on the Email tab too.
] Send event response reports by email
@ Daily
O Weekly Monday v
Email recipients: | -

%Sessicn Recording Server Properties - ® ‘

Playback Notfications CEIP Logging RBAC Emal Repot Cloud|*[*]

Session recording storage reports

June 21, 2024
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Overview

A session recording storage report provides weekly statistics on screen recordings of a single or mul-
tiple load-balanced Session Recording servers. It is emailed to you and contains digest charts similar

to the following:
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=) SERVER
Server time zone: (UTC-05:00) Eastern Time (US & Canada)

Total size of all recordings: 499.0 GB A 4% over previous week

.I 60 GB ¥ -14% 1234 A 170%

Slorage used Sessions recorded

Total size of all recordings (GB)

501 oy
454
407
360
Apr G Apr 7 Apr g Aprg Apr 10 Apr 11 Apri12
Wed Thu Fri Sal Sun Maon Tue

Storage usage per day (GB)

a
Lo FEPEEPEEEEEEEE  SEEEEREEEEEREEY BRI
| I I
0 I
Apr G Apr 7 Apr 8 Aprg Apr 10 Apr 11 Apr12
Wed Thu Fri Sat Sun Mon Tue
— J-day average @o====-- Weekday average

MNumber of sessions recorded per day

213
142
TI I I
0 |
Apr 6 Apr 7 Apr 8 Aprg Apr 10 Apr 11 Apr 12
Wed Thu Fri Sal Sun Man Tue
- J-dayaverage  ===-=- Weekday average
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Configuration

To receive emailed session recording storage reports on a daily or weekly basis, schedule reports
through Session Recording Server Properties. Make sure to configure outgoing email settings on the
Email tab too.

Note:

If your Session Recording servers are configured in a load balancing manner, schedule reports
on one of the servers. Otherwise, create a schedule on each of your Session Recording servers.
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%Sessicn Recording Server Properties - b ‘

Playback Ntfications CEIP Logging RBAC Emal Repot Cloud ¢|*

Storage report
This option allows you to receive storage reports regularly. Make sure to

configure outgoing email settings on the Email tab too.
[] Send storage reports by email
@ Daily
O Weekly | Monday v
Email recipients: [

Event response report
This option allows you to receive event response reports regularly. Make
sure to configure outgoing email settings on the Email tab too.
4] Send event response reports by email
(® Daily
O Weekly | Monday v
Email recipients: |

OK Cancel Apply

Specify file size for recordings

June 21, 2024

As recordings grow in size, recording files take longer to download and respond more slowly when
you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a
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file. When the recording reaches this limit, Session Recording closes the file and creates an extra file
to continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

« File size. The current file closes when it reaches the size, and a new file opens. By default, the
rollover occurs when the size exceeds 50 MB. Supported values: 10-300.

+ Duration. When the duration is reached, the current file closes and a new file opens. By default,
the rollover occurs when the session records for 12 hours. Supported values: 1-24.

Rollovers occur when the first of the two conditions above is met. For example, you specify 17 MB
for the size and 6 hours for the duration. When your recording reaches 17 MB in 3 hours, Session
Recording closes the file and opens a new one.

To prevent the creation of many small files, Session Recording doesn’t roll over until at least one hour
elapses regardless of the value specified for the file size. The exception to this rule is if the file size
surpasses 300 MB.

Specify the maximum file size for recordings

1. Log on to the machine hosting the Session Recording server.
2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Rollover tab.
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% Session Recording Server Properties — X ‘

Storage Signing Rollover Playback Notfications CEIP Logging RE *[*]

Rollover thresholds specify the maximum limit to which a file may grow
before a new file is started. Files are rolled over when the file size or
recording duration specified, whichever occurs first, is reached. Files are
not rolled over if the recording duration is less than 1 hour and size is less
than 200MB. Files are always rolled over when the size reaches 200MB

regardless of the duration.
File size threshold (MB): 50
Recording duration threshold (hours): 12

OK | Cancel Aoply

4. Type an integer between 10 and 300 to specify the maximum file size in MB.

5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.
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Specify recording storage locations

June 21,2024

You can store recordings on a local drive, a SAN volume, and a location specified by a UNC network
path. You can also store recordings in Azure file shares and Amazon Simple Storage Service (Amazon
S3).

Note:
+ Storing data on a NAS, based on file-based protocols such as SMB and NFS, might have per-
formance and security implications. Use the latest version of the protocol to avoid security

implications and perform scale testing to ensure proper performance.
 To archive files or restore deleted files, use the ICLDB command.

This article walks you through the following procedures:

» Specify recording storage locations in Session Recording Server Properties
« Store recordings in an Azure file share

Store recordings in Amazon S3
« Store recordings in a network shared folder

Specify recording storage locations in Session Recording Server Properties

This section provides a general procedure for setting storage locations in Session Recording Server
Properties.

1. Log on to the machine hosting the Session Recording server.

2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Storage tab.

4. Use the File storage directories list to manage the folders where recordings are stored.

After you select the folders, Session Recording grants its service with Full Control permission to
these folders.

By default, recordings are stored in the <drive>:\SessionRecordings folder of the machine
hosting the Session Recording server. You can change the folder where you store recordings,
add extra folders to load-balance across multiple volumes, or make use of more space. Multiple
folders in the list indicate that recordings are load-balanced across the folders. Load balancing
cycles through the folders.
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% Session Recording Server Properties — b

Storage  Signing FRollover Playback MNotfications CEIP  Logging RE* "

Recorded session files are stored in the directones specified. To store files
in & load-balanced manner, specify multiple directories across different
volumes.

File storage directories:

Add...
List of folders is empty.
The default folder C:\SessionRecordings will be Modify...
used.
Remaove

Specify a folder to temporanly store archived session recordings and make
them available for playback.

Restore directory for archived files:
C:\SessionRecordings Restored Browse. ..

A recording file 1s considered dormant if no new data i1s wnitten after the set
period of time has elapsed.

4

Recording file dormant time (hour) : 24

DK Cancel Apply

5. In the Restore directory for archived files field, specify a folder for restoring archived record-
ings. You can specify only one folder for restoring archived recordings.
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By default, archived recordings are restored in the <drive>:\SessionRecordingsRestore folder

of the machine hosting the Session Recording server. You can change the folder.

Store recordings in an Azure file share

To store recordings in an Azure file share, complete the following steps:

1. Inthe Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The

following table recommends configurations for your consideration.

Recording File
Size MB/hour

<6.37

<6.37

<6.37

<6.37

Approx.10

Approx.10

Approx.10

Session
Quantity

<1,000

1,000-2,000

2,000-3,000

3,000-4,000

<1,000

1,000-2,500

2,500-4,000

File Share
Type

HDD Standard
(StorageV2)

SSD Premium
SSD Premium
SSD Premium
HDD Standard
(StorageV2)

SSD Premium

SSD Premium

File Share
Quota (TB)

2

10

Session
Recording
Server
Quantity

1

Session
Recording
Server Size

Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23 working days per month, and

a one-month retention period for each recording file.

2. Addthe Azurefile share credentials to the host where you installed the Session Recording server.

a) Start a command prompt as an administrator and change the drive to the <Session

Recording Server installation path>\Bin folder.

By default, the Session Recording server is installed in C: \Program Files\Citrix\

SessionRecording\Server.
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b) Run the SsRecUtils.exe -AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,

+ <storageaccountname> is the name of your storage account in Azure.

« <filessharename> is the name of the file share contained within your storage
account.

+ <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

+ You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.

docs (G+/) & L @ 2 ©
Connect X
& sessionrecordings
SMB File share

requirement. Click here to leam more

‘ « T Upload + Add directory A\ 'Secure transfer required’ is enabled on the storage account. SMB clients connecting to this
share must support SMB protocol version 3 or higher in order to handle the encryption

& Overview

[P search files by prefix
82 Access Control (IAM) Name
Windows  Linux  macOS
Settings No files found.
"
P e .
il Properties To connect to this Azure file share from Windows, choose from the following
ion methods and run the PowerShell commands from a normal (not elevated)

Operations ell terminal:
@4 snapshots Drive letter
& Bsackup ‘ z hd
Monitoring Authentication method

- QO Active Directory
@il Metrics

(®) storage account key

@ Connecting to a share using the storage account key is only appropriate for admin access.
Utilizing Directory allows to differentiate file and folder access, per AD account,
within a share. Leamn more

$connectTestResult = Test-NetConnection -ComputerName
sremdstg.file.corewindows.net -Port 445
if (SconnectTestResult.TepTestSucceeded) {
# Save the password so the drive will persist on reboot
cmd.exe /C "cmdkey /add:"siemdstgfile core windowsnat™
Juser:"Azure\}
/pass: “DSjcn/SOpzwPXhckj TgGZUZtolh8A3PAOHBWOe +19kuid6p7xX11egNMuOXkx? )

This script will check to see if this storage account is accessible via TCP port 445, which is

mounted. Your organizati
you may use Azure Point-to
to tunnel SMB traffic to your

Learn how to circumvent the port 445 problem (VPN)

+ You can also obtain your storage account key by clicking Access keys in the left navi-
gation of your storage account page.
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= Microsoft Azure B Search resources, services, and docs (G+/)

Home > sremd >

| Access keys

Storage account

£ search (Ctrl+/) | « Use access keys to authenticate your applications when making requests to this Azure storage account. Store your access
keys so that you can maintain connections using one key while regenerating the other,
= Overview
When you regenerate your access keys, you must update any Azure resources and applications that access this storage ac
@ Activity log
Storage account name
¢ Tags =
| srcmdstg
&2 Diagnose and solve problems
Hide keys
Ao Access Control (IAM)
W Data migration key1 ’:'__g
- Key

s Storage Explorer (preview)
| DSjen/SOpzwPxhckjTgGZUZtolh8A3PAOHEWOe + 9kuid6pTxX11egNMu0Xkx7R352f2GHRFUZPIIFi11vbE/A==

Settings

Connection string
Access keys | | DefaultEndpointsProtocol=https;AccountName=| J:AccountKey=DSjcn/SOpzwPxhckjTgGZUZtolh8A3PADHBWOe +

CORS

&

key2 'f.)
Configuration

Key

3]

Encryption | 097VNcAmMY+WpgFYY0er30fMyaD20sSGGpIuBgfkDYv3Z27]19TYOMbWFaz1N6riO81c2qF5IZ0QVxaydmys02A==

&

Shared access signature Connection string

“@ Networking | DefaultEndpointsProtocol=https;AccountName=] L AccountKey=097VNcAmy+WpgFYYOBr30fMyaD20sSGGpJuB|

Q security
Il Properties
B Locks
File service
& File shares
Monitoring

@ insights

E plerts

c) Mount the Azure file share to the host where you installed the Session Recording server.
i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enterthe UNC pathinthe format of \\<storageaccountname>.file.core.windows.net\<filesshar:

Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.
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!
.l

Storage  Signing FRollover Playback MNotfications CEIP  Logging RE |+

Fecorded session files are stored in the directories specified. To store files
in & load-bzalanced manner, specify multiple directories across different
volumes.

File storage directories:

File Storage Directory

Enter a directory for storing recorded session files:

|er.file.co,le.windows.net'-sessionrecording'recon:lings | Browse. ..

Cancel

Specify a folder to temporarily store archived session recordings and make
them awvailable for playback.

Restore directory for archived files:

C:\SessionRecordings Restored Browse...

oK Cancel

iv. Click OKin the File Storage Directory dialog box.
v. Click Apply in the Session Recording Server Properties window.
vi. Click OK after Apply becomes grayed out.

vii. Click Yes when you’re prompted to restart the Session Recording Storage Manager
service.

Session Recording Server Properties

The "Citrix Session Recording Storage Manager” service needs
to be restarted for changes to come into effect,

Do you wish to restart the service now?

Store recordings in Amazon S3
Recommendations

1. Install the Session Recording server on t2.xlarge or other AWS EC2 instances with higher speci-

fications.
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2. Set the storage limit on Message Queues to a minimum of 4,194,304 KB (4 GB).

3 omputer Management O
File Action View Help
o nEEGS=IP

A— Computer Management (Local

Message Queuing Properties ? X

pns
v {f} System Tools General Storage  Server Security Security i
[1 i a
(D) Task Scheduler Fage Queving
2] Event Viewer = STANDALONE2209 More Actions

) Shared Folders *

& Local Users and Groups

(%) Performance 1D: {6EFDT1E3-4A05-4397-8B45-FADOB25FOCBD}

& Device Manager
&5 Storage

W Windows Server Backup

Computertype:  Independent client

= Disk Management Storage limits

v B _S:rvi(es and Applications Limit message storage to (KB):
N Internet Information Sei
E) Routing and Remote Ac Limit joumal storage to (KB):
L4 Services
& WMI Control

[ sQL Server Configuratic
& Message Queuing

< > Cancel | | Aooly

3. In Session Recording Agent Properties, set the lifetime of the messages on Message Queues to
14,400 seconds (4 hours).
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Session Recording Server:

Protocal :
HTTR/HTTPS port:
Port Mumber:

MESSE0E qUELE.

E@; Session Recording Agent Properties

Recording Connections Lossy Screen  Player

W2K135T-Q5KID7M bvt local

TCP
Default

Session Recording Storage Manager message gueue

e

Message life specifies the penod during which data remains in the

Message life (seconds): 7200
Session Recording Broker
Protocol: HTTP o
HTTR/HTTPS port: Custom e
Port Number: a0
Ok Cancel fnply
Note:

During the update or maintenance of the AWS Storage Gateway, recording files might not

be saved from the Session Recording server to the file share. Data losses can occur.

Steps

To store recordings in Amazon S3, complete the following steps:
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1. Create an Amazon S3 bucket. For more information, see the Amazon documentation Creating

a bucket.

v Account snapshot View Storage Lens dashboard

3268 19k 7M8

Buckets (5) info \ c Create bucket

Name w | AWS Region v | Access

2. Create and activate an Amazon S3 File Gateway. Doing so enables data transfer to and from the
Amazon S3 bucket created earlier.

For step-by-step instructions, see the following Amazon documentation:

+ Create and activate an Amazon S3 File Gateway
« Getting an activation key for your gateway

3. Create a file share with guest access. When creating the file share, select the Amazon S3 File
Gateway that you created earlier and connect the file share to your Amazon S3 bucket. For more
information, see the Amazon documentation Create a file share.

4. Gotothe machine where you installed the Session Recording server and complete the following
steps:

a) Add the file share credentials to the Session Recording server. To do so, start a command
prompt as an administrator and change the drive to the <Session Recording Server
installation path>\Bin folder. By default, the Session Recording server is installed
in C:\Program Files\Citrix\SessionRecording\Server. ~ Then run the SsRecUtils.exe
-AddAwsS3 <GatewaylPAddress> <S3Path> <GatewaylD> <Password> command.

Where,

« <GatewaylPAddress> is the IP address of your Amazon S3 File Gateway.

« <S3Path> is the name of your Amazon S3 bucket.

+ <GatewaylD> is the ID of your Amazon S3 File Gateway.

+ <Password> is the guest password that you set when creating the file share.

All the information except for the guest password is available on the file share page similar
to the following. As for the guest password, you must keep a careful record yourself.
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Example Commands

You can use the following example commands to connect to the file share.

On Microsoft Windows: net use [WindowsDriveletter]: \\ \citrixsessionrecording /user:sgw-56599C3F\smbguest

b) Set the file share as the location for storing your recordings.

i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enter the UNC path in the format of \<GatewaylPAddress><S3Path>\<subfolder>.
Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.

Store recordings in a network shared folder
Note:

+ For an accessible network shared folder, the Session Recording server accesses it through
SMB by default.

« Storing data on a NAS, based on file-based protocols such as SMB and NFS, might have per-
formance and security implications. Use the latest version of the protocol to avoid security
implications and perform scale testing to ensure proper performance.

Steps

To store recordings in a network shared folder, complete the following steps:

1. Create an account with read and write permissions for the network shared folder to be created
later. To do so, use the Windows GUI or run a PowerShell command similar to the following:

New-LocalUser -Name "YourUserName" -Password (ConvertTo-
SecureString -String "YourPassword" -AsPlainText -Force)

2. Create a network shared folder and ensure that the shared folder is accessible to the Session
Recording Server. To do so, use the Windows GUI or run the PowerShell commands similar to
the following:

New-SmbShare -Name "YourShareName" -Path "YourSharePath" -
FullAccess "YourUserName"

Grant-SmbShareAccess -Name "YourShareName" -AccessRight Change -
AccountName "YourUserName"
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3. Gotothe machinewhereyou installed the Session Recording server and complete the following
steps:

a) Addthe credentials for the created account to the Session Recording server. To do so, start
a command prompt as an administrator and change the drive to the <Session Record-
ing Server installation path>\Bin folder. By default, the Session Recording server is in-
stalled in C:\Program Files\Citrix\SessionRecording\Server. Then run the SsRecUtils.exe
-AddSharedFolder <IPAddress> <ShareName> <Protocol> <Username> <Password>
command.

Where,

« <IPAddress> is the IP address of the machine where the shared folder resides.
« <ShareName> is the share name.

» <Protocol> is fixed to SMB.

« <Username> is the user name that you set for the shared folder.

« <Password> is the password that you set for the shared folder.

For example, if \\10.100.100.100\myshare is your shared folder, you can run a command
similar to SsRecUtils -AddSharedFolder 10.100.100.100 myshare SMB myusername
mypassword.

b) Set the shared folder as the location for storing your recordings.

i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enter the UNC path in the format of \<IPAddress><ShareName>\<subfolder>.
Specify a subfolder under the shared folder to store your recording files. The Session
Recording server then automatically creates the subfolder for you.

Policies

June 21,2024

Use the Session Recording Policy Console to create recording policies, event detection policies, event
response policies, and recording viewing policies. When creating the policies, you can specify Delivery
Controllers from both the Citrix Cloud and on-premises environments.

Important:
To use the Session Recording Policy Console, you must have the Broker PowerShell Snap-in (Bro-

ker_PowerShellSnapln_x64.msi) or the Citrix DaaS Remote PowerShell SDK (CitrixPoshSdk.exe)
installed manually. Locate the Broker PowerShell snap-in on the Citrix Virtual Apps and Desktops
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ISO (\x64\Citrix Desktop Delivery Controller). Or,download the Citrix DaaS Re-
mote PowerShell SDK from the Citrix DaaS (formerly Citrix Virtual Apps and Desktops service)
download page.

Tip:

You can edit the registry to prevent recording file losses in case that your Session Record-
ing server might fail unexpectedly. Log on as an administrator to the machine where you
installed the Session Recording Agent, open the Registry Editor, and add a DWORD value

DefaultRecordActionOnError =1 under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Agent.

Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording server, protocol, and port are correct. Click OK.

4. Inthe Session Recording Policy Console, expand the target policy type.

5. Select the policy to activate.

6. From the menu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording server, protocol, and port are correct. Click OK.

4. In the Session Recording Policy Console, expand the target policy type.

5. Select the policy that you want to modify. The rules for the policy appear in the right pane.

6. To add, modify, or delete a rule:

+ From the menu bar, choose Add New Rule. If the policy is active, a pop-up window ap-
pears requesting confirmation of the action. Use the Rules wizard to create a rule.

+ Select the rule that you want to modify, right-click, and choose Properties. Use the Rules
wizard to modify the rule.

+ Select the rule that you want to delete, right-click, and choose Delete Rule.
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Delete a policy

Note:

You cannot delete a system-defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording server, protocol, and port are correct. Click OK.

4. In the Session Recording Policy Console, expand the target policy type.

5. In the left pane, select the policy to delete. If the policy is active, you must activate another
policy.

6. From the menu bar, choose Delete Policy.

7. Select Yes to confirm the action.

Configure session recording policies

August 15,2024

You can activate system-defined recording policies or create and activate your own custom recording
policies. System-defined recording policies apply a single rule to entire sessions. Custom recording
policies specify which sessions are recorded.

The active recording policy determines which sessions are recorded. Only one recording policy is ac-
tive at a time.

System-defined recording policies

Session Recording provides the following system-defined recording policies:
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[Ep Citrix Session Recording Policy Console - a] x
File Action View Help
L ARes] o (WET 7 s

[Ep Session Recording Policy Console Rule Name Description Action
v [ Recording Policies

<% System defined rule This rule will disable the recording of all sessions. Do not record
[E cutom session recording policy

[= Do not record
[E Record entire sessions excluding audio (for everyone, with notification)
[E Record entire sessions excluding audio (for everyone, without notification)
[E Record entire sessions excluding audio with lossy screen recording enabled (for everyone, with notification)
[E Record entire sessions excluding audio with lossy screen recording enabled (for everyone, without notification)
) Record entire sessions including audio (for everyone, with notification)
[E Record entire sessions including audio (for everyone, without notification)
[ Record only events (for everyone, with notification)
[& Record only events (for everyone, without notification)
% Event Detection Policies
[ Event Response Policies

« Donotrecord. The default policy. If you do not specify another policy, no sessions are recorded.

+ Record entire sessions excluding audio (for everyone, with netification). This policy
records entire sessions (including screens and events but excluding audio). Users receive
recording notifications in advance.

+ Record entire sessions excluding audio (for everyone, without notification). This policy
records entire sessions (including screens and events but excluding audio). Users do not receive
recording notifications.

« Record entire sessions excluding audio with lossy screen recording enabled (for every-
one, with notification). This policy records entire sessions (including screens and events but
excluding audio). Lossy screen recording is enabled to reduce the size of recording files. Users
receive recording notifications in advance.

+ Record entire sessions excluding audio with lossy screen recording enabled (for everyone,
without notification). This policy records entire sessions (including screens and events but
excluding audio). Lossy screen recording is enabled to reduce the size of recording files. Users
do not receive recording notifications.

+ Record entire sessionsincluding audio (for everyone, with notification). This policy records
entire sessions (including screens, events, and audio). Users receive recording notifications in
advance. You can now enable audio recording for non-optimized HDX audio. The audio that is
handled on the VDA and delivered to/from the client where the Citrix Workspace app is installed
is referred to as non-optimized HDX audio. Unlike non-optimized HDX audio, optimized HDX
audio has its processing offloaded to the client, as seen in the Browser Content Redirection
(BCR) and Optimization for Microsoft Teams scenarios.
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+ Record entire sessions including audio (for everyone, without notification). This policy
records entire sessions (including screens, events, and audio). Users do not receive recording
notifications.

« Record only events (for everyone, with notification). This policy records only events that
your event detection policy specifies. It does not record screens or audio. Users receive record-
ing notifications in advance.

« Record only events (for everyone, without notification). This policy records only events that
your event detection policy specifies. It does not record screens or audio. Users do not receive
recording notifications.

You can’t modify or delete the system-defined recording policies.

Create a custom recording policy
Considerations

You can record sessions of specific users or groups, published applications or desktops, delivery
groups or VDA machines, and Citrix Workspace app client IP addresses. To obtain the lists of
published applications or desktops and delivery groups or VDA machines, you must have the read
permission as a site administrator. Configure the administrator read permission on the Delivery
Controller of the site.

You can also specify smart access tags to use as scopes for a custom recording policy to apply to. This
feature is available for Session Recording 2402 and later. It lets you apply policies based on the
user access context including:

» The user’s location

« IP address range

+ Delivery group

« Device type

« Installed applications

A wizard within the Session Recording policy console helps you create rules. For each rule you create,
you specify a recording action and rule criteria. The recording action applies to sessions that meet
the rule criteria.

For each rule, choose one recording action:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 156



Session Recording 2407

[Ek Rules Wizard x

Step 1: Select a recording option to specify if and how a session is recorded.

(") Enable session recording with notffication

Enable audio recording
Enable lossy screen recording
() Enable session recording without notfication
Enable audio recording
Enable lossy screen recording

() Enable event only session recording with notification
() Enable event only session recording without notification

{®) Disable session recording

Step 1-2: Set parameters for screen recording

[] Hide speciic applications during screen recording.

Type the process names of the spplications that you waint to hides, Separate the process names with 2 semicolon |; Black

Next = Cancel

+ Enable session recording with notification. This option records entire sessions (screens and
events). Users receive recording notifications in advance. With this option selected, you can
further select to enable audio recording or lossy screen recording. Additionally, you can choose
to hide specific applications in screen recordings.

« Enable session recording without notification. This option records entire sessions (screens
and events). Users do not receive recording notifications. With this option selected, you can
further select to enable audio recording or lossy screen recording. Additionally, you can choose
to hide specific applications in screen recordings.

+ Enable event only session recording with netification. Recording only specific events helps
to free up storage space. This option records throughout sessions only events that your event
detection policy specifies. It does not record screens. Users receive recording notifications in
advance.

+ Enable event only session recording without notification. Recording only specific events
helps to free up storage space. This option records throughout sessions only events that your
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event detection policy specifies. It does not record screens. Users do not receive recording
notifications.

« Disable session recording. This option means that no sessions are recorded.

« Hide specific applications during screen recording. This feature lets you hide specific appli-
cations with a layer mask during screen recording. The color for the layer mask is configurable,
which can be Black, Gray, or White.

For example, you can see that an application is hidden during the recording playback:

Citrix | session Recording

Session info View playlist
> 2 User name

@ Host name:
© Ciientame

Recording 1/1

Nov 8, 2023 5:08:52 PM

00:03:12- 0 events.

View: All

v

n o ——e D) 00:02:00/00:0312 & Comments (4 Share X1 Show stats 52 FULL SCREEN

For each rule, choose at least one of the following items to create the rule criteria:

C 3

Step 2: Select the rule criteria.

Users or Groups

Published Applications or Desktop
Delivery Groups or Machines

IP Address or IP Range

Filter

Step 3: Edit the rule criteria.

Selecting a rule criterion above activates the option here. To edit, click the underlined value.

Users / Groups: Select Users or Groups...

Published Resources: Select Published Applications or Desktop...
Delivery Groups / Machines: Select Delivery Groups or Machines.
IP Address / IP Range: Select IP Address or [P Range .

Filter: Specify Tags...

= ==
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Users or Groups. Creates a list of users or groups to which the action of the rule applies. Session
Recording allows you to use Active Directory groups and white list users.

Published Applications or Desktop. Creates a list of published applications or desktops to
which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and
Desktops or Citrix Daa$S (formerly Citrix Virtual Apps and Desktops service) sites on which the
applications or desktops are available.

Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the action
of the rule applies. In the Rules wizard, choose the location of the Delivery Groups or machines.

IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the
action of the rule applies. On the Select IP Address and IP Range screen, add a valid IP address
or IP range for which recording is enabled or disabled. The IP addresses mentioned here are the
IP addresses of the Citrix Workspace apps.

Filter. Creates a list of smart access tags to which the action of the rule applies. You can config-
ure contextual access (smart access) using smart access policies on Citrix NetScaler.
# Specify Tags X

Enter custom tags separated by commas

OK Cancel

Note:

The Session Recording policy console supports configuring multiple criteria within a single rule.
When a rule applies, both the “AND”and the “OR”logical operators are used to compute the fi-
nal action. Generally speaking, the “OR”operator is used between items within a criterion, and
the “AND”operator is used between separate criteria. If the result is true, the Session Recording
policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you create more than one rule in a recording policy, some sessions might match the criteria for

more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:

Rules with the Disable session recording action have the highest priority.

Rules with the Enable session recording with notification action have the second-to-highest
priority.

Rules with the Enable session recording without notification action have the second-to-
lowest priority.

Rules with the Enable event only session recording with notification action have the medium
priority.
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+ Rules with the Enable event only session recording without notification action have the low-

est priority.

Some sessions might not meet any rule criteria in a recording policy. For these sessions, the action of
the policy fallback rule applies. The action of the fallback rule is always Disable session recording.

You can’t modify or delete the fallback rule.

Steps

To create a custom recording policy:

1. Logon as an authorized Policy Administrator to the server where the Session Recording policy

console is installed.

2. Startthe Session Recording policy console and select Recording Policies in the left pane. From

the menu bar, choose Add New Policy.
3. Right-click the New policy and select Add Rule.

4. Inthe rules wizard, select a recording option and then click Next.

@' Rules Wizard

Step 1: Select a recording option to specify if and how a session is recorded.

(O) Enable session recording with notfication

Enable audio recording
Enable lossy screen recording
(") Enable session recording without notification
Enable audio recording
Enable lossy screen recording

(") Enable evert only session recording with notification
() Enable event only session recording without notification

(@ Disable session recording

Step 1-2: Set parameters for screen recording

[] Hide specic applications during screen recording.

T..:El'i:'::EEE'E"EE of the applications L'El_.:.'..'E'LL:':E."EE:E'E[E['E:'::EEE names with a semecokon {;

Black

Cancel
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When you select Enable session recording with notification or Enable session recording
without netification, you can further select to enable audio recording or lossy screen record-

ing.

5. Select the rule criteria - You can choose one or more rule criteria:

« Users or Groups

Published Applications or Desktop
Delivery Groups or Machines

IP Address or IP Range

« Filter

6. Edit the rule criteria - To edit, click the underlined values. The values are underlined based on
the criteria that you chose in the previous step.

Note:

If you choose the Published Applications or Desktop underlined value, the Site Address
is the IP address, a URL, or a machine name if the Controller is on a local network. The
Name of Application list shows the display name.

When choosing Published Applications or Desktop or Delivery Groups or Machines, specify
the Delivery Controller for your Session Recording policy console to communicate with.

The Session Recording policy console is the only channel to communicate with Delivery Con-
trollers from the Citrix Cloud and on-premises environments.

L o

Step 2: Select the rule criteria.

Users or Groups

Published Applications or Desktop
Delivery Groups or Machines

IP Address or IP Range

Fitter

Step 3: Edit the rule criteria.

Selecting a rule criterion above activates the option here. To edit, click the underlined value.

Users / Groups: Select Users or Groups
Published Resources: Select Published Applications or Desktop.

Delivery Groups / Machines: Select Delivery Groups or Machines.
IP Address / IP Range: Select IP Address or IP Range
Filter: Specify Taas

<o ==
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For example, when choosing Delivery Groups or Machines, click the corresponding hyperlink
in the preceding screenshot and click Add to add queries to the Controller.

I

[
[k Create Query x
Site Address: [ Citrix Cloud Controller
| Enter 5 sie address |
(®) Delivery Groups () Machines
|E'1fera Defveny Group name |
Create Cancel

Close

For a description of use cases that cover the on-premises and the Citrix Cloud Delivery Con-
trollers, see the following table:

Use Case Action Required

On-Premises Delivery Controller .
a) Install Broker_PowerShellSnapln_x64.msi.

2. Clear the Citrix Cloud Controller check
box.

Citrix Cloud Delivery Controller o
a) Install the Citrix DaaS Remote PowerShell

SDK. 2. Validate the Citrix Cloud account
credentials. 3. Select the Citrix Cloud
Controller check box.
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Use Case Action Required

Switch from an on-premises Delivery Controller

_ . a) Uninstall
to a Citrix Cloud Delivery Controller

Broker_PowerShellSnapln_x64.msi and
restart the machine. 2. Install the Citrix
DaaS Remote PowerShell SDK. 3. Validate
the Citrix Cloud account credentials. 4.
Select the Citrix Cloud Controller check

box.

Switch from a Citrix Cloud Delivery Controller to . o

. . a) Uninstall the Citrix DaaS Remote
an on-premises Delivery Controller .
PowerShell SDK and restart the machine.
2. Install
Broker_PowerShellSnaplin_x64.msi. 3.
Clear the Citrix Cloud Controller check

box.

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud
credentials on the machine where the Session Recording policy console is installed. Failure
to comply can cause an error and your Session Recording policy console might not work as
expected.

To do the manual validation:

a) Logon to the Citrix Cloud console and locate Identity and Access Management > API Ac-
cess. Create an APl access Secure Client for obtaining an authentication profile that can
bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename,
and save it in a safe location. The file name is defaulted to secureclient.csv.

v

=  Citrix Cloud B = 47 ¢ H_"

« |dentity and Access Management

Authentication  Administrators ~ APl Access  Domains

Secure Clients are used to interact with Citrix Cloud APIs.

To use this secure client in a silent connector install or to access any of our APIs, use the customer ID* * *__as the customer parameter.
Name your Secure Client Create Client

Named id Creation Date Actions.

cureclient e o 3:53:01 PM Dec 3, 2018 o

b) Open a PowerShell session and run the following command to have the authentication
profile (obtained in the preceding step) take effect.
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asnp citrix.*

Set-XDCredentials -CustomerId "citrixdemo" -SecureClientFile "
c:\temp\secureclient.csv" -ProfileType CloudAPI - StoreAs "
default"

Set Customerld and SecureClientFile as required. The preceding command creates a
default authentication profile for the customer citrixdemo to bypass authentication
prompts in the current and all subsequent PowerShell sessions.

7. Follow the wizard to finish the configuration.
Note: Limitation regarding prelaunched application sessions:

« If the active policy tries to match an application name, it can’t match applications that are
opened in a prelaunched session. As a result, the prelaunched session can’t be recorded.

« If the active policy records every application and session prelaunch is enabled, a record-
ing notification appears when a user logs on to Citrix Workspace app for Windows. The
prelaunched (empty) session and any applications to be launched in that session going for-
ward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording
policies. Do not use an application name as a recording condition. This approach ensures that
prelaunched sessions can be recorded. However, notifications still appear.

Use Active Directory groups

Session Recording allows you to use Active Directory groups when creating policies. Using Active Di-
rectory groups instead of individual users simplifies the creation and management of rules and poli-
cies. For example, if users in your company’s finance department are contained in an Active Directory
group named Finance, you can create a rule that applies to all the group members by selecting the
Finance group in the

Rules wizard.

White list users

You can create Session Recording policies ensuring that the sessions of some users in your organiza-
tion are never recorded. This case is called

white listing these users. White listing is useful for users who handle privacy-related information or
when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Exec-
utive, you can ensure that sessions of these users are never recorded by creating a rule that disables
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session recording for the Executive group. While the policy containing this rule is active, no sessions
of members of the Executive group are recorded. The sessions of other members of your organization
are sessions recorded based on other rules in the active policy.

Configure the Director to use the Session Recording server

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording server in the
Trusted Root Certificates of the Director server.

2. To configure the Director server to use the Session Recording server, run the C: \inetpub)
wwwroot\Director\tools\DirectorConfig.exe /configsessionrecording
command.

3. Type the IP address or FQDN of the Session Recording server and the port number and con-
nection type (HTTP/HTTPS) that the Session Recording agent uses to connect to the Session
Recording Broker on the Director server.

Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being
recorded ends or the session recording file rolls over. Files roll over when they’ve reached the
maximum size or recording duration. For more information about the rollover thresholds, see
Specify file size for recordings.

The following table details what happens when you apply a new recording policy while a session is
being recorded and a rollover occurs:

If the previous recording policy After a rollover, the recording
was And the new recording policy is policy will be
Do not record Any other policy No change. The new policy

takes effect only when the user
logs on to a new session.

Record without notification Do not record The recording stops.

Record without notification Record with notification Recording continues and a
notification message appears.

Record with notification Do not record The recording stops.

Record with notification Record without notification Recording continues. No

message appears the next time
a user logs on.
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Configure recording viewing policies

June 21,2024

Session Recording supports role-based access control. You can create recording viewing policies in
the Session Recording policy console and add multiple rules to each policy. Each rule helps you select
a user or user group as the recording viewer and set whose recordings are visible to the viewer.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1. Log on to the machine hosting the Session Recording server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the RBAC tab.

4. Select the Allow to configure recording viewing policies check box.

‘Et]] Session Recording Server Properties — >

Storage Signing Follover Flayback Notifications CEIP Logging RBAC

Recording viewing policy

This option allows you to configure recording wiewing policies in the
Session Recording Policy Conscle.

Allow to configure recording viewing policies.

Cancel Apply
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To create a custom recording viewing policy:

Note: Different from recording policies and event detection policies, a recording viewing policy (in-

cluding all rules added within) is active immediately when it is created. You do not have to activate
it.

1. Logon as an authorized Policy Administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console. By default, there is no recording viewing policy.

L%? Citrix Session Recording Policy Console — O X

File Action View Help
o5 7@ 0 BE

@’ Session Recording Policy Console
~ [ Recording Policies
[= Do not record

Policy name

\E New policy
[#% Record event only for everyone with notification
[& Record event only for everyone without notification
[ Record everyone with notification
\E Record everyone without notification

~ | =) Event Detection Policies
\E Do not detect
[ New event detection policy

v =7 Event Response Policies
\E Do not respond
[ New event response policy
\E New event response policy(2)

|=) Recording Viewing Policies

Note: To make Recording Viewing Policies available, enable the feature in Session Recording
Server Properties first.

3. Select Recording Viewing Policies in the left pane. From the menu bar, choose Add New Policy
to create a recording viewing policy.

4. (Optional) Right-click the new policy and rename it.

5. Right-click the new policy and select Add rule.
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I% Rules Wizard

Selected user or user group who can view recordings

Next >

Cancel

6. Click Add.

7. In the Select Users or Groups dialog, select a user or user group as the recording viewer.

Note:

Aviewer must be assigned the Player role to view recorded sessions. For more information,

see Authorize users.
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| EE' Rules Wizard X
|
| Selected user or user group who can view recordings
| o —
|
| Select Users or Groups X
|
| Select this cbject type:
| Users or Groups Object Types...
| From this location:
| AWDDC1-0001 Locations...
| Enter the object names to select (examples):
| AWDDC1-0001\Administrator| Check Names
|
|
Advanced... III Cancel

Next > Cancel

Note:

In each rule, you can select only one user or user group as the recording viewer. If you
select multiple users or user groups, only your most recent selection takes effect and ap-
pears in the text box.

When you specify a recording viewer, ensure that you have assigned the viewer to the
Player role. A user without the permission to play recorded sessions receives an error mes-
sage when trying to play a recorded session. For more information, see Authorize users.

8. Click OK and then Next. The dialog for setting rule criteria appears.

9. Select and edit the rule criteria to specify whose recordings are visible to the viewer you speci-
fied earlier:

« Users or Groups
+ Published Applications or Desktop
« Delivery Groups or Machines
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l% Rules Wizard X

Step 2: Select the rule criteria.

[] Users or Groups
[] Published Applications or Desktop
[] Delivery Groups or Machines

Step 3: Edit the rule criteria.

Users / Groups: All Users
Published Resources: All Applications and Deskiop
Delivery Groups / Machines: All Delivery Groups and Machines

< Back Next > Cancel

Note:

The “OR”logical operator is used both between items within a rule criterion and between
separate rule criteria.

If you leave the rule criteria unspecified, the viewer specified earlier has no recordings to

view.

10. Follow the wizard to complete the configuration.

For example:
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@? Rules Wizard

Complete the rule setup.

Recording viewer:
| AWDDC 1-0001 | Administratol

Rule critena:

Users/ Groups  Published Resources Delivery Groups / Machines

Name Location
(:) Administrator AWDDC1-0001

< Back

Cancel

Configure event detection policies

July 16, 2024

Session Recording supports centralized configuration of event detection policies. You can create poli-
cies in the Session Recording policy console to log various events.

Events that can be detected

Session Recording detects target events and tags those events in recordings for later search and play-
back. You can search for events of interest from large amounts of recordings and locate those events

during playback.
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System-defined events

Session Recording can detect and log the following system-defined events that occur during recorded
sessions:

+ Insertion of USB mass storage devices

+ Application starts and ends

« App failures

« App installs and uninstalls

+ File renaming, creation, deletion, and moving operations within sessions

« File transfers between session hosts (VDAs) and client devices (including mapped client drives
and generic redirected mass storage devices)

+ Web browsing activities
« Topmost window events
« Clipboard activities
+ Windows registry modifications
+ User account modifications
« RDP connections
« Performance data (data points related to the recorded session)
+ Popup window events
« Printing activities
For example:

+ Eventsin an event-only recording in the web player:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 172



Session Recording 2407

€ Session Recording | Player X +
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« Eventsin a screen recording in the web player:
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regedit: 6296: "C:\Windo...

| 00:01:32 Top-most o

window:regedit. Registry

v = (m]
& 2 % a
MAR 7,2022

08:01:47 - 00:01:00 - 22 Events

R, User name: administrator
@ Host name;,
() Client name:

View: All

00:00:12 Registry
create:1380:
C:\Windows\explorer...

P

00:00:12 Registry set
value:1380:
C:Windows\explo...

i

. 00:00:12 Registry
create:1904: C:\Program
Files\Ci...

00:00:12 Registry
create:1904: C:\Program
Files\Ci...

00:00:12 Registry
create:1904: C:Program
Files\Ci...

a

00:00:12 Registry
create:1904: C:Program
Files\Ci...

a

g 00:00:12 Registry
create:1904: CiProgram
Files\Ci...

+ Events in the Session Recording player:
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£ Session Recording Player
Fle Edt View Pay Toos Hep

B b 11 @[3 |» | Search ~ [Anytime <9 (4 | [ Advanced Search..

Workspace x
Now Playing x
© 11704 8M App Start 10072 regedit 6295 "C:AWindows\regedit eve” a

© 1:17:04AM Topmost window: explorer, , 5100

© 1:17:20 AM Topmost window: regedit, Registy Editor, 10072

@ 1:17:33AM Top-most window: regedt, , 10072

© 1:17:36 AM Topmost window: regedit, Registy Editor, 10072

© 1:17:36 AM Registiy Create: 10072 C:\Windows\regeditewe: HKEY_LOCAL_MACHINE\SOFTWARE Viegest\New Key #1

© 1:18:00AM Topmost window: regedt, , 10072

© 11802 AM Topmost window: regedit, Registry Editor, 10072

© 111806 AM Registy Rename: 10072: C:\Windows\regeditexe: HKEY_LOCAL_MACHINEASOFTWARE Yiegtest\New Key #11 name
@ 1:18:16AM Top-most window: regedt, , 10072

© 1:18:20 AM Topmost window: regedit, Registy Editor, 10072

@Q 1:18:20 AM Registry Set Value: 10072 C:\Windows\regedit.exe: HKEY_LOCAL_MACHINE\SOFTWARE \iegtestiname| New Value #1
© 1:18:36 AM Registiy Delete Value: 10072 C:\Windows\regeditese: HKEY_LOCAL_MACHINE\SOFTWARE Viegtestinamel New Value #1
© 11836 AM  Registiy Set Value: 10072 C:\Windows\egedi exe: HKEY_LOCAL_MACHINE\SOFTWARE \regtestinamel version

© 1:18:47 AM Topmost window: regedt, , 10072

© 11850 AM Topmost window: regedit, Registry Editor, 10072 N

© 1:1850 A Popup Window: 10072, Registy Editor, Are you sure you want to permanently delete this key and all of its ibkeys?

© 1:1851 AM  Registy Delete: 10072: C:\Windows\regedit exe: HKEY_LOCAL_MACHINE\SOFTWARE\REGTEST\NAME

Q 1:119:14 AM Top-most window: WiShell, CtxDnDSourceProxy, 7260

© 1:19:14 AM App End: 10072 regedit

© 1:19:25AM Topmost window: explorer, . 5100

@ 111926 AM  Unexpected App Exit: 744: C:\Program Fil cati exe: CAWi RNELBASE.di
© 111927 AM  Unexpected App Exit: 5084; C:\Program Fil \ppication’ch CAWi y LBASE dl
© 1:1923 AM  Unexpected App Exit: 4860: C:\Program Fil \pplicationich CAWi LBASE dl
© 1:19:30 AM  Unexpected App Exit: 9864: C:\Program cati CAWi LBASE di
@Q 1:13:30 AM Top-most window: chrome, Untitled - Google Chrome, 744

Q11930 AM  Unexpected App Exit: 6644: C:\Program Fil cati CAWi INELBASE.di

© 1:13:32 AM Top-most window: chiome. All in one Workspace Solution for Secure Access to Apps and Data - Ciix - Google Chrome, 744
O 1:1%:32 AM Web browsing: citrix.com, Untitled - Google Chrome, chiome

Q 1:1340 AM  Top-most window: WiShel, CtxDnDSourceProxy, 7260

Q 1:19:53AM Top-most window: explorer, , 5100

O 1:20:33 AM File Create: 5100: C:\Windows\New Text Document (2)tst: 0 Bytes

@ 1:20:52 AM File Rename: 5100: C:\Windows\New Text Document (2).tst | document bt

@ 1:21:09 &AM Clipboard Operation: File, explorer, C:\Windows\document tst,

@ 1:21:09 AM Clipboard Operation: File, explorer, C:\Windows\document tst,

@ 1:21:11 AM File Move: 5100: C:\Windows\ék t | C:\Usershadmini G p\d i 0 Bytes
@ 1:21:11 AM Clipboard Operation: Text, explorer, ,
£ 1:21:98 AM_Eila Dalata: E100: Tau D, bk 1) Dk o

For more events in the Session Recording player, see the event descriptions later in this article.

Note:

Applications built by PowerBuilder might exit unexpectedly when there are active policies detect-
ing web browsing activities and topmost window events. To avoid the issue, use PowerBuilder
2019 R3 to build your applications.

Insertion of USB mass storage devices Session Recording can detect the insertion of a Client Drive
Mapping (CDM) mapped or generic redirected USB mass storage device in a client where Citrix Work-
space app for Windows or for Mac is installed. Session Recording tags these events in the recording.

( 1:2654 &AM Clipboard Operation: Text, cmd, , Administrator: Command Prompt )
 1:27.03 &M File Transfer: 7260: ClientApplicationhang.exe: HostApplicationhang.exe: 7.5 KB
© 1:27.09 AM Top-most window: Applicationhang, Form1, 3996 %
© 1:27:21 AM Top-most window: WerFault, , 5956
() 1:27.58 AM Top-most window: explorer, , 5100
(3 1:27.59 &M App Not Responding: 3996: C:\sers\administrator XF4B5\D esktop\dpplicationhang. exe

E Top-most window: explorer, , 5100

Top-most window: Taskmar, Task Manager, 6844

ient drive mapping: D

Note:

To use an inserted USB mass storage device and detect the insertion events, set the Client USB
device redirection policy to Allowed in Citrix Studio.

Currently, only the insertion of USB mass storage devices (USB Class 08) can be detected.
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Application starts and ends Session Recording supports detection of both application starts and
ends. When you add a process to the App monitoring list, apps driven by the added process and its
child processes are monitored. Child processes of a parent process that starts before Session Record-
ing runs can also be captured.

Session Recording adds the process names, cmd . exe, powershell.exe, and wsl.exe, to the
App monitoring list by default. If you select Log app start events and Log app end events for an
event detection policy, the starts and ends of the Command Prompt, PowerShell, and Windows Sub-
system for Linux (WSL) apps are logged no matter whether you manually add their process names to
the App monitoring list. The default process names are not visible on the App monitoring list.

In addition, Session Recording provides a full command line for each app start event logged.
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Session Recording Player
Fle  Edt View Flay Tools Help

= P U @G} # | Search: ~  Amytime - @ LQAd\tanc:ed Search...

Workspace x®

&5 Workspace - administrator
|3% Search Results

[ ] Favortes
Now Playing x
Usger: adminiztrator A
Domain: LEEwW A

Applicabion Desktop
Delivery Group: TSVDAZ
VDAMachine AWTSYDA-DOD2

Site: BYT_DE
Status Complate
Start 9/14/2020 1:57 AM W
Events and Bookmarks x
¥ 1:58:36 &M App End: 8976 chrome A

3 1:58:36 4M App End: 9164: chrome

) 1:58:36 AM &pp End: 10008 software_reparter_tool

) 1:58:36 &AM &pp End: 9920: software_reporter_tool

) 1:58:36 AM &pp End; 9900; software_reporter_tool

) 1:58:36 AM App End: 10164 software_reporter_toal

3 1:58:36 &M App End: 8760: chrome

) 1:58:36 AM App End: 8680 chrome

) 1:58:37 &M App Start 5080 conhost: 8416 S ?ACNWindowssystem3Zhconhost exe Oxd

) 1:52:37 AM App Start 8416 cmd: 2092; "C:iwindows \systemn32ycmd. exe’!

) 1:58:58 &M App Start: 9980; cmd: 8416 cmd —-help

) 1:55:34 &AM App Start: 7260; MessageQueuingTool 9980 C:\Users\Administrator LKEwaADesktopieszagellusuing T ool exe
2 1:5%:42 &AM App End: 7260; MessageQueuingT ool

) 200:34 &M App Start: 9144: Consoledpplication]0: 9980; C:A\Consoledpplication] 0. exe

3 200:49 AM App End: 9144: Conzoledpplication0

[ ] Ak App 4: PIML itig aidu.com -t

) 201:30 &M App End: 9544 PING
) 2:01:43 AWM App Start 9560; chrome: 9980; "'C:\Program Files (#26)\Google\Chrome\Applicationtchrome. exe”

(3 2:01:44 AWM App Start 1332 chrome: 9560; "C:MProgram Files [#26)\Google\Chrome\Applicationschrome.exe” --type=renderer -field-tial-handle=1540,5975..
() 2:01:44 AWM App Start 2644 chrome: 9560: "C:MProgram Files [#BE)\Google\ChromeApplicationschrome.exe” -type=renderer -figld-tial-handle=1540,5975...
() 2:01:44 AWM App Start 2296; chrome: 9560: "C:\Program Files [x86]\Google’\ChromehApplicationschrome.exe’ -type=utility --utility-sub-type=storage. majorn. ..
(2 2:01:44 AM  App Stark 1416: chrome: 9560; "C:\Program Files [#86)4G ooglehChrometapplicationtchrome. exe’’ —type=utility --utility-sub-type=retwork. majon...
() 2:01:44 AWM App Stat: 10172 chrome: 9560: "C:A\Program Files [#86)Google\Chromehdpplicationchrome. exe' -type=gpu-process -field-tial-handle=1540, ..
(3 2:01:44 AW App Start: 10048 chrome: 9580: "C:\Program Files [x86]%Google\ChromehApplicationtchrome.exe” -type=crashpad-handler "--uger-data-dir=C:h..
3 2:07:44 &AM App Start 8960 chrome: 95600 "C:vProgram Files (268G ooglesChiame'Applicationschrome exe’” -tppe=renderer -field-tial-handle=1540 5375 >

End of file

Application failures Session Recording detects app exits and unresponsive apps if you select Log
app failures when creating your event detection policy. The Log app failures rule applies to all
apps.

() 1:19:30 AM  Top-most window: chrome, Untitled - Google Chrome, 744

@ 1:13:30 AM Unexpected App Exit: 6644: C:\Program Files\Google\Chrome\Application\chrome.exe: C:\Windows\System324KERNELBASE dll
() 1:19:32 AM Top-most window: chrome, &ll in one Workspace Solution for Secure Access to Apps and Data - Citrix - Google Chrome, 744

@ 1:19:32 AM Web browsing: citrix.com, Untitled - Google Chrome, chrome

 1:19:40 AM  Top-most window: ‘WifShell, CtsDnDSourceProxy, 7260

App installs and uninstalls The Log app installs and uninstalls rule applies to all apps.
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@ 1:22.03 AM New App Installed: 7-Zip 19.00 (x64): Igor Pavloy: 19.00

O 12205 AM Top-most window: explorer, , 5100

O 1:22.08 M Top-most window: SearchlJl, , 1736

@ 1:22.08 AM Top-most window: explorer, Downloads, 5100

© 1:2210 &M Top-most window: ShellExperienceHost, Windows Shell Experience Host, 8392 %
 1:22155M Top-most window: explorer, , 5100

O 1:22:26 AM Top-most window: Uninst, 7-Zip 19.00 [x64] Uninstall, 6172

O 1:22:28 AM App Uninstalled: 7-Zip 19.00 (x64): lgor Pavlov: 19.00

User account modifications Session Recording can detect account creation, enablement, disable-
ment, deletion, name changes, and password modification attempts.

L7 1.Ca.U0 MIVT T UPUR YWINIJUYY, 11 1o, W3yl © [LULGl USTIS arid QIVUps [LUCAIVJSTIS ], DUWILCITT Quuuuant iuon guiimistsinig uis CUnipuuec |

() 1:23:08 AM  Popup Window: 11132, lusrmar - [Local Users and Groups (Local)sUsers], Builtin account for administering the computer

& 1:23:09 AM User Account Modification: testuser: & user account was disabled.

RDP connections Session Recording can detect RDP connectionsinitiated from the VDA hosting the
recorded session.

7

() 1:24:49 AM  Popup Window: 2192, Remote Desktop Connection, The remote computer could not be authenticated du

@ 1:2450 AM RDP Connection: 2192:

(2 1:2519 &M Top-most window: cmd, Administrator: Command Prompt, 10776

(0 1:2538 AM Top-most window: explorer, , 5100

(2 1:25:40 &M Clipboard Operation: File, explorer, C:\Users\administrator XF4B5\Desktopiconfidential. docx,

File renaming, creation, deletion, and moving operations within sessions and file transfers be-
tween session hosts (VDAs) and client devices Session Recording can detect renaming, creation,
deletion, and moving operations on target files and folders that you specify in the File monitoring
list. Session Recording can also detect file transfers between session hosts (VDAs) and client devices
(including mapped client drives and generic redirected mass storage devices). Selecting the Log sen-
sitive file events option triggers the detection of file transfers, no matter whether you specify the File
monitoring list.

(2 1:20:33 &M File Create: 5100; C:\Windows\New Text Document (2).txt: 0 Bytes

[0 1:20:52 &M File Rename: 5100: C:\Windows\New Text Document (2).txt | document. txt

[0 1:21:09 &M Clipboard Operation: File, explorer, C:\Windows\document.tst,

(2 1:21:09 &M Clipboard Operation: File, explorer, C:\Windows\document.txt,

[0 1:21:11 &AM File Move: 5100; C:\wWindows\document.tst | C:\Users\administrator XF4B5\Desktopidocument.tst: 0 Bytes
(2 1:21:11 &M Clipboard Operation: Text, explorer, |,

(2 1:21:26 &M File Delete: 5100: C:\Windows\New Text Document.tst: 0 Bytes

e e e B S T

1:25:40 Ak Clipboard Operation: File, explorer, C:\Usershadministrator XF4B5\Desktop'confidential.dock

n B
45 A = ansfe 60 0 d 0 4B5\D esktophconfidential. do = onfidential.do B

O T:2678 AM Top-most window: WTShell, CtxDnDSourceProsy, 7260

(& 1:26:19AM Top-most window: explorer, , 5100

(© 1:26:21 AM File Transfer: 7260: Client:confidential docx: Host confidential docx: 0 Bytes

() 1:26:54 &AM Clipboard Operation: Test, cmd, , Administrator: Command Prompt

|O 1:27:03 AM  File Transfer. 7260: ClientApplicationhang.exe: Host.Applicationhang.exe: 7.5 KB

N e e Ly
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Note:

To enable file drag and drop and capture the drag and drop events, set the Drag and Drop policy
to Enabled in Citrix Studio.

Web browsing activities Session Recording can detect user activities on supported browsers and
tag the events in the recording. The browser name, URL, and page title are logged. For an example,
see the following screen capture.

Events and Bookmarks

Ak Wweb browszing https: /vy, google.com, Google - Google Chrome, chrome

When you move your cursor away from a webpage that has focus, your browsing of this webpage is
tagged without showing the browser name. This feature can be used to estimate how long a user stays
on a webpage. For an example, see the following screen capture.

Events and Bookmarks

(2 2:07:43 Ak Web browsing: hitps:/ v Facebook. com, Facebook - Log In or Sign Up - Google Chrome, chrome
3 20200 &b Web browsing: https: /Awww facebook. com, Facebook - Log In or Sign Up - Google Chrome :

List of supported browsers:

+ Google Chrome
+ Microsoft Edge Chromium
+ Mozilla Firefox

Note:

This feature requires Session Recording Version 1906 or later.

Topmost window events Session Recording can detect the events when the window of an app is
on top of all others. The process name, title, and process number are logged.
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Events and Bookmarks )d

) 1:56:08 &AM Top-most window: EXCEL, BookZ, 380

() 1:56:22 4k Top-most window: explarer, CITREINSTALLATIOMLOGS, 7212
(3 1:56:36 &AM Top-most window: Tazkmar, CdiSve.exe, 9276

% 1:56:39 AM  Top-most window: explorer, Application.evts, 7212

3 1:56:55 AM  Top-most window: notepad++, , 4340

3 1:56:59 &AM Top-most window: explorer, Deskiop, 7212

(3 1:57:08 &AM Top-most window: WINWORD, Bisjijsbb j.docx. 85965

2 1:57:13AM Top-most window: notepad++, , 4940

2 1:57:20 &AM Top-most window: Taskmgr, CdfSve. exe, 9276

() 1:57:34 A Top-most window: Taskmgr, CitrisAuthentication. VitualSmartcard.exe, 9276
(% 1:57:51 &M Top-most window: regedit, FileOperationkonitorList, 584

(3 1:58:04 AM Top-most window: notepad++, shi, 4940

(3 1:58:258 &AM Top-most window: explorer, Task Switcher, 7212

3 1:55:26 &AM Top-most window: EXCEL, Grid, £850

Clipboard activities Session Recording can detect copy operations of text, images, and files using
the clipboard. The process name and file path are logged for a file copy. The process name and title
are logged for a text copy. The process name is logged for an image copy.

Note: Content of copied text is not logged by default. To log text content, go to the Session
Recording agent and set HKEY_LOCAL_MACHINE\SOFTWARE\ Citrix\SmartAuditor\
Agent\CaptureClipboardContent to 1(the default value is 0).

[&#9 Session Recording Player
Fle Edt View Play Tools Help
E bO9 :'}’ »» | Search - Anytime (=] ] Advanced Search
Workspace X || Search Results
&3 Workspace - gh User Name Application Status Start Time Duration Delivery Group VDA Machine
) Search Results - oy
=] Favortes B administrator Desktop Complete ~ 7/8/2021 4:32 AM 00:04:06  VDA1 CVDA1
B administrator Desktop Complete 7/8/2021 423 AM 00:06:43 VDA1 CVDA1
B administrator Desktop Complete ~ 7/8/2021 4:15 AM 00:05:13 VDAl CVDA1
Now Playing X
User: administrator
Domain: APRO

Applicabiorc Desktop
Delivery Group: VDA
VYDAMachine: CVDA1

Site: cooc

Status: Complete

Start 7/8/2021 4:32 AM

Login 7/8/2021 433 AM

Events and Bookmarks Other user

© 4:3410 AM Clipboard Operation: File, explorer, CAGdDemo.exe, Please waitfor the Local Session Manager

Q 43421 &AM Clipboard Operation: File, explorer, C:\test.bmp,

© 43441 AM Clipboard Operation: File, explorer, C:\Logs,

© 43459 AM Clipboard Operation: Text, explorer, ,

© 43529 AM Clipboard Dperation: Text, notepad, , *Untitled - Notepad

© 43557 AM Clipboard Dperation: Bitmap, mspaint, . test - Paint

O 4:36:04 AM Clipboard Operation: Bitmap, explorer, . Windows (C:)

© 4:36:09 AM Clipboard Operation: File, explorer. C:\testbmp, Windows (C:]

+1m30s +2m00s +2m30s

P E « » —O» +0m30s +1m00s
o o (o) o (o]
00 1377 x 794 x 32-bit © 4:36:09 AM File, explorer, C:\test bmp, Windows (C:)

Paused
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Windows registry modifications Starting with Version 2109, Session Recording can detect and log

the following registry modifications while recording sessions:

Registry modification Corresponding event

Adding a key Registry Create

Adding a value Registry Set Value

Renaming a key Registry Rename

Renaming a value Registry Delete Value and Registry Set Value
Changing an existing value Registry Set Value

Deleting a key Registry Delete

Deleting a value Registry Delete Value

For example:

IEmmll and Bookmarks

0 10505 . ey D 450 CAWmsomCpsenicans e HKEY LOCAL MACHNE COFTWARE Wicksom Wi o P

O 10:30:55 PM  Registry Set Value: 8452: C:\Windows\System32\cerss.ewe : HKEY_LOCAL_MACHINE\SOFTWAREYWOWB432Node\Microsoft\WindowshT ablet Pl IsT abletPC

O 10:30:55 PM
O 10:30:55 PM
® 10:30:55 PM

O 10:30:55 PM
© 10:3055 PM
O 10:30:55 PM
O 10:3055 PM
O 10:30:55 PM
O 10:30:55 PM
O 10:30:55 PM
O 10:30:55 PM
O 10:30:55 PM

Registry Create: 8452 C:\Windows\System32\caiss.exe: HKEY_LOCAL_MACHINE\SOF TWARE \WOWB432N ode'\Microsoft\Windows\Tablet PC

Registry Set Value: 8452 C:\Windows\System32\cerss. axe © HKEY _LOCAL_MACHINEASOFTWARE \Micrasolt\windows\CurentVersion\AutoR otation] LastOrientation
Registry Create: 8452 C\Windows\System32\cerss. ene: HKEY_LOCAL _MACHINENSOFTWARE \Microsoft\windows\CunrentVersion\AutoR otation

Registiy Set Value: 8452 C:\Windows\System32\csrss.exe : HKEY_LOCAL_MACHINE\SOF TWARE \Microsoft\w/indows\CurrentVersion‘\AutoR otation\NonPreserve| LastdutoRequest
Registry Create: 8452 C\Windows\System32\cerss.ene: HKEY_LOCAL_MACHINEANSOFTWARE \Microsoft\wWindows\CurrentVersion\AutoR otation\MonPre serve
Registry Set Value: 8452 C:AWindows\System32\csrss.exe : HKEY_LOCAL_MACHINE\SOF TWARE \Microsoft\windows\CurrentVersion\&utoR otation] LastOrientation
Registry Create: 8452 C:\Windows\System32\carss.exe: HKEY_LOCAL_MACHINENSOFTWARE \Microsoft\windows\Current¥ersion\&utoR otation

Registry Set Value: 9992 C:\Program Files\Citri\HDM}\bin\CtxGhx.exe : HKEY_LOCAL_MACHINEA\SOF TWARE \Cite\Graphics\3\LLIndicatord LLIndicator

Registry Delete Value: 9392 C:\Program Files\Citrix\HDX\bin\CtxGifx exe : HREY_LOCAL_MACHINENSOFTWARE\Citrix\Graphics\3| SessionHeight

Registry Delete Value: 3932- C:\Program Files\Citri\HDX\bin\CixGfx exe : HKEY_LOCAL_MACHINEVS OF TWARENCitris\Graphics\3| Session\idth

Registry Delete Value: 3392 C:\Program Files\Citri\HDX\bin\CtxGfx exe : HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Graphics\3] MumMonitors

Registry Create: 9392 C:\Program Files\Citioe\HDX\bin\CtuGfx exe: HKE'Y_LOCAL_MACHINE\SOF TWARE\Citri\Graphics\3

To enable this registry monitoring functionality, select the Log registry modifications option for your

event detection policy.

Performance data (data points related to the recorded session) When creating your event de-

tection policy, select Log performance data to enable the session data overlay feature. The feature

introduces a screen overlay during session playback in the web player. Itis a semi-transparent overlay

that you can relocate and hide. The overlay features the following data points related to the recorded

session:

Round trip time
Network (send)
Network (receive)

» CPU usage

Memory usage
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NOV 18,2021

11:41:52- 00:13:33 - 32 Events

00:00:26 Top-most
window:sessionmsg. . 9072

00:00:28 Top-most
window.explorer. . 7508

Network (send) L 78 Kbps

Network (receive) ~ 35Kbps e | Twiter
: 32%

2989/4088 MB (73%)

o o

Learn the Cost of a Financial
Advisor

00:00:48 App Start-9632
AN,

Amazon conhost: 2748

00:00:48 App Start:2748:
cmd: 75¢
C:\Windows\sys.

Recommended

00:00:48 App Start11232
powershell: 2748: powers.

00:00:55 App End:9632:
conhost

00:00:55 App End:11232.
powershell

00:00:55 App End:2748:
Share Current Playback x1 Hide stats 50 FULL SCREEN cmd

Popup window events When users open or close a confidential file or access a folder, a popup win-
dow might appear, showing a prompt or asking for a password. Session Recording can now monitor
such popup window events while recording sessions. Popup windows in web browsers are not moni-

tored.

Attributes of a popup window event are recorded, including the process name and content of the

prompt.

@ 1:2348 AM_Popup Window: 2192, Remote Desklop Connection, Connecting to: | [EERRIERS) Initiating remote connection..
© 1:24:05 AM Popup Window: 2192, Remote Desktop Connection, Remote Desktop cant connect to the remote computer for one of these reasons:\nini1) Remote access to the server is not enabledin2) The remote computer is tumed off\n3) The remote.

Printing activities (preview) Session Recording monitors printing activities that occur during
recorded sessions and tags the printing activities as events in recordings for later search and

playback.
Note:

This is a preview feature. It is available with Session Recording version 2407 and later. Preview
features might not be fully localized and are recommended for use in non production environ-
ments. Citrix Technical Support doesn’t support issues found with preview features.

Custom events

The Session Recording agent provides the lUserApi COM interface that third-party applications can use
to add application-specific event data into recorded sessions. Based on the event customization, Ses-
sion Recording can block sensitive information and log the session pause and session resume events

accordingly.
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Sensitive information blocking Session Recording lets you skip certain periods when recording
the screen and blocks sensitive information in these periods during session playback. To use this
feature, use Session Recording 2012 and later.

[
Fle Edt View Play Tools Hep
Q[I]% | » | Search - Anytime -9 [ Advanced Search
Workspace X || Search Results x

&5 Workspace - gh

User Name Appication Status St Time Dution  DeliveryGroup VDA Machine  Events Only Size

& Search Resut

9 F:jomes et B administrator Desktop Complete  7/8/2021 4:32 AM 00:0406  VDAT CVDA1 No 1134 KB
B administrator Desktop Complete  7/8/2021423AM  00.06:43 VDA CVDAT No 796 KB
B adminstrstor Desktop Complete  7/8/2021415AM 000513  VDA1 CVDAT No 776 KB

Now Playing x|

User: administrator
Domain: APRQ
Application: Desktop
Delivery Group: VDA1
VDAMachine: CVDA1

Site: oDC

Status: Complete

Start 7/8/2021 423 AM
Login: 7/8/2021 423 AM

Content blocked
Sentive content detected

Events and Bookmarks

O 4:26:00AM Notepads++Sentive content detected:;
O 4:2319AM Notepad++Sentive content detected:;

> Size: 796 KB © 4:26:00 AM Notepad++:Sentive content detected, 71812021 4:26:18 AM

Playing

To use this feature, complete the following steps:

1. In Session Recording Agent Properties, select the Allow third party applications to record
custom data on this VDA machine check box and click Apply.
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[% Session Recerding Agent Properties — >
Recording  Connections

Session recording
Select this option to enable policy-based session recording on this VDA

machine. If this option is not selected, session recording is disabled on
this machine.

Enable session recording for this VDA machine

Custom evert reconding

Select this option to allow third party applications to inject custom data
into the recorded session while recording is in progress. This data is
available during playback.

Allorw third party applications to record custom data on this VDA
machine

Carcel | | donly

2. Grant users permission to invoke the Session Recording Event API (IUserApi COM interface).

Session Recording adds access control to the event API COM interface starting with version 7.15.

Only authorized users are allowed to invoke the functionality to insert event metadata into a
recording.

Logon users with local administrator privileges are granted with this permission by default. To
grant other users this permission, use the Windows DCOM configuration tool:

a) On the Session Recording agent, run comenfg.exe to open the Windows DCOM configura-
tion tool.

< Run x

;7 Type the name of a program, folder, document, or
= Internet resource, and Windows will epen it for you.

Open

= =
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%. Component Services - a X
%. File Acion View Window Help -8
e 20 D6 HE ]

(21 console Root = Actions
. Component Services - CampETaTt Gaviees -

Q Event Viewer (Local) Computers e
More Actions »

/. Services (Local)

If you are granting permission to users who are not members of the domain administrator
group and the Session Recording agent is running on Windows Server 2019 or later, or
Windows 10 or later, proceed to step b. Otherwise, skip step b and go to step c directly.

b) Select Console Root > Component Services > Computers > My Computer from the left
navigation.

Right-click My Computer and select Properties.
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” .
-#= Component Services

@ Event Viewer ( Refresh all components

= R on Coordina..
~: Services (Loca

View

New Window from Here
Export List...

Properties l\\}

Help

Opens the properties dialog box for the current selection.

X
%. File Action View Window Help 8
e 2@m XEdz BE O 2
(21 Console Root Name Actions
v . Component Services “| COM+ Applications My Computer 7
v [ Computers 7“1 DCOM Config More Adi ,
1R My Commniar lore Actions

Select the COM Security tab, and then click Edit Default to add users with Local Activa-
tion permission in the Launch and Activation Permissions section.

My Computer Properties ? x
General Options Defalt Properties
Default Protocols. COM Security MSDTC

Access Pemissions.

You may edit who s allowed default access to applications. You may
also set limits on applications that determine their own pemissions.

Caution: Modifying access permissicns can affect the ability
of applications o start, connect, function and/or un securely.

Edit Limits... Edit Default..

Launch and Activation Permissions

‘You may edit whe is allowed by default to launch applications or
aciivate objects. You may alse set limits on applications that
determine their own permissions.

Caution: Modifying launch and activation pemissions can
| affect the ability of applications to start, connect, function
" andlor un securely.

Edit Limits... Edit Defaul...

Leam more about setting these properties

OK Cancel Apply
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Launch and Activation Permission ? X
Default Secuity
Group or user names:
S8 SYSTEM
ini ©
SR INTERACTIVE
Add... Remove
Permissions for SYSTEM Allow Deny
Local Launch [m] ]
Remote Launch O a
Local Activation o
Remote Activation m} o
OK Cancel

c) Select Console Root > Component Services > Computers > My Computer > DCOM Con-
fig from the left navigation.

% Component Services

- [m] X
%. File Action View Window Help - & X
e 2m XEa BE O =
ol i & & &« & &« & & & =
o, i
v szmponem Services . ) o DCOM Config -
v || Computers % Ro.. %Sy Ro.. 3% 0. %sy o.. 32-bit Preview Accessibilit... 5
v 1% My Computer Handler Surr... More Actions 4
> [ COM+ Applications
> | DCOM Config ﬁ' ﬁ' ﬁ' ﬁ' ﬁ' ﬁ' ﬁ' ﬁ'

> J Running Processes Account AccStore acppagedll  AcroBroker  AcroDistX AcroPDF  Activatable..  Activation
> I Distributed Transaction Coo! Manag... Class

§-Pvkiowi & & & & &

Addto  AdobeAcro..  ahadmin APClient  AppActivati..  AppCom  Application  Application
Windows ... HxHelpPan.. Activation... Class

& & & & &

\op! .. AppSenvice.. AppVClient —appwizcpl Authenticati.. Authenticati..
Frame Host Service Ul CredU!l O.. Ul CredUI O..

& & & & &

Authenticati.. Authenticat..  AuthHost ~ AutoMdmN.. AvailableN..  AxinstSv  Background BannerNotif..

Ul CredUl O.. Ul Terminal... Intelligent...

Battery BDEUlLaun..  BdeUISrv Bitmap Bluetooth Bluetooth Bonjour
Notificati... Class Image AVCTP Service User Service

5 | % & & &F & F & & .

®
@
®i

®

&
®

@
@
@

®

®
® ¢

BrowserBro...

Right-click Citrix Session Recording Agent and choose Properties.
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% Component Services

& & & €

Cloud Change CloudExperi.. CloudExper.. CloudExper...
‘Wnf Monitor Broker AppID Create Syst.. Create Syst..

&

CloudExper... CloudSyncExt

CMLUAUTIL

CMSTPLUA

& &« &« & & & & @

- [m] X
%. File Action View Window Help - 8 X
e @ XEGQ B O ZHEES
(23 Console Root Actions
v B Component Services ﬁ ﬁ ﬁ ﬁ ﬁ ﬁ ﬁ ﬁ DCOM Config o~
v (7] Computers Application  Application.. AppReadin.. AppService.. AppVClient — appwizcpl ~Authenticati.. Authenticati.. ) N
v 1% My Computer Frame Host Senice Ul CredUI O... UI CredUI More Actions
> (] COM+ Applications
) B oot & & & & & & & &
7 j Rflnn‘ing Processes . Authenticati.. Authenticat.. ~ AuthHost ~ AutoMdmN.. AvailableN..  AxinstSv  Background BannerNotif..
» [ Distributed Transaction Coo|| | CredUl O.. Ul Terminal.. Intelligent... Class
> 2] Event Viewer (Local)
Pk & & & & & & & @
Battery BDEUlLaun..  BdeUISrv Bitmap Bluetooth Bluetooth Bonjour  BrowserBro..
Notificati... Class Image AVCTP Service  User Service
CdfSvc CDTUHandler CElevateWl.. CExcel12Co.. CFmlfsEngine ClmeSearch.. ClmeServer.. ClmeServer..
Class host Class
Citrix Agent  Citrix EUEM Citrix Citrix Citrix PortICA (€131
COM Server ImeMsgFor..  LogonCS..  Service Stac..

d) Selectthe Security tab, and then click Edit to add users with Local Activation permission
in the Launch and Activation Permissions section.

Citrix Session Recording Agent Properties
General Location Security Endpoints Identity
Launch and Activation Permissions
O Use Default

@ Customize

Acoess Permissions

O Use Default

@ Customize

Configuration Pemmissions

O Use Default

@® Customize

Leam more about setling these properties.

OK Cancel

? x

Edit...

Edit...

Apply
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General Location Security Endpoints Identity

Launch and Activation Permission ? x|

Seaurty

Group or user names:

S8 sYSTEM
o CitrixAdmin (CNENGSREQMKFEPX\CitrixAdmin)

Add... Remove

Pemissions for SYSTEM

z
2

Deny

Local Launch

og

Remote Launch
Local Activation
Remote Activation

iy
=

0
oooag

Le

Note:

DCOM configuration takes effect immediately. There is no need to restart any services or
the machine.

3. Start a Citrix virtual session.

4. Start PowerShell and change the current drive to the <Session Recording agent installation
path>\Bin folder to import the SRUserEventHelperSnapin.dll module.

5. Run the Session-Pause and Session-Resume cmdlets to set parameters for triggering
sensitive information blocking.

Parameter Description Required or Optional

-APP The app name that calls the Required
Session-Pause and
Session-Resume cmdlets.
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Parameter

—-Reason

-AheadSeconds

Description Required or Optional

The reason that content is Optional
blocked. If you leave this
parameter unspecified, the
default setting shows, stating
Content Blocked and
Sensitive information exists
and is blocked. If you set this
parameter, the reason you
specify shows when you
navigate to the blocked period
during session playback. This
parameter is available for both
the Session-Pause and
Session-Resume cmdlets.

This parameter is available for ~ Optional
the Session-Pause cmdlet only.
It lets you configure the
amount of time of the screen
recording you want to bypass
before sensitive information is
detected. The default value is 1
S.

For example, you can run Session-Pause similar to the following:

P

w e tiher
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Search for and play back recordings with tagged events

Search for recordings with tagged events The Session Recording player allows you to perform
advanced searches for recordings with tagged events.

1. In the Session Recording player, click Advanced Search on the tool bar or choose Tools > Ad-
vanced Search.
2. Define your search criteria in the Advanced Search dialog box.

The Events tab allows you to search for tagged events in sessions by Event text or Event type or
both. You can use the Events, Common, Data/Time, and Other filters in combination to search for
recordings that meet your criteria.

Advanced Search oy
Saved Searches... Save As... Reset Values
Search Criteria

Common  Date/Time Events  Other

Citrix-defined events and events inserted by third-party applications can be tagged while a session is being recorded. To search for
recordings with target events tagged, set the search criteria below.

Event text: | |

BEvent type: | |v

Citrix. Event Monitor AppEnd

Citrix.Event Monitor. App Start

Citrix. Event Monttor CDMUSEDrive Atach
Citrix.Evert Monitor Clipboard

Citrix. Event Monitor FileCreate

Citrix. Event Monitor File Delete
Citrix. Event Monitor. File Move

Citrix. Event Monitor File Rename

Citrix. Event Monitor Generic U 5B Drive Attach
Query Builder Citrix.Event Monitor. Top Most

Citrix. Event Monitor. Web Browsing

Find the 200 most relevant refW I Rl e
Citrix.Lserfpi SessionResume

Anty Citrix-defined event

Note:

« The Event type list itemizes all event types. You can select an event type to search. Select-
ing Any Citrix-defined event means to search for all recordings with any type of events
logged by Citrix Session Recording.

+ The Event text filter supports partial match. Wildcards are not supported.
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+ The Event text filter is case-insensitive when matching.
+ For the types of events, the words App Start, App End, Client drive mapping,
and File Rename do not participate in matching when you search by Event text.

Therefore, when you type App Start, App End, Client drive mapping, or
File Rename inthe Event text box, no result can be found.

You can use events to navigate through a recorded session, or skip to the points where the events are
tagged.

System-defined event detection policy

The system-defined event detection policy is Do not detect. It’s inactive by default. When it’s active,
no events are logged.

L?';P Citrix Session Recording Policy Console
File Action View Help
o9 2@ o HmE

_Ef Session Recording Policy Conscle

Policy Name Description
~ =) Recording Policies

‘_-TDU not detect ) ) o ) This puhqr will disable bég\rrg of all events.
F:"-‘ New event detection policy
=1 New event detection policy(2)

|= Do not record
[® New policy
[ Record entire sessions (for everyone, with notification)
?L Record entire sessions (for everyone, without notification)
|= Record only events (for everyone, with notification)
?l Record only events (for everyone, without notification)
v ) Event Detection Policies
| Do not detect
[ New event detection policy
|= New event detection policy(2)
| Event Response Policies

You cannot modify or delete the system-defined event detection policy.

Create a custom event detection policy

Considerations

You can specify which events to log. A wizard within the Session Recording policy console helps you

create rules. For each rule you create, you select the events to log and specify which sessions the rule
applies to through the rule criteria settings.

For each rule, choose at least one of the following items to create the rule criteria:

+ Users or Groups. Creates a list of users or groups to which the rule applies.
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Published Applications or Desktop. Creates a list of published applications or desktops to
which the rule applies.

« Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the rule
applies.

+ IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the rule
applies. The IP addresses mentioned here are the IP addresses of the Citrix Workspace apps.

« Filter. Creates a list of smart access tags to which the rule applies. You can configure contextual
access (smart access) using smart access policies on Citrix NetScaler.

B Specify Tags X

Enter custom tags separated by commas:

OK Cancel

Contextual access (smart access) is available for Session Recording 2402 and later. It lets
you apply policies based on the user access context including:

The user’s location

IP address range

Delivery group

Device type
Installed applications

Steps

To create a custom event detection policy:

1. Logon as an authorized Policy Administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console.
By default, there is no active event detection policy.

3. Select Event Detection Policies in the left pane. From the menu bar, choose Add New Policy
to create an event detection policy.

4. (Optional) Right-click the new event detection policy and rename it.
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@ Citrix Session Recording Policy Console
File Action View Help
s HE G o)

%‘ Session Recording Policy Console

v [ Recording Policies
@ Do not record
|§ New policy
(& Record entire sessions (for everyone, with notification)
|§ Record entire sessions (for everyone, without notification)
E Record only events (for everyone, with notification)
|_E Record only events (for everyone, without notification)

v [ Event Detection Policies
[& Do not detect
[ New event detection policy
[3 New event datastinn malimimn

[ Event Response Add Rule

Activate Policy
Copy Policy
Delete Policy

View Policy
All Tasks 2
View >

Rename

Refresh

Refreshes the current sel: 2D

Rule Name
35 System defined rule

Description

Action

Logs no events

5. Right-click the new event detection policy and select Add Rule.

a) Specify one or more target events to monitor by selecting the check box next to each event

type. Scroll down the window to view all available event types.
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@' Rules Wizard

Step 1: Select one or more of the following options to specify whether to log the related events.

] Log COM mapped USE events
[1 Log generic USB redirection
[ Log app start events
Log app end events

App monitoring list:

Tipe the process names of target apps. Separate the names with 3 semicolon ()
[ Log file operations

File monitoring list:

Type the absolufe paths of fanget files. Separate the paths with a semicalon ()
[ Log web browsing activities
[] Log topmost window events
[ Log clipboard activities
[ Log registry modfications

Registry monitoring list:

Tvpe the absolute paths of farget regisines. Separate the paths with a semicolon ().

[ Log app failures

Cancel

+ Log CDM mapped USB events: Logs the insertion of a Client Drive Mapping (CDM)
mapped mass storage device in a client where Citrix Workspace app for Windows or
for Mac is installed.

+ Log generic USB redirection: Logs the insertion of a generic redirected mass storage
device in a client where Citrix Workspace app for Windows or for Mac is installed.

+ Log app start events: Logs the starts of target applications.
+ Log app end events: Logs the ends of target applications.
Note:

The Log app end events check box is grayed out before you select Log app start

events.

« App monitoring list: When you select Log app start events and Log app end events,
use the App monitoring list to specify target applications to monitor and to avoid an
excessive number of events from flooding the recordings.
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Note:

- To capture the start and end of an application, add the process name of the
application in the App monitoring list. For example, to capture the start of
Remote Desktop Connection, add the process name mstsc.exe to the App
monitoring list. When you add a process to the App monitoring list, applica-
tions driven by the added process and its child processes are monitored. Ses-
sion Recording adds the process names, cmd . exe, powershell.exe, and
ws'l.exe, to the App monitoring list by default. If you select Log app start
events and Log app end events for an event detection policy, the starts and
ends of the Command Prompt, PowerShell, and Windows Subsystem for Linux
(WSL) apps are logged regardless of whether you manually add their process
names to the App monitoring list. The default process names aren’t visible
on the App monitoring list.

- Separate process names with a semicolon (;).

- Only the exact match is supported. Wildcards aren’t supported.

- Process names you add are case-insensitive.

- To avoid an excessive number of events from flooding the recordings, do not
add any system process names (for example, explorer.exe) and web browsers
in the registry.

+ Log file operations: Logs operations on target files in the File monitoring list and
logs file transfers between session hosts (VDAs) and client devices (including mapped
client drives and generic redirected mass storage devices). Selecting this option trig-
gers the logging of file transfers, no matter whether the File monitoring list is speci-
fied.

- File events presented in the web player

View: Events
Qfite ¥
1 00:0L32File
transfer:10804:
HostCAUsers\otxad..
00:01:40 File

" transfer:10804: e
clientGAHeartBeat_b...

00:01:56 File

. ilo
¥ transter:10804: Client:New
Text Docu...

w 00:01:59 File
¥ uansfer:1080

- File events presented in the Session Recording Player

Events and Bookmarks

( 5:55:38 P File Create: 22: %\ClientC$\Personality. ini: 22 Bytes

(3 55744 PM File Transfer £404: Host:CiUsarshddministrator AMFPAAD esktopt EndProcesstonitorH ook, dln: Client\E $4EndProcesstMonitorH ook sle 1010 Bytes
(2} 5:57-47 P File Create: £4014: S\ClisnthE $5F ndProcessMonitoH ook sln: 1070 Bytes

( 558:39 PM File Transfer 2836 Host:CvUserstAdministrator AMFPAAD esktoptEndProcesstonitorH ook, sln. ClientE ndProcessMonitoHook sk 1010 Bytes
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« File monitoring list: When you select Log file operations, use the File monitoring
list to specify target files to monitor. You can specify folders to capture all files within
them. No file is specified by default, which means no file is captured by default.

Note:

- To capture renaming, creation, deletion, or moving operations on a file, add
the path string of the file folder (not the file name or the root path of the
file folder) in the File monitoring list. For example, to capture renaming,
creation, deletion, and moving operations on the sharing.pptfilein C:\
User\File, add the path string C:\User\File in the File monitoring
list.

- Both local file paths and remote shared folder paths are supported. For exam-
ple, to capture operations on the RemoteDocument.txt file in the \ \remote
.address\Documents folder, add the path string \\remote.address
\Documents in the File monitoring list.

- Separate monitored paths with a semicolon (;).

- Only exact matches are supported. Wildcards aren’t supported.

- Path strings are case-insensitive.

Limitations:

- Copying files or folders from a monitored folder to an unmonitored folder isn’t
captured.

- When the length of a file or folder path including the file or folder name exceeds
260 characters, operations on the file or folder aren’t captured.

- Pay attention to the database size. To prevent large numbers of events from being
captured, back up or delete the “Event”table regularly.

- When large numbers of events are captured in a short time, the player displays
and the database stores only one event for each type to avoid storage expansion.

+ Log web browsing activities: Logs user activities on supported browsers and tags
the browser name, URL, and page title in the recording.

Events and Bookmarks

Ak wieb browsing: https: /Ay google.com, Google - Google Chrome, chrome

List of supported browsers:

- Google Chrome
- Microsoft Edge Chromium
- Mozilla Firefox

+ Log topmost window events: Logs the topmost window events and tags the process
name, title, and process number in the recording.
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Events and Bookmarks )ld

3 1:56:08 A Top-most window: EXCEL, Book2, B850

3 1:56:22 AM  Top-most window: explorer, CITRIMINSTALLATIONLOGS, 7212
2 1:56:36 &AM Top-most window: T askmgr, CdiSwve.exe, 9276

€3 1:56:39 AM  Top-most window: explorer, &pplication.evks, 7212

3 1:56:55 M Top-most window: notepad++, , 4340

3 1:56:59 AW Top-most window: explorer, Desklop, 7212

3 1:57:08 &M Top-most window: WINWIORD, Bisjjsbb jdocx, 8596

23 15713 AM Top-most window: notepad++, , 4340

€23 1:57:20 A Top-most window: Taskmgr, CdiSwve, exe, 9276

3 1:57:34 A Top-most window: Taskmgr, CitrisAuthentication VitualSmartcard.exe, 9275
2 1:57.51 &AM Top-most window: regedit, FileD perationtd onitorList, E584

€2 1:55:04 AWM Top-most window, notepad++, shi, 4940

€3 1:55:25 AM Top-most window: explorer, Tazk Switcher, 7212

3 1:55:26 AWM Top-most window: EXCEL, Grid, G850

+ Log clipboard activities: Logs copy operations of text, images, and files using the
clipboard. The process name and file path are logged for a file copy. The process
name and title are logged for a text copy. The process name is logged for an image
copy.

+ Log registry modifications: Logs the following Windows registry modifications: add
a key or value, rename a key or value, change an existing value, and delete a key or
value.

+ Registry monitoring list: When you select Log registry modifications, type
the absolute paths of the registries you want to monitor and separate the paths
with a semicolon (;). Start a path with HKEY_USERS, HKEY_LOCAL_MACHINE,
or HKEY_CLASSES_ROOT. For example, you can type HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows ;HKEY_CLASSES_ROOT\GuestStateVDev
. If you leave this list unspecified, no registry modification is captured.

+ Log app failures: Logs unexpected app exits and unresponsive apps. This rule ap-
plies to all apps.

+ Log user account modifications: Logs the following user account modifications:
account creation, enablement, disablement, deletion, lockout, name changes, and
password modification attempts.

+ Log RDP connections: Logs RDP connections initiated from the VDA hosting the
recorded session.

+ Log app installs and uninstalls: Logs app installs and uninstalls during the recorded
session. This rule applies to all apps.

+ Log performance data: Enables the session data overlay feature. Select this check
box to view data points related to the recorded session.
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+ Log popup windows: Logs popup windows that might appear when users open or
close a confidential file or access a folder.

+ Log printing activities: Logs printing activities that occur during recorded sessions.
This feature isin preview. Itis available with Session Recording version 2407 and later.

b) Select and edit the rule criteria.
Similar to creating a custom recording policy, you can choose one or more rule criteria:

« Users or Groups

+ Published Applications or Desktop
+ Delivery Groups or Machines

« IP Address or IP Range

« Filter

To obtain the lists of published applications or desktops and delivery groups or VDA ma-
chines, you must have the read permission as a site administrator. Configure the adminis-
trator read permission on the Delivery Controller of the site.

For more information, see the instructions in the Create a custom recording policy section.
Note:

Some sessions might not meet any rule criteriain an event detection policy. For these
sessions, the action of the fallback rule applies, which is always Do not detect. You
cannot modify or delete the fallback rule.

c) Follow the wizard to complete the configuration.
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[Ee Rules Wizard X

Step 4: Complete the rule setup.

Specify a name for this nule:
|re7 |

Provide a description for this rule:
| Specific user e fitel |

Enable this nile
Summary (click Back to edit):
Log &CDM mapped USB events
Users / Groups  Published Resources  Delivery Groups / Machines  |P Address / IP Range

MName Location
& user JZUAI-SRS-1

< Back Next Cancel

After a session that matches an event detection policy starts, the session ID and its event registry val-
ues appear in the Session Recording agent. For example:

B Registry Editor - m} b4
File Edit View Favorites Help
v || Citrix A || Name Type Data
CdfCaptureService 2] (Default) REG_SZ (value not set)
Citrix Desktop Delivery Controller 28] AppMonitorList REG_MULTI_SZ cmd.exe powershell.exe wsl.exe
Citrb Virtual Desktop Agent 3% EnableAccountChangeEvents REG_DWORD 0:x000D0DOD (0)
ChibxceptionHandler ;
ook | EnableAppChangeEvents REG_DWORD 0000001 (1)
Divector ] EnableAppFaultEvents REG DWORD 000000000 (0)
FileTransfer E@Enab\eﬂppLaunchEvents REG_DWORD 000000000 (0)
Graphics 54 EnableCDMUSBDriveEvents REG_DWORD 0<D0DDDD0D (1)
GroupPolicy 3| EnableClipboardEvents REG_DWORD 00000000 (1)
HDXMediaStream 5| EnableFileOperationMonitorEvents REG_DWORD 00000000 (0)
lca 2| EnableGenericUSBDriveEvents REG_DWORD 000000000 (0)
leaConfigTool % EnableldleEvent REG_DWORD 0<D00DDDOT (1)
Icak2m 4 EnablePerfDataEvents REG_DWORD 0<D00DDD0D (0)
ImageAnalysis 5] EnablePopupWindowEvents REG_DWORD 0<D0DDDD0D (1)
Install 1| EnableRDPConnectionEvents REG_DWORD 00000000 (0)
Location 1| EnableRegistryOperationManitarEvents REG_DWORD 0000001 (1)
Metalnstall %/ EnableSessionEvents REG_DWORD 000000001 (1)
MLicensing %4 EnableTopMostEvents REG_DWORD 0xD0000D00 (0
Portica 2% EnableWebBrowsingActivities REG_DWORD 0x00DO0D0D (0)
Print ab FileOperationMonitorList REG_MULTI_SZ
serverfTA 4] IdleEventActivePktNumThrottle REG_DWORD 000000000 (0)
S"‘l’;‘z::‘t”' 4| dleEventActivePkiSizeThrottle REG_DWORD 0x0000000D (0)
; 2] | dieEventActiveThrottle REG_DWORD 000000000 (0)
v | SessionBuents
LIE 34 | dleEventThrottle REG_DWORD 0<D00DDD0D (0)
StackAgentinfe (G Registry OperationivionitorList RES AULTI 57 G ACHINE SOFTARE
SucHast
Telemetry
UniversalPrintDrivers
... | VdaCFIP A
ComputeriHKEY_LOCAL MACHINE\SOFTWARE\Citri\ Smart Auditor! SessionEvents\6
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Compatibility with registry configurations

When Session Recording is newly installed or upgraded, no active event detection policy is avail-
able by default. In this case, each Session Recording agent respects the registry values under
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to deter-
mine whether to log specific events. For a description of the registry values, see the following
table:

Registry Value Description

EnableSessionEvents 1: enables event detection
globally; 0: disables event
detection globally (default
value data).

EnableAccountChangeEvents 1: enables detecting user
account modifications; 0:
disables detecting user account
modifications (default value
data).

EnableAppChangeEvents 1: enables detecting app
installs and uninstalls; 0:
disables detecting app installs
and uninstalls (default value
data).

EnableAppFaultEvents 1: enables detecting app
failures; 0: disables detecting
app failures (default value
data).

EnableAppLaunchEvents 1: enables detecting only app
starts; 2: enables detecting
both app starts and ends; 0:
disables detecting app starts
and ends (default value data).

AppMonitorList Specifies target apps to
monitor. No app is specified by
default, which means no app is
captured by default.
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Registry Value

EnableCDMUSBDriveEvents

EnableClipboardEvents

Description

1: enables detecting the
insertion of CDM mapped USB
mass storage devices; 0:
disables detecting the insertion
of CDM mapped USB mass
storage devices (default value
data).

1: enables detecting clipboard
activities; 0: disables detecting
clipboard activities (default
value data).

EnableFileOperationMonitorEventa: enables detecting file

FileOperationMonitorList

EnableGenericUSBDriveEvents

EnablePerfDataEvents

EnablePopupWindowEvents

operations; 0: disables
detecting file operations
(default value data).

Specifies target folders to
monitor. No folder is specified
by default, which means no file
operation is captured by
default.

1: enables detecting the
insertion of generic redirected
USB mass storage devices; 0:
disables detecting the insertion
of generic redirected USB mass
storage devices (default value
data).

1: enables the session data
overlay feature; 0: disables the
session data overlay feature
(default value data).

1: enables detecting popup
window events; 0: disables
detecting popup window

events (default value data).
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Registry Value

EnableRDPConnectionEvents

Description

1: enables detecting RDP
connections; 0: disables
detecting RDP connections
(default value data).

EnableRegistryOperationMonitorExentmbles detecting Windows

RegistryOperationMonitorList

EnableWebBrowsingActivities

EnablePrintingEvents

registry modifications; 0:
disables detecting Windows
registry modifications (default
value data).

Specifies target registries to
monitor. No registry is
specified by default, which
means no registry modification
is captured by default.

1: enables detecting web
browsing activities; 0: disables
detecting web browsing
activities (default value data).

1: enables detecting printing
activities; 0: disables detecting
printing activities (default
value data).

Here are some compatible scenarios:

« If your Session Recording is newly installed or upgraded from a release earlier than 1811 that

doesn’t support event detection (logging), the related registry values on each Session Record-

ing agent are the default. Because there is no active event detection policy by default, no events

are logged.

« If your Session Recording is upgraded from a release earlier than 1811 that supports event de-

tection but has the feature disabled before your upgrade, the related registry values on each

Session Recording agent remain the default. Because there is no active event detection policy

by default, no events are logged.

« If your Session Recording is upgraded from a release earlier than 1811 that supports event de-

tection and has the feature partially or fully enabled before your upgrade, the related registry
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values on each Session Recording agent remain the same. Because there is no active event de-
tection policy by default, the event detection behavior remains the same.

« If your Session Recording is upgraded from 1811, the event detection (logging) policies config-
ured in the policy console remain in use.

Caution:

Activating the system-defined or a custom event detection policy means to ignore the relevant
registry settings on each Session Recording agent. If you do so, you can’t use registry settings
for event detection any more.

Configure event response policies

June 21,2024

You can send an email alert when a session start is detected and take the following actions in response
to logged events in recorded sessions:

+ Send email alerts

« Start screen recording immediately (with or without lossy screen recording enabled)
+ Lock session

+ Log off session

+ Disconnect session

Note:

If the Lock session action doesn’t work as expected, check the following registry keys on the
VDA and ensure that there is no registry value under them or the value data is set to 0.

« HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
« HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\System

The only system-defined event response policy is Do not respond. You can create custom event re-
sponse policies as needed. Only one event response policy can be active at a time.

For an example email alert, see the following screen capture:
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Citrix Session Recordin

File Message Help Q Tell me what you want to do
] Delete ~ =] Archive [ Move~ | € Reply %) Replyall —> Forward | Pl Todo » | G2 Mark Unreg

Citrix Session Recording Alert: A TopMost was detected. VDAMachine: AWTSVDA-0002;

e SR-ALERT <srt-no-reply@outlock.com=

This email comes from Citrix Session Recording to notify vou that a Tophbost was detected:

[CAUTION - EXTERNAL EMAIL] DG NOT re

Session Details

User Mame administrator

Domain Mame KEHTE

Start Time 11872020 3 15:06 &M

Delivery Group Rtz Desk top And AppGiroup

Application Rt Desktop,

WD Machine

Plavback URL hittpas,” wiebplaver 4 Dlaver
Event Text Tophpp: regedit

Event Time 115972020 31751 &M

oucan find the session recording video and more information here.

This is an automated email from Citrix Session Recording Do not reply

Tip:

Clicking the playback URL opens the playback page of the recorded session in the web player.
Clicking here opens the All recordings page in the web player.

Session Recording sends email alerts in the operating system language of your Session Recording
server. However, if the operating system language of your Session Recording server is not one of the
following languages that Session Recording supports, email alerts are sent in English by default:

+ English

+ French

« German
+ Spanish
» Japanese

Simplified Chinese

To customize a language to send email alertsin, find the email template called template.en.html
under<Session Recording server installation path>\Bin\templates,andthen
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change the plain text in the template to your preferred language. For example:

template.enhiml
1 DOCTYPE
2 ntml en" x s="http: .org/TR/REC-html48" xmlns "http://schemas.microsoft.com/office/2084/12/omml" xmlns:w="urn:schemas-microsoft-com:off
3 head
4 meta ="Content-Type ="text/html; charset=utf-8"
5 head
6 body 19="EN-US" link="blue k="purple"
7 div class="WordSectionl"
8 P
9 span color: M#803399"
18 [FT) $SINGLE_RECEIVERS
11 o:p o:p
12 span
13 p
14 p
15 span st color: M#883399
16 [FRIS email comes Trom CATriX SESSI10n REcording to NOTIfy you that &]-strong>SALERT_REASONS</strong
17 o:p CH )
18 span
19 p
20 table th="0 MsoNormalTable" width:12.8in;margin-left:33.75pt;background: Owhite;border-collapse:collapse” border="8"
21 tbody
22 tr
23 te vadding:8in 8in @in Bin"
24 p
25 strong><span 'font-size:10.5pt; font-family: "Verdana”,sans-serif;color: M#666699 span strong
26 p
27 i
28
29
30
31 tbody
32 table
33 P
34 span st "color: M#883399"
35 [Vou can find the session recording video and more information| -a SDISPLAY_L H.«'.\' a
36 span
37 p
38 div

System-defined event response policy

Session Recording provides one system-defined event response policy:

+ Do not respond. By default, no action is taken in response to logged events in your recordings.

Create a custom event response policy

1. Logon as an authorized policy administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console. By default, there is no active event response policy.

[ Citrix Session Recording Policy Console - O X
File Action View Help

e 7E G BHE

E}? Session Recording Policy Console Policy Name Description
= . - —
v =) Recording Policies [= Do not respond This policy will disable all alert notifications.
fifv) Do not record

[E Record event only for everyone with notification
[= Record event only for everyone without notification
E Record everyone with notification
[E Record everyone without notification

v [ Event Detection Policies
@ Do not detect

~ [ Event Response Policies
E Do not respond

~ [ Recording Viewing Policies

[E New poli
policy
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3. Select Event Response Policies in the left pane. From the menu bar, choose Add New Policy.

4.
5.

(Optional) Right-click the new event response policy and rename it.

Right-click the new event response policy and select Add Rule.

Select Email alert when a session start is detected and Use event triggers to specify how
to respond when a session event is detected based on your needs.

3 Roules Wizard

Step 1-1: Select one or more of the following oplicns.

[ Emadl adert when a session stat i detected
[ Togger responss scteans when a season avent it detectsd

Configure event tiggers and responses

Step 1-2: Enter email addresses for the alert recipients.
Emad recisents:

(ot the il dcideas o nall recenie SedE socovding fo M e Separate the actbestes il 8 semaeod

Step 1-3: Set paramet ers for dynamic screen necording.

Screen recording time span after we deled an evert

| Ao many mincfes ob you want us fo necond the screen after we defec! an event?

Sereen recording time span before we detect an avert
.%M'wmdﬂkwmm;wwnmmﬁmm e getact an evers 7

Time inberval between a sesson operation nolics and ibs execubion (avalable for sesson ook, log off, and deconnection)
.wam'mabywwmwmwamw:m afer we s the notice 7

[] Erable keswy scresn recondng

7. (Optional) Set email recipients and the email sender properties.

a) Type the email addresses for the alert recipients in the Rules wizard.

b) Configure outgoing email settings in the Session Recording Server Properties.
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[ Session Recording Server Properties

Rolover Playback Notfications CEIP

(] Application
[ VDA Machine

A Allow sending emil ntifications

SHTPserver [poficedtBean ]
Fort [ Enable SSL
[Sessson Recoong et Ssen |
stt-no-reply @outiook.com
Emal body

[ User name

7] Domain name

A Serttime

[ Delivery group.

2 Application

(VDA Machine

[ Recording URL

- x

Loggng RBAC Emal  Cou <[

Note:

If you select more than two options in the Email title section, a warning dialog ap-
pears, saying that the email subject might be too long. After you select Allow sending
email notifications and click Apply, Session Recording sends an email to verify your
email settings. If any setting is incorrect, for example, an incorrect password or port,

Session Recording returns an error message with the error details.

Vahdation Error

*

The email account can't send message successfully, please

chedk your configuration.

The SMTP server requires a secure connection or the client was
not authenticated. The server response was: 5.7.57 SMTP:
Client was not authenticated to send anonymowus mail during
MAIL FROM [BN3PRO3CAQDT2. namprdD3.prod.outlook.com]

Your email settings need about five minutes to take effect. To have your email set-
tings take effect immediately or fix the issue that emails are not sent according to the
settings, restart the Storage Manager (CitrixSsRecStorageManager) service.
Also, restart the Storage Manager service if you upgrade to the current release from

Version 2006 and earlier.

c) Edit the registry for accessing the web player.

To make the playback URLs in your alert emails work as expected, browse to the registry
key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server and
do the following:

« Set the value data of LinkHost to the URL of the domain that you use to access the
web player. For example, to access a web player at https://example.com/
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webplayer/#/player/, set the value data of LinkHost to https://example

. com.

+ Add a value EmailThreshold, and set its value data to a number in the range of 1

through 100. The value data determines the maximum number of alert emails that

an email sending account sends within a second. This setting helps slow down the

number of emails that are being sent and thus reduces the CPU usage. If you leave

the value data unspecified or set it to a number out of range, the value data falls back

to 25.
Note:

« Your email server might treat an email sending account as a spam bot and thus

prevent it from sending emails. Before an account is allowed to send emails, an

email client such as Outlook might request you to verify that the account is used

by a human user.

+ Thereis a limit for sending emails within a given period. For example, when the

daily limitis reached, you cannot send emails until the start of the next day. In this

case, ensure that the limit is more than the number of sessions being recorded

within the period.

8. (Optional) Configure event triggers and responses.

After you select Trigger response actions when a session event is detected, the Configure

event triggers and responses button becomes available. Click it to specify logged events that

can trigger the following response actions:

« Send email alerts

« Start screen recording immediately
+ Lock session

+ Log off session

« Disconnect session

Event Triggers

Dimension 1 Dimension 2

Eventtypeis | Web Browsing < [ang [URL | Inciudes and | Tab thle

Orevertypeis | Top Mest |and | App name | Includes

Oreverttypais | Fls Renams ~Jand | Path < Inciudes

Oreverttypels | File Delete v |and [Path | Includes

O everi typeis L PRIIIIN ~ 0 Fie source v | Epis
<+ [ana

and | Window title
and |Name

and | File size (MB)

and

<J<l<]<]<]<

~ | Greaterth...

Includes
Includes
Includes

Includes

sion oper
~ then Disconnect sessi
~ then [m} Start screen rec
~ then [m} Log off session
< then O Lack session

~ then O

Confim

Cancel

Note:

If your system language is German, French, or Spanish, ensure that the horizontal reso-

lution of your machine is equal to or larger than 1,700 pixels. Otherwise, text truncation
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occurs and thus the columns of the Event Triggers table are not displayed completely.

You must select the event types that the active event detection policy logs. Click Confirm

when you are finished.

Select event types from the drop-down list and set event rules through the two dimensions
that are combined using the logical AND operator. You can set up to seven event triggers for
each policy rule. You can also define your event triggers in the Description column or leave
the column empty. Your defined description of an event trigger is provided in the alert emails
if you have Send email selected and events of the type are logged. If you have Start screen
recording selected, dynamic screen recording automatically starts when certain events occur
during an event-only recording. You can enable lossy screen recording and set the time spans
for dynamic screen recording:

B Rules Wizard =

_Sl.ep 1-1: Select one or more of the lollowing oplions.

[ Emadl alert when a session stat i detected
[ Trgger response actens when a sesson event is detecied

Configure event inggers and responses

Step 1-2: Enter email addresses for the alert recipients
Emad recisents:

e amall A0gresias w0 Wil MECEVE JRaTS AOCOMINg 10 S . Saparae e A0Oresses will) & SSTscoi

Step 1-3: Set paramet ers for dynamic screen recording.
Screen recording time span sfer we deled an evert
..J-.'}Jn.mmab;w i L [0 necord the screen afier we dfect an event 7

Sereen recording lime span before we detect an avert
.%M'mma‘mmwm;wwnwmimm we detect an evers ?

Tirmee interval between a session operation notice and its execution (avaiable for sesson ook, log off, and dscornection)
.wam'mwwywwmwmwamw:m afer we s the notice 7

[] Erable krswy scresn recondng

+ Screen recording time span after we detect an event: You can configure how many min-
utes you want to record the screen after events are detected. If you leave the value unspec-
ified, screen recording continues until the recorded sessions end.

+ Screen recording time span before we detect an event: You can configure how many
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seconds of the screen recording you want to keep before events are detected. This feature
is available for both virtual desktop and app sessions. The value ranges from 1 to 120.
Setting the value to any of 1 through 10 makes the value 10 effective. If you leave the value
unspecified, the feature does not take effect. The actual length of the screen recording
that Session Recording keeps might be a little longer than your configuration.

« If you specify any of the following actions in response to logged events in recorded ses-
sions, you can notify users of the actions by filling the Time interval between a session
operation notice and its execution field:

- Lock session
- Log off session
- Disconnect session

Note:
The field value is 0 by default, which means users are not notified when you lock, log

off, or disconnect them from their virtual sessions. To notify users, set an appropriate
field value.

For an example notice, see the following screen capture:

Session Recording

For security, your session will be disconnected in 30 seconds. Please contact your system
administrator.

Reason:

You moved the file "ClipboardOperation.PNG" from C:\Test to C:\Program Files\Citrix
\SessionRecording\Agent\Bin\en on Thursday, January 12, 2023 at 1:39 AM.

« Enable Lossy screen recording: Lossy screen recording lets you adjust compression op-
tions to reduce the size of recording files and to accelerate navigating recorded sessions
during playback. For more information, see Enable or disable lossy screen recording.

For a complete list of supported event types, see the following table.

Event type Dimension Option
App Start
App name Includes, Equals, Matches
Full command line Includes, Equals, Matches
App End
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Event type

Top Most

Web Browsing

File Create

File Rename

File Move

File Delete

CDM USB

Generic USB

Idle

Dimension

App name

App name
Windows title

URL
Tab title

Browser name

Path
File size (MB)

Path

Name

Source path

Destination path

File size (MB)

Path
File size (MB)

Drive letter

Device name

idle duration (Hrs)

Option

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches
Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Greater than, Between, Smaller
than

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches
Includes, Equals, Matches
Greater than, Between, Smaller
than

Includes, Equals, Matches
Greater than, Between, Smaller

than

Equals

Includes, Equals, Matches

Greater than
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Event type

File Transfer

Registry Create

Registry Delete

Registry Set Value

Registry Delete Value

Registry Rename

User Account Modification

Unexpected App Exit

App Not Responding

New App Installed

App Uninstalled

RDP Connection

Popup Window

Dimension

File source

File size (MB)

File name

Key name

Key name

Key name

Value name

Key name

Value name

Key name

User name

App name

App name

App name

App name

IP address

Option

Equals (“host”or “client”)

Greater than

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches

Includes, Equals, Matches
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Event type Dimension Option
Process name Includes, Matches
Window content Includes, Equals, Matches

Performance Data

CPU usage (%) Greater than
Memory usage (%) Greater than
Net send (MB) Greater than
Net receive (MB) Greater than
RTT (ms) Greater than
Clipboard Operation
Data type Equals (Text, File, Bitmap)
Process name Includes, Equals, Matches
Content Includes, Equals, Matches

9. Click Next to select and edit the rule criteria.

C 4

Step 2: Select the rule criteria.

Users or Groups

Published Applications or Desktop
Delivery Groups or Machines

IP Address or IP Range

Filter

Step 3: Edit the rule criteria.

Selecting a rule criterion above activates the option here. To edit, click the underlined value.

Users / Groups: Select Users or Groups

Published Resources: Select Published Applications or Desktop.
Delivery Groups / Machines: Select Delivery Groups or Machines.
IP Address / |P Range: Select |P Address or IP Range

Filter: Specify Tags

<o ==

+ Users or Groups. Creates a list of users or groups to which the rule applies.

 Published Applications or Desktop. Creates a list of published applications or desktops

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 213



Session Recording 2407

to which the rule applies.

« Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the
rule applies.

+ IPAddressorIP Range. Createsallistof IPaddresses orranges of IP addresses to which the
rule applies. The IP addresses mentioned here are the IP addresses of the Citrix Workspace
apps.

« Filter. Creates a list of smart access tags to which the rule applies. You can configure

contextual access (smart access) using smart access policies on Citrix NetScaler.

B Specify Tags X

Enter custom tags separated by commas:

OK Cancel

Contextual access (smart access) is available for Session Recording 2402 and later. It
lets you apply policies based on the user access context including:

The user’s location

IP address range

Delivery group

Device type
Installed applications

Note:

When a session or an event meets more than one rule in a single event response policy, the
oldest rule takes effect.

10. Follow the wizard to complete the configuration.

11. Activate the new event response policy.

High availability and load balancing

June 21,2024

This section guides you through the following settings:

+ Load balance Session Recording servers
» Configure database high availability
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Load balance Session Recording servers

June 21,2024

Session Recording supports load balancing across Session Recording servers. This article summa-
rizes the load balancing configuration using the Citrix ADC as an example. For more information, see
Configure load balancing in an existing deployment and Deploy and load balance Session Recording
in Azure.

You can synchronize load balancing configurations among all Session Recording servers.
Note:

The load balancing feature requires Version 7.16 or later of the Session Recording server and
Session Recording agent.

Changes to Session Recording in support of load balancing:

+ All Session Recording servers share one folder to store recording files.

+ All Session Recording servers share one Session Recording Database.

+ (Recommended) Install only one Session Recording policy console and all Session Recording
servers share this console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording
components:

Configure load balancing (Citrix ADC part)

Configure load balancing servers Add the Session Recording servers to the load balancing
servers in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.

Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and
bind the virtual servers to the relevant load balancing services.
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2.
3.

Configure persistence on each virtual server.
(Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method
rather than the default method (LEASTCONNECTION).

4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording server, do the following

1.

(Recommended) Type the same Session Recording Database name during the Session Record-
ing server installation.

If you choose the Administrator Logging feature, we recommend you type the same Administra-
tor Logging Database name when you install each Session Recording server.

Share the Read/Write permission of the file storage folder with all Session Recording server ma-
chine accounts. After that, change to use the file storage folder as the shared folder in Ses-
sion Recording Server Properties. For more information, see Specify where recordings are
restored.

Add a value to the Session Recording server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.

Value name: EnableLB

Value data: 1 (DWORD, meaning enable)

If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager
message queue, create a host record for the Citrix ADC VIP address and add redirections in
C:\Windows\System32\msmqg\Mapping\sample_map. After that, restart the Message
Queuing service.

The redirection is similar to:

<redirections xmlns="msmg-queue-redirections.xml">
<redirection>
<from>http://<ADCHost>*/msmq/private$/
CitrixSmAudData</from>
<to>http://<LocalFgdn>/msmq/privates$/
CitrixSmAudData</to>
</redirection>
<redirection>
<from>https://<ADCHost>*/msmq/private$/
CitrixSmAudData</from>
<to>https://<LocalFqdn>/msmq/private$/
CitrixSmAudData</to>
</redirection>
</redirections>
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Where <ADCHost> is the created FQDN of the Citrix ADC VIP address, and <LocalFqdn> is the
FQDN of the local host.

6. (Recommended) After configuring one Session Recording server registry, you can use the
<Session Recording Server installation path>\Scripts\SrServerConfigurationSync.ps1
script to export configurations from this server registry and import the registry to the other
Session Recording server registries. You can also use the SrServerConfigurationSync.psl
script to add redirection mapping for message queuing.

a) On one Session Recording server, after configuring the EnableLB registry value, start a
command prompt as an administrator and run the powershell.exe -file SrServerCon-
figurationSync.ps1 —Action Export,AddRedirection ~ADCHost <ADCHost> command,
where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

b) Afterthe script runs, an exported registry file named SrServerConfig.reg is generated and
an sr_lb_map.xmlfile is added to the C:\Windows\System32\msmq\Mapping path.

¢) On other Session Recording servers, copy SrServerConfig.reg generated in the preced-
ing step, start a command prompt as an administrator, and run the powershell.exe -
file SrServerConfigurationSync.ps1 —Action Import,AddRedirection ~ADCHost <AD-
CHost> command, where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

d) After the script runs, the EnableLB value is added to the other Session Recording server
registry keysand an sr_lb_map.xmlfileisadded to the C:\Windows\System32\msmq\Mapping
path.

On the machine where you installed the Session Recording agent, do the following in Session
Recording Agent Properties

+ If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager mes-
sage queue, type the FQDN of the Citrix ADC VIP address in the Session Recording Server text
box.

« If you choose the default TCP protocol for the Session Recording Storage Manager message
queue, type the Citrix ADC VIP address in the Session Recording Server text box.

On the machine where you installed the Session Recording Player, do the following Add the
Citrix ADC VIP address or its FQDN as the connected Session Recording server.

On the SQL Server where you installed the Session Recording Database, do the following Add
all the Session Recording server machine accounts to the shared Session Recording Database and
assign them with the db_owner permission.
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Configure database high availability

July 4,2024

Session Recording does not function as expected if the Session Recording database is stopped orin a
state of failure. If the Session Recording Administrator Logging database is stopped or experiencing
failure, the administrator logging feature becomes unavailable and this prevents you from being able
to modify policies or change server properties when mandatory blocking is enabled. Therefore, it is
advisable to implement a high availability (HA) mode for the databases.

Session Recording supports the following solutions for database high availability based on the Mi-
crosoft SQL Server. Databases can automatically fail over when the hardware or software of a princi-
pal or primary SQL Server fails.

«+ Always On availability groups

The Always On availability groups feature is a high availability and disaster-recovery solution
that provides an enterprise-level alternative to database mirroring. It maximizes the availability
of a set of user databases for an enterprise. It requires that the SQL Server instances reside on
the Windows Server Failover Clustering (WSFC) nodes. For more information, see Always On
availability groups: a high-availability and disaster-recovery solution.

+ SQL Server clustering

The Microsoft SQL clustering technology allows one server to automatically take over the tasks
and responsibilities of the server that has failed. However, setting up this solution is compli-
cated and the automatic failover is typically slower than alternatives such as SQL Server data-
base mirroring. For more information, see Always On Failover Cluster Instances (SQL Server).

+ SQL Server database mirroring

Database mirroring ensures that an automatic failover occurs in seconds if the active database
serverfails. This solutionis more expensive than the other two solutions because full SQL Server
licenses are required on each database server. You cannot use the SQL Server Express edition
in a mirrored environment. For more information, see Database Mirroring (SQL Server).

Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:

+ Install the Session Recording Server components first and then configure database high avail-
ability for the created databases.
You caninstall the Session Recording Administration components with databases configured to
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be installed on the prepared SQL Server instance. Then, configure database high availability for
the created databases.

- For Always On availability groups and clustering, change the SQL Server instance
name to the name of the availability group listener or SQL Server network through
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaseln

- Fordatabase mirroring, add the failover partners for databases through HKEY _LOCAL_MACHINE
\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner
and HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server)
LoggingDatabaseFailoverPartner.

+ Configure database high availability for empty databases first and then install the Session
Recording Administration components.
You can create two empty databases as the Session Recording Database and the Administrator
Logging Database in the expected primary SQL Server instance and configure high availability.
Then enter the SQL Server instance name when installing the Session Recording Server
components:

- Tousethe Always On availability groups solution, enter the name of your availability group
listener.

- To use the database mirroring solution, enter the name of your principal SQL Server.
- To use the clustering solution, enter the network name of your SQL Server.

View recordings

June 21,2024

Use the Session Recording player or the Session Recording web player to view, search, and bookmark
recorded sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in
progress, with a delay of 1-2 seconds.

Sessions that have a longer duration or larger file size than the limits configured appear in more than
one session file.

Note:

Grant users the right to access the recorded sessions of VDAs.
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Session Recording player

June 21, 2024

The Session Recording player is a user interface that you access from a workstation to play

recorded session files. This section provides instructions for you to:

Launch the Session Recording player
Enable or disable live session playback
Enable or disable playback protection
Search for recordings

Open and play recordings

Cache recordings

Highlight idle periods

Use events and bookmarks

Launch the Session Recording Player

June 21, 2024

Launch the Session Recording player

Note:

« If a recording contains blocked content, Session Recording skips it. However, if you navi-
gate to the blocked period, your playback shows a black screen and a message indicating
that that content is blocked. To use this feature, use Session Recording 2012 and later.

+ Ifyou are using the Session Recording player 2009 and earlier to play back a recording, the
following error message appears. The web player is not impacted.

Error Playing File >

The recorded session file requires a newer version of the
Session Recording Player for playback,
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« If playback justification logging is enabled, each time you play a recording, a dialog box
appears, asking you to enter a playback justification. For more information, see Playback
logging.

1. Log on to the workstation where the Session Recording player is installed.

2. From the Start menu, choose Session Recording Player. The Session Recording player ap-
pears.

Tip:

« To customize columns to display, right-click the table header.
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» The Audio Recording column indicates whether audio in the recorded session is avail-
able during playback.

« The EventOnly column indicates a screen recording or an event-only recording.

The following screen capture shows an example of an event-only recording being
played in the Session Recording Player. All events are present in the Events and
Bookmarks panel and show as yellow dots in the lower part of the Session Recording
Player.
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« To show all recording files of a recorded session, right-click a recording on the list and

choose Follow up.
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Display or hide window elements

The Session Recording player has window elements that toggle on and off.
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Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose View.

Choose the elements that you want to display. Selecting an element causes it to appear imme-
diately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

You can set up your Session Recording player to connect to multiple Session Recording servers and
then select a Session Recording server that it connects to. The Session Recording player can connect
to only one Session Recording Server at a time.

> wnh

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Connections.
Select the Session Recording server to which you want to connect.

Enable or disable live session playback

June 21,2024

If sessions are recorded with the live playback feature enabled, you can view a session after or while
it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening
live. However, there is actually a delay of 1-2 seconds when the data propagates from the VDA.

Some functionality is not available when you view live playback sessions:

+ You can’t assign a digital signature or view the certificate until the recording is completed.

+ Playback protection can’t be applied until recording is complete. If playback protection is en-

abled, you can view live playback sessions. But they are not encrypted until the session is com-
pleted.

+ You can’t cache a file until the recording is completed.

By default, live session playback is enabled.

H W

Log on to the computer hosting the Session Recording server.

From the Start menu, choose Session Recording Server Properties.
In Session Recording Server Properties, click the Playback tab.
Select or clear the Allow live session playback check box.
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Enable or disable playback protection

June 21,2024

As a security precaution, Session Recording automatically encrypts recorded files that are down-
loaded for viewing in the player. Encrypted files can’t be copied or played on another workstation
or by another user. Encrypted files are identified with an .icle extension. Unencrypted files are
identified with an . i c’L extension. The files remain encrypted while they residein %localAppData
%\Citrix\SessionRecording\Player\Cache on the player until an authorized user opens
them.

We recommend that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Logon to the machine hosting the Session Recording Server.

2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Playback tab.

4. Select or clear the Encrypt session recording files downloaded for playback check box.

Search for recordings

June 21, 2024

The Session Recording player allows you to perform quick and advanced searches and to specify op-
tions that apply to all searches. Results of searches appear in the search results area of the Session
Recording player.

Note:

The player installation typically lets you set up a connection between the Session Recording
player and a Session Recording server. If you fail to set up the connection, you are prompted

to do so the first time you perform a search for files.

To display all available recorded sessions, up to the maximum number of sessions that might
appear in a search, perform a search without specifying any search parameters.
Perform a quick search

1. Log on to the workstation where the Session Recording player is installed.
2. From the Start menu, choose Session Recording Player.
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3.

4,

Define your search criteria:

+ Enter a search criterion in the Search field.

« Move the mouse pointer over the Search label to display a list of parameters to use as a
guideline.

« Click the arrow to the right of the Search field to display the text for the last 64 searches
you performed.

+ Use the drop-down list to the right of the Search field to select a period or duration speci-
fying when the session was recorded.

Click the binocular icon to the right of the drop-down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 enti-

ties. Citrix recommends using more accurate search conditions such as a date range or user to reduce

the result number.

1.

2.

3.

Log on to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.

In the Session Recording Player window, click Advanced Search on the tool bar or choose
Tools > Advanced Search.

Define your search criteria on the tabs of the Advanced Search dialog box:

« Common allows you to search by domain or account authority, site, group, VDA for multi-
session 0OS, application, or file ID.

+ Date/Time allows you to search date, day of week, and time of day.

+ Events allows you to search for Citrix-defined and custom events that are inserted to the
sessions.

+ Other allows you to search by session name, client name, client address, and recording
duration. It also allows you to specify, for this search, the maximum number of search
results displayed and whether archived files are included in the search.

When you specify search criteria, the query you are creating appears in the pane at the
bottom of the dialog box.

Click Search to start the search.

You can save and retrieve advanced search queries. Click Save in the Advanced Search dialog
box to save the current query. Click Open in the Advanced Search dialog box to retrieve a saved
query. Queries are saved as files with an . 7 sq extension.
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Set search options

The Session Recording player search options allow you to limit the maximum number of session
recordings that appear in search results and to specify whether search results include archived

session files.

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Search.

In the Maximum result to display field, type the number of search results you want to display.

> wnN e

A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear Include archived files.

Place access restrictions on recordings

June 21,2024

You place access restrictions on target recordings in addition to role-based access control through
recording viewing policies. Restricted recordings are accessible only to users and user groups that
are assigned the PrivilegedPlayer role through the Session Recording Authorization Console.

Note:

Placing access restrictions on live recordings is not supported.
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E Session Recording Authorization Console

File  Action View Help
ez 2@ XE = HE

[0 Role Assignments MName Type Description
% LoggingWriter
% LoggingReader
% Player
% PolicyCQuery
% PolicyAdministrator
% PrivilegedPlayer

Assign Users and Groups > From Windows and Active Directory...

View 5 From Authorization Manager...

Delete
Refresh
Export List...

Properties

Help

The following section walks you through the process of placing and removing access restrictions on
target recordings.

=

. Log on to the machine where the Session Recording player is installed.
2. From the Start menu, choose Session Recording Player.

3. Select Search Results in the Workspace pane.

4. Inthe Search Results area, select one or more target recordings.

5. Right-click and select Place access restrictions.

Users and user groups, assigned either the Player or the PrivilegedPlayer role, are allowed
to place access restrictions on recordings. The Restricted menu is available only for users and
user groups assigned the PrivilegedPlayer role.

View for the PrivilegedPlayer role:
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3 Session Recording Player (u] *®
Fle ER Vew Pay Tods Hebp

b 9 [LT <3 Search * Anytime - 53 L) Advanced Search
Workspace % | Search Results x
(53 Workspace - administrator Iser Name Appkcation Status Start Time: Duration  Delivery VDA Machine Recording Ser Size  Access restict

Search Result:

D evate o 3002 1202AM 000027 | AUTO_INSTA.. _ 244KB Mo
Resricted O admnstrator b Pay BA0/2022 1201AM  00:00:35 AUTO_INSTA TISKB Ne

Follow up

Place access restrictions

Now Playing

Events and Bookmarks x

2fies

View for the Player role:

94 Session Recording Player o -
Fle Edt  View Pay
b 9|3 -3 | Advanced Search
x

Start Tume Duration Dedvery Group

8/30/2022 1201 AM  D0:00:35

HNow Playing

Events and Bookmarks

6. Click Yes.

=Y
Fle Ed View Pay Toos Hebp
b @) Satecly v Anytime - 19 [] Advanced Search
Workspace % | Search Results x
orkspace - administrator Jser Name Applcation Status Start Time: Duration 4 VDA Machine Recording Ser. Saze  Access restict
= :::::mh B admnistrator Desktop Complete AUTO_I# 4B Ho
Resricted O admiistrator Desktop Complete AUTO_ TISKB No
Now Playing

Are you sure you want 1o restrict access 1o the selected
recordings? Restricted recordings are accessible only to
privileged players.

Hote: A single recorded session can produce more than one
recording. If you select any recording of a session, the access
restrictions apply 1o all other recordings of the same session.

Events and Bookmarks

2files

7. Verify that the selected recordings on which you placed access restrictions are moved from the
Search Results area to the Restricted area.
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(4 Session Recording Player
Fle Edt View Pay Toos Hebp
@[] » | Seach - Anptime -0 i Advarced Seach
Workspace X  Restricted
B8 Workspace - adminisirator Jser Name Application Status Start Time: Durstion  Delvery Group VDA Machine Recording Ser Sze  Access restict
& Search Resuls 2 000027 AUTO_INSTA 244KB Yes

Favortes

x

B administrator Desktop Complete  8/30/2022 12:02 AM

Now Playing x 5

Events and Bookmarks x

1file

8. Inthe Restricted area, remove access restrictions as needed. With access restrictions removed,
recordings are moved back to the Search Results area.

(3 Session Recording Player - D x
File Edt View Play Tools Help
|3 L - IE Search v Anytime -3 [ Advanced Search
Workspace x || Restricted x
User Name Apphcation Status Start Time Duration Delivery Group VDA Machine Recording Ser Size  Access restict

AUTO_INSTA.. 244KB Yes

Now Playing x ~ N o

Events and Bookmarks x|

1fie

Open and play recordings

June 21,2024

Open recordings

You can open session recordings in the Session Recording player in three ways:

+ Perform a search using the Session Recording player. Recorded sessions that meet the search
criteria appear in the search results area.

« Access recorded session files directly from your local disk drive or a shared drive.

« Access recorded session files from a Favorites folder.
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When you open a file that was recorded without a digital signature, a warning message appears. It
says that the origin and integrity of the file were not verified. If you are confident of the integrity of
the file, click Yes in the warning window to open the file.

If playback justification logging is enabled, each time you play a recording, a dialog box appears, ask-
ing you to enter a playback justification. For more information, see Playback logging.

The Session Recording player checks the Citrix Workspace app version before playing back a recorded
session. If the player doesn’t support the Citrix Workspace app version, an error is returned. To elimi-
nate the error, select Skip Citrix Workspace app version check in Session Recording Server Prop-
erties.

i% Seszion Recording Server Properties - X

Storage Signing Rollover | Playback | Notffications CEIP  Logging RE*|*

Live session playback

This option permits the playback of session recordings while recording is
still in progress.

Allow live session playback

Playback protection

Thiz option encrypts session recording files before download to the
Session Player. This prevents session recordings from being copied and
viewed by users other than the user that oniginally downloaded the file.

Encrypt session recording files downloaded for playback

Citrix Workspace app version check

This option allows users to skip the Citrix \Workspace app version check
before the Session Recording Flayer plays back a recording.

Skip Citrix Workspace app version check before playback

Cancel Aoy
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Note:

The Administrator Logging feature of Session Recording allows you to log the downloads of
recordings in the Session Recording player. For more information, see Administrator Logging.

Open a recording in the search results area

Log on to the machine where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

Perform a search.

If the search results area is not visible, select Search Results in the Workspace pane.
In the search results area, select the session you want to play.

ok~ w N

Do any of the following:

» Double-click the session.
+ Right-click and select Play.
« From the Session Recording Player menu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recording file begins with 1 _, followed by a unique alphanumeric file ID and then the
.iclor.icleextension. The .1icl extension denotes the recordings without playback protection
applied. The .1cle extension denotes the recordings with playback protection applied. Recorded
session files are saved in a folder that incorporates the date the sessions were recorded. For example,
the file for a session recorded on December 22, 2014, is saved in the folder path 2014\ 12\ 22.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Start menu, choose Session Recording Player.
3. Do any of the following:

« From the Session Recording Player menu bar, choose File > Open and browse for the file.
+ Using Windows Explorer, navigate to the file and drag the file to the Player window.
« Using Windows Explorer, navigate to and double-click the file.

If you created Favorites in the Workspace pane, select Favorites and open the file from the
Favorites area in the same way you open files from the search results area.

Use favorites

Creating the Favorites folders allows you to quickly access recordings that you view frequently. These
Favorites folders reference recorded session files that are stored on your workstation or on a network
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drive. You can import and export these files to other workstations and share these folders with other
Session Recording player users.

Note:

Only users with access rights to the Session Recording player can download the recorded session
files associated with the Favorites folders. Contact your Session Recording administrator for the

access rights.

To create a Favorites subfolder:

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

In the Session Recording Player window, select the Favorites folder in your Workspace pane.
From the menu bar, choose File > Folder > New Folder. A new folder appears under the Fa-

> wnh e

vorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Folder menu to delete, rename, move, copy, import,
and export the folders.

Play recordings

After you open a recorded session in the Session Recording player, you can navigate through the
recorded sessions using these methods:

+ Use the player controls to play, stop, pause, and increase or decrease playback speed.
+ Use the seek slider to move forward or backward.

You can also navigate through the recorded session by going to the inserted markers and custom

events.

Note:

+ During playback of a recorded session, a second mouse pointer might appear. The second
pointer appears at the point in the recording when the user navigated within Internet Ex-
plorer and clicked an image that was originally larger than the screen but was scaled down
automatically by Internet Explorer. While only one pointer appears during the session, two
might appear during playback.

« This version of Session Recording doesn’t support SpeedScreen Multimedia Acceleration
and the Flash quality adjustment policy setting. When this option is enabled, playback dis-
plays a black square.
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+ Whenyou record a session with aresolution higherthan orequal to 4096 x 4096, there might
be fragments in the recording appearance.

Use the player controls

You can click the player controls in the lower part of the player window or access them by choosing
Play from the Session Recording Player menu bar.

Player Control Function

Plays the selected session file.

Pauses playback.

Stops playback. If you click Stop, then Play, the
recording restarts at the beginning of the file.

[£]

Halves the current playback speed down to a
minimum of one-quarter of the normal speed.

¥l

Doubles the current playback speed up to a
maximum of 32 times the normal speed.

Use the seek slider

Use the seek slider in the lower part of the player window to jump to a different position within the
recorded session. You can drag the seek slider to the point in the recording you want to view or click
anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

Keyboard Key Function

Home Seeks to the beginning.

End Seeks to the end.

Right Arrow Seeks forward five seconds.
Left Arrow Seeks backward five seconds.
Move the mouse wheel one notch down Seeks forward 15 seconds.
Move the mouse wheel one notch up Seeks backward 15 seconds.
Ctrl + Right Arrow Seeks forward 30 seconds.
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Keyboard Key Function

Ctrl + Left Arrow Seeks backward 30 seconds.
Page Down Seeks forward one minute.
Page Up Seeks backward one minute.
Ctrl + Move the mouse wheel one notch down Seeks forward 90 seconds.
Ctrl + Move the mouse wheel one notch up Seeks backward 90 seconds.
Ctrl + Page Down Seeks forward six minutes.
Ctrl+ Page Up Seeks backward six minutes.

To adjust the speed of the seek slider: From the Session Recording Player menu bar, choose Tools >
Options > Player and dragthe slider to increase or decrease the seek response time. Afaster response
time requires more memory. The response might be slow depending on the size of the recordings and
your machine’s hardware.

Change the playback speed

You can set a playback speed in exponential increments from one-quarter normal playback speed to
32 times normal playback speed.

Log on to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.
From the Session Recording Player menu bar, choose Play > Play Speed.

> wn e

Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the
lower part of the player window.

Highlight the idle periods of recorded sessions

Idle periods of a recorded session are the portions in which no action takes place. The Session Record-
ing player can highlight the idle periods of recorded sessions during playback. The option is On by
default. For more information, see Highlight idle periods.

Skip over spaces where no action occurred

Fast review mode allows you to set the player to skip the portions of recorded sessions where no
action takes place. This setting saves time for playback viewing. However, it doesn’t skip animated
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sequences such as animated mouse pointers, flashing cursors, or displayed clocks with second hand

movements.

1.
2.
3.

Log on to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.
From the Session Recording Player menu bar, choose Play > Fast Review Mode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the player

window.

Change the playback display

You can do the folloing to change how recorded sessions appear in the player window:

« Pan and scale the image.

« Show playback in full screen

« Display the player window in a separate window

« Display a red border around the recorded session to differentiate it from the player window

background.

Display the player window in full screen

1.
2.
3.
4,

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose View > Player Full Screen.
To return to the original size, press Esc or F11.

Display the player window in a separate window

1.
2.
3.

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose View > Player in Separate Window. A
new window appears, containing the player window. You can drag and resize the window.

To embed the player window in the main window, choose View > Player in Separate Window,
or press F10.

Scale the session playback to fit the Player window

1. Log on to the workstation where the Session Recording player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Scale to

Fit.
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+ Scale to Fit (Fast Rendering) shrinks images while providing good quality. Images are
drawn quicker than using the High Quality option but the images and texts are not sharp.
Use this option if you are experiencing performance issues when using the High Quality
mode.

« Scale to Fit (High Quality) shrinks images while providing high quality. Using this option
can cause the images to be drawn more slowly than the Fast Rendering option.

Pan the image

1. Log on to the workstation where the Session Recording player is installed.

2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Panning.
The pointer changes to a hand. And a small representation of the screen appears in the top right
of the player window.

4. Dragtheimage. The small representation indicates where you are in the image.

5. To stop panning, choose one of the scaling options.

Display a red border around Session Recording

1. Logon to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.
From the Session Recording Player menu bar, choose Tools > Options > Player.

> W

Select the Show border around session recording check box.
If the Show border around session recording check box is not selected, you can temporarily
view the red border by clicking and holding down the left mouse button while the pointeris in

the player window.

Cache recordings

June 21,2024

Each time you open a recorded session file, the Session Recording player downloads the file from the
location where the recordings are stored. If you download the same files frequently, you can save
download time by caching the files on your workstation. Cached files are stored on your workstation
in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache

You can specify how much disk space is used for the cache. When the recordings fill the specified disk
space, Session Recording deletes the oldest, least used recordings to make room for new recordings.
You can empty the cache at any time to free up disk space.
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Enable caching

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Cache.
Select the Cache downloaded files on local machine check box.

ok wbh e

To limit the amount of disk space used for caching, select the Limit amount of disk space to
use check box and specify the number of MB to be used for cache.
6. Click OK.

Empty caches

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Cache.
Select the Cache downloaded files on local machine check box.

In the Session Recording player, choose Tools > Options > Cache.

S o

Click Purge Cache and OK to confirm the action.

Highlight idle periods

June 21, 2024

Idle periods of a recorded session are the portions in which no action takes place. The Session Record-
ing player can highlight the idle periods of recorded sessions during playback. The option is On by
default.

Note: Idle periods are not highlighted when playing back live sessions with the Session Recording
player.

To highlight the idle periods of recorded sessions, do the following:

1. Logon to the workstation where the Session Recording player is installed.

2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose View > Idle Periods and select or clear
the check box.
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Use events and bookmarks

June 21,2024
You can use events and bookmarks to help you navigate through recorded sessions.

Citrix-defined events are inserted to sessions while the sessions are recorded. You can also use the
Event APl and a third-party application to insert custom events. Events are saved as part of the session
file. You cannot delete or alter them using the Session Recording player.

Bookmarks are markers that you insert in a recorded session during session playback using the
Session Recording player. After insertion, bookmarks are associated with the recorded session
until you delete them. However, they are not saved as part of the session file but stored as sep-
arate .1iclb files in the Bookmarks cache folder on the Session Recording player, for example,
C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same
file name as the . icl recording file. To play back a recording using bookmarks on a different player,
copy the .1iclb files to the Bookmarks cache folder on that player. By default, each bookmark is
labeled with the text “Bookmark,”but you can change it to any text annotation up to 128 characters
long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the player
window. Moving the mouse over the dots and squares displays the text label associated with them.
You can also display the events and bookmarks in the Events and Bookmarks list of the Session
Recording player. They appear in this list with their text labels and the times in the recorded session
at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an
event or bookmark, you can skip to the pointin the recorded session where the event or bookmark is
inserted.

Display events and bookmarks in the list

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session
thatis currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording player is installed.

2. From the Start menu, choose Session Recording Player.

3. Move the mouse pointer to the Events and Bookmarks list area and right-click to display the
menu.

4. Choose Show Events Only, Show Bookmarks Only, or Show All.
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Insert a bookmark

SANE A R

Log on to the workstation where the Session Recording player is installed.

From the Start menu, choose Session Recording Player.

Begin playing the recorded session to which you want to add a bookmark.

Move the seek slider to the position where you want to insert the bookmark.

Move the mouse pointer to the player window area and right-click to display the menu.
Add a bookmark with the default Bookmark label or create an annotation:

» To add a bookmark with the default Bookmark label, choose Add Bookmark.

« To add a bookmark with a descriptive text label that you create, choose Add Annotation.

Type the text label that you want to assign to the bookmark, up to 128 characters. C
OK.

Add or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.

N o~ DN

Log on to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.

Begin playing the recorded session containing the bookmark.

Ensure that the Events and Bookmarks list is displaying bookmarks.

lick

Select the bookmark in the Events and Bookmarks list and right-click to display the menu.

Choose Edit Annotation.
In the window that appears, type the new annotation and click OK.

Delete a bookmark

A A

Log on to the workstation where the Session Recording player is installed.
From the Start menu, choose Session Recording Player.

Begin playing the recorded session containing the bookmark.

Ensure that the Events and Bookmarks list is displaying bookmarks.

Select the bookmark in the Events and Bookmarks list and right-click to display the menu.

Choose Delete.

Go to an event or bookmark

Going to an event or bookmark causes the Session Recording player to go to the point in the recorded

session where the event or bookmark is inserted.

1.

Log on to the workstation where the Session Recording player is installed.
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2. From the Start menu, choose Session Recording Player.
3. Begin playing a session recording containing events or bookmarks.
4. Goto an event or bookmark:

+ In the lower part of the player window, click the dot or square representing the event or
bookmark to go to the event or bookmark.

« In the Events and Bookmarks list, double-click the event or bookmark to go to it. To go
to the next event or bookmark, select any event or bookmark from the list, right-click to
display the menu, and choose Seek to Bookmark.

Session Recording web player

June 21,2024

The web player lets you use a web browser to view and play back recorded sessions. Using the web
player, you can:

« Search for recordings by using filters.

« View and play back both live and completed recordings with tagged events listed in the right
pane.

« configure cache memory for storing recordings during playback.

+ Highlight idle periods.

+ Leave comments about a recording and set a severity for each comment.
+ Share URLs of recordings.

+ View graphical event statistics for each recording.

« View data points related to each recorded session.

Access the web player

June 21,2024

The URL of the web player website is http(s) :
. To ensure the use of HTTPS, add an SSL binding to the website in 1IS and update the
SsRecWebSocketServer.config configuration file.
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Note:

+ When logging on to the web player website, domain users do not need to enter credentials
while non-domain users must.

+ Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

+ To have the web player function properly, make sure you enable WebGL in Firefox.

This article guides you through the process of installing and enabling the web player and the process
of configuring HTTPS.

Install the web player

Install the web player on the Session Recording server only. Double-click SessionRecordingWeb-
Player.msi and follow the instructions to complete your installation. For more information about
installing Session Recording, see Install, upgrade, and uninstall.

Starting from Version 2103, Session Recording migrates the WebSocket server to 1IS. With the web

player installed, the SessionRecordingRestApiService, SessionRecordingWebStreaming, and
WebPlayer applications appearin IIS.

€3 Internet Information Services (1IS) Manager
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€S- i 23 ’ Manage Server
N Start Page Filter: - % Go - G ShowAll | Groupby: Area -E- o Restart
v& ) T T recTTTToT T rcTTrOST e Ty TogEs T >
L2 Application Pools C Pages Levels Settings Strings Controls ” =
v (8] Sites .
v € Default Web Site fl\’ﬂ g,- = i
2] aspnet_client Providers  Session State SMTP E-mail
9 MsMQ
P SessionRecordingBroker
P SessionRecordinglLogging IS - ~ °
9 SessionRecordingloggingWebApplicat @ ~2 cer a ) & Y F’H &
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3 SessionRecordingWebStreaming ASP  Authentic... CGl  Compression Default  Directory ErorPages  Failed FastCGl
P WebPlayer Document  Browsing Request Tra...  Settings
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Request | Sever | Worker
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Management
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.

Ready -]

Afresh installation of Session Recording 2103 and later connects your web browser to the WebSocket
server hosted in IIS when you access the web player website. The WebSocket server hosted in IIS is
versioned 2.0, as indicated by the registry value WebSocketServerVersion under the registry key at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 241


https://docs.citrix.com/en-us/session-recording/current-release/install-upgrade-uninstall.html

Session Recording 2407

[ Registry Editor — X
File Edit View Favorites Help

Computer\HKEY_LOCAL MACHINE\SOFTWARE\Citrix\SmartAuditor\Server
v | SOFTWARE A || Name Type Data "
7-Zip ab| DatabaseFailoverPartner REG_SZ
Business Objects ab| DatabaseName REG_SZ CitrixSessionRecording2
v Citrix 2| DeferredHashCalcFileSizeThreshold REG_DWORD 0x00200000 (2097152)
Citrix Desktop Delivery Controller || 2 pormantTimelnHours REG_DWORD 0x00000030 (48)
InstallAgent 24| EnableAnalytics REG_DWORD 0x00000001 (1)
Meta'"S‘ﬂ'_' 4| EnableAzureSQLService REG_DWORD 0x00000000 (0)
v SmartAuditor 4| EnableRecordingActionLogging REG_DWORD 0x00000001 (1)
Seivel 4| EnableSRStoragelogging REG_DWORD 0x00000001 (1)
kt
ier‘?es‘ °p 4| EnableWebBasedSrPlayer REG_DWORD 0x00000001 (1)
enoos 28] LinkEmail REG S7
XenToolsinstaller B LinkExpi REG_SZ 1728000000000
ab)Lin
XenToolsNetSettings iniexpire -
a5 LinkHost REG_SZ
Classes linksal wood
Cionts & Linksalt . REG_SZ 20d974
DefaultUserEnvironment #|LoggingBlockState REG_DWORD 0x00000000 (0)
dotnet ab]| oggingDatabaseFailoverPartner REG_SZ
GitForWindows ab]LoggingDatabaseName REG_SZ CitrixSessionRecordingLogging
Google #|LoggingLoggingState REG_DWORD 0x00000001 (1)
Intel 24 MaxOpenFiles REG_DWORD 0x00002710 (10000)
JavaSoft MaxRolloverFileSizelnMB REG_DWORD 0x0000012¢ (300)
JreMetrics %4 PlaybackProtection REG_DWORD 0x00000001 (1)
Microsoft #4|PlayerUserRBACEnabledKey REG_DWORD 0x00000000 (0)
MorzillaPlugins 25)policyFilePath REG_SZ C:\Program Files\Citrix\SessionRecording\Server\\A...
ODBC $4]PolicyFileRefreshPeriodinSeconds REG_DWORD 0x0000012¢ (300)
OpenSSH #4RoleBasedSecurityEnabled REG_DWORD 0x00000001 (1)
Partner #4RolloverFileSizelnMB REG_DWORD 0x00000032 (50)
Policies #4|RolloverTimelnHours REG_DWORD 0x0000000c (12)
Python 4|SkipReceiverVersionCheck REG_DWORD 0x00000001 (1)
pl
Qualys 25)SmAudDatabaselnstance REG_SZ 10.108.92.40
RegisteredApplications | WebPlayerDisableAllRecordin: REG_DWORD 0x00000000 (0)
y g
Setup ML) WebSocketServerVersion REG_SZ 20
< > v

An upgrade installation from an earlier version to Session Recording 2103 and later connects your web
browser to the Python-based WebSocket server. To connect to the WebSocket server hosted in IIS, run
the <Session Recording server installation path>\Bin\SsRecUtils.exe -enablestreamingservice
command. To connect back to the Python-based WebSocket server, run the <Session Recording
server installation path>\Bin\SsRecUtils.exe - disablestreamingservice command. The Python-
based WebSocket server is versioned 1.0.

Enable the web player

The web player is enabled by default.

« To disable the web player, start a Windows command prompt and run the <Session
Recording Server -installation path>\Bin\SsRecUtils.exe -disablewebplayer
command.

+ To enable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\SsRecUtils.exe —-enablewebplayer
command.

Configure HTTPS

The URL of the web player website is http(s)://<FQDN of Session Recording server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to the website in 1IS and update the
SsRecWebSocketServer.conf1ig configuration file.
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Note:

When logging on to the web player website, domain users do not need to enter credentials while
non-domain users must.

To use HTTPS to access the web player website, complete the following steps:
1. Add an SSL bindingin IIS.

a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).
Note:

Most popular browsers such as Google Chrome and Firefox no longer support the
common name in a Certificate Signing Request (CSR). They enforce Subject Alterna-
tive Name (SAN) in all publicly trusted certificates. To use the web player over HTTPS,
take the following actions accordingly:

« When a single Session Recording Server is in use, update the certificate of the
Session Recording Server to a SAN certificate.
Chrome Firefox
HTTPE

HTTPS HTTRS

g

G
DA _

HITPS

SAN Certificate

=

SR Server

g
&

L1
VDA

« When load balancing is in use, ensure that a SAN certificate is available both on
Citrix ADC and on each Session Recording Server.

© v

Chwome

'
HTTPS HITPS HTTPS HTTPS @
W -n SAN Certiicate

SR Server

ADC (Load Balance)
SAN Certificate

]

]

;
%
i

<
o
=

[
Virtual Server SAN Certificate :
OnHTTPS .

b) On lIS, right-click the website and select Add Bindings. The Site Bindings dialog box ap-
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pears.

c) Click Add in the upper right corner. The Add Site Binding dialog box appears.

d) Select https from the Type list and select your SSL certificate.

Add Site Binding ? *
Type: IP address: Port:
http w |F'|.II Unassigned v| |BD |
httE l
Example: www.contoso.com or marketing.contoso.com
OK Cancel
Add Site Binding ? >
Type: IP address: Port:
https ~ | |All Unassigned v| |-1-'-13 |
Host names;
] Require Server Mame Indication
55L certificate:
Mot selected Select... View...
OK Cancel

e) Click OK.
2. Update the SsRecWebSocketServer.config configuration file.

a) Locate and open the SsRecWebSocketServer.config configuration file.

The SsRecWebSocketServer.config configuration file is typically located in the <
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Session Recording Server dinstallation path>\Bin\ folder.

b) Enable TLS by editing TLSEnable=1 and ignore the ServerPort, SSLCert, and SSLKey
fields.

c) Saveyour changes.

Hide or show content on the web player home page

June 21, 2024

After you log on, the web player home page might hide or show content based on whether the follow-
ing option is selected in Session Recording Server Properties.

& Session Recording Server Properties — X

Motifications CEIP

Hide content on the web player home page

This option prevents the web player home page from displaying any
O content. Recordings can be accessed only by way of their URLs.

« With the option selected, the web player home page hides all content. Recordings can be ac-
cessed only by way of their URLs. Recording URLs are provided in email alerts that are sent to
specified recipients. For information about email alerts, see Configure event response policies.
You can also share recording URLs through the Share Current Playback control on recording
playback pages. See descriptions later in this article.
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CifT1X | Session Recording n

AN

Failed to access Citrix Session Recording

Your account is not authorized to use the Session Recerding Player and the Session Recording web player, or your configuration such as the SSL certificate is not
correct. Contact your IT admin for help.

+ With the option unselected, the web player home page shows content similar to the following
screen capture. Click All Recordings in the left navigation to refresh the page and display new
recordings if there are any. Scroll down the webpage to select recordings to view or use filters
to customize your search results. For live recordings, the Duration column shows Live and the
play button appears green.

CilrIX | Session Recording

(3] Recordings u Host Client Event Events Only Recording Server Durat Acti
Al Recordings o © Fal SERVER B

. 23 SERVER 00:01:57 O

Admiisrator Losging fey 19 SERVER 00:02:28 O

Confeureton . May 14,2021 6:48PM False SERVER 00:00:58 O

May False SERVER 00:00550 O

Faise SERVER 00:0035 O

May 14,2021 6:20PM False SERVER 00:00:41 O

False SERVER 00:02:14 O

False SERVER 00:00:37 O

False SERVER 00:00:31 O

May 14. 2021 2:56 PM Faise SERVER 00:00:40 O

To show all recording files of a recorded session, select a recording on the list and click the Follow up

icon. The Follow up icon is available only when a recording is selected.

CifriX | Session Reqordir

Show all recordings of this

[®] Recordings ~ 5 @ wp
AllRecordings Start Time User Host Client Events Events Only Recording Server Duration Action

@ May 19,2021 5:36 PM Administrator 0 False SERVER Live
Comments v

May 19, 2021 5:23 PM 23 ue SERVER 00:01:57 »)

Administrator Logging v -
May 19,2021 5:20 PM True SERVER 000228 O
Configuration v
~
May 14, 2021 6:48 P pdminstrator 0 Falce SERVER 0000558 )
May 14,2021 6:46 PM Administrator 0 False SERVER 00:00:50 »)
May 14,2021 6:31 PM 0 False SERVER 00:00:35 (>
May 14,2021 6:20 PM 0 Fase SeRVER 0000:41 )

For a description of the recording items, see the following table.
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Item

Start time

User

Host

Client

Events

Events Only

Recording Server

Duration

Search for recordings

June 21,2024

Description

The recording start time. Click the up and down
arrows to list recordings in chronological order.
The user whose session was recorded. Click the
up and down arrows to concentrate recordings
of a user on the list and arrange users in
alphabetical order.

The host name of the VDA where the recorded
session was hosted. Click the up and down
arrows to arrange the VDA host names in
alphabetical order.

The name of the client device where the session
was running. Click the up and down arrows to
arrange the client host names in alphabetical
order.

The quantity of events in the recording. Click the
up and down arrows to arrange recordings on
the list by event quantity.

Indicates a screen recording or an event-only
recording. An event-only recording played in the
web player contains an event statistics pie chart
and histogram. The pie chart and histogram
hold static throughout playback.

The Session Recording Server that processes
recording data sent from VDAs.

The time length of the recording. Click the up
and down arrows to arrange recordings on the
list by time length.
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Search for recordings by using filters

You can search for recordings by using filters in the web player. The available filtersinclude host name,
client name, user name, application, client IP address, event text, event type, and time.

CilrIX | Session Recording

[5] Recordings

All Recordings

March 3, 20211043 AM seRveR 000805 >

False SERVER 00:01:22 »)

False SERVER 00:04:37 »)

False SERVER 00:01:34 )

For example, after you select the host name filter, the following dialog box appears. Type in the host
name (of the VDA where recorded sessions are hosted) and click Search to filter out irrelevant record-
ings and display only the relevant ones.

FILTER m Clear All
| |

You can change to a different filter by clicking the currently selected Host name, as shown in the
following screen capture. All filters are listed after you click Host name. Select a different filter as
needed.

CilTIX | Session Recording

[®] Recordings

All Recordings

User Host Client 3 Events Events Only Recording Server Duration Action

You can also click the + symbol to add filters.

FILTER m Clear All
\ \

For example, you can add the Time filter as shown in the following screen.
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FILTER m Clear All

Host name ~ ‘ ‘

Start date End date

Start Time End time
Duration
At least v Seconds
Start Time User Host Client Events Duration Action
February 9, 2021 5:22 PM gh 5 00:30:07 @

The Time filter consists of recording start date, start time, and duration.

Show all recordings of a session

There are two ways to show all recordings of a session in the Session Recording web player:

Method 1:

Select a recording and click the Follow up button to show all recordings of the recorded session.

Method 2:

Select a recording to play and click View playlist in the upper right corner of the playback page.

Place access restrictions on recordings

June 21, 2024

You place access restrictions on target recordings in addition to role-based access control through
recording viewing policies. Restricted recordings are accessible only to users and user groups that
are assigned the PrivilegedPlayer role through the Session Recording Authorization Console.

Note:

Placing access restrictions on live recordings is not supported.
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& Session Recording Authorization Console

File  Action View Help
ez nFE XE G = &=

[0 Role Assignments MName Type Description
% LoggingWriter
% LoggingReader
% Player
% PolicyCQuery
% PolicyAdministrator
% PrivilegedPlayer

Assign Users and Groups > From Windows and Active Directory...

View 5 From Authorization Manager...

Delete
Refresh
Export List...

Properties

Help

The following section walks you through the process of placing and removing access restrictions on
target recordings.

1. Enter the URL of your web player website in the address bar of a supported browser.
The URL format is http(s)://<FQDN of Session Recording server>/WebPlayer.
Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

2. In the left navigation of the web player page, expand the Recordings menu.

3. Onthe Al Recordings page, select one or more target recordings.

4. Click the Place access restrictions icon on top of the recording list.

Users and user groups, assigned either the Player or the PrivilegedPlayer role, are allowed
to place access restrictions on recordings. The Restricted menu is available only for users and
user groups assigned the PrivilegedPlayer role.

View for the PrivilegedPlayer role:
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€ Session Recordings X+ v = a x

« cC 0 a ] wms w0/ WebPlayer/#/recordings/all » % &% 0 &

[®] Recordings ~ R Folowup (3 Place access restrictions
All Recordings Start Time User Host Client Events Events Only Recording Server Duration Action
Restricted
@ August30,202212:02PM administrator - 0 False AUTO_INSTALL 00:00:27
Comments v
August 30, 2022 12:01 PM administrator 0 False AUTO_INSTALL 00:00:35 @

Administrator Logging v

Configuration v

View for the Player role:

€ Session Recordings x  + v - a8 X
<« c 0 = - i /WebPlayer/#/recordings/all 2 % % 0 2
[2] Recorcings Start Time User Host Client Events Events Only Recording Server Duration Action
All Recordings
August 30, 2022 12:02 PM administrator SEE—— 0 False AUTO_INSTALL 00:00:27 >
Comments v
August 30, 2022 12:01 PM administrator ] = 0 False AUTO_INSTALL 00:00:35 @
Administrator Logging v -
Configuration v
5. Click Confirm
€ session Recordings x o+ ~ = =] X
<« C 0O = m sm /WebPlayer/#/recordings/all e % * O 2

A Place access restrictions

Are you sure you want to restrict access to the selected recordings?
Restricted recordings are accessible only to privileged players.

Note: A single recorded session can produce more than one recording. If
you select any recording of a session, the access restrictions apply to all
other recordings of the same session.

6. Verify that the selected recordings on which you placed access restrictions are moved from the
All Recordings page to the Restricted page.

The Restricted by column shows who placed access restrictions on the relevant recordings.
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[*] Recordings ~

Start Time User Host Client Events Events Only Recording Server Duration Restricted by Action
All Recordings .

August 30,2022 12:02 PM  administrater =0 False AUTO_INSTALL 000027  X8EPW\Administrator (B
Restricted

August 30,2022 12:01PM  administrato > 0 False AUTO_INSTALL 00:00:35  X8EPW\Administrator ()
Comments v

Administrator Logging v

Configuration v

7. On the Restricted page, remove access restrictions as needed. With access restrictions
removed, recordings are moved back to the All Recordings page.

€ session Recordings x + v - X

<« C O = R IS B/ WebPlayer/#/recordings/restricted 2w RO 2 i

CIifTIX | Session Recording

[»] Recordings ~ < Followup | T Remove access restrictions
All Recordings Start Time User Host Client Events Events Only Recording Server Duration Restricted by Action
Restricted X ()
August 30,2022 12:02 PM  administrator [ False AUTO_INSTALL 00:0027  X8EPW\Administrator ( P*)
Comments v =
August 30,2022 12:01PM  administrator = o False AUTO_INSTALL 00:00:35  XBEPW\Administrator ()

Administrator Logging v

Configuration v

Open and play recordings

June 21, 2024

You can play live and completed recordings in the web player. On the recordings page, each recording
has a play button on the right side, next to the Duration item.
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Tip:

For the Player role, the Recordings menu in the left navigation shows only the All Recordings
submenu.

For the PrivilegedPlayer role, the Recordings menu shows both the All Recordings and the
Restricted submenus.

Click the play button. The playback page appears. Playback starts after memory caching.

Playback of a screen recording:

DolNoOMOBE: o pssmiii

Playback of an event-only recording:

An event-only recording played in the web player contains an event statistics pie chart and histogram.
The pie chart and histogram hold static throughout playback. You can navigate to a specific event
from within the right pane.
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Event Only Recording

MAY 8, 2021

14:38:27 - 00:02:20 - 47 Events

A User name: administrator

Client name;

Sort by All Categories v

00:00:31 Top-most
window:wfshell, ICA Seamless
Hos.

00:00:46 Top-most
windo

rer,, 10772

00:00:50 App Start:10160;
firefox: 10772: "C:\Prog.

00:00:52 App Start:860: firefox:
10160: "C:\Progra.

» @ 00:00:29/00:02:20 & Comments (7 Share Current Playbac X1 FULL SCREEN

Tip:

+ Clicking the session progress time lets you switch to the absolute date and time the session
was recorded.

« For an event-only recording, the play icon in the upper left corner is unavailable.

For a description of the player controls, see the following table:

Player Control Description

>

Plays the selected recording file.

Pauses playback.

v - Mutes/unmutes audio playback and adjusts the
volume using the slider.

——
> You can drag the progress bar during playback.
Idle periods of recorded sessions are highlighted
during playback.

Seeks backward 7 seconds.
00:05:06/00:13:33 ] . )
Indicates the current position of the recording
playback and the total recording duration. The
time format is HH:MM:SS.
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Player Control Description

(=] Comments
Lets you click and leave a comment about the

recording being played.

[~} Share Current Playback

Lets you click and copy the URL of the current
recording to the clipboard.

Show stats

Shows the overlay that features data points
related to the recorded session.

Hide stats

Hides the session data overlay.

“ Indicates the current speed of playback. Click

the icon to switch between options including
X0.5, X1, X2, and X4.

FULL SCREEN Displays the playback in full screen.

Exit full screen

Displays the playback within the webpage.

In the right pane of the playback page, the Events and Comments filters, quick search box, and some
recording data are available, for example:
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AUG 20, 2021

18:50:50-01:37:00- 359 Events

R User name: ¢
£ Host name: £

2] Client name:

View:

Q All
Events

admin:
= Comments

cer..

00:00:40 Top-most

00:00:53 Clipboard

= ® 00:00:53 ctxadmin:

00:00:54 Top-most

= L] OO:.OO:54 ctxadmin:
dgwdwd

00:01:13 Top-most
window:ipconfig,

mentaire sur

window:sessionmsg, , 8412

Operation:Text, sessionmsg, ,

window:explorer, , 8944

» The date and time on the web player machine. In this example, AUG 20, 2021 and 18:50:50.

+ The duration of the recording in playback. In this example, 01:37:00.
« The number of events in the recording. In this example, 359 EVENTS.
+ The name of the user whose session was recorded.

+ The host name of the VDA where the recorded session was hosted.

« The name of the client device where the session was running.

+ Options for sorting search results: Select All, Events, or Comments to sort search results.

Click the icon to expand the display of events. For example:

Event filters. You can select more than one filter to search for events in the current recording.
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. 00:18:29 Top-most
window:setup_wm, Windows
MediaP...

— 00:18:41 Top-most
window:wmplayer, Windows
MediaP...

« Event list. Clicking an event on the list takes you to the position of the event in the recording.

» Quick search box. The search events quick search box helps to quickly narrow down a list of
events in the current recording.

Configure preferences

June 21,2024

To configure preferences for your web player, navigate to Configuration > Preferences on the web
player page.

CilrIX | Session Recording _—

Recordings v Preferences
Set your playback preferences.
Comments v
Administrator Logging Player cache
Set the cache size you want the player to use for playback.
{8} Configuration ~
—

Preferences

Rendering options

Enable the optimized graphics engine

Clear this check box if you encounter compatibility issues that cause recording playback failures;

You can configure the following preferences for your web player:

+ Player cache. Drag the slider to set the cache size you want the player to use for playback.

+ Optimized graphics engine. We have optimized the graphics engine to improve the perfor-
mance of the web player. The optimized engine is enabled by default. If you encounter compat-
ibility or other issues with the optimized engine, you can disable it by clearing the check box.
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Increase the transport packet size for the web player

June 21, 2024

1. LocatetheWeb configurationfileunder<Session Recording installation path>/
WebSocketServer.

2. Open the Web configuration file.
3. Edit the BlockSizeMultiple value.

The default value is 1 (4 KB). We recommend you set the value to 8 (32 KB).

W Regintry Finder - Admirasteator - [Lecal Regittry] - =] g
Filg Edt ‘Www Foeorter Wiedow Help

[ HEEY_LOCAL MACHINESOFTWARE Ctri Sessioedecording! CloudChentSenioe ] +

£z Local Reghtry x| 10
L X || Mo ) Tyt Data
| | it ~ | ) Default) REG 42 fwwlue naot set)
- Auboe Cloud 3 BlopkSapebdul e REG_IDWORD
Cloudt.Eantiurvice ] SeuionRrcordingULiD REG ST PRS- 190 Pl Delad T30
Cotrrx Diegltep Dlrotry Lo
Inszailiigens
hhetainstal
- Sesmanfecording

AemTook
XemToohinsisller
NenToshMeSetings

Clayses

Cliagrits

ket

Google

Irited

Meoropodt

Mool

GOAC

Paftfs

Pehigies

Crashys =
£ ¥ £ 3

HEEY_LOCAL MACHMNESOF TWARE L dra\SernonRecordng Cloudl hentSerae Egya: 0 Walues: 2 Selected: 1

Highlight idle periods

June 21,2024
Session Recording can record idle events and highlight idle periods in the web player.
Tip:

Idle events are not visible in the Session Recording player because idle events are saved in the
Session Recording database but not in the relevant recording files (. i c1 files).

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 258



Session Recording 2407

To customize the idle event feature, set the following registry keys at HKEY_LOCAL_MACHINE\

SOFTWARE\Citrix\SmartAuditor\SessionEvents.

Registry key Default value
DisableldleEvent 0
IdleEventThrottle 30 seconds
IdleEventActiveThrottle 2 seconds

IdleEventActivePktNumThrottle 3 packets

IdleEventActivePktSizeThrottle 300 bytes

Description

To disable the idle event
feature, set the value to 1. To
enable the idle event feature,
set the value to 0.

If there is no user activity
(including graphics changes
and keyboard/mouse inputs)
longer than the time threshold
set by the registry key, an idle
event is recorded. Theidle
period is highlighted when the
recorded session plays back on
the Session Recording web
player.

Only a specified number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 2 seconds can qualify as
user activities.

Only a specified number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 2 seconds can qualify as

user activities.
Graphics packets smaller than

the key value are ignored and
the relevant time duration is
regarded as idle.
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Use events and comments

June 21,2024

In the right pane of the playback page, the Events and Comments filters are available. You can use
events and comments to help you navigate through recorded sessions in the web player.

AUG 20, 2021

18:50:50-01:37:00- 359 Events

R User name: ¢
C‘g Host name: £

&) Client name: | 7

View:

Q Au v

Events

admin:

B comments mentaire sur

cer...

00:00:40 Top-most
window:sessionmsg, , 8412

00:00:53 Clipboard
OperationiText, sessionmsg, ,

= ® 00:00:53 ctxadmin:

00:00:54 Top-most
window:explorer, , 8944

= ® 00:00:54 ctxadmin:
dagwdwd

00:01:13 Top-most
window:ipconfig,

Comment on recordings

When a recorded session is being played, you can click the Comments player control to leave com-
ments and set comment severities. Severities include Normal, Medium, and Severe. Severe and
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Medium comments are indicated with red and orange dots, respectively. During session playback,
you can view all comments about a recording. To delete a comment that you left, refresh your web-
page, expand the comment, and then click Delete.

NOV 17,2021

00:12:51 - 30 Events

Session Recording

Your actiity with the desktop or program(s) you recently started is being recorded. If
you object to this candition, close the desktop or program).
]

oms
~ a52Kbps
90 Kbps
100%
2471/4088 MB (60%)

(7} Share Current Playback X1 [ Hide stats 52 Exit full screen

Clicking a comment lets you jump to the location where the comment was given. You can view all your
comments on the My comments page.

CifrIX | Session Recording

Recordings

Comments Q
| =) comments ~

My Comments

administctor Logging ~ Q Q Q

Configuration v Please take alook Shell Session quit

Jump to Recording Jump to Recording Jump to Recording
Delete Delete Delete
Note:
.

To make the comment feature work as expected, clear the WebDAV Publishing check box in the

Add Roles and Features wizard of Server Manager on the Session Recording Server.
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Add Roles and Features Wizard

Select server roles

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles

Server Selection [ Hyper-v P

Features [ ] Network Policy and Access Services
[ ] Print and Document Services
[ ] Remote Access
[ ] Remote Desktop Services
[ ] Volume Activation Services
4 [m] Web Server (IIS) (27 of 43 installed)
4 [E] Web Server (21 of 34 installed)
PRICIRCommon HTTP Features (5 of 6 installed)
+ Default Document (Installed)
+/| Directory Browsing (Installed)
«/| HTTP Errors (Installed)

« | Static Content (Installed)
+| HTTP Redirection (Installed)
WebDAV Publishing

b [m] Health and Diagnostics (4 of 6 installed)
b |« Performance (Installed)
b [m] Security (3 of 9 installed) -

< Previous l l Next >

Share recordings as links

June 21,2024

Overview

You can share recordings as links so that other users can access the recordings directly, without the
need to search among many recordings. You can share recordings as restricted and unrestricted links.
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If you share a recording as a restricted link, only users who already have playback permission can view
the recording using the link. If you share a recording as an unrestricted link, anyone in your AD domain
can view the recording using the link.

To facilitate managing unrestricted links, Session Recording lets you:
« Set a validity period for each of the links.

(Optional) Enter a justification when generating the links.
+ Get an overview of which recordings have been shared as unrestricted links.

« View all unrestricted links of a specific recording.
Know which users have accessed an unrestricted link.

Revoke unrestricted links that haven’t expired.
Clear invalid links that have expired or revoked.

.

Note:

+ To share recordings as unrestricted links and to manage unrestricted links, you must be
assigned the PrivilegedPlayer role.
+ To view a recording using an unrestricted link, users must enter a justification.

Share recordings as restricted links

To share recordings as restricted links, complete the following steps:

1. Inthe web player, open and play the recording that you want to share.

2. Click Share on the playback page of the recording. The Generate recording link dialog ap-
pears.

Generate recording link

3. Select Restricted from the General access drop-down.
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4. Click Copy link.

After you click Copy link, either of the following messages appears, indicating a successful or

failed operation respectively:

« The URL to the shared recording has been copied to the clipboard

+ Sharing the recording URL failed

5. Apply secure sharing at the server level.

To ensure secure sharing, set the following registry values under HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server:

Registry value Description Default value Remarks

LinkExpire Time span beyond 1,728,000,000,000 (The -
which a generated URL  default value equals 2
link expires. Counted days.)
as timeticks in the unit
of 10 microseconds.

LinkSalt A security method to Kk20d974 Change the default
encrypt the preceding value to an arbitrary
URL expiration time string that preferably

ends with digits.

6. Share the generated URL link with users who already have playback permission.

Pasting the link in the address bar lets you jump to the location where the link was copied.

Share recordings as unrestricted links

Note:

To share recordings as unrestricted links, you must be assigned the PrivilegedPlayer role.

To share recordings as unrestricted links, complete the following steps:

1. Inthe web player, open and play the recording that you want to share.

2. Click Share on the playback page of the recording. The Generate recording link dialog ap-
pears.

3. Select Unrestricted from the General access drop-down.
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Generate recording link

4. (Optional) Enter your justification for sharing the recording.
5. Set an expiration period for the link to be generated.
6. Click Copy link.

After you click Copy link, either of the following messages appears, indicating a successful or
failed operation respectively:

» The URL to the shared recording has been copied to the clipboard

« Sharing the recording URL failed

7. Share the generated URL link with anyone in your AD domain.
Pasting the link in the address bar lets you jump to the location where the URL link was copied.

Note:

+ Toview a recording using an unrestricted link, users must enter a justification.
« The actions of generating and accessing unrestricted links are logged under the play-
back logging sector of administrator logging.

Manage unrestricted links

Note:

To manage unrestricted links, you must be assigned the PrivilegedPlayer role.

View which recordings have been shared as unrestricted links

To get an overview of which recordings have been shared as unrestricted links, click Manage Links in
the upper right corner of the All Recordings page.
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Start Time User Host Client Events Events Only Recording Server Duration Action
April 6,2023 10:38AM 0 False 00:00:27 >
April 6. 2023 10:28AM 0 False 00:09:41 >
April 62023 10:17AM 0 False 00:11:45 >
March 15,2023 4:31PM 0 False 00:02:13 C
March 15, 2023 4:07PM 0 False 00:03:28 »)
February 28, 2023 4:47PM 8 False 00:02:01 \P_'
February 28, 2023 9:59AM 0 False 00:04:50 >
February 28, 2023 9:32AM 0 False 00:02:33 >
February 28, 2023 9:31AM 0 False 00:00:53 P:
February 28, 2023 9:19 AM 0 False 00:40:20 .
February 28, 2023 6:33AM 0 False 02:46:00 >
February 13, 2023 2:22PM 0 False 00:04:26 »
February 13, 2023 2:11PM 0 True 00:10:52 »)

After you click Manage Links, only recordings that have been shared as unrestricted links are listed.

cording Q WASKL\Administrator
Start Time User Host Client Events Events Only Recording Server Duration Action
Apeil 6. 2023 10:38 AM linlin_s_MacBook_Pro 0 False 00:00:27 P s
April 62023 10:17 AM linlin_s_MacBock_Pro 0 False 00:11:45 L2
February 28, 2023 9:32 AM QHPLAY o False 00:02:33 F1
November 30,2022 3:01PM APACPMD2221 1 False 00:32:15 &£ s
September 21, 2022 11:37 AM NKGWYUCHUNIOL [ False 00:14:59 @1

View and manage unrestricted links of a specific recording

1. Open the Manage unrestricted links page.

Method 1: By clicking the link icon in the Action column on the All Recordings page

Cording ( WASKL\Administrator
Start Time User Host Client Events Events Only Recording Server Duration Action
April 6. 2023 10:38AM lintin_s_MacBook_Pro 0 False 00:00:27 6
April 6. 2023 10:17AM linlin_s_MacBook_Pro o False 00:11:45 &2
February 28, 2023 9:32AM QHPLAY o False 00:02:33 1
November 30, 2022 3:01PM APACPMD2221 1 False 00:32:15 £ s
September 21. 2022 11:37 AM NKGWYUCHUNJOL [ False 00:14:59 &1

Method 2: By clicking Manage Links in the Generate recording link dialog
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Generate recording link

General access

Justification
test2

Link valid for (hours)

2. Onthe Manage unrestricted links page, expand each row to view details about the unrestricted

links that are generated for the specific recording.

Manage unrestricted links X

View and manage unrestricted links generated for this recording. Expand each row to view details.

C> Refresh W Clearinvalid links

Generated at (UTC+08:00) Generated by Justification Status
Apr 10,2023 4:18:42 PM WA9KL\Administrator Expired
Apr 10, 2023 4:10:22 PM WASKL\Administrator Expired
URL

http://10.108 4 136/WebPlayer/#/player?key=al17c89a63c3f4976b12559e2bd884ee7

Viewed by Time Playback justification

WASKL\user®

WAYKL\Administrator

WASKL\AdministratorQ

Apr 10, 2023 5:45:37 PM

Apr 10, 2023 5:45:18 PM

Apr 10,2023 45313 PM

userQ's view

administrator view

administrator0's view

Apri1l, 2023 3:30:45PM WASKL\Administrator Expires in 3h37m

Apr 10,2023 5:46:11 PM WASKL\Administrator Test Revoked

3. (Optional) To revoke a link, select it and then click Revoke that appears.
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Manage unrestricted links X

View and manage unrestricted links generated for this recording. Expand each row to view details.

C¥ Refresh W Clearinvalidlinks (@ Revoke

Generated at (UTC+08:00) Generated by Justification Status
Apr10,2023 4:18:42PM WA9KL\Administrater Expired
Apr10,20234:10:22 PM WA9KL\Administrator Expired
Apr11,2023 3:30:45PM WA9KL\Administrator Expires in 3n37m
URL

http://10.108.4.136/WebPlayer/#/player?key=438a6a5b428748hb590chcc0ff8d8f2de [

Apr10,2023 5:46:11 PM WA9KL\Administrator Test Revoked

After you click Revoke, you are prompted to confirm the action.

A Revoke link

If you revoke this link, people can no longer access the recording with it.
This will not affect anyone who already had the page open.
Are you sure you want to continue?

- Je=»

4. (Optional) To remove the links that have expired or revoked, click Clear invalid links.

View graphical event statistics for each recording

June 21, 2024

Event data visualization is available in the web player for each recording. It provides graphical event
statistics for you to quickly comprehend the events inserted in recordings.

To view graphical event statistics, complete the following steps:

1. Open and play a recording.

2. Inthe upper left corner of the playback page, click the statistics icon.
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@

‘What lies beneath: the secrets of

cox

France's top serial killer expert

T 303ms
78 Kbps.

- 35Kops
32%

@

2889/4088 MB (73%)

i
7R

Learn the Cost of a Financial
Advisor

fommation 1o hats vou chooss the

53 FULL SCREEN

NOV 18, 2021
11:41:52 00:13:33 - 32 Events

3. Switch between the Screen time, File transfers, Commands, and Events tabs to view statistics

from different perspectives.

« Screen time

The Screen time tab lets you know the cumulative time an application window is in focus

(active window).

h Player
D Screen time File transfers Commands Events
XenDesktopVdaSetup 00:20:52
explorer 00:19:14
chrome 00:16:52
firefox 00:11:55
CSISS 00:10:30
ConfigurationWizard 00:07:46
powershell 00:03:00
cmd 00:02:58
mmec 00:00:35
iexplore 00:00:35
L\ Taskmgr 00:00:16
JonasAgentSystray 00:00:15
sessionmsg 00:00:14
setup_wm 00:00:12
WfShell 00:00:11
wmplayer 00:00:10
CitrixFiles 00:00:07

There is a horizontal time bar next to each application. Click the bar to view the start time

and duration each time an application becomes and stays in focus, respectively. You can

narrow down your search range by specifying a duration range other than the default All
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option. For example:

€ Player
|> Screen time File transfers Commands Events polssneL ><
— ag the top-most window
— : - |
Start time Duration
XenDesktopVdaSetup 00:20:52
explorer 00:19:14 Mzl B g
00:28:25  00:00:08
chrome 00:16:52 0020:02  00:00:15
firefox 00:11:55 00:30:04  00:00:03
csrss 00:10:30 gesteo 000602
00:30:38  00:00:01
Ni 07"
ConfigurationWizard 00:07:46 003041  0000:02
powershell 00:03:00 00:30:43  00:00:07
cmd 00:02:58 00:31:05  00:00:04
00:00:35 00:31:49  00:00:01
mme 003 00:3338 000008
iexplore 00:00:35 00:33:53  00:00:00
Taskmgr 00:00:16 - 003638 00:00:06
: 003707  00:00:03
JonasAgentSystray 00:00:15 o
00:37:20  00:00:11
sessionmsg 00:00:14 003742 0000.02
setup_wm 00:00:12 00:42:38  00:00:21
WiShell 00:00:11 fradss oo
wmplayer 00:00:10
CitrixFiles 00:00:07
OpenWith 00:00:06
mspaint 00:00:05
msedgewebview?2 00:00:05

« File transfers

The File transfers tab provides graphical statistics about bidirectional file transfers be-
tween the VDA hosting the recorded session and the client device where the session runs.
You can customize the visualization by using the following settings:

- Time granularity: Per 1 minute, Per 10 minutes, Per hour

- File transfer destination: All transfers, Transfer from host to client, Transfer from
client to host

- Number or size (Bytes or MB) of transferred files

The X axis represents the absolute time in the 24-hour system.
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€ Player
]> Screen time File transfers Commands Events
Per 1 minute A All transfers A
N

File size (Bytes)

File size (MB)

10:25 10:30 10:35 10:40 10:45 10:50 10:55 11:00 11:05 11:10 11:15 11:20 11:25 11:30

OHHEFNRWWREREONODD NN

TR T T N T T T T T S SO SO N |

. Transfer from host to client . Transfer from client to host

« Commands

The Commands tab shows CMD and PowerShell commands that are run during the
recorded session. You can customize the data display by typing your custom search in
Custom search or selecting a saved search from Saved search. The “OR”logical operator
is used to compute the final action.

€ Player
>

Screen time File transfers Commands Events

Custom search

Saved search [
VR
15/15 Commands IPv4 Address

E-mail Address
powershell: power

000114 cmd CDFTraceTask.ps: compmemt

. taskmgr

00:01:23 powershell logman: "C:\Windc

mme
00:28:16 cmd mspaint: mspaint  \inver

control
00:28:38 cmd control: "C:\Windo
00:28:49 cmd netsh: netsh
00:29:39 cmd contrel: "C:\Windows\System3 2\control.exe""C:\Windows\system3 2\sysdm.cpl”,
00:30:37 cmd mme: "C\Windows\system32\mme.exe” "C\Windows\system32\lusrmgr.msc”

« Events
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The Events tab shows the proportions and numbers of all types of events in the recorded

session.

€ Player
>

Screen time File transfers Commands

App End

App Start
25(7%)

Clipboard Operation
36(10%)

Web browsing
51(14%)

M Top-most window
M Web browsing
Pl Clipboard Operation
App Start
App End
File transfer

View data points related to each recorded session

June 21, 2024

During playback, you can click the Show stats control to view, on an overlay, the following data points

related to the recorded session:

» Round trip time

Network (send)

Network (receive)
« CPU usage

Memory usage
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NOV 18,2021

11:41:52- 00:13:33 - 32 Events

00:00:28
window.explorer. . 7508
303ms
78 Kbps
- 35Kbps s 00:00:48 App Start 963
32% conhost: 2748: \ZA\CAWN...
2989/4086 MB (73%)

Recommended eam mar 00:00:48 App Start:2745:
cmd: 7508:

C:\Windows\sys.
00:00:48 App Start11232
powershell: 2748: powers

wershell: 2748: powers.

00:00:55 App End:9632:
conhost

od Guy/Bad Guy Myth

00:00:55 App End:11232.
powershel

— 00:00:55 App End:2748:
| 4 ¥7) 00:05:06/00:13:33 @ Comments (7} Share Current Playback x1 Hide stats 54 FULL SCREEN emd

Note:

+ Session Recording collects round-trip time every 15 seconds and the rest of the data points
every second.

« Theoretically, Session Recording refreshes data on round-trip time every five seconds. How-
ever, round trip time data actually refreshes every 15 seconds because of the collection
cycle.

+ Session recording refreshes the rest of the data points every 5 seconds and presents their
average values on the overlay.

The overlay is semi-transparent. You can relocate and hide it.

+ To relocate the overlay, hover your mouse over the eight dots and then do a drag and drop.
« To hide the overlay, click Hide stats.

You can enable the overlay by selecting Log performance data when creating your event detection
policy. For more information, see Configure event detection policies.

Manage recordings

June 21,2024

ICA log database (ICLDB) is a database command-line utility used to manipulate the session record-
ing database records. This utility is installed, during the Session Recording installation, to the
<Session Recording Server 1installation path>\Bin folder on the server hosting
the Session Recording server.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 273


https://docs.citrix.com/en-us/session-recording/current-release/configure/policies/event-detection-policies.html

Session Recording 2407

Note:

If you want to use ICLDB to manage session recording files stored in Azure file shares, run the
SsRecUtils.exe -MountAzureFiles command. SsRecUtils.exe and ICLDB are in the
same folder.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the
commands using the following format:

ICLDB [VERSION | LOCATE | DORMANT | IMPORT | ARCHIVE | REMOVE |
REMOVEALL] command-options [/L] [/F] [/S] [/?]

Note:

More extensive instructions are available in the help associated with the utility. To access the
help, from a command prompt, type the \Program Files\Citrix\SessionRecording
\Server\Bin folder, and type

icldb /?. To access help for specific commands, type

icldb <specific command> /?.
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Command

ARCHIVE

Description

Archives the session recording files that you
specify. You can specify a target session
recording file to archive by using the FILEID
parameter. You can also specify target session
recording files by using the RETENTION
parameter and the FILTER or RULES parameter.
In the second case, the RETENTION parameter is
mandatory. It lets you manipulate session
recording files older than the retention period
specified. A valid retention period is 2 days at
least. Therefore, set RETENTION to 2 or a greater
value that suits your needs. The FILTER and
RULES parameters are optional. The FILTER
parameter lets you filter file paths by using the *
and ? wildcards. The RULES parameter sets
advanced filters by combining multiple filters
strictly in accordance with the
JRULES:FIELD-In-["CONDITION","
CONDITION"] ;FIELD-NotIn-["
CONDITION",'"CONDITION"] ; format. For
more information, see The RULES parameter for
ICLDB ARCHIVE and ICLDB REMOVE commands
following this table. The RULES parameter and
the FILTER parameter cannot be used together. If
you add the FILTER or RULES parameter, only
session recording files meeting both RETENTION
and FILTER or RULES are manipulated. You can
archive both recordings and events in the
recordings. The events are archived in the
ArchivedEvent database table. Example ICLDB
ARCHIVE command:

ICLDB ARCHIVE /RETENTION:<days>
[/LISTFILES] [/MOVETO:<dir>] [/
NOTE:<note>] [/FILTER:<file path
filter>] [/RULES:<advanced
filters>] [/L]1 [/F1 [/S1 [/7]
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Command Description

DORMANT Displays or counts the live recording files that
are considered dormant or unresponsive. A live
recording is considered unresponsive or
dormant when no new data is written to the
recording file after a specified period of time has
elapsed. You can specify a target session
recording file by using the FILEID parameter. You
can also check whether session recording files
are becoming dormant for the entire database,
or only recordings made within the specified
number of days, hours, or minutes. Among the
time parameters (DAYS, HOURS, and MINUTES),
only one can be specified at a time. You can
manually close unresponsive or dormant live
recordings by appending the CLOSEFILES
parameter. You can also set a time threshold on
the Storage tab of Session Recording Server
Properties to close unresponsive or dormant
live recordings automatically when the
threshold is exceeded. For more information,
see Close unresponsive or dormant live
recordings later in this article.
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Command

IMPORT

LOCATE

Description

Imports session recording files to the Session
Recording database. Use this command to
rebuild the database if you lose database
records. Also, use this command to merge
databases (if you have two databases, you can
import the files from one of the databases). The
2303 release introduces the RELOCATE
parameter to the IMPORT command. Without
the RELOCATE parameter, the IMPORT
command parses session recording files in their
entirety, which takes time. With the RELOCATE
parameter, the IMPORT command simply
locates the database records of session
recording files and updates their file paths
directly. Example ICLDB IMPORT command:
ICLDB IMPORT [/LISTFILES] [/
RECURSIVE] [/RELOCATE] [/L] [/F]
[/S] [/?] [<file>] [<directory>]

Locates and displays the full path to a session
recording file using the file ID as the criteria. Use
this command when you are looking for the
storage location of a session recording file. It is
also one way to verify if the database is
up-to-date with a specific file. Example ICLDB
LOCATE command: ICLDB LOCATE /FILEID
:<id> [/L] [/F] [/s] [/7]
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Command

REMOVE

Description

Removes the references to session recording
files from the database. Use this command (with
caution) to clean up the database. You can also
remove the associated physical files. When using
the REMOVE command, you can either specify a
target session recording file by using the FILEID
parameter or specify target session recording
files using the RETENTION parameter and the
FILTER or RULES parameter. In the second case,
the RETENTION parameter is mandatory. It lets
you manipulate session recording files older
than the retention period specified. A valid
retention period is 2 days at least. Therefore, set
RETENTION to 2 or a greater value that suits your
needs. The FILTER and RULES parameters are
optional. The FILTER parameter lets you filter file
paths by using the * and ? wildcards. The RULES
parameter sets advanced filters by combining
multiple filters strictly in accordance with the
/RULES:FIELD-In-["CONDITION","
CONDITION"];FIELD-NotIn-["
CONDITION'","CONDITION"] ; format. For
more information, see The RULES parameter for
ICLDB ARCHIVE and ICLDB REMOVE commands
following this table. The RULES parameter and
the FILTER parameter cannot be used together. If
you add the FILTER or RULES parameter, only
session recording files meeting both RETENTION
and FILTER or RULES are manipulated. Example
ICLDB REMOVE command: ICLDB REMOVE /
RETENTION:<days> [/LISTFILES] [/
DELETEFILES] [/FILTER:<file path
filter>] [/RULES:<advanced

filters>] [/L] [/F] [/S] [/7?]
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Command Description

REMOVEALL Removes all references to session recording files
from the Session Recording database and
returns the database to its original state. The
actual physical files are not deleted; however,
you cannot search for these files in the Session
Recording player. Use this command (with
caution) to clean up the database. Deleted
references can be reversed only by restoring
from your backup.

VERSION Displays the Session Recording database
schema version.

/L Logs the results and errors to the Windows event
log.

/F Forces the command to run without prompts.

/S Suppresses the copyright message.

/? Displays help for the commands.

The RULES parameter for ICLDB ARCHIVE and ICLDB REMOVE commands

The RULES parameter sets advanced filters by combining multiple filters strictly in accordance with
the /RULES:FIELD-In-["CONDITION","CONDITION"];FIELD-NotIn-["CONDITION"
, "CONDITION"]; format, where:

+ “FIELD”sets a filter with a field, which can be “path”, “user”, “group”, “deliverygroup”, “ap-
plication”, “server”, “client”, or any other column in the database table called dbo.ICLFile.

+ “In”’means that at least one of the filter conditions in the brackets must be met for a recording
file to be an operation object.

+ “NotIn”means that recording files that meet any of the filter conditions in the brackets are ex-
cluded from the operation.

+ “CONDITION”sets a filter condition with a record (or row) in the database table called
dbo.ICLFile.

« User and group records must be entered in the format of <domain>.<name>.
« Path records can be filtered by using Windows wildcards.

« You must enclose each “CONDITION”item in double quotes (") and separate two “CONDI-
TION”items with a comma (,).

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 279



Session Recording 2407

+ Do not add spaces when entering “CONDITION”items unless a “CONDITION”item itself contain
spaces.

+ Ifa“CONDITION”item contains one or more commas, enclose the “CONDITION”item in double
quotes that are followed by escaped double quotes """ " """,

+ Multiple filters can be used in various combinations. End each filter with a semicolon ().

+ The “AND”logical operator is used to compute the multiple filters. There is no limit to the num-
ber of filters, but the total length of RULES must not exceed 2,048 bytes.

Examples:

+ /RULES:group-In-["BUILTIN.Guests"];

+« /RULES:path-In-["S:\SessionRecordings\2023*"] ;group-NotIn-["
Mydomain.Suspicious","Mydomain.Persistence"];

+ /RULES:deliverygroup-In-["RdsDesktopAndAppGroup"];user—-In-["
Mydomain.AdminA","""Mydomain.Admin,,,B"""];

+ /RULES:EndReasonID-In-["1","2"];

Archive session recording files

To maintain an adequate level of spare disk capacity in the recording storage locations, archive ses-
sion recording files regularly. Depending on the amount of available disk space and typical size of
recording files, archiving intervals differ. Session recording files must be older than two days from
the start date before a session recording file can be archived. This rule is to prevent any live record-
ings from being archived before they become complete.

Two methods are available when you archive session recordings. The database record for a recording
file can be updated to have a status of archived while the file remains in the recording storage location.
This method can be used to reduce the search results in the player. The other method is to update
the database record for a recording file to the archived status and move the file from the recording
storage location to another location for backup to alternative media. When moving session recording
files, the ICLDB utility moves them to the specified directory where the original file folder structure of
year/month/day no longer exists.

The session recording record in the Session Recording database contains two fields associated with
archiving—the archive time and archive note. The archive time represents the current date and time
that a recording was archived. The archive note is an optional text note that can be added during
archiving. The two fields indicate that a recording has been archived and the time of archiving.

In the Session Recording player, archived session recordings show a status of Archived and the date
and time of archiving. Session recordings that have been archived might still be played if the files
have not been moved. If a session recording file was moved during archiving, a file not found error is
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displayed. The session recording file must be restored before the session can be played. To restore
a session recording file, provide the File ID and Archive Time of the recording file. Restoring archived
files is discussed further in the following Restore session recording files section.

The ARCHIVE command of the ICLDB utility has several parameters that are described as follows:

+ [FILEID:<id> - Lets you specify a target session recording file. You can check the ID of a session
recordingfile in the Session Recording player (Windows). A recording file name can also be used
as thefile ID.

+ [RETENTION:<days> - The retention period in days for session recordings. Recordings older
than the number of days specified are marked as archived in the Session Recording database.
The retention period must be an integer number greater than or equal to 2 days.

+ [FILTER:<filter>: Lets you filter file paths by using the x and ? wildcards. The FILTER parameter
is optional. If you add the FILTER parameter, only those session recording files meeting both
RETENTION and FILTER are archived.

+ /[RULES:<advanced filters>: Sets advanced filters by combining multiple filters strictly in
accordance with the /RULES:FIELD-In-["CONDITION","CONDITION"];FIELD-
NotIn-["CONDITION","CONDITION"]; format. The RULES parameter and the FILTER
parameter cannot be used together. For more information, see the preceding The RULES
parameter for ICLDB ARCHIVE and ICLDB REMOVE commands section in this article.

+ [LISTFILES —Lists the full path and file name of session recordingfiles as they are being archived.
This parameter is optional.

+ [MOVETO:<directory>- The directory to which you physically move archived session recording
files. The specified directory must exist. This parameter is optional. If no directory is specified,
the files remain in their original storage location.

+ [NOTE:<note> - A text note that is added to the database record for each session recording
archived. Ensure that the note is enclosed with double quotes. This parameter is optional.

+ [L—Logstheresults and errors to the Windows event log of the number of session recording files
archived. This parameter is optional.

« |F —Forces the archive command to run without prompts. This parameter is optional.

To archive session recordings in the Session Recording database and physically move session
recording files

1. Logon to the server where the Session Recording server is installed as a local administrator.

2. Starta command prompt.
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3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server Installation Path>\Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> [/LISTFILES] [/MOVETO:<dir
>] [/NOTE:<note>] [/FILTER:<file path filter>] [/RULES:<advanced
filters>] [/L] [/F]1 [/S] L[/?] command. The parametersin brackets are optional.
Remove the brackets when running the command. The RULES parameter and the FILTER
parameter cannot be used together. days is the retention period for session recording files,
directory is the directory where archived session recording files are moved to, and note is the
text note that is added to the database record for each session recording file being archived.
Enter Y to confirm the archive.

To only archive session recordings in the Session Recording database

=

. Logon to the server where the Session Recording server is installed as a local administrator.
2. Starta command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> [/LISTFILES] [/NOTE:<note>]
[/FILTER:<file path filter>] [/RULES:<advanced filters>] [/L] [/

F1 [/S] [/?] command. The parameters in brackets are optional. Remove the brackets
when running the command. The RULES parameter and the FILTER parameter cannot be used
together. days is the retention period for session recordings and nete is the text note that is
added to the database record for each session recording being archived. Enter Y to confirm the

archive.

Restore session recording files

To view a recording file archived in the Session Recording database and moved from the recording
storage location, restore it. Archived session recordings that were not moved from the recording stor-
age location during archiving are still accessible in the player.

Two methods are available for restoring session recording files that have been moved. Copy the re-
quired session recording file to the restore directory for archived files. Or, import the required session
recording file back to the Session Recording database by using the ICLDB utility. We recommend the
first method for restoring archived session recording files. Remove archived files copied to the restore
directory for archived files when you no longer need them.

The Session Recording Broker uses the Restore directory for archived files when a session recording
file is not found in its original storage location. This case occurs when the player requests a session
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recording file for playback. The Session Recording Broker first attempts to find the session recording
file in the original storage location. If the file is not found in the original storage location, the Session
Recording Broker then checks the Restore directory for archived files. If the file is present in the
restore directory, the Session Recording Broker sends the file to the player for playback. If the file is
not found, the Session Recording Broker sends a file not found error to the player.

Importing an archived recording file updates the Session Recording database with the session record-
ing information from the file, including a new storage path. Importing an archived session recording
file doesn’t move the file back to the original storage location when the session was recorded.

Note: An imported session recording file has the archive time and archive note cleared in the Ses-
sion Recording database. The next time the ICLDB ARCHIVE command is run, the imported session
recording file might become archived again.

The ICLDB IMPORT command is useful to import a large number of archived recording files. It can
repair or update incorrect and missing session recording data in the Session Recording database. It
is also useful to move session recording files from one storage location to another on the Session
Recording server. You can use the ICLDB IMPORT command to repopulate the Session Recording
database with session recordings after running the ICLDB REMOVEALL command.

The IMPORT command of the ICLDB utility has several parameters that you can use for restoring
archived recording files:

+ [LISTFILES —Lists the full path and file name of session recording files while they are being im-
ported. This parameter is optional.

+ [RECURSIVE —Searches all subdirectories for session recording files. This parameter is optional.

+ /[RELOCATE —Without the RELOCATE parameter, the IMPORT command parses session record-
ing files in their entirety, which takes time. With the RELOCATE parameter, the IMPORT com-
mand simply locates the database records of session recording files and updates their file paths
directly.

+ [L—Logs the results and errors to the Windows event log the number of session recording files
imported. This parameter is optional.

+ |F —Forces the IMPORT command to run without prompts. This parameter is optional.
Note:

The IMPORT command of the ICLDB utility also provides an optional parameter, RELOCATE, that
you can use for relocating recording files. For more information, see the Relocate session record-
ing files section in this article.

Restore session recording files by using the restore directory for archived files

1. Logon as a local administrator to the server where the Session Recording server is installed.
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2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived
session recording file.

3. Locate the session recordingfile in your backups using the File ID specified in Session Recording
Player Properties. Each session recording has a file name of i _<FileID>.1icl, where FilelD
is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To
determine the restore directory for archived files:

a) From the Start menu, choose Start > All Programs > Citrix > Session Recording Server
Properties.

b) In Session Recording Server Properties, select the Storage tab. The current restore di-
rectory appears in the Restore directory for archived files field.

Restore session recording files by using the ICLDB IMPORT command

1. Logon as a local administrator to the server where the Session Recording server is installed.
2. Starta command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

4, Either:

« Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> com-
mand where directory is the name of one or more directories, separated by a space
containing session recording files. Enter Y to confirm the import.

« Runthe ICLDB IMPORT /LISTFILES /L <file>commandwherefileisthename
of one or more session recording files, separated by a space. Wildcards might be used to
specify session recording files. Enter Y to confirm the import.

Relocate session recording files

You can move session recording files to different storage paths for load balancing or other purposes.
To ensure that the files can still be played, you must update their new paths to the Session Recording
database. To do so, use the ICLDB IMPORT command. To accelerate the import process, append the
RELOCATE parameter to the ICLDB IMPORT command.

Note:

The RELOCATE parameter is optional. Without the RELOCATE parameter, the ICLDB IMPORT com-
mand parses session recording files in their entirety, which takes time. With the RELOCATE pa-
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rameter, the ICLDB IMPORT command simply locates the database records of session recording
files and updates their file paths directly.

The following steps illustrate how to use the RELOCATE parameter to update new file paths to the
Session Recording database.

1. Move session recording files to different storage paths as needed.
2. Logon as alocal administrator to the server where the Session Recording server is installed.
3. Starta command prompt.

4. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

5. Either:

* Run the ICLDB IMPORT /LISTFILES /RECURSIVE /RELOCATE /L <
directory> command where directory is the name of one or more directories,
separated by a space containing session recording files. Enter Y to confirm the import.

e Run the ICLDB IMPORT /LISTFILES /RELOCATE /L <file> command where
file is the name of one or more session recording files, separated by a space. Wildcards
might be used to specify session recording files. Enter Y to confirm the import.

Note:

+ The RELOCATE parameter assumes that there are already records of the session recording
files in the Session Recording database.

+ Thesessionrecording files must be playable before being moved. Otherwise, the RELOCATE
parameter does not help.

+ The new storage paths of the session recording files must be recognizable by the Session
Recording server. You can try them on the Storage tab of Session Recording Server Prop-
erties.

Close unresponsive or dormant live recordings

By default, a live recording is considered unresponsive or dormant if no new data was written to
the recording file for 24 hours. You can configure this time threshold on the Storage tab of Session
Recording Server Properties to close unresponsive or dormant live recordings automatically when
this threshold is exceeded. The minimum value that you can set is 12 (hours).
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You can also manually close unresponsive or dormant live recordings by using the ICLDB DORMANT
command, for example:

ICLDB DORMANT [/DAYS:<days> | /HOURS:<hours> | /MINUTES:<minutes> | /
FILEID:<id>] [/LISTFILES] [/CLOSEFILES] [/L] [/F] [/S] [/?]

The FILEID parameter lets you specify a target session recording file and the CLOSEFILES parameter
lets you manually close unresponsive or dormant live recordings that you specify.

Tip:

You can check the ID of a session recording file in the Session Recording player (Windows). A
recording file name can also be used as the file ID.

Manage and query administrator logging

June 21, 2024

Query the administrator logging data

Requirements

+ An administrator assigned to both the LoggingReader and the Player roles can view adminis-
trator logging. To assign users to the roles, go to the Session Recording Authorization Console.

« The administrator logging page is integrated with the web player. The web player must be in-
stalled for querying administrator logging. Otherwise, 404 (page not found) errors can occur.
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« The language set for the web player browser must match the language you selected when you
installed the Session Recording Administration components.

Ensure that your SessionRecordingLoggingWebApplication site in IIS and the web player have

the same SSL settings. Otherwise, 403 errors occur when you request to access the administra-
tor logging data.
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« P> ‘b Sites » Default Web Site » al » 8 ©o-
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Y Application Pools ASP.NET S
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aspnet_client NET NET NET Error NET NET Profile .NET Roles  .NET Trust NET Users -
B MsMQ thorizat... C Pages Levels Browse Application
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64 Application Connection MachineKey Pagesand  Providers Session State SMTP E-mail
P SessionRecordingRestApiService Settings Strings Controls
P s Re dingWebSt:
 SessionRecordingWebStreaming s . @
» WebPlayer 2 ] _
() n ﬂ = h| B f g |
= 0 3, o = o4 3
ASP  Authentic..  CGl  Compression Default  Directory ErorPages  Failed
Document  Browsing Request Tra...
| & i = e | Ale o=
€ © = B 7 P =
Handler HTTP HTTP logging MIMETypes Modules  Output  Request

Mappings ~ Redirect  Respon..

8

SSL Settings

Caching Filtering

Management

7] Features View (.2 Content View
Ready

Steps

You can query administrator logging data about a Session Recording server both from the machine
that hosts the server and from other machines:

On the machine hosting the target Session Recording server

1. From the Start menu, choose Session Recording Administrator Logging.

2. Type the credentials of a LoggingReader user.

The administrator logging webpage integrated with the web player appears.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 287



Session Recording 2407

CilTIX | Session Recording

On other machines
1. Open a web browser and visit the webpage for administrator logging.

« For HTTPS: https://servername/WebPlayer/#/logging/config and
https://servername/WebPlayer/#/logging/record, where servername
is the name of the machine hosting the Session Recording server.

« For HTTP: http://servername/WebPlayer/#/logging/config and http
://servername/WebPlayer/#/logging/record, where servername is the
name of the machine hosting the Session Recording server.

2. Type the credentials of a LoggingReader user.

Logging data overview

Administrator logging data consists of:

+ Configuration logging
+ Recording reason logging
+ Playback logging.
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hiXF4BSAdministrat

CilriX | Session Recording

Configuration logging

This part logs the following administrator activities:

+ Policy change - Changes to policies on the Session Recording policy console or Citrix Director
+ Server configuration change - Changes in Session Recording Server Properties

+ Logreading - Unauthorized attempts to access the administrator logging data
To log administrator activities, enable administrator logging on your Session Recording servers. For

more information, see Disable or enable administrator logging. To enhance security, you can also
configure an administrator logging service account.

Tip:
You can enable administrator logging both through the Session Recording service and through

Session Recording Server Properties.

Recording reason logging

This part logs which policies have triggered recordings.

To enable recording reason logging, enable both administrator logging and recording reason logging
on your Session Recording servers. If administrator logging is disabled, enabling recording reason
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logging does not take effect. For information about enabling recording reason logging, see Disable or

enable the recording reason logging.

Playback logging

CilTIX | Session Recording

Playback Logging

Configuration

This part logs playback-related actions. For more information about each log record, click the plus

sign (+) in the Action Details column.

To log playback justifications, enable both administrator logging and playback justification logging on
your Session Recording servers. If administrator logging is disabled, enabling playback justification

logging does not take effect.
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:'%Sesiinn Recording Server Properties - *

Slorage  Signing  Folover Plwyback Notfications CEIP  Loggng RE ¢ [»

This opbion enables the Session Recording Administrator Logging Senvice

[+] Enable Logging Service

This opbion Blocks policy and server properties changes if logging faals

[=] Enable Mandatory Blocking

This opbon requines users 1o enter the reason when playing a recording

[+] Enable Playback Justification Logging

With playback justification logging enabled, each time you play a recording, a dialog box appears,
asking you to enter a playback justification. For example, see the following screen captures:

Justification required for playback in the web player:
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Play recording

To continue, you are required to enter the justification for playing this
recording.

Enter

D

Justification required for playback in the Session Recording player:

[ Session Recording Player
Fle Edt View Pay Toos Hep

& b O] @@ |» | Search: - Anytime - (9 (4 | [T Advanced Search...

Worspace XSehRests

L\*‘g‘;v:: - administrator User Name Application Status Start Time. Duration  Delivery Group VDA Machine Recording Ser. Sze FielD

£ Favortes onds B administrator Desktop Complete  11/4/2022213PM  00:0855  VDAZ2-SIN VDA22SIN Server22:SIN 1.067KB  4502244b-badc-417-3a73<92055621bb
] Restricted B administrator Desktop Complete  11/4/2022212PM 000048  VDA22SIN VDA22:SIN Server22SIN 10.329KB 8715bd68-1e78-4ed-896-1c5067d535¢9

I administrator Desktop Complete ~ 11/4/2022159PM 001311 VDA22SIN VDA22:SIN Server22SIN 10.812KB  c54d5dfb-530c-4517-9679-54bb¥c3a388
I administrator Desktop Complete  11/3/2022508PM  00:0025  VDA22-SIN VDA22SIN Server22:SIN 7.788KB  478ab02d-1527-473-5d05-8b0ee 1561cSa
I administrator Desktop Complete  11/3/2022506PM 000152  VDAZ2-SIN VDA22SIN Server22:SIN 10.690KB  b19c9989-4bfe-460e badl-aad3dbd2caa’s
I administrator Desktop Complete  11/2/20225:46PM  00:18:11  VDAZ2-SIN VDA22SIN Server22:SIN 1.951KB  bbc10349-ach6-4262-86ch-46bbb8c81633
B administrator Desktop Complete  10/31/2022322PM  00:0028  VDA22SIN VDA22:SIN Server22SIN 312KB  146b7392-17-4822-ada1-Tdedd53b0c62
1 administrator Desktop Complete ~ 7/4/2022 3:15 PM 00:0210  VDA22:SIN VDA22:SIN Server22SIN 544KB  SaTecdf-581f-428-89d-33b/b5%b 170
I administrator Desktop Complete ~ 7/4/20223:12PM 00:01:45  VDA22SIN VDA22SIN Server22:SIN 360KB  8180de80-465e-4034-a28d-a47 Ibdaace20
I administrator Desktop Comolete 7/4/2022 3:09 PM 00:01:15 VDA22SIN VDA22:SIN Server22:SIN 412KB  2de9746d-Sadfdeed-83X 48064652 1ffc
I administrator Desktop Ca Play recording X iIN 665KB  90722c57-4735-4446 blcc4e Tbae44ds5
I administrator Desktop Co N 281KB  321e%11-8634-41c24f5e <8483 14aack

Now Playing x || B administrator Desktop Co ) o o iN 581KB 5340fb29-1fad4d16-%97-0027a5211%
a administrator Desktop Co i ':;?:i:nue‘ you are required to enter the justification for playing this I 86KB d7925056-93a1-4fecbdc7-a7c75dG 4638
I administrator Desktop o & e N 125KB  dda7504-eddc-45%-9547-9579156b2a2
B administrator Desktop Co BN 139KB bB588c30-7%8-480a-b6b-764b4 cSe 141

Events and Bookmarks

On the condition that playback justification logging is enabled on a Session Recording server, mind
the following tips for using playback justifications:

+ If you use a player that connects to a Session Recording server, a justification is required, even
for recording files that you downloaded to a local path.

+ Asingle session can generate multiple recordings because of file rollover. When you play back
such a recorded session, you must enter a justification for each of its recordings.
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Disable or enable administrator logging

After installation, you can disable or enable the Session Recording administrator logging feature in
Session Recording Server Properties.

1. As an administrator, log on to the machine where Session Recording administrator logging is
installed.

2. From the Start menu, choose Session Recording Server Properties.

3. Click the Logging tab.

When Session Recording administrator loggingis disabled, no new activities are logged. You can query
the existing logs from the web-based Ul.

When mandatory blocking is enabled, the following activities are blocked if the logging fails. A sys-
tem event s also logged with an Event ID 6001:

+ Changes to recording policies on the Session Recording Policy Console or Citrix Director.
+ Changes in Session Recording Server Properties.

The mandatory blocking setting does not impact the recording of sessions.

Configure an administrator logging service account

By default, administrator logging is running as a web application in Internet Information Services (11S),
and its identity is Network Service. To enhance the security level, you can change the identity of this
web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording server.
2. In IS Manager, click Application Pools.

3. In Application Pools, right-click SessionRecordingLoggingAppPool and choose Advanced
Settings.

4. Change the attribute identity to the specific account that you want to use.

5. Grant the db_owner permission to the account for the database CitrixSessionRecordinglLog-
ging on the Microsoft SQL Server.

6. Granttheread permissiontotheaccountfortheregistry key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\
Warning:

Editing the registry incorrectly can cause serious problems that might require you to re-
install your operating system. Citrix cannot guarantee that problems resulting from the
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incorrect use of the Registry Editor can be solved. Use the Registry Editor at your own risk.
Be sure to back up the registry before you edit it.

Disable or enable the recording reason logging

By default, administrator logging logs every recording reason after the policy query completes. This
behavior might generate many logs. To improve the performance and save the storage, disable this
kind of logging in the registry.

1. As an administrator, log on to the machine hosting the Session Recording server.
2. Open the Registry Editor.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Set the value of EnableRecordingActionLogging to:

0: disable the recording reason logging
1: enable the recording reason logging

Best practices

June 21, 2024

You can consult the following best practices documentation for deploying Session Recording and con-
figuring load balancing:

+ Configure load balancing in an existing deployment
» Deploy and load-balance Session Recording in Azure

Configure load balancing in an existing deployment

June 21, 2024

You can add load balancing nodes using Citrix ADC in an existing Session Recording deployment. The
following servers are used as an example. You can also deploy and load-balance Session Recording
in Azure.

+ Session Recording
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Host Name Server Role 0s IP Address

SRServerl Session Recording Windows Server 10.63.32.55
Server

LBDC Domain controller Windows Server 10.63.32.82

TSVDA Session Recording Windows Server 10.63.32.215
Agent

SRSQL Session Recording Windows Server 10.63.32.91
database and the file
server

All Session Recording components and the domain controller share adomain, forexample, 1b.
com. The domain administrator account, for example, Ib\administrator, is used for server logon.

« Citrix ADC
Management IP Subnet IP Address
Host Name Server Role Address (NSIP) (SNIP)
Netscaler Citrix ADCVPX instance 10.63.32.40 10.63.32.109

For more information, see Deploy a Citrix ADC VPX instance.

Step 1: Create shared folders on the file server

1. Log on to the file server by using a domain administrator account, for example, 1b\

administrator.

2. Create a folder to store recordings and name the folder SessionRecording, forexample, C
:\SessionRecording. Sharethe Read/Write permission of the folder with a Session Record-
ing server. Using SRServer1l as an example, type LB\SRSERVER1S. The dollar sign $ is re-
quired.
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Y + | Windows (C:) — [m] X
Home Share View 2]
« v 4 e > ThisPC » Windows (C:) » v & Search Windows 2
-
Name Date modified Type Size
# Quick access
46c2a726daB69f96b3bBc 54582202 File folder
[ Desktop
Perflogs File folder
‘ Downloads Program Files File folder
=] Decuments Program Files (x36) File folder
=| Pictures SessionRecording File folder
Open
[ This PC SQLServer2017Me 1 File folder
Users Open in new window 1 File folder
¥ Network Windows SRR I File folder
&l ip Give access to > Remove access B
Restore previous versions 2 Specific people...
Include in library >
Pin to Start
Send to >
Cut
Copy
Create shortcut
Delete
Rename
Properties
Yitems 1 item selected =
Home Share View 0
<« ~ 4 & > ThisPC » Windows (C) v & Search Windows (C:) P
Name Date modified Type Size
s Quick access
46c2a726daB69f96b3bBc 54586202 10, File folder
[ Desktop
PerflLogs 10, File folder
‘ Dawnloads Program Files 11 File folder
= Documents Program Files (x86) File folder
=] Pictures SessionRecording I File folder
[0 This PC SessionReco™ Eil- s B g “
SQLServer20
& Network Users & Metwork access
Windows
Elip .
Choose people on your network to share with
Type a name and then click Add, or click the arrow to find someone.
~ Add
Name Permission Level
2 Administrator Read/Write »
§2 Administrators Qwner
\SRSERVE Read/Write v _|
|
10items 1 item selected I'm having trouble charing E =

Gsﬂare Cancel

3. Create a subfolder withinthe SessionRecordingfolderand name the subfolder share, for
example, C:\SessionRecording\share.
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] + | SessionRecording

Home Share View [7]

« - 5> ThisPC > Windows (C:) > SessionRecording » v|@| | Search SessionRecording o

Name Date modified Type Size
s Quick access

[ Deskiop
4 Downloads

|2 Documents

share 11/25/2020 5:24 AM  File folder

&= Pictures
[ This PC

¥ Network

litem  State: 3R Shared |E| =

4. Createanotherfoldertorestore archived recordings and namethefolder SessionRecordingsRestore
, for example, C:\ SessionRecordingsRestored. Share the Read/Write permission
of the folder with a Session Recording server. Using SRServerl as an example, type
LB\SRSERVER1S. The dollar sign $ is required.

5. Create a subfolder within the SessionRecordingsRestored folder and name the
subfolder share, for example, C:\ SessionRecordingsRestored\share.

Step 2: Configure an existing Session Recording server to support load balancing

This step describes how to configure an existing Session Recording server to support load balancing.
Step 7 details the procedure of adding more Session Recording servers to your existing deployment.

1. Log on to a Session Recording server by using a domain administrator account.

2. Open Session Recording Server Properties.
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Windows Server
Citrix
Ceccio Ci i inis C >_
Session Recording Administrator L... )_
Windows Windows

Session Recording Authorization C... Server Manager  PowerShell PowerShell ISE

Session Recording Policy Console

Session Recording Server Properties ‘ @

Windows
Administrativ... Task Manager Contrel Panel

Firefox

3 g r

Google Chrome Event Viewer File Explorer

Microseft SOL Server 2019
Search
Server Manager

Settings

Windmwe Arreccnnas

A

3. Add the Universal Naming Convention (UNC) paths created in Step 1 to store and restore
recording files, in this example, \\SRSQL\SessionRecording\share and \\SRSQL\
SessionRecordingRestored\share. SRSQL is the host name of the file server.

Note:

The Session Recording player cannot play files under a path that contains a drive letter or
a dollar sign ($). The exception is that you install the player and the Session Recording
server on the same machine.
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% Session Recording Server Properties — >

Storage  Signing Rollover Playback Motfications CEIP Logging RE Y| *

Recorded session files are stored in the directories specified. To store files
in & load-balanced manner, specify multiple directories across different
volumes.

File storage directories:

4SR50 WSession Recording \share Add.

Specify a folder to temporarily store archived session recordings and make
them available for playback.

Restore directory for archived files:
I"-."-.SHSGL“-.Sessil:unHecnrdingsﬂestnred"-share l Browse...

Corca | [IIESB%

4. Add a value to the Session Recording server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.

Value name: EnableLB
Value data: 1 (D_WORD, meaning enable)
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B Registry Editor
File Edit View Favorites Help

ComputetHKEY_LOCAL_MACHINE\SOFTWARE Citrix\ SmartAuditor\Server

"D Computer Mame Type Data
:EE:—E b‘iiﬁfﬁg 5] (Default REG_SZ (value not st
HKEY_LOCAL M}\CHINE ‘.’.'A%]_Installed REG_DWORD 0x00000001 (1)
w
- BCDONIN00 %4 AllowLivePlayback REG_DWORD 0x00000001 (1)
5 . .
HARDWARE at ]AzureSQLServ!ceAdm!nPasswo‘.. REG_SZ
SAM '_"]AzureSQLSeNl(eAdmmUserna.” REG_SZ
SECURITY 3_"] DatabaseFailoverPartner REG_SZ
o SOFTWARE {h] DatabaseMame REG_SZ CitrixSessionRecerding
w7 Citrix 344 DeferredHashCalcFileSizeThres... REG_DWORD 0x00200000 (2097152)
Citrix Desktop Delivery Controller || %] DormantTimelnHours REG_DWORD 0xDD00O03D (43)
Citrix Session Recording '-'-'5] EnableAnalytics REG_DWORD 0x00000001 (1)
InstallAgent '-'-%] EnableAzureSOLService REG_DWORD 000000000 (0)
Metalnstall e EnableLB REG_DWORD 0x00000001 (1) |
SmartAuditor ?AﬁEnabIeRecordmgActanLoggmg REG_DWORD 0x00000007 (1)
Server ) Enable5RStoragel ogging REG_DWORD Ox0000000T (1)
HenTools '.'.%] EnableWebBasedSrPlayer REG_DWORD 0x00000001 (1)
KenToolslnstaller ab] FileStorageDirectories REG_MULTI_SZ WWSRSOL'SessionRecording'share
KenToolsNetSettings ab] LinkEmail REG 57
Classes a5] LinkExpire REG SZ 1728000000000
E'e':"t‘s N ab] LinkHost REG_SZ
. ault serEnvironment 5] LinkSalt REG_SZ Ii2oda74
m:;g © 14 LoggingBlockState REG_DWORD (x00000001 (1)
Microsoft ab] LeggingDatabaseFailoverPartner REG_SZ
Moszilla ab) LeggingDatabaseName REG_SZ CitrixSessionRecerdinglogging
mozilla.org '-’-%] LoggingLoggingState REG_DWORD 0x00000001 (1)
ODBC 4 MaxOpenFiles REG_DWORD 0x00002710 (10000)
OpensSH {"] NotifyMessageByCulture REG_MULTI_SZ
Partner '_"] MotifyMessageDefault REG_SZ Your activity with the desktop or programis) you r..
Policies %4 PlaybackProtection REG_DWORD 0x00000001 (1)
Cualys ‘-’-%] PlayerUserRBACEnabledKey REG_DWQORD 000000000 (0)
RegisteredApplications ab) PolicyFilePath REG_SZ ChProgram Files\Citrix\SessionRecording\Server\...
Setup ‘.’-%] PolicyFileRefreshPeriodInSeco.. REG_DWORD 0x0000012¢ (300)
WOWE432Mode ‘.’.%] RoleBasedSecurityEnabled REG_DWORD 000000001 (1)
SYSTEM '.'.'5] RolloverFileSizelnMB REG_DWORD 000000032 (50)
HKEY_USERS #| RolloverTimelnHours REG_DWORD 0x0000000c (12)
HKEY_CURRENT_CONFIG 4 SkipReceiverVersionCheck REG_DWORD 0x00000001 (1)

5. Restart the Citrix Session Recording Storage Manager service.

Step 3: Configure load balancing in Citrix ADC

There are two ways to configure load balancing in Citrix ADC - TCP passthrough and SSL offloading.

Configure load balancing through TCP passthrough

The following topologies show how to configure load balancing through TCP passthrough.

+ If you are using the Python-based WebSocket server (Version 1.0):
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(- ""‘fgg? ADC Load Balancing

-

l = HTTPS TP ‘ 1301‘ 443 ‘ 80 ‘ ‘1 ———————— >‘ 1301‘ 443 ‘ 80 ‘ ‘
e=——3N 443 T T T

HTTP
o

HTTP 80 E
HTTPS 443 SAN Certificate
MSMQ 1801

Session Recording Server

] E
e SAN Cerificate

Session Recording Server

TTPS |HTTP
443 | 30

o O

Client

+ If you are using the WebSocket server hosted in IIS (Version 2.0):

i- ysua ADC Load Balancing 5
: T Sockel 80
L TS Tcp ‘ 1301‘ Y ‘ 80 ‘4 """"" >‘ 1301‘ 413 ‘ 30 ‘ : HTTPS 443
JLI. "TE § ’ ; SAN Cerlificate

MSMQ 1801

Session Recording Server

( 0 ¢ 0
(s
e =)
l‘g-g SAN Cerificate
1 Session Recording Server
N
HTTPS | HTTPAVebSOCKe
443 80

® 0

Client

To configure load balancing through TCP passthrough, complete the followings steps:

1. Logon to your Citrix ADC VPX instance.

2. Navigate to Configuration > System > Settings > Configure Basic Features.
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cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu System / Settings
Settings
Licenses
Settings Modes and Features
Diagnostics Configure Modes
I Configure Basic Features I
High Availability > Configure Advanced Features
NTP Servers Configure Extra Management CPU
Reports
Profiles
Partition Administration >
User Administration b
Authentication >
Auditing >
SNMP > ADM
AppFlow @ > Configure ADM Parameters

3. Select Load Balancing and click OK.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

@ Configure Basic Features

SSL Offloading HTTP Compression
Load Balancing Content Switching

Content Filter Integrated Caching

Rewrite Citrix Gateway

Authentication, Authorization and Auditing

o IR

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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cifrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Traffic Management / Load Balancing / Servers

Q Searchin Menu
Syst
e > Servers @

AppExpert >

I Traffic Management I g | Add ‘ Select Action ~
Load Balancing i ~ i
Q Click here to search or you can enter Key : Value format

Virtual Servers
NAME STATE

Services
. No items
Service Groups
Meniters
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing [ S
Content Switching >

IPADDRESS / DOMAIN

Type the name and IP address of a Session Recording server and then click Create. For example:

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

Documentation

Downloads

® Create Server

Name*
srv-1 @
o) IP Address Domain Mame
IPAddress®
10.63.3255 {D

Traffic Domain

| Enable after Creating

Comments

Click the save icon in the upper right corner to save your changes.
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Traffic Management / Load Balancing / Servers

Servers @
Q Click here to sea ou can enter Key - Value format o

NAME STATE IPADDRESS / DOMAIN TRAFFIC DOMAIN

| ¥ sivl @ENABLED 10633255 0

Total 1 25PerPage v Page 1 ofl

5. For WebSocket server Version 1.0, add load balancing services of ports 80, 1801, 22334, and
443 for each Session Recording server. For WebSocket server Version 2.0, add load balancing
services of ports 80, 1801, and 443 for each Session Recording server.

Navigate to Traffic Management > Load Balancing > Services and click Add.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Services /[ Services
System > .
Services
AppExpert >
ﬂ]’rafﬁc Management b Services o Auto Detected Services 0 Internal Services = 6

Load Balancing )
I o8¢ Baancing | e Add ‘ Statistics | | No action

Virtual Servers

. Click here to search or vou can enter Key - Value format
Services Q ere 1o search or you can enter Rey - Value 1o

Service Groups NAME SERVER STATE

Moenitors No items
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing |

S N

Content Switching

Type a name for each load balancing service that you add. Choose Existing Server, select the
IP address of your target Session Recording server, select TCP as the server protocol, and type
a port number. Click OK.
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Cifrix ADC VPX (1000)

DEHLIE]L

Configuration

Reporting Documentation Downloads

® Load Balancing Service
Basic Settings

Service Mame*

srv-1-80

©)

New Server o) Existing Server
Server”®

srv-1(10.63.32.55) %
Protocol*

TCP 0]
Port*

80 @
» More

o [

Bind the TCP protocol monitor to each load balancing service.
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Service Load Balancing Monitor Binding / Load Balancing Menitor Binding
Load Balancing Monitor Binding

Select Monitor*
H tp >]| Add || Edit ‘@

 Binding Details

Weight
1

| State

ﬁ Clcse

Click the save icon in the upper right corner to save your changes.

Traffic Management / Load Balancing / Services / services

Services
Services |4 | Auto Detected Services | 0 | Internal Services | 6
‘ Add ‘ ‘ Edit ‘ ‘ Delete ‘ ‘ Statistics ‘ ‘Atlmn -
m] Name state
] snv-1-1801 our
] sn-1-22334 our
() SIv-1-443 our
(%] sv-1-80 oup

.
Tip:
.

1P Address/Domain Name

10623255

10633255

10633255
10623255

Q
Search
Port Protocol Max Clients Max Requests. Cache Type Traffic Domain
801 TCP 0 0 SERVER 0
22334 TCP o 0 SERVER 0
a3 TP 0 0 SERVER 0
80 TP 0 0 SERVER 0

The load balancing service of port 22334 is required only for WebSocket server Version

1.0.

6. Add load balancing virtual servers.

For WebSocket server Version 1.0, complete the following steps to add load balancing virtual
servers of ports 80, 443, 1801, and 22334. For WebSocket server Version 2.0, add load balanc-
ing virtual servers of ports 80, 443, and 1801. For example:
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Traffic Management / Load Balancing / Virtual Servers

Virtual Servers ) ®|:|
Add Edit Delete Enable Disable Statistics Action - Search ~
[m] Name State Effective State IP Address Port Protocol Method Persistence % Health Traffic Domain
a vsrv-80 o ouP 10.633260 80 TCP LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/O DOWN [
[} oUP @UP 10633260 1801 Tcp LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/0 DOWN o
[m] oupP ouP 10633260 443 TP LEASTBANDWIDTH SOURCEIP % 1UP/0 DOWN o
[m] Vsiv-22334 ouP ®UuP 10.63.3260 22334 TcP LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/Q DOWN o

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.

Reporting Documentation Downloads

Menu Traffic Management / Load Balancing / Virtual Servers

Q Searchi

System .
Virtual Servers @
AppExpert
iTrafﬁc Management | e | Add ‘ ‘ Statistics ‘ | Select Action v

LOa(IBBIanCin“ e Click hero tn caarch or yntl can ante (ny - ~ farmat
NAME STATE EFFECTIVE STATE IP ADDRESS

Services

. No items
Service Groups

Menitors ToEl@
Metric Tables
Servers
Persistency Groups

Radius Nodes

Priority Load Balancing [

W

Content Switching

Add each virtual server with the Citrix ADC VIP address based on the TCP protocol.
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citrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Basic Settings

Create a virtual server by specifying a name, an IP address, a port. and a protocol type. If an application is accessible from the Internet, the virtual server IP (VIP) address is a publi
network {(WAN), the VIP is usually a private (ICANN non-routable) IP address.
You can configure multiple virtual servers to receive client requests, thereby increasing the availability of resources to process client requests

Name*

vsrv-80 @
Protocol*

cP v @
IP Address Type*

IP Address e
IP Address®

10 . 63 . 32 . 60 (@)

Port

80 (0]

Bind each virtual server to the load balancing service of the same port. For example:

Cifrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

@ Load Balancing Virtual Server

Load Balancing Virtual Server | Exportasa Template

Basic Settings

Name vsrv-80 Listen Priority -

Protocol TCP Listen Policy Expression NONE

State @®DOWN Redirection Mode P

IP Address 10.63.32.60 Range 1

Port 80 IPset -

Traffic Domain 0 RHI State PASSIV
AppFlow Logging ENABLI

Retain Connections on Cluster NO
TCP Probe Port -

Services and Service Groups

A service s a logical representation of an application running on a server.
A service group enables you to manage a group of services as though it were a single service. After creating a service group, you can bind it to a virtual server, and you can add service:
Note: Bind at least one service or service group to the virtual server.

Click Continue to display the advanced settings and select the method, persistence type, and any other configuration detail that you might need.

No Load Balancing Virtual Server Service Binding

Mo Load Balancing Virtual Server ServiceGroup Binding
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Service Binding / Service

Service @3

Q Click here to search or you can enter Key : Value format

NAME
srv-1-80
srv-1-443
srv-1-1801

srv-1-22334

Total 4

Choose a load balancing method.
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Method

Method is a load balancing algorithm that the Citrix ADC usesto s

Load Balancing Method®

LEASTEANDWIDTH e @

Mew Service Startup Reguest Rate

0

Backup LB Method*
ROUNDROBIN e

Mew Service Reguest unit”

PER_SECOND v

Increment Interval

Configure persistence on each virtual server. We recommend you select SOURCEIP as the per-
sistence type. For more information, see Persistence settings.
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Persistence

Configure persistence to route all connections from the same use
persistence type fails.

Select Persistence Type*

E]SDUHCEIP

Time-out {mins)*

2

IPv4 Metmask

265 . 25h

RULE

Ma
£
o

IPvE Mask Length

128

OTHERS

]
(%]
o

@

. Create a host record for the Citrix ADC VIP address on the domain controller.

,gl_., DNS Manager X
Eile Action View Help
= sE XE Hm 8
r% I?NS Name Type Data Timestamp
v i LEDC ﬂ_msdc;
w || Forward Lookup Zones j sites
» 2] _msdcslb.com j_tcp
> = Ib.com jiudp
» [ Reverse Lockup Zones = X
o 0 Trust Paints jDomamDnsZones
» [| Conditional Forwarders jForestDn;Zones
E (same as parent folder) Start of Authority (SOA) [47], Ibdc.lb.com., hostma... static
E (same as parent folder) MName Server (MNS) Ibde.lb.com. static
E(same as parent folder) Haost (A) 10,63.32.82 11/19/2020 2:00:00 AM
Elibde Host (A} 10.63.32.82 static
Eleooc Host (A) 10.63.32.1 11/19/2020 11:00:00 PM
Host (A) 10 60
Elsrserven Host (A} 10.63.32.55 11/18/2020 2:00:00 AM
ElsRserver2 Host (A} 10.63.32.68 11/19/2020 11:00:00 PM
ElsrsaL Host (A) 10.63.32.91 11/23/2020 3:00:00 AM
Eltsvoa Host (A) 10.63.32.215 11/23/2020 2:00:00 AM
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8. To access the web player over HTTPS, ensure that a SAN certificate is available both on Citrix
ADC and on each Session Recording server. A SAN certificate contains the FQDNs of the Citrix
ADC and of each Session Recording server.

n  Certificate >

General Cetals  Certification Path

Show: | <all= e
Field Yalue 6
5] Autharity Key Identifier KeyID=693d13b5780dch45ab. ..

CF‘.L Distribution Paints [1]CRL Distribution Point: Distr. ..
@.ﬁ.uthnrity Information Access  [1]Authority Info Access: Acc...
a Certificate Template Name WehbServer

Subject Alternative Mame DS Mame=netscaler.lb.com, ...
[=Key Jsage
DThumbprint

ceaabtf2c434becie 338000904, .

DMS Mame=netscaler.|b.com
DMS Mame=10.563.32.60

IP Address=10.63.32.60

DMS Mame=localhost

DMS Mame=5RServer 1.lb.caom
DMS Mame=10.63.32.55

IP Address=10.53.32.55

DMS Mame=localhost

Edit Properties... Copy to File...

Configure load balancing through SSL offloading

The following topologies show how to configure load balancing through SSL offloading.

« If you are using the Python-based WebSocket server (Version 1.0):
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== MSMQ
- 1801
VDA
l =T HTTPS|
443
VDA

& [F

SAN Certificate

ADC Load Balancing

=

Certificate

HTTPS 443

« If you are using the WebSocket server hosted in IIS (Version 2.0):

MSMQ
1801
VDA

- HTTPS]|
= 443

VDA

MSMQ_ 1801
Session Recording Server

Certificate

HTTPS
443

® 0

Client

& F

SAN Certificale
ADC Load Balancing

ECS e O I

TCP |

443 ‘ 1801 } """""" } wsm| 443 ‘

Session Recording Server

HTTPS/WebSocket(WSS) 443
Certificate

MSMQ_1801
Session Recording Server

HTTPS/WebSocket(WSS)
443

® 0

Client

1. Log on to your Citrix ADC VPX instance.

Certificate

Session Recording Server
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2. Navigate to Configuration > System > Settings > Configure Basic Features.

Cifrix ADC VPX (1000)

ET G LGE Configuration Reporting Documentation Downloads
Q) Search in Menu System / Settings
Settings
Licenses
Settings Modes and Features
Diagnostics Configure Modes
| Configure Basic Features |
High Availability > Configure Advanced Features
NTP Servers Configure Extra Management CPU
Reports
Profiles
Partition Administration >
User Administration 5
Authentication >
Auditing >
SNMP > ADM
AppFlow |E| N Configure ADM Parameters

3. Select SSL Offloading and Load Balancing and click OK.

Cifrix ADC VPX (1000)

EE [ E Configuration Reporting Documentation Downloads

® Configure Basic Features

S5L Offloading HTTP Compression

.~ Load Balancing Content Switching
Content Filter Integrated Caching
Rewrite Citrix Gateway

Authentication, Authorization and Auditing

o [

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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cifrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Traffic Management / Load Balancing / Servers

Q Searchin Menu
Syst
e > Servers @

AppExpert >

I Traffic Management I g | Add ‘ Select Action ~
Load Balancing i ~ i
Q Click here to search or you can enter Key : Value format

Virtual Servers
NAME STATE

Services
. No items
Service Groups
Meniters
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing [ S
Content Switching >

IPADDRESS / DOMAIN

Type the name and IP address of a Session Recording server and then click Create. For example:

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

Documentation

Downloads

® Create Server

Name*
srv-1 @
o) IP Address Domain Mame
IPAddress®
10.63.3255 {D

Traffic Domain

| Enable after Creating

Comments

Click the save icon in the upper right corner to save your changes.
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Traffic Management / Load Balancing / Servers

Servers @
Q here to seat ou can enter Key - Value format
NAME STATE IPADDRESS / DOMAIN TRAFFIC DOMAIN
| v srv-1 @ENABLED 10633255
Total 1 25 Per Page

v Page 1 ol

5. Add load balancing services for each Session Recording server that you added in the previous

step.

Add the following load balancing services for each Session Recording server:

+ (Required only when you are using the WebSocket server Version 1.0) SSL load balancing

service of port 22334 that binds to the TCP monitor
+ SSL load balancing service of port 443 that binds to the HTTPS monitor
« TCP load balancing service of port 1801 that binds to the TCP monitor

Traffc Management / Load Balancing / Services / Services
Services
Services 3 Auto Detected Services  © temal Services | 6
Stat

(m] Name State IP Address/Domain Name Port Protocol Max Clients Max Requests Cache Type
®60 . L ERVER

O 1 L] SERVES

[m 4 ®UP 10633255 2: L SERVEI

Traffic Bomain

Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Services [ Services
System > H
Services
AppExpert b
IIIT,-afﬁC Management v Services @)  Auto Detected Services 0 Internal Services &

I Load Balancing | e ‘ Statistics

| Mo action ~

Virtual Servers

e Q ck here to search or you can enter Key : Value format

Service Groups NAME SERVER STATE

Monitors No items
Metric Tables
Servers

Persistency Groups

Radius Nodes @
Priority Load Balancing |E| >
Content Switching @ >
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(Required only when you are using the WebSocket server Version 1.0) Add an SSL load
balancing service of port 22334 for each Session Recording Server. Type a name for the
load balancing service, choose Existing Server, select the IP address of a Session Recording
server, select SSL as the server protocol, type port number 22334, and click OK.

For example, see the following screen capture.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

® Load Balancing Service

Basic Settings

Service Name®
srv-1-22334 @
Mew Server e Existing Server

Server®

srv-1(10.63.32.55) o

Protocol*

SSL v (D
Port*
22334 @D

» More

o =

Bind the TCP monitor to the SSL load balancing service you just added.
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Service Load Balancing Monitor Binding / Load Balancing Monitor Binding

Load Balancing Monitor Binding

Binding Details

ad || Edt | ©

Weight
1 ®

| State

. |

Add an SSL load balancing service of port 443 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording server, select SSL as the server protocol, type port number 443, and click OK.
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Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

® Load Balancing Service

Basic Settings

Service Mame*

srv-1-443 @

Mew Server e Existing Server
Server*

srv-1(10.63.32.55) W
Protocol*

S5L e

&

Port

| 443 | @

» Maore

o [

Bind the HTTPS monitor to the SSL load balancing service you just added.
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Service Load Balancing Monitor Binding / Load Balancing Menitor Binding

Load Balancing Monitor Binding

Select Monitor*

https E‘ Add it | @

Binding Details

Weight
1

 State

m Close

Add a TCP load balancing service of port 1801 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording server, select TCP as the server protocol, type port number 1801, and click OK.
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Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentat

® Load Balancing Service

Basic Settings

Service Name*
srv-1-1801 @
Mew Server e Existing Server

Server*
srv-1(10.63.3255) W

Protocol®

TCP e {D

i

Port

1801 @

b More
o I

Bind the TCP monitor to the TCP load balancing service you just added.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 321



Session Recording 2407

Service Load Balancing Monitor Binding / Load Balancing Menitor Binding

Load Balancing Monitor Binding

Select Monitor*

fcp > | | Add Edit |®

Binding Details

Weight
1

| State

- .

6. (Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
each SSL load balancing service of port 22334,

Navigate to System > Profiles > HTTP Profiles and click Add.
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cCitrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu System / Profiles / HTTP Profiles
System e '
I Profiles
Licenses
P TCP Profiles = 13 HTTP Profiles Database Profiles = 0 SSL Profil
Settings
Diagnostics Add
High Availability b
NTP Servers Q Click here to search or you can enter Key : Value format
Reports NAME DROP INVALID INVALIDATE HTTI
Profiles nshttp_default_profile » b'e
Partition Administration S nshttp_default_strict_validation v v
User Administration > nshttp_default_internal_apps v '
Authentication >
Total 3
Auditing >
SNMP b

Select the Enable WebSocket connections check box and accept the other default settings.
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HTTP/2 Initial Window Size
65535

HTTP/2 Maximum Concurrent Streams
100

HTTP/2 Maximum Frame Size
16384

HTTP/2 Minimum Server Connections

20

HTTP/2 Maximum Header List Size

24576

HTTP/2 Maximum Ping Frames Per Minute

HTTP/2 Maximum Reset Frames Per Minute

HTTP/2 Maximum Empty Frames Per Minute

HTTP/2 Maximum Settings Frames Per Minute

0]
Alternative Service | Connection Multiplexing Drop invalid HTTP requests
Mark HTTP/0.9 requests as invalid Mark CONNECT Requests as Invalid Mark TRACE Reguests as Invz
Mark RFC7230 Non-Compliant Transaction as Invalid Mark HTTP Header with Extra White Space as Invalid Compression on PUSH packet
| Drop extra CRLF | Enable WebSocket connections (D | Enable RTSP Tunnel
Drop extra data from server | HTTPWeblogging Persistent ETag

Adaptive Timeout

Type a name for the HTTP profile, for example, websocket_SSL.

Go back to each SSL load balancing service of port 22334, for example, srv-1-22334. Click
+ Profiles.
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Citrix ADC VPX (1000) g Partition | ngroot v

Not configured default

Dashboard Canfiguration Reporting Documentation Downloads -ﬁ-

G Load Balancing Service

Basic Settings Ve Help
Service Name Traffic Domain 0
Server Name srv-1 Number of Active Connections - Advanced Settings
IP Address 10.63.32.55 Hash ID -
Server State @®DOWN Server ID None =+ Thresholds & Timeouts
Protocol SSL Clear Text Port -
Port 22334 Cache Type SERVER [ + Profiles
Comments Cacheable NO
Health Monitoring YES o
AppFlow Logging ENABLED +  Policies

Monitering Connection Close Bit NONE
4+ SSL Profile

Service Settings VAR
4+ SSL Policies
Sure Connect Use Source IP Address  NO
Surge Protection  OFF Client Keep-Alive NO + Certificate
Use Proxy Port YES TCP Buffering NO

Select the HTTP profile, for example, websocket_SSL, and click OK and then Done.

Profiles
Met Profile

w | 4+
TCP Profile

w | 4+
HTTP Profile

websocket 550 1 +

DM5 Profile Mame

L

Done

7. (Required only when you are using the WebSocket server Version 2.0) Add an HTTP profile for
each SSL load balancing service of port 443.

8. Create a host record for the Citrix ADC VIP address on the domain controller.
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2, DNS Manager

File  Action View Help

e« | HEXE= BmE §E8E

2, DNS
~ 5 LBDC

~ | Forward Lookup Zones
=) _msdeslb.com
=/ lb.com
~| Reverse Lookup Zones
| Trust Points

~ Conditional Forwarders

Narne

_P—_Lmsdcs

j_sites

e

i
jDomamDnsZones
:]FnrestDnsZnnes
E—|(same as parent folder)
E—l(same as parent folder)
E—l(same as parent folder)

Type

Start of Authority (SOA)
Mame Server (MN5)

Host (A)

Host (A)

Host (A)

Data

[47], Ibdc.lb.com., hostma...

lbdc.lb.com.
10.63.32.82
10.63.32.82
10.63.32.1

Timestamp

static

static

11/19/2020 2:00:00 AM
static

11/19/2020 11:00:00 PM

ElTsvoa

Host (A)
Host (&)
Host (A}
Host (A)

10.63.32.60
10,63.32.55
10.63.32.68
10.63.32.91
10,63.32.215

11/18/2020 2:00:00 AM
11/18/2020 11:00:00 PM
11/23/2020 3:00:00 AM
11/23/2020 2:00:00 AM

9. Add load balancing virtual servers.

Add the following load balancing virtual servers with the Citrix ADC VIP address.

+ (Required only when you are using the WebSocket server Version 1.0) load balancing vir-
tual server of port 22334 based on SSL

« load balancing virtual server of port 443 based on SSL

+ load balancing virtual server of port 1801 based on TCP

For example, see the following screen capture.
Traffic Management / Load Balancing / Virtual Servers

Virtual Servers

Add Statistics Action -
a Name State Effective State IP Address Port Protocol Method Persistence % Health
[m] varv- oup our 10 EIP

oup our 10

our our 10,

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.
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ciftrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Virtual Servers
System > .
Virtual Servers @
AppExpert
iTrafﬁc Management | e | Add ‘ ‘ Statistics ‘ | Select Action v
I Load Balancing I b N o
Q) Click here to search or you can enter Key : Value format
= NAME STATE EFFECTIVE STATE IP ADDRESS
Services
. No items
Service Groups
Total 0

Menitors

Metric Tables
Servers
Persistency Groups

Radius Nodes

Priority Load Balancing [

W

Content Switching

Add each virtual server with the Citrix ADC VIP address. Type a server name, select TCP or SSL,
and select the relevant port number as described earlier.

Cilrix_ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Basic Settings

Create a virtual server by specifying a name, an IP address, a port. and a protocol type. If an application is accessible from the Internet, the virtual server IP (VIP) address is a publi
network {(WAN), the VIP is usually a private (ICANN non-routable) IP address.
You can configure multiple virtual servers to receive client requests, thereby increasing the availability of resources to process client requests

Name*

vsrv-80 @
Protocol*

CP v @
IP Address Type*

IP Address e
IP Address®

10 . 63 . 32 . 60 (@)
Port*

80 (@)
» More

Bind each virtual server to the load balancing service of the same port. For example:
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Tip:

Service Binding / Service

Service &

Edit

Q Click here to search or you can ente

NAME

srv-1-22334

] svi-443

srv-1-1801

Total 3

The load balancing service of port 22334 is required only when you are using the Web-

Socket server Version 1.0.

Choose a load balancing method.
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Method

Method is a load balancing algorithm that the Citrix ADC usesto s

Load Balancing Method®

LEASTEANDWIDTH e @

Mew Service Startup Reguest Rate

0

Backup LB Method*
ROUNDROBIN e

Mew Service Reguest unit”

PER_SECOND v

Increment Interval

Configure persistence on each virtual server. We recommend you select SOURCEIP as the per-
sistence type. For more information, see Persistence settings.
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Persistence

Configure persistence to route all connections from the same user
primary persistence type fails.

Select Persistence Type*

@ SOURCEIP OTHERS (D

Time-out (mins)*
30 0

[Pvd Metmask

255 . 255 . 255 . 255

IPvE Mask Length

128

(Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
the load balancing virtual server of port 22334.

Profiles x
A profile is a collection of settings that can be applied to a MetScaler entity, such as a virtual server or service. You can apply the same profile to multiple entities of the same type.

Net Profile HTTP Profile

‘ h |B |:| [websucket_SSL vl
TCP Profile —

| I+ =2
LB Profile DN5 Profile Name

| I+l “[+)l7]
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10. Install a Subject Alternative Name (SAN) certificate in Citrix ADC.

Obtain a SAN certificate in PEM format from a trusted Certificate Authority (CA). Extract and up-
load the certificate and private key files in Citrix ADC by navigating to Traffic Management >
SSL > Server Certificate Wizard.

For more information, see SSL certificates.

4 Install Certificate

Certificate-Key Pair Mame*

Ibcard

Certificate File Name*

Choose File w |lbcard.cer
Key File Name™*

Choose File w |lbcard key
Password™

[....| ]

#| MNotify When Expires

No SNMP Trap destination found. Notification will not be sent until 2 trap destination is configured.

Motification Period

30

11. Bind a SAN certificate to each SSL load balancing virtual server.

Navigate to Traffic Management > Load Balancing > Virtual Servers, select an SSL load bal-
ancing virtual server, and click Server Certificate.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 331


https://docs.citrix.com/en-us/citrix-adc/current-release/ssl/ssl-certificates.html

Session Recording 2407

Cilrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Load Balancing Virtual Server | Export as a Template

Basic Settings

Mame vsrv-443
Protocol SSL

State ®DOWN

IP Address 10.63.32.60
Port 443

Traffic Domain 0

Services and Service Groups

1 Load Balancing Virtual Server Service Binding

Mo Load Balancing Virtual Server ServiceGroup Binding

Certificate

Mo Server Certificate

MNo CA Certificate

Add the previously mentioned SAN certificate and click Bind.

Step 4: Configure an existing Session Recording Agent to support load balancing

1. Log on to the Session Recording Agent by using a domain administrator account.
2. Open Session Recording Agent Properties.

3. Complete this step if you use Microsoft Message Queuing (MSMQ) over TCP.
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Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box.

LE} Session Recording Agent Properties —

Recording Connections

>

Session Recording Server: MNetScaler Ib.com

Session Recording Storage Manager message queue

Protocol: TCP L
HTTR/HTTFS port: Default
Fort Number:

Message life specifies the period during which data remains in the

message quels.

Meszage life (seconds):

Session Recording Broker
Protocaol: HTTFS e
HTTR/HTTPS part: Custom b

Carcs

On each Session Recording server, add and set the IgnoreOSNameValidation
DWORD value to 1 under HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\MSMQ\
Parameters. For more information, see Knowledge Center article CTX248554.

4. Complete this step if you use MSMQ over HTTP or HTTPS.

(Skip if this step is done) Create a host record for the Citrix ADC VIP address on the domain con-

troller.
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@

7, DNS Manager *
File  Action View Help
= D XE = Bm § 8
2 [ENS Name Type Data Timestamp
v & Lsnc ——_Lmsdcs
~ || Forward Lockup Zones j sites
-| _msdes.lb.com j_t(p
- | Ib.com -
| Reverse Lookup Zones j’Udp
Trust Points jDomamDnsZones
| Conditional Forwarders jFD'EStD”SZDHES
E—|(same as parent folder) Start of Authority (SOA) [47], Ibdc.lb.com., hostma...  static
E—l(sameas parent folder) Mame Server (MN5) lbdc.lb.com. static
[—l (same as parent folder) Host (4) 10.63.32.62 11/19/2020 2:00:00 AM
i Host (A) 10.63.32.82 static
Host (A) 10.63.32.1 11/19/2020 11:00:00 PM
10.63.32.60
Host (A) 10.63.32.55 11/19/2020 2:00:00 AM
Host (A) 10.63.32.68 11/19/2020 11:00:00 PM
Host (A} 10.63.32.91 11/23/2020 3:00:00 AM
Elrsvoa Host (A} 10.63.32.215 11/23/2020 2:00:00 AM

Oneach Session Recording server,runthe powershell.exe -file SrServerConfigurationSyn

.psl -Action AddRedirection - ADCHost <ADCHost> command to add redirec-
tions from Citrix ADC to the local host. <ADCHost> isthe FQDN of the Citrix ADC VIP address. A
redirection file, for example, sr_1b_map.xmlis generated under C: \Windows\System32

\msmg\Mapping.

E¥ Administrator: PowerShell

1b_map.xml

er.lb.com

Note: Change to the folder where SrServerConfigurationSync.ps1 resides when you

run PowerShell.exe.

Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box. For exam-
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ple:
.E,'-J Session Recording Agent Properties — »

Recording Connections

Session Recording Server: NetScalerb.com

Session Recording Storage Manager message queue

Pratocaol: HTTP ~
HTTR/HTTPS port: Default w
Port Number:

Message life specifies the peried during which data remains in the
MESSage queLe.

Message life (seconds):

Session Recording Broker

Protocol: HTTPS v
HTTR/HTTPS port: Custom w
Port Mumber:

Conoe | [ opy

Step 5: Configure an existing Session Recording player to support load balancing

On each machine where you installed the Session Recording player component, add the Citrix ADC
VIP address or its FQDN as the connected Session Recording server.

Step 6: Check whether load balancing works for the configured, existing Session
Recording server

1. Launch a Citrix virtual session.
2. Check whether the session can be recorded.

3. Check whether the web player and the Session Recording player can play back the recording
file.

Step 7: Add more Session Recording servers

1. Prepare a machine in the same domain and install only the Session Recording server and Ses-
sion Recording Administrator Logging modules on the machine.
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Citrix Virtual Apps and Desktops 7

¥ Licensing Agreement
v Core Components
Features
Database and Server
Administrator Logging
Summary
Install

Finish

Features

4

Feature (Select all)

Session Recording Palicy Cansale
Citrix Session Recording Policy Console

Session Recording Server
Citrix Session Recording Broker and Storage Management

Session Recording Administrator Logging
Administrator L
itie

ng captures Session R
to the Session Re

recording ac

Session Recording Database
Citrix Session Recording Database

Back I

Mext

|  Cancel

Server configuration changes and

2. Use the same database names as the existing Session Recording server. For example:
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Citrix Virtual Apps and Desktops 7
Administrator Logging Configuration

¥ Licensing Agreement Specify Session Recording logging configuration
" Core C onents
e Configuration

+ Features
The Administrator Logging database is installed on the SQL Server instance:

+ Database and Server

SRS0L
Administrator Logging
Summa
i Administrator Logging database name:
Install
| CitrixSessionRecerdinglogging
Finish

Test connection...

Enable Administrator Logging

<

This option enables the Session Recording Administrator Logging service,

Enable mandatary blacking
This option blocks pelicy and server property changes if logging fails.

Back | " Next | Cancel

3. Disable the network firewall on the machine.

4. On the SQL Server where you installed the Session Recording database, add all the Session
Recording server machine accounts to the shared Session Recording database and assign them

with the db_owner permission. For example:
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Lt); Microsoft SOL Server Management Studio (Administrator)

File Edit View Debug Tools Window Help
= | " - - o | a2 New Cuery P I o | - - | b | Generic Debugger -
gl v X @ Database User - LB\SRSERVER2S - o x
Connect~ ¥ *¥ (VIS P T sert = © Hob
= i@ SRSOL (SOL Server 14.0.900.75 - LB\ = »
=] Databases & Owned Schemas
Systern Databases & Membership User type:
Database Snapshots F Securables Windows user
= i@ CitrixSessionRecording # Edended Propet
Database Diagrams User name:
Tables LB\SRSERVER2S | |
Views Login name:
External Resources WVEHZ‘ ‘
Synonyms -
Programmability
Service Broker
Storage Default schema:
=] Security I |db° I
= Users
&3 dbo
&7 guest ‘Connechon
&2 INFORMATION_S Server:
ﬁ LBASRSERVER1S SRSAL
&3 LB\SRSERVER2S Connection:
&9 LB\SRSERVER3S LB'administrator
& oy ¥ View connection properties
Roles
Schemas
Asymmetric Keys
Certificates Progress
Symmetric Keys Ready
Always Encrypted Ke
Database Audit Speci
Security Policies
W CitrixSessionRecordingLoggi
Security - e
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W Database User - LB\SRSERVER2S — O x
e IT Script ~ @) Help
& General
& Owned Schemas
y 2 Database role membership:

& Securables

Role Members
& Exended Properties

<

db_accessadmin

db_backupoperator
db_datareader
db_datawriter
db_ddladmin
db_denydatareader
db_denydatawriter
db_owner I
db_zecurtyadmin

O
O
O
O
O
[J
O

Connection

Server:
SRSGL

Connection:
LB administrator

ﬁ View connection properties

Progress
Ready

Cancel

5. Share the Read/Write permission of the recording storage and restore folders, for example,
SessionRecording and SessionRecordingsRestored, with the machine account
of the new Session Recording server, for example, LB\SRServer2s$. The dollar sign $ is
required.

6. Repeat Step 3 to add load balancing services for the new Session Recording server and edit
existing virtual servers to add bindings to the load balancing services. There is no need to add
more virtual servers. For example:
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Cifrix. ADC VPX (1000)

DEELEL Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Servers
System
Servers @
AppExpert
I Traffic Management W Select Action w
Load Balancing w

re to search or you can ent:

Virtual Servers

. NAME STATE IPADDRESS / DOMAIN
Services

srv-1 @®ENABLED 1063.3255
Service Groups @ @ ! -

. @ENABLED 10633274
Monitors

Metric Tables o=l
Servers

Persistency Groups

Radius Nodes (

cifrix ADbcvex (1

Dashboard Configuration Reporting Documentation Downloads

Q Traffic Management / Load Balancing / Services / Services
System .
Services
AppExpert
ITmmc Management ~ Services )  Auto Detected Services 0 Internal Services | 6
Load Balancing o

Virtual Servers

Service Chaining

User

Services
Service Groups NAME SERVER STATE IP ADDRESS/DOMAIN NAME PORT PROTOCOL
Menitors srv-1-80 eupP 10633255 80 TcP
Metric Tables srv-1-443 eurP 1063.3255 443 TCP
Servers srv-1-1801 eUuP 10633255 1801 TCP
Persistency Groups eup 10.63.32.65 22334 TCP
Radius Nedes @ euP 1063.32.74 443 TCP
Priority Load Balancing \I\ > oupP 1063.32.74 80 CcP
Content Switching \1\ > eouP 10633274 1801 CcP
Cache Redirection @ > srv-2-22334 ®UuP 10633274 22334 TCP
DNS > Total 8
GsLe @ >
ssL 3
Subscriber >
>
>
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cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Q1 Search in Menu Traffic Management / Load Balancing / Virtual Servers

System

Virtual Servers

AppExpert >

<

ITraﬁicManagemenl | Add | | Edit | ‘ Delete | ‘ Disable | | Rename | ‘ Statistics | | Select Action ~

Load Balancing i

Q Click here to search or you can er

NAME STATE EFFECTIVE STATE IP ADDRESS

:Value format

Services

vsrv-80 L JUY euP 10.63.32.60
Service Groups

. vsrv-1801 eup eUP 10.63.3260
Monitors

vsrv-443 L JUS euP 10.63.3260
Metric Tables

Servers vsrv-22334 euP euP 10.63.32.60

Persistency Groups Total 4

Radius Nodes

Priority Load Balancing

Content Switching

Cache Redirection

DNS

GSLB

SSL
Subscriber

Service Chaining

=)
R N N VIV VR

User

Optimization >

Qarnritu ~
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Load Balancing Virtual Server Service Binding

SERVICE NAME IP ADDRESS PORT PROTOCOL
srv-1-22334 10.63.32.55 22334 TCP
srv-2-22334 1063.3274 22334 TcP

7. Copythe Session RecordingAuthorization Console configurationfile, SessionRecordingAzManStore
. xm<l, from the existing Session Recording server to the new Session Recording server. The file
livesin <Session Recording Server installation path>\App_Data.

8. Touse MSMQ over HTTP or HTTPS for the new Session Recording server, complete the following
steps to import the registry settings of the currently functioning Session Recording server.

On the existing Session Recording server, for example, SRServer1l, run the powershell
.exe —file SrServerConfigurationSync.psl -Action Export — ADCHost

<ADCHost > command, where <ADCHost> is the FQDN of the Citrix ADC VIP address. An
exported registry file, SrServerConfig. reg, is generated.

Copy the SrServerConfig.reg file to the new Session Recording server and run the
powershell.exe -file SrServerConfigurationSync.psl -Action Import
,AddRedirection — ADCHost <ADCHost> command. The EnableLB value is added
to the registry key of the new Session Recording Server at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server and a sr_1lb_map.xml file is added
under C: \Windows\System32\msmg\Mapping.

9. Repeat the procedure to add another Session Recording server.
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Troubleshoot
+ Sessions are not recording when you use a CNAME record or an ALIAS record for a Session
Recording server. For more information, see Knowledge Center article CTX248554.

+ Recording files can be stored locally but cannot be stored in a Universal Naming Convention
(UNC) path. To address thisissue, change the start mode of the Citrix Session Recording Storage
Manager service to Automatic (Delayed Start).

Deploy and load balance Session Recording in Azure

June 21,2024

Prerequisites

« You already have Citrix Virtual Apps and Desktops or Citrix Daa$S (formerly Citrix Virtual Apps
and Desktops service) installed in Azure.
+ You have an Azure account.

Step 1: Upload the Citrix Virtual Apps and Desktops installer to Azure
Note:

Skip Step 1 if you use your Citrix account credentials to access the Citrix Virtual Apps and Desk-
tops download page and download the product ISO file to a VM in Azure.
1. Inthe Azure portal, create a general-purpose v2 storage account and accept the default perfor-

mance tier, Standard.

All access to Azure Storage goes through a storage account.
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A\ Create storage account - Micros: X +

&« (&} & portal.azure.com/#create/Microsoft.StorageAccount

Microsoft Azure R Search resources, services, and docs (G+/)

Home > Storage accounts >

Create storage account

AR LA U L YA L LA U VA [ YA 1 IS S I 0§ IR R LA Ry Al L A LAy S URA ARy S i

redundant. Azure Storage includes Azure Blobs (objects), Azure Data Lake Storage Gen2, Azure Files, Azure Queues, and Azure
Tables. The cost of your storage account depends on the usage and the options you choose below.
Learn more about Azure storage accounts '

Project details

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all
yaur resources.

Subscription * ‘ cse-dev-03-ca ~ |

Resource group * ‘ ~ |

Create new

Instance details

The default deployment model is Resource Manager, which supports the latest Azure features. You may choose to deploy
using the classic deployment model instead. Choose classic deployment model

Storage account name * (1) ‘ |

Location * | (s) East us v |
performance (D @ Standard O Premium

Account kind O ‘ StorageV2 (general purpose v2) v |
Replication ® { Read-access geo-redundant storage (RA-GRS) % I

< Previous Next : Networking >

https://portal azure.com/#

2. Navigate to your new storage account and select Containers in the Blob service section to cre-
ate a container.
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= Microsoft Azure P Search resources, services, and docs (G+/)

D& ®z 2 0

ome > (D
= I | Containers  # -

Storage account
| « + Container

Search containers by prefix

O Search (Ctrl+/) v O Refresh

‘Access keys
® Geo-replication
@ CORs

Name Last modified

& Configuration You don't have any containers yet. Click '+ Container' to get started.
A Encryption

@ Shared access signature

“§ Networking

O security

@ Static website

1! Properties

A Locks

Blob service
B Custom domain
@ Data protection
& Object replication
& Azure CON

3  Add Azure Search

3. Upload the Citrix Virtual Apps and Desktops installer to the container.

(J Show deleted containers

Public access level Lease state

= Microsoft Azure P Search resources, services, and docs (G+/) e [‘9 b ? ©
Home > yuchunjstg1 > Upload blob x
fa— yuchunblob/
Container Files O
\p Search (Ctrl+/) \ « T Upload (& Change accesslevel () Refresh Ti] Delete 2 Change't & Acquir o \"Citﬂ'x,V‘ﬂuaLApPs,aﬂd,DesktOPs,.» \E
1 Overview Authentication method: Access key (Switch to Azure AD User Account) (] overwite i files already exist
Location: yuchunblob
A2 Access Control (IAM)
4 v Advanced
Search blobs by prefix (case-sensitive) J (
Settings
@ Shared access signature Name Modified Access tier Blob type Size m
pload
Access policy No results
1l Properties
O Metadata

Step 2: Create a SQL managed instance in the Azure portal

For more information, see Create an Azure SQL Managed Instance.

Step 3: Create Azure virtual machines (VMs)

Choose Windows Server 2019 Datacenter —Gen1 for the image and Standard_D4as_v4 -4 vcpus,
16GiB memory for the size. For more information, see Create a Windows virtual machine in the Azure

portal.
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c

@ portal.azure.com/#create/Microsoft.VirtualMachine

Microsoft Azure

R Search resources, services, and docs (G+/)

All services > Virtual machines >

Create a virtual machine

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all

Your resources.

Subscription * ([ | cse-dev-03-ca v ‘
Resource group * @ | (New) Resource group N ‘

Create new

Instance details

Virtual machine name * (O | ‘

Region * @ | ws)eastus v |

Availability options () | No infrastructure redundancy required ~ ‘

Image * (@ l [ windows Server 2018 Datacenter - Gen' ~ ]
See all images

Azure Spot instance (O D

Size * (1) | Standard_D4s_v3 - 4 vcpus, 16 GiB memory ($83.22/month) .
See all sizes

Administrator account

Username * (1) I

Review + create < Previous ‘ Next : Disks >
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Step 4: Remote desktop and download the Citrix Virtual Apps and Desktops installer to
the Azure VMs

= iosorsare [T DG ®a 2 ©

— X

T Upload (3 Change accesslevel () Refresh [i] Delete 2 Change tier & Acquire lease

A Access Control (IAM)
O Show deleted blobs

Settings
Name Modified Access tier Blob type size Lease state

Y Citrix_Virtual_Apps_and_Desktops_7_2012iiso 3/4/2021, 6:37:47 PM Hot (Inferred) Block blob 48

£ Create snapshot

2 Change tier

& Acquire lease

[ii] Delete

Step 5: Run the installer to install Session Recording components on the Azure VMs

For more information, see Install the Session Recording Administration components.

Step 6: Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. Inthe Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Number of Session
Recorded Recording Session
Recording File  Sessions Per File Share File Share Server Recording
Size MB/hour  Day Type Quota (TB) Quantity Server Size
<6.37 <1,000 HDD Standard 2 1 Standard
(StorageV2) D4as_v4
<6.37 1,000-2,000 SSD Premium 3 1 Standard

D4as_v4
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Number of
Recorded

Recording File  Sessions Per
Size MB/hour  Day

<6.37

<6.37

Approx.10

Approx.10

Approx.10

2,000-3,000

3,000-4,000

<1,000

1,000-2,500

2,500-4,000

File Share
Type

SSD Premium
SSD Premium
HDD Standard
(StorageV2)

SSD Premium

SSD Premium

File Share
Quota (TB)

5

3

10

Session
Recording
Server
Quantity

1

Session
Recording
Server Size

Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23 working days per month, and

a one-month retention period for each recording file.

2. Addthe Azurefile share credentials to the host where you installed the Session Recording server.

a) Start a command prompt as an administrator and change the drive to the <Session

Recording server installation path>\Bin folder.

By default, the Session Recording server isinstalled in C: \Program Files\Citrix\

SessionRecording\Server.

b) Run the SsRecUtils.exe -AddAzureFiles <storageAccountName> <fileShareName>

<accesskey> command.

Where,

+ <storageaccountname> is the name of your storage account in Azure.

+ <filessharename> is the name of the file share contained within your storage

account.

+ <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

+ You can obtain your storage account key from the connection string that appears

when you click the Connect icon in your file share page.
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docs (G+/)

Connect X

sessionrecordings

& sessionrecordings
SMB File share

R Search (Ctrl+/) «

A\ 'Secure transfer required” is enabled on the storage account. SMB clients connecting to this
share must support SMB protocol version 3 or higher in order to handle the encryption
Click here to leamn more.

T Upload -+ Add directory

& Overview [ search files by prefix
R Access Control (IAM) Name

Windows  Linux  macOS
Settings No files found. J—

" )
fIt Properties To connect to this Azure file share from Windows, choose from the following
authentication methods and run the PowerShell commands from a normal (not elevated)
PowersShell terminal:

Operations
4 snapshots Drive letter

& Bsackup [z o
Monitoring Authentication method

O Active Directory
Metrics

(®) storage account key

@ Connecting to a share using the storage account key is only appropriate for admin access.
Utilizing Active Directory allows to differentiate file and folder access, per AD account,
within a share. Leam more

$connectTestResult = Test-NetConnection -ComputerName

sremdstg.file.core.windows.net -Port 445

if (SconnectTestResult.TcpTestSucceeded) {
# Save the password so the drive will pes

ist on reboot

Juser:“Azure\
[ /pass:'"DSjcr\)szw hckjToGZUZtolh8A3PAOHBWOR +19kuid6p7xX11eqNMUOXKX? [

This script will check to see if this storage account is accessible via TCP port 445, which is
the port SMB uses. If port 445 is available, your Azure file share will be persistently
mounted. Your organization or internet service provider (ISP) may block port 445, however
you may use Azure Point-to-Site (P2S) VPN, Azure Site-to-Site (S25) VPN, or ExpressRoute
to tunnel SMB traffic to your Azure file share over a different port.

Learn how to circumvent the port 445 problem (VPN)

+ You can also obtain your storage account key by clicking Access keys in the left navi-

gation of your storage account page.
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= Microsoft Azure B Search resources, services, and docs (G+/)

Home > sremd >

| Access keys

Storage account

£ search (Ctrl+/) | « Use access keys to authenticate your applications when making requests to this Azure storage account. Store your access
keys so that you can maintain connections using one key while regenerating the other,
= Overview
When you regenerate your access keys, you must update any Azure resources and applications that access this storage ac
@ Activity log
Storage account name
¢ Tags =
| srcmdstg
&2 Diagnose and solve problems
Hide keys
Ao Access Control (IAM)
W Data migration key1 ’:'__g
- Key

s Storage Explorer (preview)
| DSjen/SOpzwPxhckjTgGZUZtolh8A3PAOHEWOe + 9kuid6pTxX11egNMu0Xkx7R352f2GHRFUZPIIFi11vbE/A==

Settings

Connection string
Access keys | | DefaultEndpointsProtocol=https;AccountName=| J:AccountKey=DSjcn/SOpzwPxhckjTgGZUZtolh8A3PADHBWOe +

CORS

&

key2 'f.)
Configuration

Key

3]

Encryption | 097VNcAmMY+WpgFYY0er30fMyaD20sSGGpIuBgfkDYv3Z27]19TYOMbWFaz1N6riO81c2qF5IZ0QVxaydmys02A==

&

Shared access signature Connection string

“@ Networking | DefaultEndpointsProtocol=https;AccountName=] L AccountKey=097VNcAmy+WpgFYYOBr30fMyaD20sSGGpJuB|

Q security
Il Properties
B Locks
File service
& File shares
Monitoring

@ insights

E plerts

c) Mount the Azure file share to the host where you installed the Session Recording server.
i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enterthe UNC pathinthe format of \\<storageaccountname>.file.core.windows.net\<filesshar:

Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.
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!
)

Storage  Signing FRollover Playback MNotfications CEIP  Logging RE |+

Fecorded session files are stored in the directories specified. To store files
in & load-bzalanced manner, specify multiple directories across different
volumes.

File storage directories:

File Storage Directory

Enter a directory for storing recorded session files:

|er.file.co,le.windows.net'-sessionrecording'recon:lings | Browse. ..

Cancel

Specify a folder to temporarily store archived session recordings and make
them awvailable for playback.

Restore directory for archived files:

C:\SessionRecordings Restored Browse...

oK Cancel

iv. Click OKin the File Storage Directory dialog box.
v. Click Apply in the Session Recording Server Properties window.
vi. Click OK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Session Recording Server Properties

The "Citrix Session Recording Storage Manager” service needs
to be restarted for changes to come into effect,

Do you wish to restart the service now?

Step 7: Add a load balancer

If there is more than one Session Recording server, we recommend you add a load balancer in front
of them. Azure offers many options to load-balance traffic requests. This section walks you through
the process of creating Citrix ADC, Azure Load Balancer, and Azure Application Gateway in Azure.
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Option 1: Create a Citrix ADC VPX instance in Azure

1. Inthe Azure portal, type Citrix ADC in the search box.

2o i A0

Services Marketplace See all

Rece o \ivenrena Broadcast 9 Citrix ADC

B4 Citrix ADC 13.0 - Azure Stack
B Citrix ADC 121
B4 Citrix ADC VPX FIPS

Name Resources

it Viewed

No results were found.

]
<
z

2w seconds ago

) yu sw seconds ago
Documentation Seeall

= minutes ago

Tutorial: Azure Active Directory single sign-on ...

@ = minutes ago
Tutorial: Azure Active Directory integration with Citrix ..

& S8 Azure AD secure hybrid access | Microsoft Docs Rl2ge

&> SR Linux virtual desktops with Citrix - Azure Example . ay ago

() snt Resource Groups ay ago

<} 18 No results were found. reeks ago

= eeks ago

25 Didn find what you were looking for? i 9

() st @ 11y searching in Activity Log |

4> VN & Try searching in Azure Active Directory 10nth ago

(%) tin searching all subscriptions. Change fonth ago

Navigate

Subscriptions (%] Resource groups All resources Dashboard

2. Choose the Citrix ADC VPX Bring Your Own License plan and then click Create.

Home >

Citrix ADC »

Citrix

Citrix ADC < add to ravorites
CitrxX. oo

Azure benefit eligible o'

Selecta plan | Citrix ADC VPX Bring Your Own License

Overview  Plans  Usage Information + Support ~ Reviews

Citrix ADC is an enterprise-grade application delivery controller that delivers your applications quickly, reliably, and securely, with the deployment and pricing flexibility to
meet your business’ unique needs. Designed to provide operational consistency and a smooth user experience, Citrix ADC eases your transition to the hybrid cloud.

Why Citrix?

Citrix ADC offers high performance with fast application delivery, a ¢ system, and or and automation for
applications across cloud or hybrid environments for greater agilty. Citrix's all-in-one solution brings point solutions under one roof, ensuring simplicity and security every
step of the way.

Key Benefits:

* Flexible & Consistent: Citrix ADC is the most comprehensive, feature-rich ADC available across a wide variety of deployment options with the most flexible pooled
capacity licensing option in the industry.

o Best User Experience: Citrix is the only vendor to offer an intelligent, global load-balancing service that uses real-time Internet traffic and data center health to route
users to the best source for their applications and content.

* Integrated App Security: A single code base across physical, virtual, bare-metal, and containers enables consistency across your applications and workflow.
Comprehensive application security with Layer 3 to Layer 7 protection and built-in API protection ensures you don't have to worry about vulnerable assets.

- A e A

3. Select or create a resource group and set the other settings on the Basics tab.

4. Set VM configurations.
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A Crestz Citrix ADC - Microsoft Az X 4=

« (&) 8 portal.azure.com/#create/citrix.netscalervpx-Tvm-3nicnetscalervpx-1vm-3nic-byol

= Microsoft Azure L Search resources, services, and docs (G+/)

Home > Citrix ADC >

Create Citrix ADC

A Changes on this step may reset later selections you have made. Review all options prior to deployment.

L]
Basics VM Configurations  Network and Additional Settings Review + create

Virtual Machine Configurations

Virtual machine size * (O 1x Standard DS3 v2
4 vcpus, 14 GB memory
Change size

05 disk type (D ‘0‘ Premium_LRS

Assign Public IP (Management) © (®) Yes

Assign Public IP (Client traffic) O (®) Yes
Unique public IP domain name suffix * (O | d28e81a280 v
Azure Monitoring Metrics (0 O Enabled
(®) Disabled
Backend Autoscale (0 O Enabled
(®) Disabled

| < Previous | | Next : Network and Additional Settings >

5. Check and modify network settings if necessary. Choose ssh (22), http (80), https (443) for
public inbound ports.

Avirtual network is automatically created. If you already have a Session Recording environment
installed, you can use its virtual network and server subnet settings.
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Microsoft Azure £ search resources, services, and docs (G+/)

Home > Citrix ADC >

Create Citrix ADC

Configure virtual networks

Virtual network * (O | (new) citrix-adc-vpx-virtual-network ~ ‘
Create new

Management Subnet * (O | (new) 01-management-subnet (10.1.25.0/24) ~ ‘

Cliert Subnet * () [ new) 11-client-subnet (10.1.29.0/24) v

Server Subnet * (@ | (new) 12-server-subnet {10.1.30.0/24) ~ ‘

Public IP (Management)

Management Public IP (NSIP) * (D) | (new) citrix-adc-vpx-nsip ~ ‘
Create new
Manzgement Domain Name (O | citrix-adc-vpx-nsip-23f12ee6b2 \/‘

.eastus.cloudapp.azure.com

Public IP (Clientside)

Clientside Public IP (VIP) * (&) | (new) citrix-adc-vpx-vip s ‘
Create new
Clientside Domain Name (& | citrix-adc-vpx-vip-23f12eesb2 \/‘

.eastus.cloudapp.azure.com

Public Inbound Ports (Management only)

Ports open for Management public IP () O None

O ssh2)

(®) ssh (22), http (20), htps (443)

Review + create | < Previous | | Next : Review + create >
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= Microsoft Azure 2 Search resources, services, and docs |

Hoeme > Citrix ADC >

Create Citrix ADC

Basics VM Configurations MNetwork and Additional Settings Review + create

Boot diagnostics

Diagnostic storage account * (D (new) citrixadcvpred2bdbe259 v

Create New

Network Settings

Configure virtual networks

Virtual network * (& | (new) citrix-adc-vpx-virtual-network ~ |
Create new

Management Subnet * @O | (new) 01-management-subnet (10.1.32.0/24) ~ |

Client Subnet * (@ | (new) 11-client-subnet (10.1.33.0/24) v |

Server Subnet * (@ | (new) 12-server-subnet {10.1.34.0/24) ~ |

Accelerated Networking

Accelerated Metworking (Management @ On
Interface) @ O o

Accelerated Metworking (Client Interface) @ on

@ O of
Accelerated Networking (Server @ on
Interface) @ O off
Public IP (Management)
Management Public IP (NSIP) * (@ | (new) citrix-adc-vpx-nsip ~
Cronto moaa

Review + create | < Previous | | Next : Review + create > |

6. Click Next: Review + create to create the Citrix ADC VPX instance and wait for the deployment
to complete.
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= Microsoft Azure £ Search resources, services, ai

Home > Citrix ADC >

Create Citrix ADC

G Walidation Passed

Basics VM Configurations Metwork and Additional Settings Review + create

PRODUCT DETAILS

Citrix ADC
by Citrix
Terms of use | Privacy policy

TERMS

By clicking "Create", | (3) agree to the legal terms and privacy statement(s) associated with the Marketplace offering(s)
listed abave; (b) authorize Microsoft to bill my current payment method for the fees associated with the offering(s),
with the same billing frequency as my Azure subscription; and (<} agree that Microsoft may share my contact, usage
and transactional information with the provider(s) of the offering(s) for support, billing and other transactional
activities. Micrasoft does not provide rights for third-party offerings. See the Azure Marketplace Terms for additional

details.

Basics

Subscription cze-dev-03-ca
Resource group srcmdtest

Region East US

Citrix ADC Release Version 13.0

License Subscription Bring Your Own License
Virtual Machine name citrix-adc-vpx
Username nsraot

Password P

VM Canfinuratinns

Create < Previous MNext Download a template for automation

7. Setthe subnet IP (SNIP) address and the Citrix ADC VIP address to be on the same subnet.

The SNIP address and the VIP address must be on the same subnet. In this example, we set the
VIP address to be on the subnet of the SNIP address.

a) Stop the citrix-adc-vpx virtual machine.

b) Change the subnet of the VIP address.
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Microsoft Azure

citrix-adc-vpx-nic11

citrix-adc-vpx-nic11 | IP configurations

Network interface

Home > srib )|

[0 search (ctri+n | « 4 ad & X
@ Overview IP forwarding settings
@ Activity log 1P forwarding
"R Access control (IAM) Virtual network
@ Tags

IP configurations
Settings

B2 DNS servers

@ Network security group

£ adc

O Refresh

Enabled)

srazureautovnet

@ The associated virtual machine ‘citrix-adc-vpx' must be either stopped or deallocated in order to be able to edit the subnet.

" .
i1l Properties -
‘ P search IP configurations
B Locks .
Name IP Version Type
Automation vip 1Pv4 Primary

.f. Tasks (preview)

5 Export template

Support + troubleshooting
= Effective security rules
© Effective routes

R New support request

Private IP address Public IP address

192.168.2.4 (Dynamic) Unassigned (citrix-adc-vpx-vip)  ***

Home > srlb > citrix-adc-vpx-nicl1

citrix-adc-vpx-nic11 | IP configurations

Network interface

2 search (Ctrl+) « -+ Add

@ overview

X Discard O Refresh

@ Activity log

A Access control (IAM)

@ Tags 1P forwarding settings
IP forwarding

Settings

s Virtual network
& IP configurations

=

&= DNS servers IP configurations

A\ The virtual machine associated with this network interface will be restarted to utilize the new subnet.

Enabled :'

srazureautovnet

@ Network security group Subnet * srazureautosubnet (192.168.1.0/24)
il Properties
2 search IP configurations
B Locks K i i
Name IP Version Type Private IP address Public IP address
Automation vip IPv4 Primary 192.168.2.4 (Dynamic) Unassigned (citrix-adc-vpx-vip)

2 Tasks (preview)

5 Export template
Support + troubleshooting
= Effective security rules

< Effective routes

8 New support request

c) Start the citrix-adc-vpx virtual machine

Option 2: Create an Azure load balancer

Azure Load Balancer is a TCP passthrough service. The following diagram shows load balancing

through TCP passthrough.
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sricpruled43

4 ,

LoadBalancerFront...

\ — L

, /

\“\grtcpru le SQ]’"

1. Create an Azure load balancer.

SRBackendPool

SR-Server

- srtcprule22334

bt

SR-5erver?2

a) Search in the Azure portal and select Load Balancers from the Marketplace.

= Microsoft Azure £ load balancer

Bl & Q

Services

Azure servic
&» Load balancers
+ [ Load balancing - help me choose (Preview)
Creat & Application gateways
resource @ Front Doors

(@ Web Application Firewall policies (WAF)

# CloudAMQP
Recent resot
# CloudMonix

Name & Workload Insights

@ srappGvi | = CloudSimple Nodes

&S CloudSimple Services
() yuchunjiang

& SRLoadBalan ReseUrees

No results were found,
4> SRVnet

() srtest Didn't find what you were looking for?
& LB-hubtest-T B Try searching in Activity Log

— B Try searching in Azure Active Directo
= asfazuretests 9 Y

() srazureauto | Searching all subscriptions. Change

4-> VNet-hubtest

Seeall Marketplace

B3 KocSistem Azure Load Balancer Management
9 Load Balancer / ADC
Y aiScaler Load Balancer & Site Acceleration

£ Ishlangu Load Balancer ADC IS-5000 (5Gbps)
Documentation

Load Balancer | Microsoft Docs
What is Azure Load Balancer? - Azure Load Balancer

Azure Load Balancer concepts | Microsoft Docs

Quickstart: Create a public load balancer - Azure portal .

Resource Groups

No results were found

Virtual network

YuchunJiang@citrix.com 7 |
amrix

& 2?2 O

See all

%

More services

Seeall

amonth ago

On the Basics tab of the Create load balancer page, configure settings as described in the

following table:

Setting

Value

Subscription
Resource group
Name

Region

Type

SKU

Select your subscription.

For example, select sribtest created earlier.

Enter SRLoadBalance.
Select (US) East US.
Select Internal.

Select Standard
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Setting

Value

Virtual network

Subnet

IP address assignment

Availability zone

For example, select srazureautovnet created
earlier.

For example, select srazureautosubnet created
earlier.

Select Dynamic.

Select Zone-redundant.

e e e e

Home >

Create load balancer

1S accessible via public IV addresses, or Internal wnere It 1s only accessible from a virtual network. Azure 10ad balancers alse
support Network Address Translation (MAT) to route traffic between public and private IP addresses. Learn more.

Project details

Subscription *

L

Resource group *

Instance details

Mame *
Region *
Type* ©

SKU* @

Configure virtual network.

Virtual network * (@

Subnet *

IP address assignment *

Availability zone * @

Review + create < Previous

| cse-dev-03-ca ~ |
| sribtest ~ |
Create new

| SRLoadBalance \/|
[ Ws) gastus v |

o Standard Load Balancer is secure by default. This means Network Security
Groups (N5Gs) are used to explicitly permit and whitelist allowed traffic. If you
do not have an NSG on a subnet or NIC of your virtual machine resource,
traffic is not allowed to reach this resource. Please configure an NSG to ensure
communication if needed. For outbound communication, an explicit
outbound rule is needed. Learn more about outbound connectivity cf

| srazureautovnet e |

| srazureautosubnet (192.168.1.0/24) o |
Manage subnet configuration

O Static @ Dynamic

| Zone-redundant ~

Next : Tags > Download a template for automation

b) Add load balancerresources, including a back-end pool, health probes, and load balancing

rules.

« Add a back-end pool.
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Select the load balancer you created from the resources list and click Backend pools

in the left navigation. Click Add to add a back-end pool.

2 BTN (]

SRLoadBalance | Backend pools

Load balancer

2 search (Ctrl+/) «

€ Overview

Backend pool Virtual machine Virtual machine status

Activity log

A Access control (IAM) No results
€ Tags

£? Diagnose and solve prablems
settings

Frontend IP configuration

T Health probes

= Load balancing rules

B inbound NAT rules

il Properties

6 Locks

Monitoring

B Alerts

fifi Metrics

@ Insights

Automation

i3 Tasks (preview)

E Export template

Enter a name for the new back-end pool and then click Add.

Network interfact

Home > SRLoadBalance >

Add backend pool

SRLoadBalance

|

Name * | | SRBackendPoal I o
|

Virtual network (® srazureautovnet (sribtest)

1P version @ IPvad.

O v

Virtual machines

You can only attach virtual machines in eastus that have a standard SKU public P configuration or no public 1P configuration.
All 1P configurations must be on the same virtual network.

Virtual machine Ty IP Configuration Ty Availability set Ty

No virtual machines selected

Virtual machine scale sets

Virtual Machine Scale Sets must be in same location as Load Balancer. Only IP configurations that have the same SKU
(Basic/standard) as the Load Balancer can be selected, All of the IP configurations have to be in the same Virtual Network,

@ No virtusl machine scale set is found in eastus that matches the above criteria
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+ Add health probes.

Select the load balancer you created from the resources list and then click Health

probes in the left navigation.

p il e I e

Home > SRLoadBalance

® SRLoadBalance | Health probes

Load balancer

P Search (Ctrl+/) « t add

& overview |;) Search probes

Activity log Name Ty Protocol Ty Port
Ao, Access control (1AM) No results,

€ Tags

. Diagnose and solve problems
Settings

& Frontend IP configuration

% Backend pools

Y= Load balancing rules

B inbound NAT rules

il Properties

E| Locks

Monitoring
BN Alerts
fil Metrics
P Insights

Automation

% Tasks (preview)

F Export template

Support + troubleshooting

Click Add to add health probes on ports 80, 22334, 1801, and 443.

= Microsoft Azure P Search resources, services, and docs (G+/)

Home > SRLoadBalance

® SRLoadBalance | Health probes

Load balancer

[ search (cui+n | « 4 add O refresh
Settings =
o .2 Fiter by name.

B Frontend IP configuration Name protocol
%/ Backend pools

SRHealthProbe1801 Tcp
! Hesliprebes SRHealthProbe22334 Tcp
%= Load balancing rules

SRHealthProbed43 e
B inbound NAT rules

SRHealthProbeg0 Tcp

I} properties

B Locks
Monitoring

@ Diagnostic settings
# Logs

B alerts

i Metrics

@ Insights
Automation

s Tasks (preview)

) Exoort temolate

Used By

SRICPRule1801

SRICPRule22334

SRICPRule443

SRICPRule80

For example, use the following settings to create a health probe on port 80.

Value

Setting

Name

Enter SRHealthProbe80.
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Setting Value

Protocol Select TCP.

Port Enter 80.

Interval 5

Unhealthy threshold Select 2 for the number of unhealthy threshold

or consecutive probe failures that must occur
before a VM is considered unhealthy.

e e e

Home > SRlLoadBalance >

SRHealthProbe

SRLoadBalance

Save >< Discard f Delete

Name *
|l sreeatherobesd | /]

Protocol (i)
Tcp v

Port * n;w
|l 20
|
Interval * (@

[s |

seconds

Unhealthy threshold * @
[2 |

consecutive failures
Used by @
MNot used

+ Add a load balancing rule.

Select the load balancer you created from the resources list and then click Load bal-
ancing rules in the left navigation. Click Add to add a load balancing rule.
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e e e

Home > SRLoadBalance

v— SRLoadBalance | Load balancing rules
Y™ Load balancer

[ 2 search ctrl+) | « Add

& Overview |P Search load balancing rules

Activity log Name +4  Load balancing rule
Ao Access control (1AM} No results.

€ Tags

pa Diagnose and solve problems

Settings
B Frontend IP configuration
% Backend pools

T Health probes

Load balancing rules

Bl inbound NAT rules
Il Properties

E| Locks
Moenitoring

R plerts

fd Metrics

@ Insights
Automation

il. Tasks (preview)

5! Export template

Support + troubleshooting

Click Add to add load balancing rules for ports 80, 22334, 1801, and 443.

Home > SRLoadBalance

v= SRLoadBalance | Load balancing rules - X
™ Load balancer

O Search (Ctrl+/) « + Add

Settings " [P Search losd balancing rules

B Frontend IP configuration Name T4 Load balancing rule 14 Backend pool T4 Health probe N
® Backend pools SRTCPRule1801 SRTCPRule1801 (TCP/1801) ‘SRBackendPool SRHealthProbe1801

% Health probes SRTCPRule22334 SRTCPRule22334 (TCP/22334) SRBackendPool SRHealthProbe22334

&= ioed balending ruies SRTCPRule443 SRTCPRule443 (TCP/443) SRBackendPool SRHealthProbe443

B Inbound NAT rules SRTCPRule80 SRTCPRule80 (TCP/80) SRBackendPool SRHealthProbes0

11} Properties

B Locks

Monitoring

& Diagnostic settings
® Logs

W Alerts

fidl Metrics

@ Insights
Automation

S Tasks (preview)

) Export template

For example, use the following settings to create a load balancing rule for port 80.
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Setting

Name

IP Version

Frontend IP address
Protocol

Port

Backend port
Backend pool
Health probe
Session persistence
Idle timeout (minutes)
TCP reset

Outbound source network address translation
(SNAT)

Value

Enter a name, for example, SRTCPRule80.

Select IPv4.

Select LoadBalancerFrontEnd.
Select TCP.

Enter 80.

Enter 80.

Select SRBackendPool.

Select SRHealthProbe80.
Select Client IP.

Accept the default setting.
Select Enabled.

Select (Recommended) Use outbound rules to

provide backend pool members access to the

internet.
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= Microsoft Azure P Search resources, services, and docs (G+/)

Home > SRLoadBalance >

Add load balancing rule

SRloadBalance

Name *

| srrceruleso |
| —
IP Version *

® pva (O 1pve

Frontend IP address * (0

| 182.168.1.22 (LozdBalancerFrontEnd) ~

[ Harorts @

Protocol
@ O uoe
Bart *
30 | |

Backend port * (D
[ | ]
Backend pool @

| SRBackendPool ~ |

Health probe @
| sRresithprobeso (e | v
1

Session persistence (@
| cientie | M
—_——

Idle timeout (minutes) &
o [+]

TCP reset

Floating IP @

z

+ Add the Azure VMs where the Session Recording server is installed to the back-end

S

pool.
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e e e

Home > SRLeoadBalance

i SRLoadBalance | Backend pools

Load balancer

2 Search (Ctrl+/) | “ + add () Refresh

& overview
B Backend pool Virtual machine Virtual machine status
Activity log

SRBackendPool
Ao Access control (IAM)

¢ Tags

&2 Diagnose and solve problems
Settings

E Frontend IP configuration

1" Health probes

Y= Load balancing rules

B inbound NAT rules

ill eroperties

2 Locks

Monitoring

BB Alerts

Home > SRLoadBalance > Add virtual machines to backend pool
SRBackendPool

@ You can only attach virtual machines that are in the same location and on the same virtual network as the loadbalancer.
virt P

O 1p Adaress tandard SKU publc 1P or no publc P

IP Version P E—— Virtual network == SRVnet Resource group == all Availabity set == all
® 1pw
O [0 virtual machine 7, Resourcegroup T4 IP Configuration 14 Avallabllityset *  Tags Notes

O 1

O srsenverz

Virtual machines

You can only attach virtual machines in eastus that have a standard SKU public IP configuration or no put
AllIP configurations must be on the same virtual network

Virtual machine T4 1P Configuration 4 Avallability set T,

No virtual machines selected

Virtual machine scale sets

ation as Load Balances
e selected. All of the IP confi

@ o virtual machine scale setis found in eastus that matches the above criteria

Virtual machine scale set 1P address

‘ = e

c) Test the Azure load balancer.
If you cannot add a server to the back-end pool and the following error message appears
NetworkinterfaceAndLoadBalancerArelnDifferentAvailabilitySets, disassociate the
public IP address of the server network interface.
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— Microsoft Azure

Home » srlbtest » SR-Serverl-ip » sr-server172 >

ipconfigl

sr-server1 T2

Public IP address settings
Public IP address

i/ - - - -\.
(_ Disassociate .I

Public IP address *

SR-Serverl-ip (20.62.236.36) A
Craate new

Private IF address settings

Virtual network/subnet
srazureautowvnet/srazureautosubnet

Assignment

@D o)

F address

|

=2 ¥

[

Option 3: Create an Azure application gateway
Tip:
Application Gateway V2 does not support routing requests through an NTLM-enabled proxy.
1. Create an Azure application gateway.
Configure the following settings when you create an application gateway.

« Onthe Basics tab, set Tier to Standard.
« On the Frontends tab, set Frontend IP address type to Private. The new application
gateway is used as an internal load balancer.

2. Add a back-end pool.
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Home > SRAppGWV1 >

Edit backend pool

A backend pool is 2 collection of resources to which your application gateway can send traffic. A
backend pool can contain virtual machines, virtual machines scale sets, IP addresses, domain names, or
an App Service.

AGbackendpoo

A enapoo
Add backend pool without targets
N - )

Backend targets

2 items
Target type Target
IP address or FQDM 192.168.1.12 [ ==~
| IP address or FODN 182.168.1.18 I i .
| IP address or FOQDN v | | |

Associated rule

SRHttpRules0
SRHttpRuled43

3. Create HTTP settings.

Azure Application Gateway supports both HTTP and HTTPS for routing requests to back-end
servers. Create HTTP settings for ports 80, 443, and 22334.

« HTTP over port 80
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Home > SRApPGV1

v— SRAppGV1 | HTTP settings

Application gateway

Add HTTP setting p

HTTP settings name

ttpSetting80

2 Search (Ctrl+/) « + Add
K ACESs Conuon ) =

P Search HTTP settings
® Tags &

£ Diagnose and solve problems

Settings

& Configuration

Name Port

| SRHttpSetting80 80
SRHttpSetting443 443
SRHttpSetting22334 22334

@ Web application firewall
% Backend pools

Y= HTTP settings

B Frontend IP configurations
33 Listeners

= Rules

¥ Health probes

1l Properties

B Locks

Monitoring

KB Alerts

fill Metrics

B Diagnostic settings

« HTTP over port 443

Backend protocol
® wrre O wrres

8ackend port ¥
80

Additional settings
Cookie-based affinity ©
O Enable (®) Disable

Connection draining @

O tnable (@ pisable

Request time-out (seconds) * @
20 ‘

Override backend path ©

Host name

8y default, Application Gateway does not change the incoming HTTP host header from the client and sends the header
unaltered to the backend. Multi-tenant services like App service or APl management rely on a specific host header or SNI
extension to resolve to the correct endpoint. Change these settings to overwrite the incoming HTTP host header.

An authentication certificate is required to allow back-end servers in Application Gateway

V1. The authentication certificate is the public key of back-end server certificates in Base-

64 encoded X.509(.CER) format. Forinformation on how to export the public key from your
TLS/SSL certificate, see Export authentication certificate (for vl SKU).

Home > SRAppGV1

v= SRAppGV1 | HTTP settings

™ Application gateway

[2 seerch (ctrl+n « + Add
R A Conmon )

AP Search HTTP settings
@ Togs &

& Diagnose and solve problems

Settings

& Configuration

Name port
SRHttpSetting80 80
SRHttpSettingd43 443
SRHttpSetting22334 22334

@ Web application firewall
B/ Backend pools

7= HTTP settings

B Frontend IP configurations
22 Listeners

“ Rules

T Health probes

111 Properties

8 Locks

Monitoring

0 Alerts

fidl Metrics

& Diagnostic settings

Add HTTP setting

HTTP settings name

Backend prot
O wrP (@) HTTPS

Backend port *
443

Backend authentication certificate

For end-to-end SSL encryption, the backend must be whitelisted with the application gateway. Upload the public certificate of
the backend servers to this HTTP setting

Use for App service

O Yes ® No
Certificate
stlo

Additional settings
Cookie-based affinity ©
® enable O Disable
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S wvem i g G

Home > SRAppGV1

v— SRAppGV1 | HTTP settings

- Application gateway
[0 search (cu+ «  + add

R ALLess Lonuor gamy R

[P search HTTP settings

@ Tags

&2 Diagnose and solve problems

Add HTTP setting

Connection draining ©

(O Enable (®) Disable

Request time-out (seconds) * ©

Settings

& Configuration

[20
Name Port
Override backend path ©
SRHttpSetting80 80 ‘
[ SRHtpSetting443 443 J
Host name
SRHttpSetting22334 22334

@ Web application firewall
% Backend pools

= HTTP settings

& Frontend IP configurations
33 Listeners

L Rules

1 Health probes

1l Properties

B Locks

Monitoring

E Alerts

Metrics

B Diagnostic settings

« HTTP or HTTPS over port 22334

By default, Application Gateway does not change the incoming HTTP host header from the client and sends the header
unaltered to the backend. Multi-tenant services like App service or APl management rely on a specific host header or SNI
extension to resolve to the correct endpoint. Change these settings to overwrite the incoming HTTP host header.

rich

with new host name

Host name override
(®) Pick host name from backend target

(O Override with specific domain name

&.g. contoso.com

Use custom probe @
Yes (® No

e

If WebSocket uses HTTP, use the same setting as port 80.

If WebSocket uses HTTPS, use the same setting as port 443.

4, Add afront-end IP address.

DAStarh o v i o0 1)

Home > SRAppGV1

&5 SRAppGV1 | Frontend IP configurations

Application gateway

O Search (Ctrl+/) | « (L2 search frontend IP configurations
A ACLESS COnuo! Ay
Type Status
@ Tags
Public Not configured
2 Diagnose and solve problems
Private Configured

Settings
& Configuration

@ Web application firewall
% Backend pools

I= HTTP settings

B Frontend IP configurations
23 Listeners

L Rules

? Health probes

11l Properties

B Locks

Monitoring

R Alerts

Metrics

B Diagnostic settings

5. Add listeners.

appGwPrivateFrontendip 10.7.06

IP address Associated listeners

SRListener80, 2 more

Add listeners on ports 80, 443, and 22334, for example:
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rosoft Azure P Search resources, services, and docs (G+/)

Home > SRAPpGV1

53 SRAppGV1 | Listeners %

Application gateway

£ Search (Ctrl+/) « + Add listener () Refresh

2 ACtess Conon Ay
Application Gateway provides native support for WebSocket across all gateway sizes. There is no additional configuration required to enable or disable WebSocket support. If a WebSocket traffic is received on the

@ Tags Application Gateway, it is automatically directed to the WebSocket enabled backend server using the appropriate backend pool as specified in application gateway rules.

Learn more about listeners and WebSocket support.

[P Search listeners

£ Diagnose and solve problems

Settings Name Protocol Port Associated rule Host name
& Configuration SRListener80 HTTP 80 SRHttpRule80

@ Web application firewall SRListener443 HTTPS 443 SRHttpRule443

% Backend pools SRListener22334 HTTPS 22334 SRHttpRuIe22334

7= HTTP settings SSL Policy

& Frontend IP configurations The SSL policy defines the SSL protocol version and available ciphers. Choose from one of the predefined policies or create a custom security policy to match your organizational security requirements.

Learn more about SSL policy.
Selected SSL Policy
L Rules Default (change)

25 Listeners

¥ Health probes Min protocol version

" TLSvi0
11! Properties

Cipher suites

B Locks

TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
Monitoring TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
W Alerts TLS_ECDHE RSA_WITH_AES_256_CBC_SHA384

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

Metrics
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

B Diagnostic settings - TLS ECDHE RSA WITH AES 128 CBC SHA

« Listener on port 80

Microsoft Azure 2 Search resources, services, and docs (G+/)

Home > SRAppGV1 >

SRListener80

SRAppGV1

SRListeners0

Frontend IP* (i)

| Private ~ |

Port* (&)

Associated rule
SRHttpRules0

Additional settings

TTerener ijpe @

@ Basig O Multi site

Error page url

O Yes @ No

« Listener on port 443

Create a self-signed certificate and upload the certificate to the Azure portal when you cre-
ate the HTTPS listener. For more information, see Certificates supported for TLS termina-
tion and Create a self-signed certificate.
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Home > SRAppGV1 >

SRListener443

SRAPPGVT

Frontend IP* (@)

Private = |
Port * (&)
443 /|

Protocol @

Choose a certificate
O Create new @ Select existing

Certificate ®

| Ibde v

\:' Renew or edit selected certificate

Associated rule
SRHitpRule443

Additional settings

TISTEmeT Tfpe (0

@ Basi O Multi site

Error page url

O Yes @ Mo

« Listener on port 22334

If WebSocket uses HTTP, use the same setting as port 80. If WebSocket uses HTTPS, use the
same setting as port 443. The following example shows the setting of an HTTPS listener
on port 22334.
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= Microsoft Azure ' Search resource

Home > SRAppGWV1 >

SRListener22334

SRAppGY1

SRListener22334

Frontend IP* (i)

| Private s |
Port* (@
| 22334 v|
Protocol @

HTTP HTTPS

Cheoose a certificate
O Create new @ Select existing

Certificate *
| Ibdc v

D Renew or edit selected certificate

Associated rule
SRHttpRule22334

Additional settings

Listener type (0

@ Basic O Multi site

Error page url

O Yes @ Mo

6. Create request routing rules.

Create rules for ports 80, 443, and 22334, for example:
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P Search rsoutces,sevioes and docs (G+1)

Home > SRARRGV1
53 SRAppGV1|Rules - X

Application gateway

[0 search (ctrt+n « =+ Request routing rule
A AGKESs CONUO! AN
[ 2 search rules

@ Tags
Name Type Listener
£ Diagnose and solve problems
SRHItpRuIe8O Basic SRListener80
Settings B
SRHttpRuledd3 Basic SRListenerd43
-
& Configuration SRHttpRule22334 Basic SRListener22334

@ Web application firewall
® Backend pools

Y= HTTP settings

B Frontend IP configurations
23 Listeners

£ Rules
1 Health probes
11} Properties
A Locks
Monitoring

B Alerts

fil Metrics

B Diagnostic settings

+ Routing rule for port 80
SRHttpRule80

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

SRHttpRules0

jes]
=
w
&

]
m

" Listener | *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocol. If the listener criteria are met,
the application gateway will apply this routing rule,

SRListeners0 ~

Listener *

SRHttpRule80

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

SRHttpRulesD

=
&
o
&
3
o

*Listener |*Backend targets

Choose a backend pool to which this routing rule will send traffic. You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend pool O Redirection
AGbackendpoal >
Backend target* @ | ackendpoo |
SRHitpsetting20 -
HTTP settings * (0 | 2 g |
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+ Routing rule for port 443
SRHttpRule443

SRAppGWV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name SRHttpRuled43

*Listener | *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocaol. If the listener critena are met,
the application gateway will apply this routing rule.

. i i
Listenar * SRListenerd43

SRHttpRule443

SRAppGV

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

n
[
=1
i
[
[

*Listener |*Backend targets

Choose a backend pool to which this routing rule will send traffic. You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend poal O Redirection

| AGbackendpool ~ |

Backend target * (O

. SRHttpSetting443 v
HTTP settings * @ | P J |

+ Routing rule for port 22334

SRHttpRule22334

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name SRHttpRule2

*Listener *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocal. If the listener criteria are met,
the application gateway will apply this routing rule,

- ~
Listener * SRListener22334
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SRHttpRule22334

SRAPPGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name SRHttpRule22334

*Listener *Backend targets

Choose a backend pool to which this routing rule will send traffic, You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend poal O Redirection

Backend target * (D) | AGbackendpool hd |

HITP settings * © | SRHitpSetting22334 v |

7. Add the Azure VMs where the Session Recording server is installed to the back-end pool.

8. Configure Session Recording servers according to Knowledge Center article CTX230015.

Troubleshoot

June 21,2024

The troubleshooting information contains solutions to some issues that you might encounter during
or after installing the Session Recording components.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of the Registry Editor can be solved. Use the Registry Editor at your own risk. Be sure to back up
the registry before you edit it.

Diagnostic logging

July 6,2024
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Report message queue quota exceedance on each VDA to the Session Recording server

In any of the scenarios outlined below, there’s a chance of exceeding the maximum size of the Mi-
crosoft Message Queuing (MSMQ) directory on a VDA, resulting in packet drops or pushback.

+ Onthe VDA side, the incoming rate of Message Queuing messages exceeds the outgoing rate.

+ The network connection between the VDA and the Session Recording server is poor and thus
messages are stuck in the queue on the VDA side.

« The queue quota on the Session Recording server side is used up and messages are stuck in the
queue on the VDA side.

To facilitate diagnoses and troubleshooting, Session Recording can capture and report the issues as
logs to the Session Recording server for display in the Windows Event Viewer. This feature is enabled
by default. You can disable and re-enable the feature by using the following registry value on the
target VDA:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\DiagnosticLoggingEnabled
Value data: 1 =enabled, 0 =disabled

You can also set how long these logs can be retained on the Session Recording database. To do so, go
to the Logging tab of Session Recording Server Properties and configure the Retention period for
diagnostic logs. The default value is 30 days.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 377



Session Recording 2407

[}y Session Recording Server Properties

Admin logging

[] Enable Logging Service

Enable Mandatory Blocking

Enable Playback Justification Logging

Diagnostic logging

—_— X

Storage Signing Rollover Playback Notifications CEIP Logging RE «|» |

This option enables the Session Recording Administrator Logging Service.

This option blocks policy and server properties changes if logging fails.

This option requires users to enter the reason when playing a recording.

Retention period for diagnostic logs: 50

| day(s)

OK

Cancel | Apply
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Event ID table

August 15, 2024

The following table provides a quick reference for specific event IDs and their meanings. Each event
ID includes a description and a severity level to help understand the nature of the event and the ap-
propriate response. If any of these events occur, you can check them in the Windows Event Viewer.
Event logs related to the Session Recording administration components can be viewed on the Ses-
sion Recording server. Event logs generated by the Session Recording agent can be viewed on the
VDA. Event logs generated by the Session Recording player can be viewed on the machine where the
player is installed.

Event ID Description Level

2001 Database Connection Information
Established

2002 Service Start Success Information

2003 Service Stop Success Information

2004 Error: Service Start Failure Error

2005 Error: Data Lost For File Error

2006 Warning: Certificate Warning
Approaching Expiry (Days)

2007 Warning: Certificate Warning
Approaching Expiry (Hours)

2008 Warning: Certificate Warning
Approaching Expiry (Minutes)

2009 Error: No Active Policy Error
Document

2010 Error: Unknown Active Policy Error
Document

2011 Error: Unsupported Active Error
Policy Document Version

2012 Error: Method Loading Active Error
Policy Document

2013 Error: Failed Verify Generated Error
Signature

2014 Error: Failed Verify CAS Error

Configuration
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Event ID

2015

2016
2017

2018

2019

2020

2021

2022

2023

2024

2025

2026

2027

2028

2029

2030
2031

2032

2033

Description

Audit: Successful File
Download
Audit: Successful File Query

Audit: Successful New Policy
Document

Audit: Successful Load Policy
Document

Audit: Successful Save Policy
Document

Audit: Successful Copy Policy
Document

Audit: Successful Rename

Policy Document

Audit: Successful Set Policy
Document Description

Audit: Successful Set Policy
Document Read Only

Audit: Successful Delete Policy
Document

Audit: Successful Set Active
Policy Document

Message Rejected User On Role
Based Security

Error: Method Principal Access
Check

Error: Method Setting Database
Connection String

Error: Method Get Time
Adjustment

Error: Method Searching Files

Error: Method Retrieving Live
File Updates

Error: Method Opening For
Encryption

Error: Method Opening For
Reading

Level

Audit

Audit
Audit

Audit

Audit

Audit

Audit

Audit

Audit

Audit

Audit

Information

Error

Error

Error

Error

Error

Error

Error
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Event ID

2034

2035
2036
2037
2038

2039

2040

2041

2042

2043

2044

2045

2046

2047

2048

2049

2050

2051

2052

Description

Error: Method Retrieving
Encryption Percent Complete
Error: Method Reading File

Error: Method Querying File
Error: Method Closing File

Error: Method Enumerating
Account Authorities
Error: Method Enumerating

User Names

Error: Method Enumerating
Group Names

Error: Method Enumerating
Client Names

Error: Method Enumerating
Client Addresses

Error: Method Enumerating
Farm Names

Error: Method Enumerating
Zone Names

Error: Method Enumerating
Server Names For Farm
Error: Method Enumerating
Server Names For Farm And
Zone

Error: Method Enumerating
Server Names For Farm And
Delivery Group

Error: Method Enumerating
Application Names

Error: Method Enumerating
EventType Names

Error: Method Loading Policy
Console Config File

Error: Method Saving Policy
Console Config File

Error: Method Enumerating
Policy Documents

Level

Error

Error
Error
Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error
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Event ID

2053

2054

2055

2056

2057

2058

2059

2060

2061

2062

2063

2064

2065
2066
2067

2068

2069

2070
2071

2072

Description

Error: Method Getting Policy
Document

Error: Method Creating New
Policy Document

Error: Method Loading Policy
Document

Error: Method Saving Policy
Document

Error: Method Copying Policy
Document

Error: Method Renaming Policy
Document

Error: Method Setting Policy
Document Description

Error: Method Deleting Policy
Document

Error: Method Getting Active
Policy Document

Error: Method Setting Active
Policy Document

Error: Method Running Policy
Document Test Query

Error: Method Processing Log
Service Notification

Error: Method Encrypting

Error: Method Create Directory

Error: Method Receiving
Message

Error: Method Create Recorded
Session File Writer

Error: Method Reopen
Recorded Session File Writer
Error: Method Creating File

Error: Method Open File For
Append
Error: Method Removing LRU

Level

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error
Error

Error

Error

Error

Error

Error

Error
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Event ID

2073

2074

2075
2076
2077

2078
2079

2080

2081

2082

2083

2084

2085

2086

2087

2088

2089

2090

2091

Description

Error: Method Getting File
Details

Error: Method Removing
Expired Readers

Error: Method Deleting File

Error: Method Writing File

Error: Method Writing
Signature
Error: Method Opening Queue

Error: Method Receiving From
Queue

Error: Method Establishing
Database Connection

Error: Method Removing
Message From Queue

Error: Method Load Active
Cached Policy Document
Error: Method Init Policy
Engine

Error: Method Enum Player
User Policy Groups

Error: Method New Player User
Policy Group

Error: Method Update Player
User Policy Group

Error: Method Delete Player
User Policy Group

Error: Method Enum Player

User Role Policies
Error: Method New Player User

Account Role Policy

Error: Method Delete Player
User Account Role Policy
Error: Method Set File Hidden
Attribute

Level

Error

Error

Error
Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error
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Event ID Description Level

2092 MSMQ storage quota on VDA Error
was exceeded

Installation of server components fails

June 21,2024

The installation of the Session Recording server components fails with error codes 2503 and 2502.
Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local
Users and Groups have write permission for this folder. If not, manually add write permission.

Test connection to the database fails during install

June 21,2024

When you install the Session Recording database or the Session Recording server, the test connection
fails with the error message Database connection test failed. Please correct database instance
name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the
permission limitation failure.

Agent cannot connect to the server

June 21, 2024

When the Session Recording agent cannot connect to the Session Recording server, the Exception
caught while sending poll messages to Session Recording Broker event message is logged with an
exception text. The exception text provides reasons why the connection failed. The reasonsinclude:

+ The underlying connection was closed. Could not establish a trust relationship for the
SSL/TLS secure channel. This exception means that the Session Recording server is using a
certificate signed by a CA that the server hosting the Session Recording agent does not trust or

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 384



Session Recording 2407

the server hosting the Session Recording agent does not have a CA certificate. Alternatively, the
certificate might have expired or been revoked.

Solution: Install a correct CA certificate on the server hosting the Session Recording agent. Use
a CAthatis trusted.

« The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The machine hosting the Session
Recording server rejects the connection because it accepts only secure connections.

Solution: Use Session Recording Agent Properties to change the Session Recording Broker
protocol to HTTPS.

« The Session Recording Broker returned an unknown error while evaluating a record pol-
icy query. Error code 5 (Access Denied). For more information, see the Event log on the
Session Recording server. This error occurs when sessions are started and a request for a
record policy evaluation is made. The error is a result of the Authenticated Users group (the de-
faultmember) being removed from the Policy Query role of the Session Recording Authorization
Console.

Solution: Add the Authenticated Users group back to this role, or add each server hosting each
Session Recording agent to the PolicyQuery role.

« The underlying connection was closed. A connection that was expected to be kept alive
was closed by the server. This error means that the Session Recording server is down or un-
available to accept requests. The IIS might be offline or restarted, or the entire server might be
offline.

Solution: Verify that the Session Recording server is started and connected to the network.
Make sure that 1IS is running on the server.

« The remote server returned an error: 401 (Unauthorized). This error manifests itself in the
following ways:

- On startup of the Session Recording agent service, an error describing the 401 error is
recorded in the event log.

- Policy query fails on the Session Recording agent.

- Session recordings are not captured on the Session Recording agent.

Solution: Ensure that the NT AUTHORITY\Authenticated Users group is a member of the local
Users group on the Session Recording agent.
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&- Computer Management

File Action View Help

=2 #EXE = BE
A& Computer Management | Name Description
“ [fi System Tools & Administrators Administrators have complete and unrestricted access to the computer...
» @ Task Scheduler #Backup Operators Backup Operators can override security restrictions for the sole purpos..
’ Q E:‘em:f\':r: & Cryptographic Operators Members are authorized to perform cryptographic operations.
; ; LO::US:rs ::d Gr & Distributed COM Users Members are allowed to launch, activate and use Distributed COM obj...
1)
| Users #Event Log Readers Members of this group can read event logs from local machine
= Guests " —— N — -~ - ) by defaul...
| Groups & Users Properties m Y
> (& performance IS IUSRS Sl oot i —
= Device Manager & Network Configurati General es to ma...
4 = Storage & Performance Log Us . e counter...
{=F Disk Management || & Performance Monito %‘I Users locally a...
» s Services and Applicat & Power Users pssess limi...
& Remote Desktop Us - - ly
) Description: Users are prevented from making accidental or intentional
#& Replicator I system-wide changes and can run mostapplications
& Users | #tem—wid...
. M Members:
& HelpLibraryUpdaters embers:
2 Message Capture Usd| 2, CITRTE\Domain Users Microsoft ...
P Ty |NMEINT AUTHORIT Y Autentcated Users (S-1-5-11) (s to be as.
%"SQLSENEQUUSMSS RFJ NT AUTHORITYAINTERACTIVE (S-1-5-4) (les to be as
srvdsk
2SQLServer20055QLBr A ||es to be as...
BsQLServerDTSUser$N| \[es to be as...
SsQLServerFDHostUsel) |les to be as...
M sQLServerMSASUsery) \les to be as...
I sQLServerMsSQLSend ||es to be as...
SQLServerMSSQLUsel) ||es to be as...
Changes to a user's group membership
& sQLServerReportSenyl| [ o ] [ P— e e e o \les to be as...
B sQLserversQLAgentl)| logs on. les to be as...
B WinRMRemaoteWMIU| [ ] ’ l |igement p...
& _vmware__ 2l Cancel Apply

Server cannot connect to the database

June 21,2024

When the Session Recording server can’t connect to the Session Recording database, you might see
a message similar to one of the following:

Event Source:

A network-related or instance-specific error occurred while establishing a connection to SQL
Server. This error appears in the applications event log with ID 2047. You can find the event login the
Event Viewer on the Session Recording server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing
database connection. This error appears in the applications event log in the Event Viewer of the
Session Recording server.
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Unable to connect to the Session Recording server. Ensure that the Session Recording server is
running. This error message appears when you launch the Session Recording policy console.

Resolution:

+ You installed Microsoft SQL Server on a stand-alone server and failed to configure the correct
services or settings for Session Recording. The server must have the TCP/IP protocol enabled
and the SQL Server Browser service running. See the Microsoft documentation for information
about enabling these settings.

+ During the Session Recording installation (administration portion), incorrect server/database
information was given. Uninstall the Session Recording database and reinstall it, supplying the
correct information.

+ The Session Recording database server is down. Verify that the server has connectivity.

+ The machine hosting the Session Recording server or the machine hosting the Session Record-
ing database server cannot resolve the FQDN or NetBIOS name of the other. Use the ping com-
mand to verify that the names can be resolved.

+ Check the firewall configuration on the Session Recording Database to ensure that the SQL
Server connections are allowed. For more information, see the Microsoft article at https://docs
.microsoft.com/en-us/sql/sql-server/install/configure-the-windows-firewall-to-allow-sql-
server-access?redirectedfrom=MSDN&view=sql-server-verl5.

Logon failed for user ‘NT_AUTHORITY\ANONYMOUS LOGON’. This error message means that the
services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.

Check the recording success rate

June 21,2024

You can check the recording success rate to learn whether all sessions that match the active recording
policy are recorded. The recording success rate is calculated as follows:

Recording success rate = the number of successfully recorded sessions / the total number of sessions
matching the active recording policy

Prerequisites

+ This feature requires the Session Recording server minimum version 2203.

« To obtain site configuration and session data for accurate calculation, you must install the Bro-
ker PowerShell Snap-in (Broker_PowerShellSnapln_x64.msi). You can locate the snap-in on the
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Citrix Virtual Apps and Desktops I1SO (\x64\Citrix Desktop Delivery Controller) and follow the in-
structions to install it.

« Foranon-premises Delivery Controller, install and use the Citrix Virtual Apps and Desktops Pow-
erShell SDK. For a Delivery Controllerin Citrix Cloud, install and use the Citrix DaaS Remote Pow-
erShell SDK. To determine which SDK to install and use, be aware of the Delivery Controller that
you specified when you configured your recording policy.

Steps

To check the recording success rate across your deployment, complete the following steps:

1. Use a domain user account with proper permission to log on to the machine where you have
installed the Session Recording server.

2. Start PowerShell and change the current drive to the <Session Recording server installation
path>\Bin folder.

3. Run acommand based on the type of your deployment:

« For an on-premises Delivery Controller, run either of the following commands as needed:

- Ifthe FQDN of the Session Recording serveris the same with the FQDN in the certificate
bound to the Session Recording server, run SsRecUtils.exe -CalcRecSuccessRate
<Delivery Controller address>.

- Ifyou have specified a custom domain name with the certificate binding, run SsRecU-
tils.exe -CalcRecSuccessRate <Delivery Controller address> - SRBrokerURL <cus-
tom domain name>.

« For a Delivery Controller in Citrix Cloud, run the following commands in sequence:

Add-PSSnapin Citrix.Broker.Admin.V2

Set-XDCredentials -Customerld “<Citrix Cloud customer ID>"-SecureClientFile
“<path to secure client file>”-ProfileType CloudApi -StoreAs default

get-xdauthentication

SsRecUtils.exe -CalcRecSuccessRate CloudDDC

4. Checktherecording success rate. If all sessions that match the currently active recording policy
are recorded, the recording success rate is 100%. Otherwise, the recording success rate is lower
than 100% and you are prompted to check failed recordings in a file where session details are
provided. For example:
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100% recording success rate

50% recording success rate

B Administrator: C:\Windows\system3Z\cmd.exe - a X

Sessions are not recording

June 21, 2024

If application sessions are not recording successfully, check the application event log in the Event
Viewer on the Session Recording agent and Session Recording server. Doing so can provide valuable
diagnostic information.
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If sessions are not recording, the possible cause might be:

+ Component connectivity and certificates. If the Session Recording components cannot com-
municate with each other, session recording can fail. To troubleshoot recording issues, verify
that all components are configured correctly to point to the correct machines and that all cer-
tificates are valid and correctly installed.

+ Non-domain-joined machines. Session Recordingis designed to runinadomain environment.
If you are not running in an Active Directory or Azure Active Directory environment, you might
experience recording issues. Ensure that all Session Recording components are running on ma-
chines that are members of an Active Directory domain or Azure Active Directory domain.

+ Session sharing conflicts with the active policy. Session Recording matches the active policy
with the first published application that a user opens. Subsequent applications opened during
the same session continue to follow the policy thatisin force for the first application. To prevent
session sharing from conflicting with the active policy, publish the conflicting applications on
separate multi-session OS VDAs.

+ Recordingis not enabled. By default, installing the Session Recording Agent on a multi-session
OS VDA enables recording for the VDA. Recording does not occur until an active recording policy
is configured to allow it.

+ The active recording policy does not permit recording. A session can be recorded only when
the session meets the rules of the active recording policy.

» Session Recording services are not running. For sessions to be recorded, the Session Record-
ing Agent service must be running on a multi-session OS VDA and the Session Recording Storage
Manager service must be running on the machine hosting the Session Recording Server.

« MSMQ is not configured. If MSMQ is not correctly configured on the server running the Session
Recording Agent and the machine hosting the Session Recording Server, recording problems
might occur.

Unable to view live session playback

June 21, 2024

If you experience difficulties when viewing recordings using the Session Recording player, the follow-
ing error message might appear:

Download of recorded session file failed. Live session playback is not permitted. The server
has been configured to disallow this feature. This error indicates that the server is configured to
disallow the action.

Resolution: In Session Recording Server Properties, choose the Playback tab and select the Allow
live session playback check box.
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Recordings are corrupted or incomplete

June 21,2024

« When you view corrupted or incomplete recordings in the player, you might also see warnings
in the Event logs on the Session Recording server.

Event Source: Citrix Session Recording Storage Manager
Description: Data lost while recording file <icl file name>

The issue occurs when MCS or PVS is used to create VDAs with a master image configured and
Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId
for MSMQ.

As aworkaround, create a unique QMId for each VDA. For more information, see Install, upgrade,
and uninstall.

+ The Session Recording player might report an internal error with the message - “The file being
played has reported that an internal system error (error code: 9) occurred during its origi-
nalrecording. The file canstill be played up to the point that the recording error occurred”
when playing back a certain recording file.

The issue occurs due to insufficient buffer size on the Session Recording Agent when graphic
intensive sessions are recorded.

As a workaround, change HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor
\SmAudBufferSizeMB to highervalue data on the Session Recording agent, and then restart
the machine.

Verify component connections

June 21,2024

During the setup of Session Recording, the components might not connect to other components. All
the components communicate with the Session Recording server (Broker). By default, the Broker (an
IIS component) is secured using the IIS default website certificate. If one component can’t connect to
the Session Recording server, the other components might also fail when attempting to connect.

The Session Recording agent and the Session Recording server (Storage Manager and Broker) log con-
nection errors in the applications event log. You can view the log in the Event Viewer of the machine
hosting the Session Recording server. The Session Recording policy console and the Session Record-
ing player display connection error messages on screen when they fail to connect.
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Verify that the Session Recording agent is connected

ok wbh e

Log on to the server where the Session Recording agent is installed.

From the Start menu, choose Session Recording Agent Properties.

In Session Recording Agent Properties, click Connection.

Verify that the correct FQDN is entered in the Session Recording Server field.

Verify that the server given as the value for the Session Recording server is accessible to your
VDA for multi-session OS.

For more information, see Agent cannot connect to the server.

Note:

Check the application event log for errors and warnings.

Verify that the Session Recording server is connected

Caution:

Using the Registry Editor can cause serious problems that might require you to reinstall the oper-

ating system. Citrix cannot guarantee that problems resulting from incorrect use of the Registry

Editor can be solved. Use the Registry Editor at your own risk.

HwnN e

Log on to the machine hosting the Session Recording server.

Open the Registry Editor.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
Verify that the SmAudDatabaselnstance value correctly references the Session Recording data-
base you installed on your SQL Server instance.

For more information, see Server cannot connect to the database.

Verify that the Session Recording database is connected

1.

Using a SQL Management tool, open your SQL instance that contains the Session Recording
database you installed.

2. Open the Security permissions of the Session Recording database.

3.

Verify that the Session Recording Computer Account has access to the database. For example,
if the machine hosting the Session Recording server is named SsRecSrv in the MIS domain, the
computer account in your database must be configured as MIS\SsRecSrv$. This value is config-
ured during the Session Recording database installation.
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Test IIS connectivity

You can test connections to the Session Recording server IIS site by using a Web browser to access
the Session Recording Broker webpage. It can help you determine whether problems with commu-
nication between Session Recording components stem from misconfigured protocol configuration,
certification issues, or problems starting Session Recording Broker.

To verify 1IS connectivity for the Session Recording agent:

1. Log on to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:

» ForHTTPS:https://servername/SessionRecordingBroker/RecordPolicy
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording server.

« For HTTP: http://servername/SessionRecordingBroker/RecordPolicy.
rem?wsdl, where servername is the name of the machine hosting the Session Record-
ing server.

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

To verify 1IS connectivity for the Session Recording player:

1. Logon to the workstation where the Session Recording player is installed.
2. Open a Web browser and type the following address:

« For HTTPS: https://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
server.

« For HTTP: http://servername/SessionRecordingBroker/Player.rem?

wsdl, where servername is the name of the machine hosting the Session Recording
server.

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

To verify IIS connectivity for the Session Recording policy console:

1. Logon to the server where the Session Recording policy console is installed.
2. Open a Web browser and type the following address:

« ForHTTPS:https://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording server.
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« FOorHTTP:http:
, Where servername is the name of the machine hosting the Session
Recording server.

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

If you see an XML document within your browser, it verifies that the Session Recording policy console
is connected to the Session Recording server using the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording
server must be configured with a server certificate. All component connections to the Session Record-
ing server must have root certificate authority (CA). Otherwise, attempted connections between the
components fail.

You can test your certificates by accessing the Session Recording Broker webpage as you would when
testing IIS connectivity. If you are able to access the XML page for each component, the certificates
are configured correctly.

Here are some common ways certificate issues cause connections to fail:

+ Invalid or missing certificates. If the server running the Session Recording agent does not
have a root certificate to trust the server certificate and cannot trust and connect to the Session
Recording server over HTTPS, causing connectivity to fail, verify that all components trust the
server certificate on the Session Recording server.

+ Inconsistent naming. If the server certificate assigned to the machine hosting the Session
Recordingserveris created usingan FQDN, all connecting components must use the FQDN when
connecting to the Session Recording server. If a NetBIOS name is used, configure the compo-
nents with a NetBIOS name for the Session Recording server.

« Expired certificates. If a server certificate expired, connectivity to the Session Recording server
through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session
Recording serverisvalid and has not expired. If the same certificate is used for the digital signing
of session recordings, the event log of the Session Recording server provides error messages
that the certificate expired or warning messages when it is about to expire.

Search for recordings using the player fails

June 21, 2024
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If you experience difficulties when searching for recordings using the Session Recording player, the
following error messages might appear:

+ Search for recorded session files failed. The remote server name could not be resolved:
servername. The servername is the name of the server to which the Session Recording player
is attempting to connect. The Session Recording player cannot contact the Session Recording
server. Two possible reasons are an incorrectly typed server name or that the DNS cannot re-
solve the server name.

Resolution: From the player menu bar, choose Tools > Options > Connections and verify that
the server namein the Session Recording Servers listis correct. Ifitis correct, fromacommand
prompt, run the ping command to see if the name can be resolved. When the Session Recording
server is down or offline, the search for recorded session files failed error message is Unable to
contact the remote server.

+ Unable to contact the remote server. This error occurs when the Session Recording server is
down or offline.

Resolution: Verify that the Session Recording server is connected.

+ Access denied. An access denied error can occur if the user was not given permission to search
for and download recorded session files.

Resolution: Assign the user to the Player role using the Session Recording Authorization Con-
sole.

+ Access denied when the Player role is assigned. This error occurs when you install the Ses-
sion Recording player on the same machine with the Session Recording server, and you have
enabled UAC. When you assign the Domain Admins or Administrators user group as the Player
role, a non-built-in administrator user in that group might fail to pass the role-based check.

Resolutions:

- Run the Session Recording player as an administrator.
- Assign specific users as the Player role rather than the entire group.

- Install the Session Recording player in a separate machine rather than the Session Record-
ing server.

« Search for recorded session files failed. The underlying connection was closed. Could not
establish a trust relationship for the SSL/TLS secure channel. The error occurs when the
Session Recording server uses a certificate that is signed by a CA that the client device does not
trust or have a CA certificate for.

Resolution: Install the correct or trusted CA certificate workstation where the Session Recording
player is installed.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 395



Session Recording 2407

« The remote server returned an error: (403) forbidden. This error is a standard HTTPS error
that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects
the connection because, by default, it is configured to accept only secure connections.

Resolution: From the Session Recording Player menu bar, choose Tools > Options > Connec-
tions. Select the server from the Session Recording Servers list, and click Modify. Change the
protocol from HTTP to HTTPS.

Troubleshoot MSMQ

If a notification messageis given but the viewer cannot find any recordings after asearch in the Session
Recording player, there is a problem with MSMQ. Verify that the queue is connected to the Session
Recording server (Storage Manager). Use a Web browser to test for connection errors (if you are using
HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Logon to the server hosting the Session Recording Agent and view the outgoing queues.

2. Verify that the queue to the machine hosting the Session Recording server has a connected
state.

« If the state is waiting to connect, there are messages in the queue, and the protocol is
HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Ses-
sion Recording Agent Properties), perform Step 3.

+ Ifthestateis connected and there are no messages in the queue, there might be a problem
with the server hosting the Session Recording server. Skip Step 3 and perform Step 4.

3. Ifthere are messages in the queue, open a Web browser and type the following address:

o For HTTPS: https: , Where
servername is the name of the machine hosting the Session Recording server.

« For HTTP: http: , where
servername is the name of the machine hosting the Session Recording server.

If the page returns an error such as The server only accepts secure connections, change the
MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a
problem with the website security certificate, there might be a problem with a trust relationship
for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is
trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording
server and view private queues. Select citrixsmauddata. If there are messages in the queue
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(Number of Messages Column), verify that the Session Recording StorageManager service is
started. If it is not, restart the service.

Record Linux sessions (preview)

June 21,2024

As an experimental feature starting with the Linux VDA 2212, you can record and replay sessions
hosted on a Linux VDA. For more information, see Session recording (preview) in the Linux VDA
documentation.

Note:

Allthe policies you set for recording Windows sessions don’t apply to the Linux session recording.


https://docs.citrix.com/en-us/linux-virtual-delivery-agent/current-release/configure/session-recording.html
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